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About This Guide 

Organization 

This manual describes Novell DOS™ 7, a disk operating system 
designed to run on Intel* 8086, 8088, 80286, 386* (and later) and 
compatible microprocessors. 

Novell DOS 7 also includes Personal NetWareT~ a networking 
component that allows you to share your computer's resources with 
other users on a DOS network. 

Before you start using the operating system or the network, read the 
documentation from the manufacturer of your computer so that 
you are reasonably familiar with the computer and how it works. 

You should also read Chapter 1, "Introduction to Novell DOS 7" and 
Chapter 4, "Working with Novell DOS 7," which describe the main 
features of the operating system and explain certain concepts that 
you should be familiar with before you use the operating system. 

Before starting to set up your Personal NetWare network, read the 
section in Chapter 18, "Introduction to Personal NetWare" which 
describes terms and concepts related to networking and Personal 
NetWare in particular. 

This manual, the Novell DOS 7 User Guide, documents all aspects of 
the operating system and networking software. 

Refer to the following chapter and appendix summaries to decide 
which parts of the manual are applicable to you. 

+ Chapter 1, "Introduction to Novell DOS 7," introduces this 
operating system, and some general operating system concepts. 

About This Guide XV 



+ Chapter 2, "Installing Novell DOS 7," explains how to install 
the operating system. 

+ Chapter 3, "Installing Personal NetWare," explains how to 
install the network components. 

+ Chapter 4, "Working with Novell DOS 7," describes more 
operating system concepts, and how to start using the operating 
system. 

+ Chapter 5, "Using the Online Documentation," explains how 
you access information in DOSBook, the online manual. 

+ Chapter 6, "Editing Text Files," explains how to use EDIT, a 
menu-based editor that you can use to create and edit text files. 

+ Chapter 7, "Batch Processing," explains how to store 
frequently-used sets of commands in either a batch file or a 
macro. There are also full descriptions of the batch file 
subcommands. 

+ Chapter 8, "Commands," provides an overview of the operating 
system command set. This chapter also explains how to edit the 
command line without retyping the entire command. For 
detailed descriptions of each operating system command, use 
DOSBook. 

+ Chapter 9, "Configuring the System," explains how to change 
the system configuration by using the SETUP program. It also 
describes CONFIG.SYS and AUTOEXEC.BAT, which are the two 
main configuration files, and the commands that you can use 
in CONFIG.SYS. 

+ Chapter 10, "Managing Memory," describes the features offered 
by the memory management tools, and explains how to use 
them to maximize the memory available to your applications. 
This chapter also includes detailed descriptions of the 
commands required to load the memory management device 
drivers. 

+ Chapter 11, "Improving Disk Performance," describes two 
utilities that you can use to get maximum performance from the 
hard disk: a disk optimizer (DISKOPT) and a cache program 
(NW CACHE). 
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+ Chapter 12, "Disk Compression," describes how to use the 
Stacker* disk compression program in order to store more 
information on the hard disk. 

+ Chapter 13, "Multitasking and Task Switching," explains how to 
install and configure the Task Manager, a program that allows 
you to switch quickly and easily from one application to 
another. It also explains how to use all the features provided by 
the Task Manager menu. 

+ Chapter 14, "Securing Information," describes how to set up 
and make the best use of operating system security to prevent 
unauthorized access to information and resources on your 
computer whether or not it is part of a network. 

+ Chapter 15, "Recovering Information," describes how you can 
recover deleted data, and how the file recovery commands work 
together. 

+ Chapter 16, "Redirecting Information," explains how to redirect 
the input and output of information on your computer. 

+ Chapter 17, "Setting Up Code Page Switching," explains how to 
set up and use code page switching on your system. The 
operating system allows you to change between different 
character sets, so that you can work with documents in different 
languages using a mechanism called code page switching. 

+ Chapter 18, "Introduction to Personal NetWare," introduces the 
terms and concepts with which you will need to be familiar 
before setting up or using the Novell DOS 7 network 
component. 

+ Chapter 19, "Planning Your Network," is intended for the 
person who is responsible for setting up the network and 
describes the issues you should consider before starting to set up 
the network. 

+ Chapter 20, "Setting Up the Network," describes how to set up 
the network and how to change the network setup whenever 
necessary. 

+ Chapter 21, "Using the Network," describes the operations you 
can perform as a user of the network. 
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+ Chapter 22, "Optimizing and Maintaining the Network," 
describes operations that you should perform occasionally to 
ensure that the network is operating as efficiently as possible. 

+ Chapter 23, "NET Commands," describes how to use the 
Personal NetWare NET commands at the operating system 
prompt to perform user and administration tasks on the 
network. 

+ Chapter 24, "Using Network Diagnostics," describes how to use 
the Network Diagnostics program, which allows you to monitor 
the operation of Personal NetWare in your workgroup. 

+ Chapter 25, "Configuring Your Computer for Desktop SNMP 
Services," explains the procedures for configuring the 
workstation services. 

+ Chapter 26, "Running IPX and SPX Applications in a Task­
Switching Environment," describes how to use the Net Ware® 
task switching files that provide the data buffers needed to 
support IPX™ and SPX requests made from applications 
running in a DOS session. 

+ Appendix A, "Troubleshooting," describes problems you may 
experience using the operating system and, where possible, 
their solutions. This appendix also explains error messages 
displayed when the system either fails to boot or crashes while 
it is running. For explanations of other error messages, refer to 
DOSBook. 

+ Appendix B, "Preparing the Hard Disk" summarizes how to use 
FDISK to prepare the hard disk, if the hardware dealer has not 
already done this, before installing the operating system. 

+ Appendix C, "NetWare DOS Requester," describes the DOS 
client software that provides the interface between DOS and the 
network. 

+ Appendix D, "Code Pages," lists the character sets of the code 
pages supported by the operating system. 

+ The Glossary lists terms and their definitions, as used in this 
manual. 
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New Features in Novell DOS 7 

If you are familiar with an earlier version of this operating system 
you will find that this new version includes some significant 
advances in DOS technology. 

+ The Personal NetWare networking component enables you to 
set up a peer-to-peer DOS network so that you can share 
resources between computers running Novell DOS 7 and MS 
Windows. Personal NetWare includes a network diagnostics 
program. 

+ The INSTALL and SETUP programs are enhanced to include the 
new operating systems features. 

+ The Task Manager has been enhanced to provide "multitasking" 
on 386 (and later) computers. This means that you can run 
multiple applications simultaneously. 

+ Security for your computer is enhanced, including the following 
features: 

+ A "one-time login" allows you to log in to your computer and 
any Novell® network to which you are connected. 

+ A "screen saver" allows you to lock your computer against 
unauthorized use without logging out. 

+ Search and Destroy is anti-virus software that rids your 
computer of any existing viruses. 

+ The Stacker program allows you to create and work with Stacker 
compressed drives. 

+ NWCACHE is a disk caching program that makes your 
operating system run faster by reducing the time it spends 
waiting for data from disk. 

+ The EMM386 memory manager is enhanced to support DPMI 
and multitasking. 
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+ DOS Protected Mode Services (DPMS) allow DPMS-aware 
programs to run in protected mode. Novell DOS 7 DPMS-aware 
programs include DELWATCH, the disk cache (NWCACHE), 
and the Personal NetWare server (SERVER.EXE). 

+ Fastback Express (FBX) is a new program for backing up and 
restoring data quickly and easily. 

+ MS Windows versions of the following programs are included: 
Search and Destroy, Fastback Express, LOCK, and the network 
commands. There is also a Novell DOS 7 program group for MS 
Windows. 

+ EDIT, the text editor, has a new menu interface that includes 
mouse support. Also, DOSBook can now be accessed from 
within EDIT. 

+ The DOSKEY command allows you to create and work with 
macros. 

+ The new debugger, DEBUG, is compatible with other earlier 
DOS versions. Although DEBUG is not documented in this 
manual, it is fully documented in DOSBook, the online manual. 

+ NetWars is an arcade-style network game that you can play 
alone or with other network users. 

Enhanced Commands in Novell DOS 7 

The following commands have been enhanced in this version of the 
operating system. They are all described in detail in the "Command 
Reference" chapter of DOSBook, the online manual. 

+ CHKDSK 

+COMP 

+DEL 

+ DELWATCH 

+ DISKCOPY 
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+ DISKOPT 

+ DOSBOOK 

+ERASE 

+ FC 

+FIND 

+FORMAT 

+LOCK 

+ MEM 

+SHARE 

+ TASKMGR 

+ TREE 

+UNDELETE 

+ XCOPY 

The following batch file subcommands have been enhanced: 

+ CHOICE (new command) 

+IF 

The following CONFIG .SYS command have been enhanced: 

+ DOS (replaces HIDOS) 

+ DRIVPARM 

+ STACKS (new command) 
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chapter 1 Introduction to Novell DOS 7 

This chapter describes Novell DOS™ 7 briefly for those who are 
unfamiliar with operating systems, and lists some of the important 
features of the operating system. If you are not familiar with 
operating systems, read this chapter and Chapter 4, "Working with 
Novell DOS 7," before installing the operating system. 

If you are already familiar with operating systems, see "Features of 
Novell DOS 7" on page 1-5, and then go straight to Chapter 2, 
"Installing Novell DOS 7," for an introduction to the installation 
process. 

What is Novell DOS 7? 

Novell DOS 7 is a disk operating system (DOS) that coordinates the 
different parts of your computer to make them work as a single 
system. The operating system is the link between the physical parts 
of your computer such as the screen and the keyboard (your 
hardware) and the applications you run on the computer (your 
software). 

Novell DOS 7 creates the environment in which you interact with 
your computer and within which your programs work. 

The operating system allows you to run applications such as word 
processors and spreadsheets, and to organize the data you produce 
from your applications into files and directories so that you can 
manage it easily. Refer to Chapter 4, "Working with Novell DOS 7" 
for more information on files and directories. 
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Your computer stores the operating system programs that manage 
your applications and data on disk. When the operating system is 
loaded, these programs are moved from the disk into memory. 
Memory is used for temporary storage of programs and data while 
they are in use. When the information is no longer being used, the 
information is stored on the disk again. Refer to Chapter 4, 
"Working with Novell DOS 7," for more details about memory and 
the types of disk. 

The operating system uses memory to make multitasking possible on 
computers with a 386* processor (or later). When you enable the 
operating system's multitasking capability, your computer can run 
more than one program simultaneously. 

With the correct hardware, you can use the operating system to link 
your computer with other computers so that you can share 
information and resources. When computers are linked together, 
this is known as a computer network. Novell DOS 7 includes 
Personal NetWareT~ which is the software you need to create your 
own network; see the section "What is a Network?" below. 

What is a Network? 

A network consists of several computers with network interface 
boards linked together by special cables. When you have a network 
of computers, you can share software and resources, such as 
printers, with other computer users. 

Networking allows printers and disks (or parts of disks) which are 
not physically part of your computer to appear to applications as 
though they were. This is done by adding new disk drive letters (F:, 
for example) and printer ports (LPT3, for example) to those that the 
operating system already knows about. This way, applications can 
treat all disk drives and printers as though they were part of your 
desktop computer, even if some of them are physically part of some 
other computer. 

Many applications default to printing on LPTl, so for convenience 
network software allows you to redirect output being sent to LPTl 
so that it actually goes to a networked printer and not to the port 
on your own computer. 
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There are two different approaches to creating a network. The 
following sections explain them. 

Client-Server Networking 

Figure 1-1 

A Client-server 
Network 

In a client-server-based network, the server is a computer dedicated 
to managing the network resources. The server is the central part of 
the network, holding many resources in one place. Other computers 
(known as clients) access this central server for applications, data, 
and hard disk space. The server manages the sharing of application 
and data files among the clients using these resources. Servers also 
handle printing by storing print jobs until printers are available, 
and then directing the print jobs to their respective printer 
destinations. 

When a computer sends a request to the server for a word­
processing application and a document, for example, the server 
sends the application and the document across the network. The 
application and the document are loaded into the memory 
belonging to the computer. The server simply supplies the files and 
stores or prints documents as requested. 
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Peer-to-peer Networking 

Figure 1-2 

A Peer-to-Peer 
Network 

In a peer-to-peer network, any computer with a hard disk drive is a 
potential server. Any of the computers on the network offering 
applications, files, printers, and disk drive space to other computers 
is a server. A computer that makes a request for network resources is 
called a client. In a peer-to-peer network, resources are not located 
on a central computer but they are shared by the computer where 
the resources are resident. 

The advantage of the peer-to-peer method is that you can share 
printers, applications, CD-ROMs, data files, and other resources 
without the need for them to be centrally located in one place. You 
also do not have to assign one of your computers solely as a server 
since any computer can be a server when necessary. 

Workstation 3 

1-4 Novell DOS 7 User Guide 



Personal NetWare 

Personal NetWare, the networking system that is included in Novell 
DOS 7, provides the server and client software that enable you to set 
up a network, and to connect to Novell® NetWare® servers as well. 

The minimum hardware requirements for running Personal 
NetWare are as follows: 

+ Two or more of the following computers with hard disks and a 
minumum of 640 KB of RAM (if DOS-only) or 2 MB of RAM (if 
you are running MS Windows) on each computer: IBM* PC, 
PC/AT*, PC compatible, IBM PS/2*, IBM PS/2 compatible 

+ A cabling system (to physically connect the computers) 

+ A Network Interface Board for each computer 

+ 6 to 8 MB of fixed disk space 

Refer to Chapter 18, "Introduction to Personal Net Ware," for an 
introduction to Personal NetWare. 

Features of Novell DOS 7 

Online Manual 

The following sections provide an overview of some of the 
important features in this operating system. 

Novell DOS 7 is supplied with a complete online manual, DOSBook. 
The online manual contains detailed information about all of the 
features of the operating system including the basic commands, and 
the advanced utilities. 

Novell DOS 7 also has online help available for all its commands. 
Refer to Chapter 4, "Working with Novell DOS 7," for more 
information about online help. 

Introduction to Novell DOS 7 1-5 



Memory Management 

The memory management features include a set of device drivers 
and commands that enable you to manage memory efficiently and 
make as much memory as possible available to your applications. 
There are various device drivers available; the one you need to use 
depends upon the type of hardware you have. Refer to Chapter 10, 
"Managing Memory," for an introduction to memory and memory 
management. 

DOS Protected Mode Services 

Disk Compression 

A new DOS Protected Mode Services (DPMS) interface has been 
added to allow specially-implemented device drivers and TSRs such 
as disk compressors and disk caches to operate in extended memory 
on computers that have 286* microprocessors and above. This 
makes more memory within the first megabyte available to 
applications and other conventionally-written drivers and TSRs. 
Both Stacker* (the disk compression program), and NWCACHE (the 
disk cache) use DPMS. More detailed information about DPMS is 
available to system developers in the DOS Protected Mode Services API 
guide. 

The disk compression component enables you to keep more 
information on your hard disk by compressing the data on it. Once 
you have installed and run this component, it automatically 
uncompresses and compresses data read from or written to the disk. 
Refer to Chapter 12, "Disk Compression" for more information 
about disk compression. 
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Disk Performance 

Server Networking 

Client Networking 

Security 

There are two components of the operating system that improve the 
performance of your hard disk: NWCACHE and DISKOPT. 

+ NW CACHE increases disk access speed by reducing the amount 
of time taken for data to be read from or written to the disk or 
diskettes. 

+ DISKOPT "optimizes" the disk performance by reorganizing the 
arrangement of the data on the disk. 

Refer to Chapter 11, "Improving Disk Performance," for more 
information about NWCACHE and DISKOPT. 

The operating system network component, Personal NetWare, 
allows you to set up your computer as a server so that you can share 
your data, programs, and printers with other users on the network. 
You can also share application files if you have the necessary license 
agreements. 

When you install the client software on your computer, not only 
can it act as a client of a Personal NetWare server on the network, 
but it can also be a client of a NetWare server. Thus, creating a 
Personal NetWare network does not conflict with existing NetWare 
server-based networks. You can also add NetWare servers to your 
Personal NetWare network to increase the network services 
available. 

Security allows you to use a single username and password to log in 
to both your machine and the network. As well as this security, you 
can use the sophisticated anti-virus software to protect your 
computer against computer viruses. 
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Multitasking 

File Recovery 

Multitasking allows you to run tasks in the background 
simultaneously with a task in the foreground. For example, you 
could run a document comparison tool in the background and 
switch to a foreground process such as text editing. The document 
comparison continues to run while you edit another document. 

On computers with 8088, 8086 and 80286 (or compatible) 
microprocessors you can still switch between tasks but a task will 
not continue to run when it is in the background. 

The DELWATCH and UNDELETE commands enable your computer 
to keep track of deleted files, and recover them if you accidentally 
delete them. The backup component, Fastback Express, allows you 
to save files to any logical DOS device regularly and recover them 
later if you need them. 

MS Windows Support 

Many of the operating system commands are also written to run 
under MS Windows. You can load the MS Windows versions of 
these commands if you run MS Windows on your computer. These 
commands are placed in a MS Windows program group when you 
install the operating system. 

Running DOS from ROM 

Your computer may have DOS in ROM (read-only memory). In this 
case you will find that the operating system is already installed on 
your computer and starts automatically when you switch it on. 

Extending Your Computer System 

You may wish to extend your computer system by adding extra hard 
disks, memory boards, or diskette drives. You should consult your 
dealer about what you can use with the operating system if you are 
in any doubt. 

1-8 Novell DOS 7 User Guide 



chapter 2 Installing Novell DOS 7 

Starting INSTALL 

Note,.f' 

ProcedureT 

ProcedureT 

Before you install this operating system, if you already have DOS running on 
your machine, you may want to use your existing backup command to back up 
all the information on your hard disk. 

To start installing the operating system if you have DOS running on 
your machine: 

1. Run your existing DOS system as you usually do. 

2. Place the Novell DOS™ 7 installation diskette in drive A: or B:. 

3. Type A:INSTALL or B:INSTALL at the system prompt. 

If you do not have DOS running on your machine: 

1. Place the Novell DOS 7 installation diskette in drive A:. 

2. Press <Ctrl><Alt><Del>. 

The installation process starts automatically. To get help on 
INSTALL, press <Fl>. You can quit the INSTALL program at any 
time by pressing <Alt> X. 

Installing Novell DOS 7 from a Network Drive 

To install Novell DOS 7 from a network drive, use the XCOPY 
command with the /H switch to copy all the files, including the 
system and hidden files, to the network drive. To install it on each 
computer, the user must change to the network drive, and type 
INSTALL to run the install program. 
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The INSTALL Program 

Before the installation process begins, INSTALL scans your 
computer to obtain information about your existing hardware and 
software. INSTALL also requires information from you. Enter the 
information INSTALL requires by selecting from a list of options, or 
typing it in. 

The INSTALL program installs the following components: 

+ Novell DOS 7 Standard System 

+ Networking System 

+ MS Windows Utilities 

Unless you specify otherwise, INSTALL installs all these 
components. If you do not have MS Windows, INSTALL does not 
install the MS Windows part of the operating system. INSTALL 
calculates how much space is needed for the operating system and 
for each component, and displays how much space is available on 
your computer. Unless you have a limited amount of space 
available, install all the operating system components. 

INSTALL uses the information obtained about your computer to 
create suitable default settings. Accept the default settings for the 
installation and, if you need to change them, use SETUP after you 
have installed the operating system. 

INSTALL copies the operating system files to the default directories, 
or to the directories you specify. As the installation progresses, a 
gauge shows the percentage of the installation completed, and the 
name of each operating system file is displayed as it is copied. 

INSTALL copies the files for the components you selected to install, 
but does not enable them. You must use SETUP after you have 
installed the operating system and restarted the computer to enable 
such features as networking, disk compression, and security. 
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After Installing 

When the installation is complete, INSTALL gives you the options 

+ To read the README file which contains important information 
about the operating system 

+ To restart your computer to run Novell DOS 7 

+ To yiew the AUTOEXEC.BAT and CONFIG.SYS files 

+ To discard changes to these files 

It is recommended that you read the README file before exiting the 
INSTALL program. You can then exit INSTALL by selecting one of 
the other options. 

Read Chapter 4, "Working with Novell DOS 7" if you are not an 
experienced DOS user. If you are an experienced computer user, 
refer to Chapter 8, "Commands" to learn more about this operating 
system. 

Use SETUP to change the default settings for your system, or to 
enable additional Novell DOS 7 features, such as multitasking and 
system security. You must restart your machine so that it is running 
Novell DOS 7 before you can use SETUP. Refer to Chapter 9, 
"Configuring the System" for detailed information on how to use 
SETUP. 

Copying the System Diskettes (DISKCOPY) 

Before going any further, it is a good idea to make copies of your 
system diskettes. Use the DISKCOPY command to do this. Refer to 
Chapter 4, "Working with Novell DOS 7" for information about 
diskettes and commands. 

You will need as many blank diskettes as you have system diskettes, 
and the blank diskettes must all be the same type. DISKCOPY 
detects whether or not the blank diskettes have been formatted, and 
if not, formats them before copying. You can also use the FORMAT 
command to format a diskette. 
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Note.,.f' 

Type the following command at the system prompt if your machine 
has a hard disk, and follow the instructions given: 

DISKCOPY A: A: <Enter> 

If you have a twin-diskette drive system where both diskette drives 
are the same format, type the following instead: 

DISKCOPY A: B: <Enter> 

Remember to label the diskettes in the same way that the originals are labelled, 
so that if you need to use any of the copies you can find the diskette you need 
easily. 
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chapter 3 Installing Personal NetWare 

Preparing to Install the Network 

For an introduction to networks, see "What is a Network?" on page 
1-2. 

Personal NetWare™ comprises client and server software with 
which you can set up a peer-to-peer network, and connect to an 
existing NetWare® network. You can set your computer up to act as 
a client, or client and server. The client software allows you to 
connect to NetWare servers, running NetWare versions 2.x, 3.x, and 
4.x, and to a Personal NetWare workgroup at the same time. 

This chapter describes how to install the network software. It does 
not cover how to install network cabling. The section "Network 
Boards" gives general information about network boards; for 
detailed information, refer to the documentation supplied with the 
network board. 

To install the network, you must do the following: 

+ Install the network board. 

Each computer that is part of the network must have a network 
board installed. The network board enables your computer to 
send information to, and receive it from, other computers that 
are part of the network. You also need to configure the network 
board. 

+ Use a suitable cable to link the computers. 

All the computers that are to be part of this network must be 
linked together with special cables. There are several types of 
cable you can use. 
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Network Boards 

+ Join the cable to each network board. 

The cable used and the network board must be compatible. In 
some cases, you need to use a connector to join the cable to the 
socket in the network board. 

If your computer is already part of a network, then cabling and the network 
board are already in place, and you do not need to do the above. 

+ Plan your network. 

Decide which computers are to share resources, which 
computers are to use resources only, and which resources are to 
be shared. You might also want to ensure that usernames and 
resource names are consistent, and unique. 

+ Configure Personal NetWare. 

You must first configure Personal NetWare on a computer that 
is to share resources. You can then configure it on other 
computers that are to be part of the network. 

+ Create accounts for network users, and create network 
resources. 

Once the network hardware is in place, and you have installed 
Personal NetWare, you must create accounts for network users, 
so that they can use the shared resources, such as printers 
applications and data files. You can set up user accounts and 
resources for the network using the workgroup administration 
program, NET ADMIN. 

After you have installed Personal NetWare, and loaded the network on your 
computer for the first time, you can use the program SETUP /FIRST to create a 
simple network. The program lets you create or join a workgroup, create an 
account with a username you specify during installation, and specify which 
resources to share. 

When you install the network board, you must configure it. 
Configuring the network board involves assigning particular values 
to certain settings on the board. These settings allow the network 
board to communicate with your computer. 
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IRQ 

0 

2 

3 

4 

5 

6 

7 

Used by 

With some network boards, you must configure the board by setting 
switches on the board manually, before you place it in the slot 
inside your computer. Other boards have a software program that 
allows you to configure the board after you have placed it inside 
your computer. Refer to the documentation for the network board 
to see if you have to configure the board before or after attaching it 
to your computer. 

It is important that you keep a record of the settings you use to 
configure the network board, because you might need to supply this 
information when you configure Personal NetWare. 

The settings for which you assign values are: 

+ Interrupt Request Line (IRQ) 

The network board uses an interrupt request line to send a 
signal to the computer's central processing unit (CPU). The 
network board must use a unique IRQ. The following table 
shows the IRQs that are commonly used by other devices, and 
the ones that are most likely to be available. If not used by 
COM2: and LPT2:, most network boards use IRQ3 or IRQS. 

IRQ Used by 

Timer output 0 8 Real time clock 

Keyboard 

EGA/VGA 

COM2: 

COMl: 

LPT2: 

Diskette 

LPTl: 

Note,.f' 

9 Available 

10 Available 

11 Available 

12 Available 

13 Co-processor 

14 Hard disk 

15 Available 

If you specify an interrupt for the network board that is already being used by 
another device, you can still install the network board, but the network software 
will not run successfully. 
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+ Base Input/Output Port (1/0 port) 

The base input/output port is a channel used by the network board 
to transfer information to the CPU. All hardware devices must use 
an 1/0 port unique to each device. The following table shows the 
1/0 ports and the devices that are most likely to use them. If your 
computer does not have one of these devices, the interrupt given for 
the device in the table might be available. 

1/0 Port Device 1/0 Port Device 

1FO AT* disk controller 

200 Game controller/joystick (200-20F) 

220 Novell® network keycard 

240 

260 LPT2: (278-27F) 

280 LCD display on Wyse* 2108 PC 

2AO 

2CO 

300 

320 

340 

360 

380 

3AO 

3CO 

3EO 

XT* hard disk interface 

LPTl: (378-37F) 

SLDC/Sec Bi-Sync interface (380-38C) 

Primary Bi-Sync interface (3A0-3A9) 
Monochrome display (3B0-3BB) 

EGA display control (3C0-3CF) 
CGA display control (3D0-3DF) 

COM3: (3E8-3EF) 
Diskette controller (3F0-3F7) 
COMl: (3F8-3FF) 

2EO COM4: GPIB-Adapter 0 (2El) 
COM2: Data acquisition 

+ Base Memory Address 

The base memory address specifies the location in memory that 
the network board uses to exchange information from your 
computer with other computers on the network. It is also 
known as the RAM start address. Some network boards do not 
use RAM; if your network board is one of these, you do not need 
to specify a value for this setting. 

The base memory address often available for the network board 
is D800 (sometimes written as D8000). 
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Personal NetWare Initial Configuration 
I 

ProcedureT 

Note,.f' 

Before you begin configuring Personal NetWare, if you are new to 
networks, it is strongly recommended that you read Chapter 18, 
"Introduction to Personal NetWare," and Chapter 19, "Planning 
Your Network." Decide which computers are to share resources. The 
first computer on which you configure Personal NetWare must be a 
computer which you want to use to share resources. 

To configure Personal NetWare, you must use the SETUP command. 
Unless you disabled the network option when you installed the 
operating system, INSTALL copied the network software to the 
directory C: \NW CLIENT, or the directory you specified. If you did 
disable that option when you installed the operating system, keep 
your installation diskettes close to hand, since SETUP may require 
some of the files contained on these diskettes in order to configure 
Personal NetWare. 

When you configure the network software, your computer becomes 
a client for the network, or you can choose to make the computer a 
server as well. Use the following procedure to do both of these: 

1. Move to the NWDOS directory, and at the system prompt, type 

SETUP <Enter> 

To get on line help in SETUP, press <Fl>. 

2. Choose the Networking option. 

If the network files were not copied at installation time, SETUP 
detects this and prompts you to insert the appropriate 
installation diskette. 

The Network Client/Desktop Server Configuration screen 
displays. 

3. Select the Primary Network Interface Card. 

If your computer is already connected to a NetWare or NetWare 
Lite™ network, SETUP detects the type of the network board 
used and displays the name of the board in the Primary Network 
Interface Card field. 
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If SETUP cannot detect the type of network board used, view the 
list of boards available. Choose one from the list, or if your 
board is not included in this list, select the OEM supplied driver 
option. SETUP asks you to supply a path name for the driver. 

4. Select Share this computer's resources to allow the computer to 
share its resources such as disk drives and printers. 

If this is the first computer on which you are configuring 
Personal NetWare, you must select this option. If you do not 
want to share the resources of this computer, but to use 
resources provided by other computers, do not select this 
option. 

5. Select User of this computer and enter a name. 

Personal NetWare uses the name you supply to generate a name 
for your computer that identifies it to other computers on the 
network. It also uses this name to generate names for the disk 
drives and printers that you want to share, and to give a 
username to the account it creates. The maximum length for 
this name is ten characters. 

If you are unfamiliar with networks, press <Accept the above and 
continue> to proceed with the configuration. You do not need to 
follow the remaining steps in this procedure. Read the sections 
"Personal Net Ware Configuration Summary" on page 3-9 and "After 
Configuring" on page 3-10 to find out what to do next. If necessary, 
you can use SETUP to change the default configuration for the 
network, after you have finished the initial Personal NetWare 
configuration. 

If you are familiar with networks, you can use the remaining 
options on this screen to change the default configuration. 

6. Press <Servers to connect to> to specify the types of servers to 
which you want to connect your computer. 

You can choose to connect to NetWare 2.x, 3.x and 4.x servers, 
and Personal NetWare workgroups. To save memory, select only 
the types of servers that are part of the network you use. 
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7. You can specify a preferred NetWare server, tree, or 
workgroup. 

If you specify a preferred server, tree or workgroup, Personal 
NetWare attempts to connect you to these when you load the 
network software. 

8. Select the First Network Drive. 

The first network drive is the drive used as a login drive. For 
example, if you have A: and B: as diskette drives, and C: as the 
hard disk drive, you could assign D: as the first network drive. 

9. Press <Accept the above and continue> to return to the main 
screen. 

10. Press <Network Management> to configure the network 
management, if you use it. 

If you use SNMP, select this option. The NMR Network 
Management module is configured to load automatically; 
deselect this option if you do not want to use it. 

11. Press <Accept the above and continue> to save any changes you 
have made and return to the main screen. 

12. Select <Configure Primary Interface Card> to change the 
configuration information for the network board. 

The information in this screen varies according to the type of 
network board you are using. SETUP displays the information 
supplied by the driver for the network board which is specified 
in the .INS file. If the settings displayed are not the same as the 
ones you used when you installed the network board you must 
change these settings displayed in SETUP. 

For example, the following fields are displayed if you have an 
NE2000 board. 

+INT 

This is the interrupt request line that the network board uses 
to send a signal to the CPU. 
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+PORT 

This is the input/output port used by the network board to 
transfer information to the CPU. 

+ MEM 

This is the base memory address that specifies the location in 
memory used by the network board to exchange 
information with other computers on the network. 

+ Optional Node Address 

This is a means of identifying the board in your machine. 
The node address is unique to the board in your computer 
and is optional on Ethernet networks. 

+ Media Frame Type(s) 

Information is sent across a network in packets, and the 
Media Frame Type tells the network drivers what type of 
header to use for the packets. 

If you use NetWare 3.11 or earlier versions, make sure the 
media frame type 802.3 is specified. If you use Net Ware 3.12 
or later versions, make sure the media frame type 802.2 is 
specified. 

13. Press <Accept the above and continue> to save the changes you 
have made and return to the main screen. 

Once you have made all the configuration changes, press <Accept 
the above and continue> and then <Start Installation> to complete the 
process. 

If your computer is already part of a NetWare 2.x, 3.x or 4.x network, the driver 
and client software already exist on your machine, but SETUP replaces them 
with the versions supplied with this operating system. 

SETUP places a request in your AUTOEXEC.BAT file to run a file 
called STARTNET.BAT. When you reboot your computer, the request 
to run STARTNET.BAT lets you choose whether or not to load the 
network. If you do not load the network when you reboot, you can 
load it later by running STARTNET.BAT. 

Read the following sections "Personal NetWare Configuration 
Summary" and "After Configuring" on page 3-10 to see what to do 
next. 
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Personal NetWare Configuration Summary 

The following is a summary of what the SETUP program does as it 
configures the network. 

+ Establishes what network board you have in your computer. 

+ Sets the first network drive. 

+ Allows you to choose to share resources and lets you enter a 
name that 

• is used as a username 

• can be used as a name that identifies a computer that shares 
resources to other computers on the network 

• can be used as a name for certain network resources 

+ Prompts you to confirm the network board configuration. 

+ Generates the STARTNET.BAT file which loads the network 
drivers, and places this file in the network directory 
(C:\NWCLIENT by default). 

+ Inserts a query into your AUTOEXEC.BAT file that asks you if 
you want to load the network. 

+ Generates (or updates) the NET.CFG file and places it in the 
network directory. This file contains configuration information 
for NetWare and Personal NetWare . 

• AddsthecommandSETUP /FJ:RSTtoyourSTARTNET.BATfile 
which lets you set up a basic network. 
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After Configuring 

Note,.~ 

When the initial configuration is complete, quit SETUP and restart 
your computer. Answer Y to the prompt Load Network Software 
to load Personal NetWare. The SETUP I FIRST command in 
STARTNET.BAT runs the SETUP program so that you can 

+ Create or join a workgroup 

+ Create an account using the name you entered in the User of this 
computer option during initial configuration 

+ Specify which resources to share, if you are sharing resources on 
this computer 

SETUP /FIRST displays a welcome screen which describes what the 
program does; choose to continue or to exit from SETUP /FIRST. If 
you do not use SETUP /FIRST, a user with workgroup administrator 
privileges must run the workgroup administration program, NET 
ADMIN, to create a workgroup, place the server in a workgroup, 
create accounts and specify the shared resources. The procedures for 
setting up the network with NET ADMIN are described in Chapter 
20, "Setting Up the Network." 

You cannot use SETUP /FIRST on a computer that does not share resources until 
you have run it on one that does share resources. 

SETUP /FIRST prompts you to enter a name for the workgroup. If 
you are using the first computer on which you have configured 
Personal NetWare, you must specify a name for the workgroup. 
Press <Accept the above and continue>. The next screen lets you 
specify which of the available resources you want to share. The 
default resources to share are all the hard disk drives on the 
computer, and the first parallel printer port. Change these, if 
necessary, and then press <Accept the above and continue>. 

When you create a workgroup, an account called the SUPERVISOR 
account is created. This account has workgroup administrator 
privileges. There is only one SUPERVISOR account in each 
workgroup. 
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When you use SETUP /FIRST on computers that share resources, and 
later on computers that simply use resources, you also create an 
account for yourself in the workgroup. This account is given a 
username that is the same as the name you entered in the User of this 
computer option during configuration. 

To exit SETUP /FIRST, press <Save Changes and Exit>. You are then 
logged in to the workgroup using the account created by 
SETUP /FIRST. This account has the username specified during 
configuration, and the account has workgroup administrator 
privileges. 

Any account that has workgroup administrator privileges must be given a 
password to prevent use of the account by anyone other than the proper user. 

After you have configured Personal NetWare on the other 
computers that share resources, you can use SETUP /FIRST to 

+ Place them in the workgroup 

+ Specify which resources these computers are to share 

+ Create a user account using the name specified during 
configuration 

When you use SETUP /FIRST on these computers, select the existing 
workgroup name instead of typing in a workgroup name. You can 
also use NET ADMIN to do the above. 

After you have configured Personal NetWare on computers that are 
not going to share resources, you can use SETUP /FIRST to create an 
account in the workgroup for each user, using the name specified 
during configuration. 

If you run SETUP /FIRST as described above, the following are true: 

+ A single workgroup has been created which has at least one 
server in it. 

+ A SUPERVISOR account for the workgroup has been created. 
This account has workgroup administrator privileges. 
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+ An account is created in the workgroup, for each user, with a 
username that is the same as the name specified in the User of 
this computer option during configuration. All these accounts 
have workgroup administrator privileges. No account has a 
password as yet. 

+ The resources to share (hard disk drives and printers) have been 
specified. 

You now have a simple network set up. You may find that this 
network is sufficient for your needs. If so, then refer to the sections 
"Managing Servers" on page 20-14," "Sharing Directories" on page 
20-24," and "Sharing Printers" on page 20-32" to learn how to set 
these up for use. 

If you want to create more accounts in the workgroup, or do not 
want every user to have workgroup administrator privileges, refer to 
"Creating and Modifying User Accounts" on page 20-6. If you are 
concerned about security, read Chapter 14, "Securing Information." 

If your computer does not share resources, then refer to Chapter 21, 
"Using the Network" so you can make the best use of the resources 
available. It is also a good idea to set a password on your account as 
soon as possible; refer to the section "Changing Your Password" on 
page 21-35. 

Upgrading from NetWare Lite 

3-12 

If you already use NetWare Lite, there is a program, NLMIGRAT, 
provided with this operating system so that you can easily move 
from NetWare Lite to Personal NetWare. 

Using NLMIGRAT transfers the following components of your 
NetWare Lite network to Personal NetWare: 

+ The NetWare Lite server 

+ The user accounts 

+ The shared resources 

+ The current rights 
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checklistV 

In order to transfer these resources, you must have 

0 Configured Personal NetWare and chosen to share the resources on 
a computer that is also a NetWare Lite server before configuring 
Personal NetWare on any other computer. 

0 Created a workgroup for the Personal NetWare server using 
SETUP /FIRST or NET ADMIN. 

0 Logged in to the workgroup using the SUPERVISOR account. 

Once you have configured Personal NetWare on the first computer 
that shares resources and run SETUP /FIRST, there are two accounts 
available in the workgroup; a user account and the SUPERVISOR 
account. The SUPERVISOR account gives you sufficient 
administrative rights to transfer all the NetWare Lite resources. 

To run this program, at the system prompt, type 

NLMIGRAT <Enter> 

The program transfers the NetWare Lite components in the 
following order: 

+ Server settings 

+ User names and accounts 

+ Resources 

+ Access rights for printers and directories 

After you have transferred the NetWare Lite components to 
Personal NetWare, restart your computer, and load the new 
network. 

The upgrade program cannot move the Net Ware Lite user passwords 
because the passwords are encrypted. Once you have loaded 
Personal NetWare, you must reset each user password. Refer to 
"Creating and Modifying User Accounts" on page 20-6, to learn 
how to set passwords. 
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3-14 

If all the NetWare Lite resources are not transferred, it might be 
because the account you used does not have the correct 
administrative rights. The administrative rights and the NetWare 
Lite resources you can transfer with those rights are shown as 
follows: 

If your account is the 

Server Owner 

Server Manager 

Workgroup 
Administrator 

You can transfer 

Server settings, resources (directories and 
printers), and access rights 

Server settings, resources (directories and 
printers), and access rights 

Workgroup audit, and user accounts 

The SUPERVISOR account always has workgroup administrator 
privileges, and is also the server owner unless another account has 
been designated the server owner. Use NET ADMIN (the workgroup 
administration program) to change the level of administrative 
rights for an account. NET ADMIN is described in Chapter 20, 
"Setting Up the Network." 
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chapter 4 

Memory 

Disks 

Working with Novell DOS 7 

This chapter is your starting point for using the Novell DOS™ 7 
operating system. 

If you are already an experienced user, or you have used this 
operating system before, you do not need to read this chapter. Refer 
to the rest of this manual for more information about the operating 
system. 

Every computer has memory to store information and to run 
programs. Memory stores information as patterns of 1 's and O's, 
called bits. A group of eight bits is called a byte. A character such as 
3 or? can be represented in one byte of memory. Because computers 
contain large amounts of memory, however, memory is usually 
referred to in terms of kilobytes (KB) and megabytes (MB); one KB is 
1,024 bytes and one MB is 1,024 KB. 

The memory used to run programs is referred to as Random Access 
Memory, or RAM for short. 

Disks provide permanent storage of the programs you use on your 
computer and the data you accumulate as you use them. 

There are several different types of disk you can use: hard disks, 
diskettes (floppy disks), and memory (or virtual) disks. The 
following sections give brief descriptions of these types of disk. 

There is another type of disk called a removable disk. Exam pl es of 
these are Syquest* and Bernoulli* drives. 
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Hard Disks 

Diskettes 

Disk Drives 

A hard disk is permanently fixed inside your computer. Hard disks 
are sometimes referred to as fixed disks. 

Diskettes are removable from your computer. They are available in 
different sizes and capacities; 5.25-inch diskettes have capacities of 
360 KB and 1.2 MB while 3.5-inch diskettes have capacities of 720 
KB, 1.44 MB, and 2.88 MB. 

Always handle diskettes with care. 

Protecting Data on Diskettes 

To prevent data being copied onto a diskette, or its contents being 
changed in any way, you can write-protect it. 

Write-protect a 5.25-inch diskette by placing a tab (usually supplied 
with the diskette) over the notch in the top right-hand side of the 
diskette. The diskette is write-protected until the tab is removed. 
Some 5.25-inch diskettes do not have a notch; these diskettes are 
permanently write-protected. 

The write-protect notch on 3.5-inch diskettes is built into the 
diskette. To write-protect the diskette, slide the plastic tab up so that 
a hole appears through the write-protect notch. 

You get access to a disk or diskette through a drive. A drive is 
identified by a letter followed by a colon. The first diskette drive is 
usually A:, the second diskette drive B:, and the hard disk drive is 
usually the C: drive. If there is more than one partition on the hard 
disk, each partition is assigned its own drive letter so that it can be 
accessed as a separate drive. 
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Disk Configurations 

Memory Disks 

Computers usually have one of the following disk configurations: 

+ A hard disk and a single diskette drive 

+ A hard disk and two diskette drives 

If you have a hard disk, you will perform most of your work on the 
hard disk. 

The third type of disk, a memory disk, is not a physical disk but part 
of your computer's memory that the operating system treats as a 
disk. This is why a memory disk is also referred to as a virtual disk. 
Use the Novell DOS 7 device driver VDISK.SYS to set up a memory 
disk; refer to Chapter 9, "Configuring the System" for information 
on how to do this. 

A memory disk only stores data temporarily. When you switch off 
your computer, or reboot, any data stored in a memory disk is lost. 
You must use a hard disk or diskettes to store data permanently. 

Preparing Disks for Use 

Before you can use a hard disk, it must be formatted and 
partitioned. Formatting the disk enables it to store data. Partitioning 
the disk divides it into one or more partitions so that the operating 
system can store and retrieve data more easily. Also, the operating 
system must be installed on a primary partition. 

If the hard disk manufacturer has already prepared the disk, you do 
not need to do it yourself. The operating system installation 
program detects whether your hard disk has been prepared, and 
gives you appropriate instructions if the hard disk is not prepared. 
Refer to Appendix B, "Preparing the Hard Disk" for more 
information. 
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Commands 

You may also need to format diskettes before using them. 
Formatting divides the diskette into sections so that the operating 
system can store and retrieve data on the diskette. Use the FORMAT 
command to do this; refer to the "Command Reference" chapter of 
DOSBook for more information on FORMAT. 

You use a command to make your computer carry out a particular 
task such as copying a file. Commands can act on specified files, 
groups of files, or entire disks. Command names are usually 
followed by options which modify the way the computer carries out 
the command. 

The Novell DOS 7 command set includes four different types of 
command: internal, external, batch file commands, and 
configuration commands. 

The following sections describe the different types of command and 
how to use them. 

Internal Commands 

Internal commands are the commands that are loaded into memory 
when you start up the operating system, because they are used most 
frequently. They are loaded from a file called COMMAND.COM, so 
it is easy for the operating system to execute them. You can run 
internal commands whenever the system prompt is displayed. 

External Commands 

External commands are only loaded into memory when you run 
them, to save space in memory. External command files have the 
filename extensions .COM and .EXE. When you enter an external 
command at the system prompt, the operating system retrieves the 
appropriate command file from disk and executes it. The operating 
system must have access to the directory which contains the 
external command file. 
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PATH is an internal command that enables the operating system to 
locate external commands. Refer to the "Command Reference" 
chapter of DOSBook for a detailed description of PATH. 

Batch File Commands 

A file in which you store a sequence of commands you use 
frequently is called a batch file. You can use a batch file to start an 
application, for example. When you enter the name of the batch file 
at the system prompt, the commands in the batch file are executed 
one after the other, as if you are entering them separately. 

The operating system provides a special set of commands to use in 
batch files. These batch file commands are stored the same way as 
internal commands, except the CHOICE command. Refer to 
Chapter 7, "Batch Processing" for further information. 

Configuration Commands 

Configuration commands are used in the file CONFIG.SYS. The 
operating system reads the CONFIG.SYS file every time you start 
your computer, and executes all the commands it finds. Many 
CONFIG.SYS commands are added to the CONFIG.SYS file when 
you install the operating system or run the SETUP program, but you 
can also edit CONFIG.SYS yourself. Refer to Chapter 9, 
"Configuring the System" for more information about the 
configuration commands. 

Entering Commands 

You enter commands at the system prompt. Whenever you see the 
prompt, you know that the computer is waiting for you to enter an 
instruction from the keyboard. The information you enter at the 
prompt is referred to as the command line. 

If the operating system is installed on a hard disk, the default system 
prompt appears as follows: 

[Novell DOS] C:\> 

This indicates that C: is the current drive. When you enter a 
command, the operating system always looks to the current drive. 
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If you have installed the operating system onto diskettes, then A:\> 
is shown as the current drive in the system prompt. 

After typing the command line, you must always press <Enter> to 
make the operating system carry out the instructions. 

Command names are up to eight characters in length and are 
usually followed by options that modify the way the operating 
system carries out the command. For example: 

DIR C:\LETTERS /2 

Command options such as C: \LETTERS are known as parameters. 
The parameter C: \LETTERS tells the DIR command which 
directory's files to list. Command options with a forward slash (/) 
are referred to as switches. You use a switch to select a particular 
version of the command. The switch /2, for example, tells DIR to 
display the directory listing in two columns. 

Punctuation is usually required to separate command names from 
their associated options. In general, you include a space between 
the command name and the options and a space between each 
option. You must have a space between parameters, and between 
parameters and switches, but you can type several switches without 
using a space between them. For example: 

DEL C:\LETTERS\MAYLET.TXT /CS 

Sometimes, other symbols are required, such as commas and 
colons. The MODE command, for example, looks as follows: 

MODE COM1:9600,N,8,1 

The "Command Reference" chapter of DOSBook includes the 
complete syntax for every operating system command as well as an 
explanation of the syntax. 
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Editing the Command Line 

Changing Drives 

If you make a mistake when typing a command, you see the 
following message when you enter the command: 

Command or filename not recognized 

You may have simply mistyped the instruction or directed the 
command to the wrong drive (see "Changing Drives" below). If you 
make a mistake and you have not yet pressed <Enter>, you can 
correct the command line by pressing the <Backspace> key which 
erases the command line one character at a time. You can then type 
the command line again. 

The operating system also has a powerful feature that stores 
commands entered previously and lets you recall them by pressing 
the up and down arrow keys. You can then edit and issue them 
again. You may have enabled this feature when you installed the 
operating system by setting the HISTORY option to ON. If you did 
not enable HISTORY, you can enable it at any time by running the 
SETUP program; see Chapter 9, "Configuring the System" for 
detailed information about using SETUP and the HISTORY option. 

The "Command Reference" chapter of DOSBook contains a 
complete list of the keys you can use for command line editing. See 
the sections "Command Line Editing" and "Extended Command 
Line Editing" in the "Command Reference" chapter of DOSBook, 
the online manual. 

When you enter a command, the operating system always looks for 
that command on the current disk drive. If you want a command to 
operate on another drive, you change drives by entering the new 
drive letter followed by a colon. For example: 

A: 

This changes the current drive to drive A: and the default prompt 
changes to: 

[Novell DOS] A:\> 
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Any command you enter now operates on the A: drive. 

You can tell the operating system to look at another drive without 
changing the current drive by including the drive letter (and colon) 
when entering the command. For example: 

DIR A: 

Getting Online Help for Commands 

You can display help text about any command and its options by 
entering the command followed by /? or /H. 

You can also use DOSBook to obtain information about the 
operating system. DOSBook is an online manual. To display 
information about a particular command, type the following at the 
system prompt, where command is the command you want 
information about: 

DOSBOOK command <Enter> 

Displaying a Screenful of Data at a Time 

Some commands display information that fills more than one 
screen; text moves off the screen (scrolls) so that you miss the first 
part of the information. This will happen if you enter a DIR 
command and the listing is very long, for example. You can suspend 
scrolling in any of the following ways: 

+ Press the <Pause> key or <Ctrl> S. To start scrolling again, press 
any key. 

+ Some commands have a switch, /P, that causes listings to display 
one screenful at a time. 

+ Use the MORE command. Refer to the "Command Reference" 
chapter of DOSBook for a description of MORE. 
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Stopping Commands 

You can stop a command after entering it by pressing <Ctrl> C or 
<Ctrl><Break>. Command processing stops and you return to the 
system prompt. 

Working with Files and Directories 

Information stored permanently on a hard disk or diskette is 
organized into files. Files contain information such as programs, or 
the text of a letter or report. 

Every file has a name to identify it and (optionally) an extension. A 
filename extension is separated from the filename by a period(.) 
and often identifies the class of the file: LETIER.TXT, for example. 

Directories are a means of keeping track of your files by organizing 
them into groups according to contents, project names, user names, 
classes, and so on. Directories contain information about the files 
they have stored in them, including file size, time of creation, and 
when they were last changed. Directories can be arranged in a 
hierarchical structure so that they can contain other directories 
(subdirectories) as well as files. A directory can also have an extension 
to its name, but extensions to directory names are not used 
frequently. 

Naming Files and Directories 

Filenames and directory names can be up to eight characters in 
length. A file can have a filename extension of up to three 
characters. The valid characters to use are letters (A through Z) and 
numbers (0 through 9). 

The following special characters are not valid: 

<>=,;:.*?[]/\+I 
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Table 4-1 

Also note that the operating system uses special names to identify 
peripheral devices added to your computer called "reserved device 
names." You should not name your files with any of these. There are 
also some common filename extensions that are used for particular 
types of files; refer to Table 4-1. 

Reserved Device Names and Filename Extensions 

Reserved Device Name Reserved Filename Extension 

CON .$$$ 

AUX or COMn .BAK 

PRN or LPTl .BAS 

LPT2 .COM 

LPT3 .CPI 

NUL .EXE 

CLOCK$ .SYS 

Common File Commands 

There are some commands that you will use very frequently with 
files; refer to Table 4-2. 

Table 4-2 

File Commands 

Command 

COPY 

DIR 

MOVE 

DEL, ERA, 
DELQ, ERAQ 
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Purpose 

Copies one or more files between disks, 
directories, and files. 

Lists the files in the current directory. 

Moves one or more files between disks and 
directories. 

Deletes one or more files. DELQ and ERAQ 
prompt you before deleting each file. 



Table 4-2 continued 
File Commands 

Command 

TYPE 

RENAME (REN) 

PRINT 

Purpose 

Displays the contents of a text file on the 
screen. 

Changes the name of one or more files. 

Sends a file to a printer if one is connected 
to your computer. 

Note that Novell DOS 7 has extended versions of COPY, DIR, and 
DEL. They are XCOPY, XDIR, and XDEL. The "Command 
Reference" chapter of DOSBook has detailed descriptions of these 
and all the commonly-used file commands. 

Working with Groups of Files 

Wild cards 

To make it easier for you to use commands with files, the operating 
system has wildcards and filelists. Using wildcards and filelists, you 
can make these commands operate on more than one file at a time. 

Use wild cards to partially specify a filename or filename extension 
so that several files match it. There are two types of wildcard: the 
question mark (?) and the asterisk (*). 

The ? Wildcard 

The question mark (?) matches any character in exactly the same 
position as the question mark. The following example shows this: 

CHAPTER?.DOC matches with CHAPTERl.DOC 

CHAPTER2.DOC 

Therefore, you can use a single command to copy both of these files, 
by using the ? wildcard in the command line. 
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File lists 

4-12 

The * Wildcard 

The asterisk (*) is "shorthand" for several question marks. The 
asterisk is valid from the position in which it appears to the end of 
the filename. The following example shows this: 

CHAP*.* matches with 

and with 

CHAPTER I.DOC 

CHAPTER2.DOC 

CHAPMEM.FAX 

CHAPFAX.BAK 

Be careful when you use wildcards. The wildcard *.*,the global wildcard, 
includes all files. Typing DEL*.* would delete all files in a directory. If you use 
the global wildcard, the operating system prompts you before executing the 
command. If you want prompting before you delete any files, use DELQ and 
ERAQ. 

A filelist is a text file that contains a list of filenames. When you use 
a filelist at the system prompt, the filelist name is preceded by the 
@(at) symbol. This tells the command that the file immediately 
following the@ is a filelist, and to execute on each file named in the 
filelist. 

Create filelists as text files. There is no limit to the number of 
filenames you can include, and you can use wildcards within 
individual filenames (but not in the filelist name). Each filename 
must be on a separate line or separated from other filenames by a 
space, tab, or comma. 

For example, you could create a filelist called @MYFILE.LST 
containing the following: 

FRED.BAT 

BERT.BAT 

*.DAT 

Then, when you perform an operation on @MYFILE.LST such as 
copying it, FRED.BAT, BERT.BAT, and all files in the current 
directory with extension .DAT are copied. 
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Directory Concepts 

The following is a list of concepts that you need to understand to 
make the most of the operating system's directory structure: 

+ The root directory 

When you prepare a disk or diskette and start storing files on it, 
a directory is created called the root directory. It is not practical 
to have a large number of files in the root directory so the 
operating system allows you to build up hierarchical directory 
systems, one for each disk (or drive) on your system. 

+ Subdirectories 

Directories created from the root directory are called 
subdirectories. Subdirectories can also contain other 
subdirectories. As you add more and more directories to the 
structure, it begins to grow into an inverted "tree," with the root 
at the top and the branches growing downwards. 

+ The current directory 

The directory in which you are working is considered the 
current directory by the operating system. When you carry out 
a task such as creating a file, the operating system assumes that 
you want to create the file in the current directory, unless you 
specify otherwise. 

You can move around the directory structure from the root 
downwards, and up to the root again. You can also go directly to a 
subdirectory without going through intervening directories. Use 
the CHDIR (or CD) command to move around the directory 
structure; refer to the "Command Reference" chapter of DOSBook 
for a description of CHDIR (CD). 
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Special Directory Symbols 

Paths 

4-14 

A directory which contains a subdirectory is known as the "parent" 
of the subdirectory. All directories except the root have a parent 
directory. The operating system uses special symbols to indicate the 
current directory and the parent of the current directory: 

means the name of the current directory. 

means the directory above the current one (the 
parent directory). 

These entries are automatically created by the operating system 
when you make a directory. When you issue a DIR command, the 
entries. and .. appear at the top of the listing. You cannot delete the 
. and .. entries in a directory. 

In a tree directory structure, more than one file or directory can 
have the same name. For example, both the directories SALES and 
ACCOUNTS can contain a file called FRANCE.DOC. The operating 
system distinguishes between the two files called FRANCE.DOC by 
using a path. The path shows the operating system the route 
through the directory structure to the files. 

Specify a path using a series of directory names, separated by 
backslashes(\). This traces a route through the tree structure to the 
desired point. When the first directory in the path is preceded by a 
backslash, the path begins at the root directory. Paths which begin 
with a directory name are taken as starting from the current 
directory. 

When you add a filename to a path, it becomes a file specification 
(or filespec). The path in a file specification can contain up to 32 
subdirectories but must not exceed 63 characters. 
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Working with Directories 

Table 4-3 

Directory Commands 

Redirection 

There are five commands that are used specifically with directories. 
They are listed in Table 4-3. 

Command 

TREE 

MKDIR (MD) 

CHOIR (CD) 

REN DIR 

RMDIR (RD) 

Purpose 

Lists all the directories on a specified drive. 

Creates a directory. 

Changes your current directory. 

Renames a directory. 

Deletes an empty directory. 

Refer to the "Command Reference" chapter of DOSBook for a more 
detailed description of all these commands. 

Redirection involves changing the way you send information to a 
command, or receive the result of the command. You can redirect 
input (what you enter at the keyboard) and output (the result of a 
command), which is usually sent to the screen. 

Redirecting Output 

To send output to a file or print device, for example, instead of the 
screen, use the redirection symbol >. For instance, you could store 
the output from a DIR command in a file by using redirection. The 
following command stores the current directory listing in the file 
MYLIST.DOC: 

DIR > MYLIST. DOC <Enter> 
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Redirecting Input 

Pipes and Filters 

You can also redirect the output from a command to a device, using 
the device name. The following command, for example, sends the 
current directory listing to the first parallel printer: 

DIR > PRN <Enter> 

You can use the redirection symbol< to make a command take its 
input from a file. 

The following command, for example, sorts the contents of the file 
TELNUMS.DOC into alphabetical order: 

SORT < TELNUMS • DOC <Enter> 

In order to use the output from one command as the input to 
another, you can use a pipe (the vertical bar I). The following 
command, for example, pipes the directory listing through the 
MORE command: 

DIR I MORE <Enter> 

MORE displays the listing one screenful at a time. 

MORE is a special type of command, known as a "filter command. 
Filter commands read input, act upon it and then output the result, 
often to the screen. The common filter commands are MORE, SORT, 
and FIND. 

You can pipe commands through filter commands and combine 
them with redirection. 

Refer to Chapter 16, "Redirecting Information" for more 
information on redirection. 
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chapter 5 Using the Online Documentation 

The Novell DOS™ 7 online manual is called DOSBook. It contains 
detailed reference information about all aspects of the operating 
system, such as detailed descriptions of the Novell DOS 7 command 
set. This chapter explains how to start DOSBook and use the online 
documentation. 

Note that some commands, such as DISKOPT and EDIT, have a full­
screen interface that includes a Help menu; this provides detailed 
help text about how to use the utility, and you may find that you 
do not need to refer to DOSBook for these commands. 

Starting DOSBook 

Note,.f' 

To use a mouse in DOSBook, you need to load a suitable mouse 
driver first: MOUSE.COM, for example. 

Start DOSBook by entering the following at the system prompt: 

DOSBOOK 

A Welcome screen is displayed that lists five options you can choose 
to find the information you need in various ways. Table 5-1 
describes these options. 

If you have a monochrome monitor, you may need to type DOSBOOK /B to 
force the DOSBook display to be black and white rather than shades of gray, 
which can be difficult to read. 
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Table 5-1 

If you require information about a specific topic, you can enter the 
following at the system prompt: 

DOSBOOK topic 

where topic is the name of the subject you want to find, for example, 
a command name. This takes you directly to the index if a match is 
found, where you can select it to read the information about the 
topic. 

Welcome Screen Options 

Select this option 

Introduction 

Configuring 

Commands 

Contents 

Index 

To 

Go to the introductory chapter of DOSBook. 

Read the chapter about configuring your 
system. 

Display a table of the DOS commands. Select a 
command by clicking on it with the mouse or 
highlight the command by using the <Tab> key 
and press <Enter>. 

Go to the complete contents list of DOSBook. 

Go to the complete index listing for DOSBook. 

Select one of these options by clicking on it with the mouse or, if 
you are using the keyboard, highlight the option by using the <Tab> 
key and press <Enter>. Repeat this selection procedure to select other 
highlighted items in DOSBook, for example, chapter titles from the 
contents list or items from the index. 
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Help on DOSBook 

After you have started DOSBook, press the <Fl> key for detailed 
help about how to use DOSBook. This help fully explains how to 
move around DOSBook by using either the mouse or the keyboard. 
It also explains the concept of keywords, and demonstrates how 
they work in DOSBook. 

There is also a Help menu at the top of the DOSBook screen; display 
this menu either by selecting it with the mouse or by pressing 
<Alt> H. The menu enables you to access the DOSBook Glossary, 
Contents, and Index, and lists the short keys associated with these 
functions. It also lists the short keys for moving between sections of 
DOSBook. 

Searching for Information 

You can search for a topic in DOSBook by searching the index for 
words, or searching for a specific word in the text. To search the 
index in DOSBook, start typing a word that you wish to find and a 
search dialog box is displayed. This shows the word that you are 
typing in. Press <Enter> or click on the <Search> button to search the 
index. If a match is found, you are taken to that entry in the index 
where it is highlighted. To read the information about it, press 
<Enter> or click the mouse button. If no match is found, you are left 
in the index at the letter that the word started with. 

To search for a particular word in the text, open the Search menu by 
clicking on it with the mouse or by pressing <Alt> S, and select 
Search text. A dialog box displays in which you type a word and then 
press <Enter>, or click on the <Search> button to search for that 
word. 

When you search the index for a topic you can press <F3> to repeat 
your last search. Use this to find another entry in the index, because 
there may be more than one match to the word you are trying to 
find. You can also use <F3> to repeat your last text search. 
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Search Menu 

Search index 

Search text 

Repeat last search 
<F3> 

Keywords 

Reference Keyword 

Enables you to search for a topic in the index. You are taken to the entry 
in the index if a match is found. 

Enables you to search for a word in the text. 

Repeats the above searches allowing you to find another topic in the index 
or the next word in the text. This option is only available after you have 
completed a search. 

This section introduces you to the concept of keywords, which are 
central to the way that you use DOSBook. 

In DOSBook, certain words or groups of words are defined as 
keywords, and are highlighted to distinguish them from the rest of 
the text. There are two types of keyword, each highlighted 
differently: 

+ Reference keywords 

+ Glossary keywords 

The form the highlighting takes depends upon the type of monitor 
and upon the color configuration of your computer; refer to the 
DOSBook help (press <Fl>) to see how they appear on your 
computer. 

A reference keyword represents a link to another part of DOSBook. If 
you move the mouse cursor to a reference keyword and click on the 
keyword, you jump to a point in DOSBook where there is more 
information related to that keyword. If you are using the keyboard 
rather than the mouse, use the <Tab> key to select a reference 
keyword, and then press <Enter>. 

To go back to the screen from which you jumped, use the mouse to 
select the <Backtrack> button at the bottom of the screen, or press 
<Alt> B. 
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Glossary Keyword 

A glossary keyword enables you to display a short note that provides 
further information about the keyword. If you move the mouse 
cursor to a glossary keyword and click on the keyword, a new 
window is opened with a short note about the keyword. If you are 
using the keyboard rather than the mouse, use the <Tab> key to 
select a glossary keyword, then hold down the <Enter> key. The note 
clears from the screen when you release the mouse button or the 
<Enter> key. 

How to Move Around DOSBook 

Table 5-2 

DOSBook Buttons 

The following tables summarize the buttons you can use to move 
around DOSBook. 

Table 5-2 explains the function of the buttons at the bottom of the 
DOSBook screen. You must use the mouse to select a button; refer 
to Table 5-3 for the keyboard alternatives. 

Use this button 

<Backtrack> 

<Next> 

<Previous> 

<Exit> 

To 

Jump back to the section you last viewed. 
(Repeated use of this button enables you to 
trace back through the screens you have 
viewed.) 

Go to the next page. 

Go to the page that precedes the current 
page. 

Exit DOSBook. 
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The table below lists the keys you use to move around DOSBook, 
and to invoke the various features provided within DOSBook. 

Table 5-3 

DOSBook Keyboard Commands 

To do this 

Display the DOSBook Contents. 

Display the DOSBook Glossary. 

Display the DOSBook Index. 

Display the information associated with the selected keyword. 

Exit DOSBook. 

Go to the next page. 

Go to the page that precedes the current page. 

Jump back to the section you last viewed. (Repeated use of this button 
enables you to trace back through the screens you have viewed.) 

Jump to the start of the current section. 
Jump to the end of the current section. 

Move the text cursor to the start of the current screen display. 
Move the text cursor to the end of the current screen display. 

Scroll through the text. 

Select the Help menu. 

Select the next keyword. 
Select the previous keyword. 

Select the Window menu. 

Select the Search menu. 

Repeat last text search. 
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Use these keys 

<Alt> C 

<Alt> G 

<Alt> I 

<Enter> 

<Alt> X 

<Alt> N 

<Alt> P 

<Alt> B 

<Ctrl><Home> 
<Ctrl><End> 

<Home> 
<End> 

<up-cursor> or <PgUp> 
<down-cursor> or 
<PgDn> 

<Alt> H 

<Tab> 
<Tab><Shift> 

<Alt> W 

<Alt> S 

<F3> 



Printing from DOSBook 

You can print the section of DOSBook that is currently displayed or 
print the whole chapter that you are in. Select the Print section 
option from the Window menu. The Print dialog gives you the 
option to either print to a device or specify a filename. If you enter 
a filename, the text is saved to that file. Instead of a filename, you 
can specify an output device, such as LPTZ. You can then choose the 
<Print Section> or <Print Chapter> buttons. 

Note that DOSBook outputs the text in non-Postscript* format. If 
you want to print on a PostScript printer, you must first run the 
SCRIPT command. For example, to print to a Postscript printer on 
LPTl, enter the following command before you run DOSBook: 

SCRIPT LPTl 

SCRIPT will intercept the text that DOSBook sends to LPTl, convert 
it to Postscript, then pass the Postscript text onto LPTl. 
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chapter 6 

Starting EDIT 

Editing Text Files 

This chapter describes how to use EDIT, a menu-based editor which 
you can use to create and edit text files. You can use a keyboard or 
mouse, and there are shorthand forms for some of the common 
commands, including WordStar* compatible commands. You can 
use EDIT to do the following: 

+ Create a new file 

+ Browse through a file 

+ Edit a file 

To start the operating system editor from the system prompt, type 
the following: 

EDIT <Enter> 

The EDIT menu interface displays, showing the Select File to Edit 
dialog box. The current drive and directory shows in the Files field. 
The Files window displays a list of the files in the current directory, 
and the Dir and Drives window displays the subdirectories and the 
available drives. 

EDIT has on-line help available; press <Fl> to use it, or select the 
<Help> button. 
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Note,.~ 

Using EDIT 

There are three ways you can select a file to open within EDIT. 

1. Type the filename, including the path if the file is in a different 
directory, in the File field. To open the file, press <Enter>, or use 
the mouse to point to the <OK> button and click to select it, or 
press <Tab> three times to highlight the <OK> button and press 
<Enter> to select it. 

If the filename you enter does not exist, EDIT recognizes this and prompts 
you to choose whether or not to create the file. Select <OK> if you want to 
create the file. Select <Cancel> if you do not want to create the file. EDIT 
returns you to the Open File dialog box. 

2. Move to the Dir and Drives window using the mouse or <Tab> 
key. Select a drive or directory by scrolling through the list, 
using the <up-cursor> and <down-cursor> keys until you reach 
the drive or directory you require. Note that as you scroll 
through the list, the entry in the File field changes to reflect 
which directory or drive is highlighted in the window. 

Press <Shift><Tab> to move back to the Files window. Scroll 
through the list of files until you find the file you wish to open. 
Nate that the filename in the File field changes as you scroll 
through the list. Once the correct filename appears in the File 
field, select <OK> using the mouse, or by pressing <Tab> twice 
and then <Enter>. 

If you type EDIT at the system prompt followed by the path, if needed, and 
name of a file, EDIT opens that file directly, and does not display the Open 
File dialog box. If the file does not exist, EDIT prompts you to choose 
whether or not the file is created. Select <OK> to create it, or <Cancel> to 
edit a different file. 

3. If the file already exists, move the mouse pointer to the filename 
you want in the list of files and double-click the mouse button. 

To enter text, type as you would using a word processor or 
typewriter except, when you reach the end of a line, press <Enter> 
to start a new line. This is because in EDIT there is no "word wrap"; 
it does not automatically start a new line unless you tell it to do so. 

Notice that as you type, at the bottom of the screen, EDIT displays 
how many characters and columns you are entering, for example: 
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Chr=l08 Col=3 

This tells you the current position of the cursor. The directory path 
and filename are also displayed at the bottom of the screen. 

There is a scroll bar at the right side of the EDIT screen. Move the 
mouse pointer over the scroll bar slider and drag the slider up and 
down to move through the file. 

Inserting and Overwriting Text 

Note~f' 

EDIT has two modes for entering text: insert (ins) and overwrite 
(ovr). When you start EDIT, you are automatically in insert mode. 
The message ins is shown at the bottom right corner of the screen. 

When you enter text in insert mode, existing text moves to the right 
as you type. 

To switch to overwrite mode, press <Ins> or <Ctrl> V. In overwrite 
mode, if you position the cursor at the point where the new text is 
to start and begin typing, any existing text is overwritten. 

To switch to insert mode again, press <Ins> or <Ctrl> V again. 

Remember that if ins is at the bottom of the screen, you are in insert mode. If 
ovr is displayed, you are in overwrite mode. 

At the top of the screen is the menu bar. To open a menu, use the 
mouse to point to the menu name and click on it, or press <Alt> and 
the initial letter of the menu name. To choose an option from the 
menu, use the mouse to point to the option and click on it, or move 
the highlight bar over the option using the <up-cursor> and 
<down-cursor> keys and press <Enter>. You can also type the 
highlighted letter from the option to select it. 

You can select menu options that are followed by <Alt><character> 
by pressing the <Alt> key and the given character without opening 
the menu first. 
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File menu 

Open ... <Alt> 0 

Read <Alt> R 

Save <Alt> V 

DOS shell <Alt> D 

Exit <Alt> X 

Block menu 

Start 

End 

Hide/Show 

Copy 

Move 

Delete <Del> 

Write to file ... 

Search menu 

Search for string 

Search and replace 

Repeat last search <F3> 
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Opens a new file. 

Reads another file into the current file at the 
current cursor position. 

Saves the current file. 

Lets you access the DOS system prompt 
without quitting EDIT. 

Exits EDIT. 

Marks the start of the block at the current 
cursor position. 

Marks the end of the block at the current 
cursor position. 

Hides/reveals the block highlight. 

Copies the marked block of text. 

Moves the marked block of text. 

Deletes the marked block of text. 

Writes the marked block of text to a file. 

Searches for the specified text string. 

Searches for the specified text string and 
replaces it with another. 

Performs the previous search again. 



Help menu 

Help for help 

Contents 

Previous topic 

DOS Book 

About... 

Displays help information on using EDIT 
online help. 

Displays the list of contents for EDIT online 
help. 

Displays the last help topic read. 

Displays DOSBook, the online manual for 
the operating system. 

Displays copyright information. 

Moving the Cursor 

You can move the cursor around your file in steps of one character, 
one word, or one page, or you can jump directly to the start or end 
of the file. 

To Move the Cursor One Character 

Note,.f' 

+ To the right, <right-cursor> key or <Ctrl> D. 

+ To the left, <left-cursor> key or <Ctrl> S. 

+ Up one line, <up-cursor> key or <Ctrl> E. 

+ Down one line, <down-cursor> key or <Ctrl> X. 

On some keyboards the four keys D, S, E, and X form an approximate diamond 
shape on your keyboard, sometimes called the "cursor-control diamond." The 
position of these keys may help you to remember what they do. 

To Move the Cursor One Word 

+ To the left, <Ctrl><left-cursor> key or <Ctrl> A. 

+ To the right, <Ctrl><right-cursor> key or <Ctrl> F. 

The keys A and F are also part of the "cursor-control diamond." 
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To Move the Cursor One Page 

+ To the previous page, <PgUp> or <Ctrl> R. 

+ To the next page, <PgDn> or <Ctrl> C. 

A "page" is the number of lines displayed on your screen. When you 
move down a page, some of the previous page will still be displayed 
on the screen, to make it easier for you to find your place again. 

To Move the Cursor to the Start or End of a Line 

+ To the beginning of a line, press <Home> or <Ctrl> QS. 

+ To the end of a line, press <End> or <Ctrl> QD. 

To Move the Cursor to the Start or End of a File 

Using the Tab Key 

+ To the beginning of a file, press <Ctrl><Home> or <Ctrl> QR. 

+ To the end of a file, press <Ctrl><End> or <Ctrl> QC. 

You can use the <Tab> key to move the cursor across the page and 
insert text at set points. The tab stops are preset to every eighth 
column across the screen. You can think of the <Tab> key as 
meaning "add space characters until you reach the next tab stop." 

Moving Text Down a Line 

If you press <Ctrl> N when editing text, the rest of the line at the 
cursor is taken down to the next line, while the cursor remains 
where it is. 
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Scrolling Through the Text 

You can also use the scroll bar at the right hand side of the EDIT 
screen to move through the text. Move the mouse pointer to the 
scroll bar slider, click on the slider, and move the slider up or down. 
The text scrolls, corresponding to the movement of the slider. 

Inserting a File at the Cursor 

Deleting Text 

To read in a file, place the cursor where you want the file to be 
inserted, open the File menu and select Read, or press <Alt> R. You 
can also press <Ctrl> KR. The Select File to Read dialog box displays. 

Either type in the name of the file you want to insert, or select it 
from the Files window, and press <OK>. The file is inserted at the 
cursor. The remaining text is moved down to accommodate the new 
text. 

Text can be deleted a character at a time, a word at a time or one line 
at a time. (You can also delete blocks of text; see "Working With 
Blocks of Text" on page 6-9.) 

Deleting a Character 

+ To delete the character the cursor is on, press the <Delete> key 
or <Ctrl> G. 

The character is deleted from the screen, and the text to the right of 
the cursor shifts to the left to fill the gap. 

If you press <Delete> or <Ctrl> G repeatedly, characters will continue 
to be deleted until you reach the end of the file. 

+ To delete the character to the left of the cursor, press the 
<Backspace> key or <Ctrl> H. 

The character is deleted from the screen and the text to the right of 
the cursor shifts to the left to fill the gap. 
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Note~f' 

Deleting a Word 

Deleting a Line 

If you press <Backspace> or <Ctrl> H repeatedly, characters continue 
to be deleted until you reach the beginning of the file. 

If you press <Delete> at the end of a line, you delete the invisible 
"newline" character and bring up the next line. Similarly, pressing 
<Backspace> or <Ctrl> H at the beginning of a line moves that line 
up to the end of the previous line. 

If you want to delete more than one character, it is usually quicker to use one 
of the key combinations described in the following sections. 

In EDIT a "word" is defined as a string of characters that starts at the 
current cursor position and continues up to and including the first 
following space. 

+ To delete a whole word, position the cursor at the beginning of 
the word to be deleted and press <Ctrl> T. 

+ To delete part of a word, place the cursor within the word and 
press <Ctrl> T. The letters at and beyond the cursor are deleted. 
The text to the right of the cursor shifts to the left to fill the gap. 

Position the cursor anywhere in the line to be deleted and press 
<Ctrl> Y. The line is deleted and lines below it move up to fill the 
gap. 

On some keyboards, the keys G, H, T and Y (for deleting characters, words and 
lines) are next to each other and form an approximate square. You may find this 
helps you to remember these commands. 
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Working With Blocks of Text 

You can mark a section or block of text and then move, delete, copy, 
or store it into a separate file. A block of text can be any size 
(according to how much disk space you have). 

Marking a Block of Text 

To mark a block of text, place the cursor at the start of the section 
you want to mark, open the Block menu, and select the Start 
command to set the start of the block. You can also press <Ctrl> KB. 
The text is marked with <B>. Move the cursor to the end of the 
block of text, open the Block menu, and select the End command. 
You can also press <Ctrl> KK. The end of the text block is marked 
with <K> and the text block is highlighted. 

You can also use the mouse to mark a block of text. Move the mouse 
pointer to where you want the block to start and drag the mouse to 
where you want the block to end. 

Moving a Block of Marked Text 

To move a block of marked text, place the cursor where you want 
the block to be moved to, open the Block menu, and select the Move 
command. You can also press <Ctrl> KV. The text is erased from its 
original position and moved to where the cursor is. The text moves 
up to fill the gap. 

Deleting a Block of Marked Text 

To delete a block of marked text, open the Block menu, and select 
the Delete command. You can also press <Ctrl> KY or <Del>, the 
Delete key. The text is deleted and the text beneath it moves up to 
fill the gap. 
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Copying a Block of Marked Text 

To copy a block of marked text, move the cursor to where you want 
the block of text copied, open the Block menu, and select Copy. You 
can also press <Ctrl> KC. The block of text is copied to the cursor 
position, still marked. The original text remains where it is and is no 
longer marked. 

Storing a Block of Marked Text in a File 

To store a block of marked text in a separate file, open the Block 
.menu, and select Write to file .... You can also press <Ctrl> KW. The 
Select File to Write dialog box displays. 

Either enter the name of the file where the text is to be stored in the 
File field or select a path, if needed, and filename from the list in the 
Files window, and select <OK>. The file is created and the block of 
marked text is written to it. If the file already exists, you are asked: 

File already exists, overwrite? 

Select <OK> to overwrite the file, <Cancel> if you want to keep the 
file as it is. If you select <Cancel>, no action is taken; open the Block 
menu, and select Write to fzle ... or press <Ctrl> KW again and enter a 
different filename. 

Hiding the Highlight Block 

Note,.f' 

Once you have set the block markers, you can switch the highlight 
for the block on or off. Open the Block menu and select Hide, or 
press <Ctrl> KH. The highlight block disappears. To redisplay the 
highlight block, use the Show command which replaces the Hide 
command in the Block menu, or press <Ctrl> KH again. 

When a block of text is hidden, you cannot copy, move or delete it. 
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Saving Your Work 

Using Markers 

Inserting a Marker 

To save changes you have made to a file, open the File menu and 
select Save, or press <Alt> V. EDIT saves the changes and updates the 
backup file (see "Automatic Backup Files" on page 6-14). You can 
then carry on editing your file. You can also press <Ctrl> KS to save 
changes and resume editing the file. 

If you want to save your work and start work on a different file, then 
open the File menu and select Open ... or press <Alt> 0. The Select 
File to Edit dialog box displays. Either type the name of the new file, 
or select an existing file from the Files window. 

If you have made changes to the file you were working on 
previously, EDIT detects this, and before opening the new file, EDIT 
prompts you to choose whether or not to save the current file. Select 
<Yes> to save it, or <No> to abandon any changes. 

You can also press <Ctrl> KD to save changes to a file and start 
editing a new file. 

To save changes and exit from EDIT, open the File menu and choose 
Save and then Exit, or press <Alt> V, followed by <Alt> X. You can also 
press <Ctrl> KX to save changes and exit EDIT directly. 

You can insert markers that act as "bookmarks" in a text file. The 
maximum number of markers you can insert is 10. Once a marker 
is placed at a particular point in the text, a simple key combination 
returns you to that point in the text. 

To insert a marker in the text, move the cursor to where you want 
to place the marker. Press <Ctrl><Fl >to set the first marker. You can 
also set the marker by pressing <Ctrl> K<l > where <1 > is on the 
numeric keypad. To set subsequent markers, press <Ctrl><Fn>, or 
<Ctrl> K<n>, where <Fn> is the next function key up to <Fl 0>, and 
<n> is the next number on the numeric keypad up to <0>. 
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Moving to a Preset Marker 

To return to a marker already set in the text, press <Alt><Fn> where 
<Fn> is the function key you used to set the marker, or press 
<Ctrl> Q<n> where <n> is the number on the numeric keypad you 
used to set the marker. 

Note that any markers set in a file are lost when you either quit 
editing that file and open a new file, or exit from EDIT. 

Searching for and Replacing Strings of Text 

You can search for strings of text in EDIT, and replace them with 
another string. 

Searching for a String of Text 

6-12 

To search for a string of text, press <Alt> S to open the Search menu 
and select the Search for string option, or press <Ctrl> QF. The Search 
dialog box displays. Enter the string which you wish to find in the 
Search string field. 

You can set the following options on a text string search: 

+ Ignore case 

Select this option if you do not want the search to be case­
sensitive. 

+ Match whole words only 

Select this option if you want the search to locate entire words. 
For example, if you specify the search string "the," and do not 
select this option, then words like "their" and "they" are also 
located. 

+ Begin search at file start 

Select this option if you want to search the entire file for the 
string, rather than from the current cursor position. 

Press <OK> to start the search. 
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Searching for and Replacing a Text String 

To search for a text string and replace it with another, press <Alt> S 
to open the Search menu and select the Search and replace option, or 
press <Ctrl> QA. 

The Search and Replace dialog box displays. Enter the text string in 
the Search string field and the replacement text string in the 
Replacement string field. 

The options listed previously are also available in this dialog box as 
well as the following: 

+ Replace without further dialogue 

Select this option if you do not want to confirm each 
replacement each time the search string is found. 

Repeating the Previous Search 

Quitting EDIT 

You can repeat a search by opening the Search menu and selecting 
the Repeat last search option, or by pressing <Ctrl> Lor <F3>. The 
most recent search is repeated with the same options set. Note that 
if you have set the Begin search at file start option, then repeating the 
search finds the first occurrence of the text string in the file, not the 
next occurrence from the cursor position. 

To quit EDIT, open the File menu and select the Exit command, or 
press <Alt> X. 

If you have made changes to a file EDIT prompts you to choose 
whether to save the changes or not. Select <Yes> to save the changes 
and exit from EDIT, or <No> to abandon the changes and exit. Select 
<Cancel> if you do not want to exit from EDIT. 

You can also press <Ctrl> KX to exit EDIT and save changes, or 
<Ctrl> KQ to exit and abandon changes. 
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Automatic Backup Files 

6-14 

When you open an existing file, a "working copy" of the file is 
stored in memory. The original file remains on your disk, unaltered. 

When you save your edited file, the working copy is stored on the 
disk and is given the name of the original file. The old file becomes 
an EDIT backup file with the extension .BAK. 

Example 

If you open the file MYTEXT.DOC and edit it, when you save the file 
the following happens: 

+ The original file MYTEXT.DOC is renamed to MYTEXT.BAK. 

+ The new version is stored with the name MYTEXT.DOC. 

You can use backup files to recover files: if the current version is 
found to be incorrect or accidentally erased, for example. 

If you accidentally deleted the file MYTEXT.DOC, you could revert 
to the .BAK file by typing: 

COPY MYTEXT.BAK MYTEXT.DOC <Enter> 

To prevent any filename conflicts, EDIT does not allow you to edit 
files with the extension .BAK. 

Before you start editing a file, make sure that there is enough free 
space on the disk to store both the original file with the .BAK 
extension, and the edited version of the file. 
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Technical Details 

+ EDIT produces ASCII files with no embedded specific control 
characters, so its output can be used for batch and similar files. 
It allows 8-bit characters to be entered and displayed. 

+ There is no size limit on the files you can edit, apart from that 
imposed by the amount of disk space you have available. 

+ The <Enter> key inserts two characters into the file being edited: 
a carriage return (ASCII code 13) and a line feed (ASCII code 10), 
in that order. Note that a single CR, a single LF, or a CR/LF pair 
is always treated as a single character when moving through the 
text. 

+ The <Tab> key inserts a character (ASCII code 09) into the file. 
On screen the Tab character inserts spaces from the cursor 
position to the next tab stop. A tab stop is preset at every eighth 
column across the screen. 

+ EDIT does not insert any special End-of-File marker, but 
recognizes the End-of-File marker <Ctrl> Z (ASCII code 26) used 
by some older editors. 

+ EDIT provides automatic creation of .BAK backup files. It does 
not allow you to edit files with a .BAK extension. 

+ During use, EDIT creates two temporary files. EDIT places these 
files in the subdirectory given in the TEMP environment 
variable. If you have not set this variable, EDIT places them in 
the same directory as the file you are editing. The files are 
automatically deleted when you quit EDIT. 

Writing to the Screen 

EDIT writes direct to the screen memory (rather than via BIOS calls) 
if you have an EGA or VGA display. For all other display types, EDIT 
writes to the screen via BIOS calls. However, you can force EDIT to 
write via BIOS calls regardless of the display type by invoking EDIT 
with the ID switch: 

EDIT /D <Enter> 
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Command Summary 

Table 6-1 

Summary of EDIT Commands 

Function Keys 

Getting Help 

Displays help text <Fl> <Ctrl> J Help 
<Alt> H 

Moving the Cursor 

Start of file <Ctrl><Home> <Ctrl> QR 

End of file <Ctrl><End> <Ctrl> QC 

Start of the line <Home> <Ctrl> QS 

End of the line <End> <Ctrl> QD 

Character left <left-cursor> <Ctrl> S 

Word left <Ctrl><left-cursor> <Ctrl> A 

Character right <right-cursor> <Ctrl> D 

Word right <Ctrl><rig ht-cursor> <Ctrl> F 

Previous line <up-cursor> <Ctrl> E 

Next line <down-cu rs or> <Ctrl> X 

Scroll text down one line <Ctrl><u p-cu rso r> <Ctrl> W 

Scroll text up one line <Ctrl><down-cu rsor> <Ctrl> Z 

Previous page <Pg Up> <Ctrl> R 

Next page <PgDn> <Ctrl> C 
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Table 6-1 continued 

Summary of EDIT Commands 

Function Keys 

Deleting Text 

Delete character <Del> <Ctrl> G 

Delete line <Ctrl> Y 

Delete character to the left <Backspace> <Ctrl> H 

Delete word to the right <Ctrl> T 

Working with Blocks of Text 

Mark the start of a block of text <Ctrl> KB Start 

Mark the end of a block of text <Ctrl> KK End 

Move a marked block of text <Ctrl> KV Move 

Delete a marked block of text <Del> <Ctrl> KY Delete 

Copy a marked block of text <Ctrl> KC Copy 

Store a marked block of text in a file <Ctrl> KW Write to file 

Hide the block markers and highlight <Ctrl> KH Hide/Show 

Saving Files 

Save changes, exit <Alt> V <Ctrl> KX Save 
<Alt> X Exit 

Save changes, edit new file <Alt> V <Ctrl> KO Save 
<Alt> 0 Open 

Save changes, resume editing <Alt> V <Ctrl> KS Save 

Abandon changes, edit new file <Alt> 0 <Ctrl> KQ Open 
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Table 6-1 continued 
Summary of EDIT Commands 

Function Keys 

Using Markers 

To insert a marker <Ctrl> <Fn> <Ctrl> 
K<n> 

To go to a marker <Alt> <Fn> <Ctrl> 
Q<n> 

Other Commands 

Switch between insert and overwrite <Ins> <Ctrl> V 

Read in a file at the cursor <Alt> R <Ctrl> KR Read 

Insert a new line at the cursor <Enter> 

Insert a new line after the cursor <Ctrl> N 

Insert a control character at the cursor <Ctrl> P 

Enter character codes directly into a file <Ctrl> QN 

Go to the DOS shell <Alt> D DOS Shell 

Search for a specified text string <Ctrl> QF Search for 
string 

Search for and replace a specified text <Ctrl> QA Search and 
string replace 

Repeat the previous search <F3> <Ctrl> L Repeat last 
search 
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chapter 7 Batch Processing 

When you work with the operating system, you usually enter 
commands at the system prompt and the system executes them. 
This is referred to as interactive processing. There is another kind of 
processing, however, called batch processing. 

This chapter describes two methods of batch processing: batch files 
and macros. 

What is a Batch File? 

As you work with the operating system, you will probably find that 
you enter a command or a sequence of commands over and over 
again. You may have a set procedure each morning to load a 
spreadsheet program, for example, and another procedure in the 
evening to back up the files you created or changed during the day. 

Batch processing allows you to collect all the commands you need 
to carry out a task into a single batch file so that you do not need to 
enter each command individually. When you enter the name of the 
batch file at the system prompt, each command in the file is 
executed as if you had entered them one at a time. Using a batch 
file also ensures that a procedure is carried out in exactly the same 
way every time. 

For example, assume that you use the following commands every 
day to back up your files: 

CD \LETTERS <Enter> 

(to make LETTERS the current directory) 

ERASE * . OLD <Enter> 

(to erase all files with the extension .OLD) 
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MD A: \DAYSWORK <Enter> 

(to create the directory DAYSWORK on the A: drive) 

COPY * . DOC A: \DAYSWORK <Enter> 

(to copy all files with the extension .DOC to A:\DAYSWORK) 

You can create a batch file that contains all of these commands 
called DAYOVER.BAT. Then, at the end of the day, you would only 
need to enter the following to execute all of the commands: 

DAY OVER 

Creating Batch Files with EDIT 

You can create batch files using EDIT or another word processor. 

If you want to use a word processor other than EDIT, make sure that the 
completed batch file is in ASCII format. Refer to the word processor 
documentation for more information. 

The rules for naming a batch file are the same as for any other file 
except that you must use the extension .BAT. Also, you must enter 
each command in the batch file on a separate line. 

To create the batch file described in the previous section, for 
example, type the following at the system prompt: 

EDIT DAYOVER. BAT <Enter> 

Because this is a new file, you see a message asking you whether you 
want to create it. Press <OK> and the EDIT screen is displayed. 

Type the commands you want in the batch file, as follows, pressing 
<Enter> at the end of each line: 

CD \LETTERS 

ERASE *.OLD 

MD A:\DAYSWORK 

COPY *.DOC A:\DAYSWORK 

Press <Ctrl> KX to save the file and exit EDIT. 
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Note~~ There are several other ways of saving files and quitting EDIT. Refer to Chapter 
6, "Editing Text Files" for complete information. 

Use this procedure to create any batch file you require. 

Creating Batch Files with COPY 

Instead of using EDIT or another word processor, you can use the 
COPY command to create batch files directly at the system prompt. 

Use the following version of COPY: 

COPY CON f ilespec 

When you specify CON as the device, every character you enter is 
recorded in the destination file you specify (filespec), except for the 
line editing characters you use, such as <Enter> to start a new line 
or <Ctrl> H to delete the character to the left of the cursor. See the 
sections "Command Line Editing" and "Extended Command Line 
Editing" in the "Command Reference" chapter of DOSBook for a 
complete list of the command line editing keys. 

Press <Ctrl> Z or <F6> when you have finished entering your file and 
close the file by pressing <Enter>. 

Running Batch Files 

To run a batch file, it must be located in the current directory or in 
one of the directories in the search path defined by PATH. Refer to 
the description of PATH in the "Command Reference" chapter of 
DOSBook for more information about search paths. 

Run a batch file by entering its name in the command line; you do 
not need to include the extension (.BAT). 

When the batch file is finished executing, the system prompt 
returns. 
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Example 

Assume you created the following batch file to copy two sets of files 
from the current drive to the root directory of the diskette drive: all 
files in the directory DIRA and then all files with the extension 
.DAT in the directory DIRB. 

CD \DIRA 

COPY *. * A:\ 

CD \DIRB 

COPY *.DAT A:\ 

CD\ 

When you run the batch file, you might see something similar to 
the following at the system prompt as each command in the file is 
executed: 

CD \DIRA 

then 

COPY *. * A:\ 

PGMl.EXE 

PGM2.EXE 

PGM3.EXE 

3 File(s) copied 

then 

CD \DIRB 

then 

COPY *.DAT A:\ 

MON.DAT 

TUES.DAT 

WED.DAT 

THURS.DAT 

FRI.DAT 

5 File ( s) copied 
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then 

CD\ 

Stopping Batch Files 

Press <Ctrl> C to stop a batch file while it is running. You will see the 
following message: 

Halt Batch Process (Y/N)? 

Answer Y for YES and the remaining commands in the batch file are 
not executed. You return to the system prompt. 

Answer N for NO and the remaining commands will be processed. 

Displaying Messages 

By default, the commands contained in a batch file are displayed 
during batch file execution. To disable this feature, set the ECHO 
command to OFF. Enter ECHO by itself at the system prompt to see 
the current status of ECHO. You can also prevent the display of 
individual commands in a batch file by preceding the command 
with@. Refer to the descriptions of@ and ECHO in "Batch File 
Command Reference" starting on page 7-14. 

ECHO can also be used to display messages during batch file 
execution. When you include a message preceded by ECHO in your 
batch file, that message displays regardless of whether the ECHO 
feature itself is set to ON or OFF. 

For example, assume you include the following statements at the 
beginning of a batch file: 

@ECHO OFF 

ECHO THIS IS MY FIRST 

ECHO BATCH FILE 
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When you run the batch file, the following message is displayed: 

THIS IS MY FIRST 

BATCH FILE 

Comments 

When ECHO is ON, any comments or remarks that you include in 
a batch file are also displayed. You include comments by using the 
REM command; any line in a batch file that begins with REM is 
ignored during execution (other than being displayed when ECHO 
is ON). 

Using Replacement Variables 

By using replacement variables in a batch file, you can make the 
batch file behave differently according to the parameters you enter 
with the filename when you run the file. When you run the batch 
file, the variables are replaced by the parameters entered at the 
system prompt. 

Replacement variables are entered as %n, where n is a number from 
0 through 9. %0 represents the batch file name. %1 represents the 
first parameter at the system prompt, %2 represents the second 
parameter, %3 the third parameter, and so on. 

If you want to use more than 10 parameters, you must also use the 
SHIFT command in your batch file. SHIFT allows you to change the 
position of command line parameters by shifting them one 
parameter position to the left. Refer to the description of SHIFT in 
"Batch File Command Reference" starting on page 7-14. 

If you want to use the% character in a filename within a batch file, 
you must enter it twice. If the filename is TEST%.DAT, for example, 
you must enter it in the batch file as TEST%%.DAT. Generally 
speaking, you should not use the % character in filenames. 

When you run the batch file at the system prompt, always separate 
parameters with a space and make sure that they are entered in the 
correct sequence. 
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Example 

The following batch file MOVEOVER.BAT, if created in 
C: \AMANDA \LETTERS, copies any file from 
C:\AMANDA \LETTERS to C:\QUERIES\DONEWITH and then 
deletes the original: 

COPY %1 C:\QUERIES\DONEWITH 

ERASE %1 

So to run MOVEOVER.BAT to copy and delete a file called 
JONES.LET, you would simply type the following: 

MOVEOVER JONES . LET <Enter> 

The operating system would then execute the following 
commands: 

COPY JONES.LET C:\QUERIES\DONEWITH 

ERASE JONES.LET 

To copy and delete SMITH.LET instead, you would type the 
following: 

MOVEOVER SMITH.LET <Enter> 
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Using Environment Variables 

Table 7-1 

Environment Variables 

You can also use environment variables in batch files. Environment 
variables are similar to replacement variables except that they are 
not provided in the command line that runs the batch file. Some 
are pre-defined by the operating system, some are set by specific 
commands, and some are handled by the SET command. Refer to 
the description of SET in the "Command Reference" chapter of 
DOSBook for information about SET. 

Table 7-1 lists the standard environment variables. 

Variable Name 

APPEND 

COM SPEC 

NWDOSCFG 

OS 

PATH 

PEXEC 

PROMPT 

TEMP 

VER 

Function 

The current APPEND search path. 

The location on disk of the command 
interpreter. 

The directory containing the system 
configuration files. 

The current operating system name. 

The current PATH search path. 

Used by the PROMPT command. 

The current system prompt. 

The directory used to hold temporary files. 

The current operating system version. 

To use the current value of an environment variable in a batch file, 
enclose it in% signs. 

For example, the following command changes the current system 
prompt: 

PROMPT %OS% $P$G <Enter> 
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Controlling Execution of Commands 

Most batch files are more than just commands and variables. You 
can also use various special batch file subcommands to control the 
flow of execution within a batch file and perform more complex 
tasks. 

Conditional Execution 

Use the IF statement to specify a condition that must be true before 
a command is run. 

You can specify that one string must equal another, for example. 
Assume that you want to create a batch file called GAME.BAT to 
start a certain computer game when you type the following 
command: 

GAME FUN <Enter> 

You could include the following statement in GAME.BAT so that 
the game is started only if% 1 (the first parameter in the command 
line) is FUN. If %1 is not FUN, the operating system skips the PLAY 
command and processes the next line in the batch file. 

IF "%1" == "FUN" PLAY 

After PLAY is finished, the next line of the batch file is processed. 

Changing Execution Flow 

You can also force processing of a batch file to switch to another 
part of the file and continue executing commands from that point. 
You do this by using a label, to identify a particular point within the 
file, and a GOTO command. 

For example, when execution reaches the GOTO statement in the 
following lines, it is forced to jump back to the label START and 
continue processing from there. 

:START 

TYPE INFO.TXT 

GOTO START 
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The next example shows a batch file with three GOTOs in it. 

@ECHO OFF 

REM GOTO.BAT - Example of Using GOTOs 

GOTO LABEL! 

REM This part is never executed 

ECHO This part is never executed 

:LABEL2 

ECHO The program is at LABEL2 

GOTO END 

REM This part is executed first 

:LABEL! 

ECHO The program is at LABEL! 

GOTO LABEL2 

REM This part is executed last 

:END 

ECHO This is the end of the file 

You can use GOSUB instead of GOTO when you want to force 
execution to a subroutine rather than an individual command. 
Statements are processed until a RETURN command is encountered. 

Novell DOS 7 User Guide 



Using IF and GOTO Together 

By using GOSUB or GOTO commands together with IF statements, 
you can run different sections of the batch file according to 
different conditions. 

Many external commands set a return code or "error level" when 
they finish. The value such a command returns can be tested using 
an IF ERRORLEVEL command. The following batch file, for 
example, tests the return code from an XCOPY operation: 

XCOPY %1 %2 

IF ERRORLEVEL 1 GOTO FAIL 

DEL %1 

GOTO END 

:FAIL 

ECHO Copy Failed - Not Deleting Files 

:END 

You can also specify that a certain file or condition must exist or 
must be true before a command is executed. The following batch 
file, for example, uses IF to test whether expanded memory is 
available before starting a calculator application called CALC: 

IF EXIST EMMXXXXO GOTO OK 

ECHO EMS memory manager not loaded - Load EMS 

ECHO driver 

GOTO END 

:OK 

CALC 

:END 

Refer to the descriptions of IF, GOTO, and GO SUB in "Batch File 
Command Reference" starting on page 7-14 for more information 
about using these commands to control batch file execution. 
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Using System Information 

Table 7-2 

You can use a number of "system information" values in a batch 
file. These values are like environment variables but in most cases 
you cannot set their values yourself. They are useful, however, for 
displaying extra information or for testing to determine the way in 
which the batch file executes. All the system information variables 
are listed in Table 7-2. 

System Information Variables 

Variable Name Explanation 

AM_PM a.m. or p.m. 

Day 01 to 31 

Day_of_Week Monday, Tuesday, etc. 

Hour 1 to 12 

NDay_of_Week 1 to 7 (1 =Sunday) 

Month 01 to 12 

Month Name May, June, December, etc. 

Year 1983, 201 6, etc. 

Short_ Year 83, 95, etc. 

Hour24 00 to 23 

Minute 00 to 59 

Second 00 to 59 

Greeting_ Time Morning, Afternoon, or Evening 

Errorlevel Error return code 

OS Operating system (NWDOS) 

OS_ Version Operating system version number 
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Table 7-3 

The following variables are only available when you have the 
NetWare® drivers and shell loaded: 

System Information Variables (NetWare) 

Variable Name Explanation 

Login_Name User's login name 

P _Station Physical station number 

Station Station number 

The following statements in a batch file, for example, cause the 
appropriate greeting (including the greeting time and login name) 
to display for any user. Mail will only be checked, however, if the 
user is FRED. 

ECHO "Good %Greeting_Time% %Login_Name%" 

IF NOT "%Login_Name%" == "FRED" GOTO NOMAIL 

ECHO "Checking Mail" 

:NOMAIL 

Running a Batch File from Inside Another 

If you want to run a batch file from inside another batch file, simply 
include the name of the second batch file inside the first. The 
second batch file is run when the operating system processes the 
line containing the name of the file. When it has finished running, 
you return to the system prompt. The remaining statements in the 
original batch file are not executed. 

To run a batch file from inside another and then return to the 
original batch file and continue processing, you can use the CALL 
command in the original file. 
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The following batch file OUTER.BAT, for example, displays a 
message and then calls another batch file, INNER.BAT. When 
INNER.BAT is finished, execution returns to OUTER.BAT and 
processes the next line (which displays another message): 

@ECHO OFF 

REM OUTER.BAT 

ECHO I am in OUTER.BAT 

CALL INNER 

ECHO I am back in OUTER.BAT 

You can call as many batch files as you like from inside another 
batch file. 

Refer to the description of CALL in "Batch File Command 
Reference" starting on this page for more information. 

Batch File Command Reference 

7-14 

Note,.~ 

Any command you enter at the system prompt can be used in a 
batch file, using the same syntax as you would use when entering 
the command at the system prompt. Refer to the "Command 
Reference" chapter of DOSBook for descriptions of all these 
commands. 

As described previously in this chapter, however, there are also 
special commands available for use with batch files called batch file 
subcommands. Batch file subcommands allow you to write batch 
files that are like simple programs. This section describes each of 
these commands. 

All batch file subcommands (except CHOICE) are internal commands. CHOICE 
is an external command that is only used in batch files. 

The conventions used in the following command descriptions are 
the same as those used in the "Command Reference" chapter in 
DOSBook; refer to this if you need an explanation of the 
conventions. 
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@ 

Format 

Explanation 

Example 

1 
• 

Format 

Explanation 

@ command 

@prevents the specified command from displaying during batch file 
execution. 

The following line in a batch file turns the ECHO feature off and 
ECHO OFF itself is not displayed: 

@ECHO OFF 

? ["message_string"] command 

The question mark (?) at the beginning of a statement causes the 
operating system to prompt the user about whether the statement 
should be processed. 

You can also specify the text of the prompt by including it between 
the question mark(?) and the beginning of the statement, enclosed 
by double quotation marks. 

When you run a batch file containing a? statement, a response to 
the prompt is required by the user before processing continues. 
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Example 

:label 

Format 

Explanation 

Note that the maximum length of a batch file statement (including 
?) is 128 characters. 

The following statement in a batch file causes the system to prompt. 
the user before deleting all the files with the extension .OLD from 
C:\ACCOUNTS: 

?DEL C:\ACCOUNTS\*.OLD 

So, when the file executes, the user sees the following: 

DEL C:\ACCOUNTS\*.OLD (Y/N) ? 

If the user answers Y, the DEL command is run and the files are 
deleted. If the user answers N, the command is ignored and the next 
line in the batch file is processed. 

:label 

A label defines a point within a batch file that can be referenced by 
a GOSUB, GOTO, or SWITCH command within the same file. 

Only the first eight characters in a label are recognized; any 
additional characters are ignored. 

Labels are not displayed during batch file execution. 
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CALL 

Format 

Explanation 

Example 

CHOICE 

Format 

Explanation 

CALL f ilespec 

CALL runs another batch file before the next statement in the 
original batch file is processed. 

The search path defined by the PATH command is used to locate the 
second batch file. 

The following batch file uses two CALLs to other batch files: 

REM This file runs BATCH2 and then BATCH3 

CALL BATCH2 

CALL BATCH3 

CHOICE [IC: choices] [/N] [/S] [/T[: ]c,nn] [text] 

The CHOICE command is used in batch files to present the user 
with choices. The user selects from the displayed choices by 
pressing a key, and CHOICE returns an ERRORLEVEL value that 
reflects the key pressed. The ERRORLEVEL value can be used by 
other batch file commands, such as IF, to control what the batch file 
does next. 
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Note~f' 

Command Switches 

/?or /H 

IC: choices 

/N 

IS 

/T:c,nn 

text 

Examples 

CHOICE is an external command that is only used in batch files and is therefore 
described here rather than in the "Command Reference" chapter of DOS Book. 

Displays help text. 

Specifies the keys that the user can select from; choices can be any keys 
that can be used on a command line except <Space>, <Tab>, and/. By 
default, CHOICE displays these key choices after any prompt text specified 
in the CHOICE command. If choices are not specified, CHOICE displays 
[Y,N]?. 

Disables the display of the choice keys and the question mark after the 
prompt text. 

Specifies that the choice keys are case-sensitive. 

Specifies that CHOICE defaults to key c after nn seconds unless the user 
makes a selection before then. c must be one of the characters specified 
by the /C switch. If you do not specify the /C switch, c must be Y (for Yes) 
or N (for No). nn can be in the range 0-99 but if nn is 0, the /T switch is 
ignored. 

Specifies the prompt text that precedes the key choices displayed to the 
user. The text must not include a forward slash (/). 

CHOICE returns ERRORLEVEL 1 if the user selects the first of the 
key choices, ERRORLEVEL 2 if the user selects the second of the 
keys, and so on. If the user presses <Ctrl> C instead of selecting one 
of the keys, CHOICE returns 0. 

If the user enters an invalid CHOICE command, ERRORLEVEL 255 
is returned, and help text is displayed. 

If you include the following command in a batch file: 

CHOICE /C:yne Yes, No, or Exit 

the user sees the following message when the batch file runs: 

Yes, No, or Exit [Y,N,E] 
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Note~f" 

CHOICE returns ERRORLEVEL 1 if the user presses Y, 2 if they press 
N, and 3 if they press E. 

In the following example CHOICE defaults to Y, unless the user 
makes a selection within 10 seconds: 

CHOICE /C:yne /T:y,10 Yes, No, or Exit 

The next example demonstrates how CHOICE can be used in 
conjunction with other batch file commands. In this example, the 
user is given the option to select one of tqiree utilities: DOSBook, 
EDIT, or SETUP. ' 

@echo off 

:start 

els 

echo DOSBOOK 

echo EDIT 

echo SETUP 

echo -------

choice /c:desq Select an option or Q to quit 
if errorlevel 4 goto end 

if errorlevel 3 goto setup 

if errorlevel 2 goto edit 

if errorlevel 1 goto dbook 

:setup 

setup 

goto start 

:edit 

edit 

goto start 

:dbook 

dos book 

goto start 

:end 

els 

The IF statements in this example are true if the ERRORLEVEL value returned by 
CHOICE is greater than, or equal to, the ERRORLEVEL specified in the IF 
statement. Therefore, the IF statements are listed with the highest ERRORLEVEL 
first; if the order was reversed, the batch file would always jump to DOSBook. 
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ECHO 

Format 

Explanation 

FOR 

Format 

Explanation 

ECHO [ON!OFF!message] 

ECHO enables or disables the display of commands during batch 
file execution when you specify ON or OFF. ECHO is ON by default. 
To display the current status of ECHO, enter ECHO without a 
parameter. 

@ECHO OFF is often used at the beginning of a batch file to prevent all 
commands from being displayed, including ECHO OFF itself. 

ECHO displays a message during batch file execution when you 
specify ECHO message. Use multiple ECHO statements to display 
more than one line of message text. 

If you type a period immediately after ECHO in a batch file, a blank 
line appears when you run the batch file. 

FOR %%variable IN (fileset) DO command 

FOR executes the specified command for each file in a set of files. In 
sequence, each filename is substituted for the command. 

You can use wildcards in filenames; all matching filenames on the 
current drive will be substituted. 
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Example 

GO SUB 

Format 

Explanation 

Example 

The following statement in a batch file types two files to the screen 
in turn: 

FOR %%£ IN (ACCT.BAS ACCT2.BAS) DO TYPE %%£ 

GOSUB label 

GOSUB causes batch file execution to jump to the specified label, 
process commands until RETURN is found, and then go back to the 
line immediately after GOSUB and continue processing from there. 
You must use a RETURN with GOSUB. 

The following batch file types a text file to the screen and then runs 
a subroutine to type three more text files before calling a second 
batch file. 

TYPE INTRO.TXT 

GOSUB LISTS 

CALL SUMMARY 

EXIT 

:LISTS 

TYPE LISTA.TXT 

TYPE LISTB.TXT 

TYPE LISTC.TXT 

RETURN 
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GOTO 

Format 

Explanation 

Example 

GOTO label 

GOTO causes batch file execution to jump to the specified label and 
continue from there. 

You must include the label referenced by a GOTO. If the label is not 
found, you see the following error message: 

Label xxxxxxxx not found 

Note that only the first eight characters of a label are recognized. 

The following batch file displays a file called INFO.TXT over and 
over again until you stop the file by pressing <Ctrl> C or 
<Ctrl><Break>. 

:START 

TYPE INFO.TXT 

GOTO START 
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IF 

Format 

Explanation 

IF [NOT] condition] [OR [NOT] condition2] [AND [NOT] 
condition]] command 

IF specifies conditional execution of commands within a batch file. 
The command is executed when the condition is true. When the 
condition is not true (or true, if you specify IF NOT), command is 
ignored and the next statement in the batch file is executed. 

The conditions can be any of the following: 

ERRORLEVEL n 

This condition is true when the error code produced by the 
previous program is greater than or equal to n (where n is a 
number). 

stringl =1==1 !=I<> string2 

This condition is true when the relationship between the 
specified string (stringl) and another string (string2) matches the 
specified symbol: "identical to"(= or==) or "not identical to"(!= 
or<>). Strings can be literal strings or batch variables (%hour%, 
for example). 

#valuel =1==1 !=I<> #value2 

This condition is true when the relationship between the 
absolute value of the specified variables matches the specified 
symbol. 

EXIST f ilespec 

This condition is true when filespec exists, in the specified 
directory or in the current directory (if no dirpath is specified in 
filespec). 
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DIREXIST dirpath 

This condition is true when dirpath exists, in the specified 
directory or in the current directory (if no dirpath is specified in 
dirpath). 

Examples 

The following batch file uses several IF statements to test the 
ERRORLEVEL from an XCOPY operation: 

REM XCOPY and 

XCOPY %1 %2 

IF ERRORLEVEL 

IF ERRORLEVEL 

IF ERRORLEVEL 

IF ERRORLEVEL 

DEL %1 

GOTO END 

:FAILl 

DEL with ERRORLEVEL Testing 

s GOTO FAILS 

4 GOTO FAIL4 

3 GOTO FAIL2 

2 GOTO FAILl 

ECHO Files %1 not found - not deleting files 

GOTO END 

:FAIL2 

ECHO Aborted - not deleting files 

GOTO END 

:FAIL4 

ECHO Could not start XCOPY - not deleting 
files 

GOTO END 

:FAILS 

ECHO Disk write failure - not deleting files 

:END 

The following IF statement specifies that WHERE IS JOHN? displays 
only ifJOHN is not the current value of the %1 parameter. Note that 
the strings are enclosed by quotation marks; you should always use 
quotation marks around strings to prevent syntax errors, especially 
when no parameters are specified: 

IF "%1"<>"JOHN" ECHO WHERE IS JOHN? 
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PAUSE 

Format 

Explanation 

The IF statement in the following set of statements means that the 
commands between DIR B: and the label XYZ will only be executed 
if MYFILE does not exist in the current directory: 

IF EXIST MYFILE GOTO XYZ 

DIR B: 

:XYZ 

PAUSE [remark] 

PAUSE delays batch file processing so that an action can be 
performed, such as changing diskettes. 

PAUSE always displays the following message: 

Strike a key when ready . . . 

You can specify an additional remark of up to 122 characters; this is 
optional, however. 
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Example 

REM 

Format 

Explanation 

The following batch file includes a PAUSE command with a remark 
specified: 

COPY A:*.* B: 

@ECHO OFF 

PAUSE Insert new disk in DRIVE A: 

COPY A:*.* B: 

When this batch file runs, the files on the diskette in the A: drive 
are copied to the diskette in the B: drive. Processing is then 
suspended and the following message appears on the screen: 

Insert new disk in DRIVE A: 

Strike a key when ready . . . 

You can either insert a new diskette and press any key to continue 
or press <Ctrl> C to stop batch file processing. 

REM I [remark] 

REM or a semi-colon(;) causes the operating system to treat a 
statement as a comment or remark. Any line in a batch file preceded 
by REM or a semi-colon is not processed. 

If ECHO is ON, REM lines will be displayed on the screen as the batch file 
executes. 
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RETURN 

Format 

Explanation 

SHIFT 

Format 

Explanation 

The maximum length of remark is 123 characters. You can use 
commas, spaces, and tabs to separate words. Empty comment lines 
(REM with no remark) are useful for adding space to a batch file, 
making it easier to read and edit. 

RETURN 

RETURN causes batch file execution to return to sequential 
processing of commands after a GOSUB or SWITCH statement. 

SHIFT 

SHIFT allows you to access more than nine command line 
parameters (%1 to %9) by shifting their position to the left. 

When SHIFT is executed, the value in %0 is replaced by the value in 
%1, %1 is replaced by %2, %2 by %3, and so on up to %8, which is 
replaced by the value of %9. 

Use SHIFT as many times as you need to get all of the parameters in 
the command line, up to a maximum of 10 at a time. Think of the 
batch parameters as a "window"; SHIFT simply moves the window 
one position to the right. 
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Example 
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SHIFf is most useful when you are using a batch file to perform a 
single operation many times and using a varying number of 
command line parameters. 

The batch file COPYX, for example, is designed to copy a number 
of files to a single destination directory; you would enter the 
following to run COPYX: 

COPYX filenamel filename2 filename3 ..• dirpath 

COPYX.BAT would be written as follows: 

@ECHO OFF 

IF 11 %1" == "/?" GOTO HELP 

REM COPYX requires at least 2 parameters if 

REM the first parameter is not /? 

IF 11 %2" == 1111 GOTO FAIL 

SET COPYX_FILE = 
:LOOP 

REM If the second parameter is empty, the 

REM first parameter must be the destination 

IF 11 %2" == 11
" GOTO NO_MORE_FILES 

REM Otherwise, add the first parameter to the 

REM list of files to copy 

SET COPYX_FILE = %COPYX_FILE% %1 

REM Now SHIFT the parameters so that %1 is 

REM replaced by %2, etc. 

SHIFT 

REM Go back to look at the rest of the 

REM parameters 

GOTO LOOP 

:NO_MORE_FILES 

REM The first parameter now contains the 

REM destination 

REM COPYX FILE contains the list of files 

REM copy 

FOR %%i IN (%COPYX_FILE%) DO XCOPY %%i %1 

Novell DOS 7 User Guide 

to 



SWITCH 

Format 

Explanation 

GOTO END 

:FAIL 

ECHO COPYX: At least 2 parameters are 
required 

GOTO END 

:HELP 

ECHO COPYX: Multiple file copy program 

ECHO Enter: COPYX filename! filename2 ... 
dirpath 

GOTO END 

:END 

SET COPYX_FILE 

SWITCH labell, label2[, labe13 ••• label9] 

SWITCH causes batch file processing to switch between several 
different subroutines within the same batch file, depending on the 
information (label) provided by the user. SWITCH also causes the 
batch file to prompt the user for this information. In effect, 
SWITCH creates a simple menu interface. 

When the label is entered, execution jumps to that label in the 
batch file and returns to the line following SWITCH when a 
RETURN command is encountered. 

The maximum number of labels you can use in a SWITCH 
command is nine. 
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Example 
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The following batch file defines a SWITCH routine for selecting an 
application from a list of applications: 

@ECHO OFF 

:BEGIN 

CLS 

ECHO 

ECHO 

ECHO 1 

ECHO 2 

ECHO 3 

ECHO 4 

APPLICATIONS MENU 

Word Processor 

Desktop Publisher 

Database 

Exit 

ECHO Choose a number from 1 to 4 

SWITCH WP, VP, DB, EX 

GOTO BEGIN 

:WP 

EDIT 

RETURN 

:VP 

CALL VPPROF 

RETURN 

:DB 

CD \DATABASE 

DB 

RETURN 

:EX 
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What are Macros? 

A macro is similar to a batch file; it consists of a number of 
commands that you execute by entering a single name at the 
system prompt. The main difference between batch files and 
macros is that macros are stored in RAM rather than on disk and 
can be run from any directory. This means that they run faster than 
batch files. Macros use memory that would normally be used by 
command line HISTORY information, however. Also, macros are 
lost when you reboot your computer. 

The following sections in this chapter, about using macros, describe 
further differences between batch files and macros. 

Creating Macros Using DOSKEY 

The operating system provides the DOSKEY command to work with 
macros. 

To create a macro, simply type the DOSKEY command at the system 
prompt as follows: 

DOSKEY macroname = commands <Enter> 

The number of commands you can put in a macro is limited by the 
length of a single line (127 characters); all the commands in a 
macro must be on the same line. 

Separate each command with $T (or $t). The following command 
line, for example, defines a macro that lists all the .TXT files in the 
current directory in order of size before copying them to the root 
directory of the A: drive: 

DOSKEY CPYTXT = XDIR *.TXT /Z $t COPY *.TXT A:\ 

Besides $t, there are other special characters you can use in a macro. 
They are listed in the following table. 
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Special Character 

$L (or $1) 

$G (or $g) 

$G$G (or $g$g) 

$B (or $b) 

Meaning 

Equivalent to the less-than sign ( <). 

Equivalent to the greater-than sign (> ). 

Equivalent to the double greater-than sign 
(»). 

Equivalent to the piping symbol (I). 

Note the following restrictions about what you can use in macros: 

+ You cannot use GOTO commands in macros or start a macro 
from inside another macro. You can run a batch file from inside 
a macro, however. 

+ Replacement variables are $1 through $9 in macros instead of 
%1 through %9 as in batch files. 

+ You can define an environment variable in a macro using SET 
but you cannot use any environment variables in the macro 
itself. 

Editing Macros 

You edit a macro by editing the command line you entered to create 
it. Use the command line HISTORY feature to recall the command 
line, edit it, and then re-enter it. 

Running and Stopping Macros 

7-32 

To run a macro, enter its name at the system prompt, followed by 
any parameters required. Make sure you leave a space between the 
macro name and the parameters. 

To stop a macro, press <Ctrl> C. This stops the command that is 
currently executing. Press <Ctrl> C as many times as necessary to 
stop every command in the macro. 
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Saving Macros in Batch Files 

The best way of saving your macros is to put the commands into a 
single batch file and then run the batch file whenever you want to 
make the macros available. 

To save macros this way, use the DOSKEY command with the 
/macros option and a redirection symbol. The following command, 
for example, stores all the macros currently stored in memory in a 
batch file called MACROS.BAT: 

DOSKEY /MACROS >MACROS.BAT 

Saving macros in batch files also means you can edit them in the 
future. 
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chapter 8 Commands 

This chapter summarizes the operating system commands. It also 
lists keys you can use to edit the command line. 

Command Summary 

Table 8-1 lists the commands that you can enter from the command 
line. The commands are grouped under the following categories: 

• Date and Time • Networking 

• Directories • Online Help 

• Disk Compression • Operating System 

• Disk Management • Printing Files 

• Files • Program Control 

• Input/Output • Recovering Files 

• International Language Support • Screen Display 

• Memory Management • Security 

Refer to the "Command Reference" chapter of DOSBook for the 
syntax of a particular command and for an explanation of how to 
use that command. For the syntax and explanation of any NET 
command (to work with the network), refer to the "NET 
Commands" chapter of DOSBook. Chapter 5, "Using the Online 
Documentation," in this manual explains how to access 
information in DOSBook. You can also display help text for any 
command by entering the command followed by /? or /H. 

For an alphabetical listing of the operating system commands, refer 
to the "Command Reference" chapter of DOSBook. 
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Note~f' In this manual, batch file subcommands are summarized in Chapter 7, "Batch 
Processing," and CONFIG.SYS commands are summarized in Chapter 9, 
"Configuring the System." Chapter 10, "Managing Memory," has information 
about the configuration commands that help you manage memory. For 
detailed descriptions of all batch file, CONFIG.SYS, and memory management 
commands, however, refer to DOSBook. 

Table 8-1 

Operating System Commands 

To do this: 

Date and Time 

Display and change the current date 

Display and change the current time 

Change the time and date stamp for files 

Directories 

Assign a different drive letter to a drive or directory 

Attach a directory structure to an empty subdirectory on another drive 

Back up or restore directories 

Display the current directory path or change the current directory 

Copy an empty subdirectory structure 

Create a new directory 

Delete an empty directory 

Delete a group of subdirectories and files 

Display a directory structure 

List the files in a directory 

Move a directory 

Rename a directory 

Replace a subdirectory path with a drive letter 
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Use this command: 

DATE 

TIME 

TOUCH 

ASSIGN 

JOIN 

FBX 

CHOIR or CD 

XCOPY 

MKDIR or MD 

RMDIR or RD 

XDEL 

TREE 

DIR 
XDIR 
(more options) 

MOVE 

REN DIR 

SUB ST 



Table 8-1 continued 
Operating System Commands 

To do this: 

Disk Compression 

Create an empty Stacker* drive using available disk space 

Decompress the data on a Stacker drive 

Display the status of Stacker drives 

Mount or unmount a Stacker drive 

Preview drive compression 

Disk Management 

Back up or restore disk contents 

Compare the contents of entire diskettes 

Copy an entire diskette 

Display the volume label of a disk drive 

Create, modify, or delete a disk volume label 

Improve the performance of the hard disk 

Format a diskette or hard disk 

Partition and format a hard disk 

Unformat a diskette 

Verify the integrity of data on a disk, and make corrections 

Files 

Display or change the password protection level 

Back up or restore files 

Check that data has been written correctly to disk 

Use this command: 

CREATE 

UNSTACK 

STACKER 

STACKER 

PREVIEW 

FBX 

DISKCOMP 

DISKCOPY 

VOL 

LABEL 

DISKOPT 
NWCACHE 

FORMAT 

FDISK 

UN FORMAT 

CHKDSK 

PASSWORD 

FBX 

VERIFY 
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Table 8-1 continued 

Operating System Commands 

To do this: 

Com pare two files 

Convert .EXE files to .BIN or .COM files 

Copy or combine files 

Delete "pending delete" files 

Change file attributes 

Display the contents of a text file on screen 

Edit a text file 

Erase a file (no automatic query for confirmation) 

Erase a file (automatic query for confirmation) 

Show a directory structure (to locate a file) 

Find a string of characters in a text file 

Move a file 

Print a file 

Rename a file 

Recover a file 

Change the time and date stamp for files 

Set a search path for commands or batch files 

Transfer files between two computers 
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Use this command: 

COMP 
FC 

EXE2BIN 

COPY 
REPLACE 
XCOPY (more options) 

DELPURGE 

ATIRIB 

TYPE 

EDIT 

DEL 
ERASE or ERA 
XDEL (more options) 

DELQ 
ERAQ 

TREE 

FIND 

MOVE 

See Printing Files 

RENAME or REN 

See Recovering Files 

TOUCH 

PATH 
APPEND 

FILELINK 



Table 8-1 continued 
Operating System Commands 

To do this: 

Input/Output 

Redirect input and output 

Sort input alphabetically, and write it to an output device 

International Language Support 

Change the active code page for national language support 

Display international characters on a CGA monitor 

Load the appropriate keyboard for the country 

Select the time and date format, currency symbol, and code page 

Prepare, select, or display a code page 

Memory Management 

Load a program into upper memory 

Display information about current memory usage 

Disable selected memory features 

Enable or disable the EMM386 memory manager 

Networking 

Perform network tasks using the NET utility 

Use the network administration utility 

List network users and send messages to them 

Use the network diagnostics utility 

Perform network tasks using the command line 

Use this command: 

CITY 
Filter symbol I 
Redirection symbols >, < 
and>> 

SORT 

NLSFUNC 
CHCP 

GRAFTABL 

KEYB 

COUNTRY 

MODE 

HILOAD/LOADHIGH 

MEM 

MEMMAX 

EMM386 

NET 

NET ADMIN 

NET CONSOLE 

NET DIAGS 

NET commands 
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Table 8-1 continued 
Operating System Commands 

To do this: 

Play the arcade-style network game 

Online Help 

Open DOSBook, the online manual. 

Operating System 

Change system configuration settings 

Display the version number of the current operating system 

Load another copy of COMMAND.COM 

Lock your computer temporarily 

Modify the system prompt 

Transfer operating system files and COMMAND.COM to a specified 
drive 

Printing Files 

Assign and set up a printer 

Print a graphical display by using the <PrtScr> key 

Print a text file 

Print a text file to a Postscript* printer 

Program Control 

Create a macro 

Debug a program 

Define variable strings in the command processor environment 

Enable the sharing of files and data 
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Use this command: 

NETWARS 

DOSBOOK 
HELP 

SETUP 

VER 

COMMAND 

LOCK 

PROMPT 

SYS 

MODE 

GRAPHICS 

PRINT 
COPY 

SCRIPT 

DOS KEY 

DEBUG 

SET 

SHARE 



Table 8-1 continued 
Operating System Commands 

To do this: 

Enable or disable the stopping of programs with <Ctrl><Break> 

Load a program during startup 

Load and configure the Task Manager 

Terminates a batch file or secondary command processor 

Recovering Files 

Delete "pending delete" files 

Recover backups 

Recovers lost data from a damaged disk 

Recover deleted files 

Save deleted files on disk 

Save the File Allocation Table on disk 

Screen Display 

Change the display mode 

Clear the screen 

Display text on the console a screenful at a time 

Modify the cursor for laptop computers 

Modify the system prompt 

Security 

Display or change the password protection level for files 

Lock your computer temporarily 

Scan drives and directories for software viruses 

Disable security if you cannot access the hard disk 

Use this command: 

BREAK 

INSTALL 

TASKMGR 

EXIT 

DELPURGE 

FBX 

RECOVER 

UNDELETE 

DELWATCH 

DISKMAP 

MODE 

CLS 

MORE 

CURSOR 

PROMPT 

PASSWORD 

LOCK 

SD SCAN 
SD RES 

UNSECURE 
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Command Line Editing 

Table 8-2 

To save you effort when typing commands, the operating system 
provides command-line editing features. The commands you issue 
can be stored in memory so that you do not need to re-type a 
recently-issued command if you make a typing error; you can 
simply redisplay the command as you first entered it, edit it, and 
then re-issue it. 

The following table lists the command-line editing keys. Refer to 
the "Command Reference" chapter of DOSBook for a detailed 
example of how to edit a command line. 

Command Line Editing Keys 

Key 

<Esc> 

<Backspace> 

<Del> 

<Ins> 

<Fl> 

<F2> 

<F3> 

<F4> 

<F5> 

<F6> 

Function 

Cancels the command line and leaves the original stored command line 
unchanged. 

Deletes the previous character in the stored command line. 

Deletes the currently highlighted character from the stored command 
line. 

Allows you to insert characters into the stored command line. Any 
characters you insert are displayed on screen. Switch insert mode off by 
pressing <Ins> again. 

Copies and displays one character from the stored command line. 

Copies all characters up to the specified character from the stored 
command line ( <F2> must be followed by a character). 

Copies all the remaining characters from the stored command line to the 
screen. 

Deletes all characters up to the specified character from the stored 
command line (<F4> must be followed by a character). 

Copies the current command line (as edited) to the stored command line; 
the line is not edited as a command and you can edit it further if you want. 

Specifies the End-Of-File marker (<Ctrl> Z). If you create a file using the 
COPY command, for example, press <F6> when you finish entering the 
text to mark the end of the file. 
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Table 8-2 continued 

Command Line Editing Keys 

Key Function 

<F9>/<Fl 0> Clears the stored command line. 

Extended Command Line Editing 

The operating system offers additional command line editing keys, 
with more advanced functions than those described above. These 
extended editing keys are described in the "Command Reference" 
chapter of DOSBook. 
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chapter 9 

Note~f' 

Configuring the System 

To improve the efficiency of your operating system, and maximize 
the performance of your programs, you can adjust the way in which 
the system is configured. 

The operating system configuration is defined by the CONFIG .SYS 
and AUTOEXEC.BAT files, both of which are executed every time 
you boot the system. This chapter describes these files. 

The SETUP program provides a quick and easy way of changing the 
system configuration at any time after it has been installed. SETUP 
presents you with a set of menus from which you choose the 
appropriate options. When you exit SETUP, it automatically makes 
the necessary changes to CONFIG.SYS and AUTOEXEC.BAT. These 
changes will take effect the next time you reboot the system. This 
chapter describes what you can do in SETUP and how to use it. 

For some advanced configuration changes, you may need to edit 
the configuration files directly using EDIT or another text editor. 
This chapter includes complete descriptions of all the special 
commands you can use in CONFIG.SYS. 

There are three CONFIG.SYS commands (DOS, HIDEVICE/DEVICEHIGH, and 
HllNSTALL/INSTALLHIGH) that are used for optimizing the way in which the 
system uses memory. These commands are also described in Chapter 10, 
"Managing Memory." 
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Using SETUP to Configure the System 

The SETUP program allows you to make most of the changes to the 
system configuration that you may need without editing the 
configuration files yourself. Use SETUP to configure any of the 
following system features: 

DOS System & Memory 
Management 

Disk Compression 

Disk Performance 

Data Protection & Security 

Task Management 

Networking 
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• 386* or 80286 memory manager (EMM386 or HIMEM), 
DPMS, location of DOS software in memory 

• Country and keyboard 

• DOS parameters (system PATH, environment parameters, 
keyboard HISTORY, disk parameters, PROMPT command, 
directories for temporary and initialization files) 

• Optional DOS device drivers and utilities (ANSI.SYS, 
GRAFTABL, FASTOPEN, SHARE, code page switching) 

• Global color set 

• Creating and reconfiguring Stacker* drives 

• VDISK.SYS 

• NWCACHE disk cache 

• DELWATCH 

• DISKMAP 

• Anti-virus software 

• DOS screen saver/system lock 

• Enabling or disabling system security 

• Task Manager (multitasking or task switching) 

• Interface card 

• Personal NetWare server software 

• Network management 

• Server connections 



Starting SETUP 

Start SETUP by making NWDOS the current directory, and typing 
the following command at the system prompt: 

SETUP <Enter> 

The first menu you see lists the features of the operating system for 
which you can choose to set options: DOS System and Memory 
Management, Disk Compression, Disk Performance, Data Protection and 
Security, Task Management, and Networking. Select the area you want 
to configure and you will see a series of menus relating to that area 
of the operating system. When you finish changing values and exit 
SETUP, the appropriate commands are automatically placed in your 
CONFIG.SYS and AUTO EXEC.BAT files. The next time you boot the 
system, it is configured with the new settings. 

Getting Help in SETUP 

Leaving SETUP 

SETUP has extensive online help which is "context-sensitive"; 
simply press the <Fl> key when an option is highlighted or when 
your cursor is on a field for which you want to view help 
information. 

You can leave SETUP at any time and return to the operating system 
by pressing <Alt> X and choosing to exit to DOS. Your existing 
system configuration is not affected and you can go back into 
SETUP at any time to change values. Configuration values will not 
actually change until you reboot the system. 

SETUP Advise Mode 

To see a summary of your current system configuration which 
includes current memory managers, available memory, last 
physical drive, and (if applicable) recommendations to improve the 
efficiency of the system, enter the following command: 

SETUP /A 
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By default, this information is also displayed whenever you start the 
operating system. 

Configuring the System by Editing the Configuration 
Files 

Note~f" 

It is always easier and safer to use SETUP to make changes to the 
system configuration. Occasionally, however, you may want to 
make a change that can only be made by editing the configuration 
files yourself. Loading a CD-ROM driver, for example, can only be 
accomplished by manual editing of CONFIG.SYS. 

You can use any system command in the AUTO EXEC.BAT file. Refer 
to the "Command Reference" chapter of DOSBook for information 
about the syntax and function of each system command. 

The HILOAD/LOADHIGH and MEMMAX commands, which are used to manage 
memory, are also described in Chapter 10, "Managing Memory." 

In the CONFIG.SYS file, you can use any of the CONFIG.SYS 
commands. For information about the syntax and function of each 
CONFIG.SYS command, refer to "CONFIG.SYS Command 
Reference" starting on page 9-9. 

Three CON FIG.SYS commands are used to optimize the way in which the 
system uses memory. These commands (DOS, HIDEVICE/DEVICEHIGH, and 
HllNSTALL/INSTALLHIGH) are also described in Chapter 10, "Managing 
Memory." 
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CON FIG.SYS 

When you install the operating system, a CONFIG.SYS file is built 
for you automatically and stored in the root directory of the disk 
from which you start the operating system. 

The information specified in the CONFIG.SYS file depends on the 
values you choose during the INSTALL program. Whenever you 
want to change these values, run SETUP and choose options 
appropriately. 

To view your current CONFIG.SYS file, type the following at the 
system prompt: 

TYPE CONFIG. SYS <Enter> 

You will see something similar to the following: 

SHELL = C:\COMMAND.COM /P /E:1024 

DEVICE = C:\NWDOS\EMM386.EXE 

BREAK = ON 

BUFFERS = 20 

FILES = 20 

FCBS = 4, 4 

FASTOPEN = 512 

LASTDRIVE = E 

HISTORY ON, 256, OFF, OFF, OFF 

COUNTRY= 001,,C:\NWDOS\COUNTRY.SYS 

All of the commands included in this example are explained in 
"CONFIG.SYS Command Reference" starting on page 9-9. 

You can also view the CONFIG.SYS file in SETUP by choosing the 
option to view CONFIG.SYS at the end of the SETUP program, if 
you have made changes. 
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AUTOEXEC.BAT 

The AUTOEXEC.BAT file is a batch file that is run every time you 
start the operating system to configure it appropriately. When you 
install the operating system, an AUTOEXEC.BAT file is 
automatically built for you and stored in the root directory of the 
disk from which you load the operating system. The file must 
always be stored on this disk, which is usually your hard disk. 

To view your current AUTO EXEC.BAT file, type the following at the 
system prompt: 

TYPE AUTOEXEC. BAT <Enter> 

When you make changes to the system configuration using SETUP, 
the commands included in AUTOEXEC.BAT may change 
accordingly. You can view AUTOEXEC.BAT during SETUP by 
choosing the option to view AUTOEXEC.BAT at the end of the 
SETUP program, if you have made changes. 

Any command that you want to run automatically whenever the 
system boots can be used in AUTOEXEC.BAT. Refer to the 
"Command Reference" chapter of DOSBook, where all of the 
system commands that you may want to add to AUTOEXEC.BAT 
(or that you will find already included in the file after installation 
or SETUP) are described in detail. 

The following commands are particularly useful in the 
AUTOEXEC.BAT file: 
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Table 9-1 

AUTOEXEC.BAT Commands 

Command 

KEYB 

PATH and APPEND 

SET 

TIME and DATE 

PROMPT 

Description 

KEYB tells the operating system what kind of keyboard you are using. If 
you have a national keyboard (that is, one different from the standard 
keyboard used in the USA), you must run the KEYB command each time 
you start the operating system, to ensure that the characters you type are 
the same as those displayed on the screen. 

PATH tells the operating system where to look for command, program, 
and batch files. 

APPEND tells the operating system where to look for any other type of file, 
such as a data file. 

Placing PATH and APPEND commands in AUTOEXEC.BAT automatically 
tailors the system search path to your own directory hierarchy, every time 
you start the operating system. 

SET inserts strings of information into the command processor's master 
environment. These strings are then available to all programs and 
applications that you run. 

TIME and DATE set the system time and date. You need to use TIME and 
DATE if your computer does not have a battery-powered clock. TIME and 
DATE prompt you to type in the correct time and date, and then set the 
system clock for you. 

Placing TIME and DATE commands in AUTOEXEC.BAT means that you are 
prompted to set the system clock every time you start the operating 
system. 

If you do have a battery-powered clock, the operating system reads it 
automatically at startup, unless you use TIME or DATE in AUTOEXEC.BAT. 

PROMPT changes the default system prompt. For example, you could 
change it to show the current directory. You can change the prompt at 
any time, but placing the PROMPT command in AUTOEXEC.BAT (via 
SETUP) saves you having to define the prompt every time you start the 
operating system. 
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Starting Applications in AUTOEXEC.BAT 

You can start your favorite software applications automatically by 
loading them from your AUTOEXEC.BAT file. 

For example, assume you have a word processor called WundaWord 
that is started by typing WW from a directory called 
\WUNDAWRD. Normally, you would need to type both the 
following commands: 

CHDIR \WUNDAWRD <Enter> 

WW <Enter> 

Edit AUTOEXEC.BAT to add both commands, to load WundaWord 
automatically every time you start your computer. 

Bypassing the Configuration Files 

If you want to perform a "clean boot" of your computer by 
bypassing the CONFIG.SYS and AUTOEXEC.BAT files during 
startup, press and release <F5> (once only) after the computer 
finishes its internal tests. This is usually indicated by a beep. The 
computer will then start with a basic ("clean") configuration 
instead of its usual configuration. 

Confirming Each Configuration Command 

If you want the system to prompt you to confirm each CONFIG.SYS 
and AUTOEXEC.BAT command during startup, press and release 
<F8> (once only) after the computer finishes its internal tests. This 
is usually indicated by a beep. The commands in CONFIG .SYS and 
AUTOEXEC.BAT are displayed one at a time followed by a prompt; 
answer Y to execute the command or N to bypass it. 
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CONFIG.SYS Command Reference 

Note,.f' 

1 
• 

Format 

Explanation 

The commands explained in this section can all be used in your 
CONFIG.SYS file. Remember, however, that it is always easier to let 
SETUP update CONFIG.SYS automatically rather than to edit the 
file yourself. 

Each command is described in the same way as the internal and 
external commands are described in the "Command Reference" 
chapter of DOSBook. Refer to the section called "Command 
Syntax" for an explanation. 

Three CONFIG.SYS commands (DOS, HIDEVICE/DEVICEHIGH, and HllNSTALL/ 
INSTALLHIGH) are also described in Chapter 10, "Managing Memory," because 
they are used to optimize the way in which the system uses memory. 

? ["message_string"] command 

When you use ? at the beginning of a statement, the operating 
system prompts you about whether or not you want the statement 
executed. 

Use? with DEVICE statements, for example, so that you can choose 
whether or not to install specific device drivers when you start the 
operating system. Similarly, use ? in CHAIN statements to choose 
whether or not to transfer control to a different configuration file. 

You can also specify text for the prompt by including a message 
string between ? and the statement, enclosed by double quotation 
marks. 
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Examples 

A response to the prompt specified by ? is required before you can 
proceed, unless you set a limit on the amount of time allowed for a 
response. The statement is then ignored if no response is received. 
Use the TIMEOUT command to set a time limit for a response; see 
TIMEOUT. 

Note that the maximum length allowed for a command statement, 
including? and a message string, is 128 characters. Any statement 
longer than this will be ignored. 

The following statement means that you will be asked whether or 
not you want ANSI.SYS loaded (before it loads): 

?DEVICE = C:\NWDOS\ANSI.SYS 

So whenever you start the operating system and CONFIG.SYS is 
executed, you see the following: 

DEVICE = C:\NWDOS\ANSI.SYS (Y/N) ? 

If you type Y, ANSI.SYS loads. If you type N, the statement is 
ignored. 

The next statement specifies a message to display when prompting. 

?"Do you want ANSI.SYS?"DEVICE = C:\NWDOS\ANSI.SYS 

This statement causes the following to display whenever you boot 
the operating system: 

Do you want ANSI.SYS? 

Answer Y to load ANSI.SYS or N to ignore the statement. 
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:label 

Format 

Explanation 

Example 

BREAK 

Format 

Explanation 

:label 

Use :label to define a location (label) that a GOSUB, GOTO, or 
SWITCH command can reference; refer to the descriptions of 
GOSUB, GOTO and SWITCH in this chapter. 

Only the first eight characters after the colon are recognized as the 
label by GOSUB, GOTO, and SWITCH. 

The following sequence of statements includes a label (MEMDISK) 
that is referenced by a GOTO command: 

? "Do you want a memory disk? (Y/N)" GOTO MEMDISK 

:MEMDISK 

DEVICE=VDISK.SYS 

BREAK = ONIOFF 

The value of BREAK determines whether or not you can stop a 
program while it is running by pressing <Ctrl><Break> or <Ctrl> C. 
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Note~~ 

BUFFERS 

Format 

Explanation 

Set BREAK to ON when you want to be able to do this; the operating 
system also looks for <Ctrl><Break> or <Ctrl> C when the program is 
reading to or writing from a disk. 

Set BREAK to OFF to disable it; <Ctrl><Break> or <Ctrl> C will only 
stop the program the next time it reads from the keyboard, writes 
to the screen, or writes to a printer. 

BREAK allows you to stop programs quickly: programs, for example, 
that do not use standard input and output operations very often, 
such as programs that perform lengthy calculations before printing 
the final output. 

A BREAK command is overruled if you enter a BREAK command at 
the command line; refer to the "Command Reference" chapter of 
DOSBook for a description of BREAK. 

Many applications disable this feature; you must use the method documented 
with the application to stop it. 

BUFFERS nn 

Use the BUFFERS command to specify the number of buffers you 
want in memory. Buffers are small areas (blocks) of memory that 
the operating system uses during disk read and write operations to 
temporarily store the information being read or written. 

You can specify between 3 and 99 buffers. The default number of 
buffers is 15. 

The number of buffers available generally affects the speed at which 
a program accesses files; the more buffers there are, the faster the 
program accesses files. 
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CHAIN 

Format 

Explanation 

Note~~ 

Keep in mind, however, that each buffer you specify uses memory 
that could otherwise be used for the program itself and for data; if 
you specify too many buffers, your program may actually run 
slower than if you specified fewer buffers. 

The documentation for your programs should indicate how many 
buffers to specify. A number between 10 and 30 is generally sensible 
but you may need more if your program uses a large number of files. 
A desktop publishing program, for example, may need more than 
30 buffers. 

CHAIN filespec 

Use the CHAIN command to transfer control (when CONFIG .SYS is 
executing) to another configuration file. CHAIN automatically 
verifies that filespec exists. If it does exist, the current configuration 
file is closed and the operating system begins executing the 
statements in filespec. If it does not exist, processing returns to the 
original configuration file. 

If you use the CHAIN command to transfer control to a configuration file on 
another drive, you must specify the full path including the drive in all DEVICE 
and HIDEVICE/DEVICEHIGH statements in that configuration file. 

CHAIN is most useful when you are using a system with read-only 
or ROM disks; CHAIN allows you to change the configuration 
specified in the ROM-based copy of CONFIG.SYS. 

CHAIN is also useful with the? command; you can group together 
similar CONFIG.SYS commands into additional CONFIG.SYS files 
and then execute them with a single conditional statement; refer to 
the description of ? in this chapter. 
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Example 

CLS 

Format 

Explanation 

COUNTRY 

Format 

Explanation 

The following sequence of statements includes a CHAIN command 
that tells the operating system to look for the CONFIG.SYS file on 
drive D: when it reaches the CHAIN command during execution. If 
a CONFIG.SYS file exists on drive D:, that file will be executed 
rather than the rest of the one containing the CHAIN command. If 
CONFIG.SYS does not exist on drive D:, the original CONFIG.SYS 
continues to execute. 

BUFFERS = 10 

COUNTRY= 44,,C:\NWDOS\COUNTRY.SYS 

CHAIN = D:\CONFIG.SYS 

CLS 

Use the CLS command to clear the screen. 

COUNTRY nnn, cp, [d:]\path\COUNTRY.SYS 

Use the COUNTRY command to load the COUNTRY.SYS file. This 
file provides the following: 
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+ Date and time format appropriate for your country 

+ Currency symbol of your country 

+ Code page to use 

In European countries, the preferred date format is day/month/ 
year, in North America the preferred format is month/day/year, and 
in Japan it is year/month/day. 

The COUNTRY.SYS file also affects the DATE, TIME, and TOUCH 
commands; refer to the "Command Reference" chapter of 
DOSBook for explanations of these commands. 

When specifying the COUNTRY command, you must include the 
following in addition to the complete filespec of COUNTRY.SYS: 

+ Country code (nnn) 

Specify one of the codes listed in Table 9-2. Note that a country 
code does not include information about the type of keyboard 
you are using; refer to the "Command Reference" chapter of 
DOSBook for a description of the KEYB command. 

+ Code page for which country information is required (cp) 

If you do not specify a code page, the default code page for your 
country (nnn) is assumed. In Table 9-2, the first code page listed 
in the Code Pages column is the default code page. 

Note that the default values may already be set correctly for your 
country so they may not need to be changed. 
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Table 9-2 

Country Codes and Code Pages 

Country Code Code Pages 

Australia 061 437 850 

Belgium 032 437 850 

Canada (French) 002 863 850 

Denmark 045 865 850 

Finland 358 437 850 

France 033 437 850 

Germany 049 437 850 

Hungary 036 852 850 

Italy 039 437 850 

Latin America 003 437 850 

Netherlands 031 437 850 

Norway 047 865 850 

Portugal 351 860 850 

Russia 007 866 850 

Spain 034 437 850 

Sweden 046 437 850 

Switzerland (French) 041 437 850 

Switzerland (German) 041 437 850 

Turkey 090 857 850 

United Kingdom 044 437 850 

United States 001 437 850 
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Example 

CPOS 

Format 

Explanation 

Example 

The following entry in your CONFIG.SYS file would convert the 
currency symbol and date and time formats to the Italian versions 
using code page 43 7: 

COUNTRY= 039, 437, C:\NWDOS\COUNTRY.SYS 

CPOS nn, nn 

Use the CPOS command to position the cursor on the screen. 

Specify the row (the first nn) to set the vertical position of the 
cursor. The row number can be from 1 to 25. 

Specify the column (the second nn) to set the horizontal position of 
the cursor. The column number can be from 1 to 80. 

The following statement causes the cursor to appear on the screen 
in row 10 and column 10: 

CPOS 10, 10 
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DEVICE 

Format 

Explanation 

Note.,.f" 

DEVICE filespec [options] 

Use the DEVICE command to install (and configure) device drivers. 

You need device drivers to operate devices (such as printers and 
keyboards) that are not recognized as default parts of your system. 
Most device drivers are hardware-specific although a few (such as 
VDISK.SYS, supplied with the system) are designed for software 
functions. Device drivers usually have the filename extension .SYS. 

You configure device drivers by specifying the appropriate options 
in the DEVICE statement (options) after the name of the driver 
(filespec). 

You can use ? in DEVICE statements to be prompted before drivers 
are loaded; you therefore have the option of loading or not loading 
a particular driver every time you start the operating system. 

Supplied Drivers 

Device drivers for the keyboard, the screen, disk drives, the printer, 
and auxiliary devices are automatically loaded as part of the system 
startup procedure. The operating system also provides a number of 
optional device drivers that you can load with DEVICE commands. 
ANSI.SYS, DISPLAY.SYS, DRIVER.SYS, PRINTER.SYS, and VDISK.SYS 
are described in detail in this chapter. 

EMM386.EXE, HIMEM.SYS, EMMXMA.SYS, and DPMS.EXE are memory 
managers. They are described in Chapter 10, "Managing Memory." 
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New Hardware Drivers 

Whenever you add a new piece of computer hardware, such as a 
mouse or a printer, you must copy the device driver supplied with 
the new hardware onto the drive from which you start the 
operating system. Then you must use a DEVICE statement in 
CONFIG.SYS to make sure that the operating system finds the 
driver and loads it every time you boot the system. 

Example DEVICE statements for each optional device driver 
supplied with the operating system are included in the driver 
descriptions. 

Device Drivers Supplied with the Operating System 

ANSI.SYS 

This section describes the drivers that are supplied with the system. 
See Chapter 10, "Managing Memory," for descriptions of the 
memory managers (EMM386.EXE, HIMEM.SYS, EMMXMA.SYS, 
and DPMS.EXE). 

The DEVICE statements that load the supplied drivers are 
automatically added to your CONFIG.SYS file when you load 
drivers using SETUP or INSTALL. 

ANSI.SYS is a device driver for the keyboard and the screen. It 
provides extra options for programs that need to move the cursor, 
change the screen display, or assign keyboard use. ANSI.SYS options 
are in the form of ANSI escape sequences, which all start with the 
ESC character (lB hex). The ANSI.SYS driver can detect escape 
sequences sent via the normal DOS function calls but it cannot 
detect character output from the ROM BIOS directly. 

ANSI.SYS must be loaded for certain commercial applications; refer 
to the documentation for your applications to determine whether 
or not you need ANSI.SYS. 
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Loading ANSI.SYS 

Load ANSI.SYS if it is required by responding to the appropriate 
prompt during SETUP (or INSTALL). You can also load ANSI.SYS by 
editing the CONFIG.SYS file directly and adding the following 
DEVICE statement: 

DEVICE = C:\NWDOS\ANSI.SYS 

ANSI.SYS will now be loaded every time you start the operating 
system. 

Using ANSI Escape Sequences 

The general form of the ANSI escape sequence is as follows: 

+ A one-byte ESC character (hexadecimal lBH) 

+ A one-byte [character (hexadecimal SBH) 

+ One or more decimal numbers separated by semicolons 

+ A single command character 

Create ANSI escape sequences using a word processor or editor, such 
as EDIT, that allows you to input the ESC and [ control codes. In 
EDIT, for example, you create the ESC code by pressing <Ctrl> P 
followed by the <Esc> key. 

The following information describes different types of ANSI escape 
sequences: to position the cursor, to erase, and to change the 
display mode. Note the following about each of these escape 
sequences: 

+ y and x represent row and column numbers. Row numbers (y) 
are between 1 and 50, with 1 at the top of the screen, and 
column numbers (x) are between 1 and 79, with 1 at the far left 
of the screen. You specify these numbers in ASCII digits. If you 
do not specify a number (or specify 0), the default value is used. 

+ Spaces are shown only to make the sequences easier to read; 
they are not required. 
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Positioning the Cursor 

Cursor position (CUP): ESC [ y;x H 

Horizontal and vertical position (HVP): ESC [ y;x f 

CUP and HVP position the cursor according to the coordinates 
specified. The default (and null) value is the top left corner of 
the screen. CUP and HVP are equivalent. 

Cursor up (CUU): ESC [ y A 

Moves the cursor up y rows without changing the column 
position. This sequence is ignored if the cursor is already at the 
top of the screen. 

Cursor down (CUD): ESC [ y B 

Moves the cursor downy rows without changing the column 
position. This sequence is ignored if the cursor is already at the 
bottom of the screen. 

Cursor forward ( CUF): ESC [ x c 

Moves the cursor to the right without changing the row 
position. This sequence is ignored if the cursor is already in the 
far right column. 

Cursor backward (CUB): ESC [ x D 

Moves the cursor to the left without changing the row position. 
This sequence is ignored if the cursor is already in the far left 
column. 

Device status report (DSR): ESC 6 n 

Cursor position report (CPR): ESC y;x R 

The DSR sequence instructs the console driver to return the CPR 
sequence. The CPR sequence reports the cursor position in 
terms of row and column. CPR is returned via the keyboard 
input. 

Save cursor position (SCP): ESC [ s 
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Table 9-3 

Screen Modes 

Restore cursor position (RCP): ESC [ u 

SCP stores the current cursor position; RCP restores the cursor 
to that position. The default for RCP, if no SCP was issued, is 0,0. 
These escape sequences cannot be nested. 

Erasing 

Erase display (ED): ESC [ 2 J 

Erases the display and moves the cursor to the top left of the 
screen. 

Erase line (EL): ESC [ K 

Erases from the cursor position to the end of the row. 

Changing the Display Mode 

Set graphics rendition (SGR): ESC [ n ; • • • ; n m 

n 

0 

4 

5 

7 

8 

30 

31 

Sets various screen modes that remain in effect until a different 
SGR sequence is issued. The screen mode specified by n can be 
any one of the following: 

Mode 

Return to the default (which is white characters on a 
black background) 

High intensity (bold) 

Underscore (monochrome displays only) 

Flashing 

Inverse video (black characters on a white background) 

Invisible (black on black) 

Black foreground 

Red foreground 
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Table 9-3 continued 

Screen Modes 

n Mode 

32 Green foreground 

33 Yellow foreground 

34 Blue foreground 

35 Magenta foreground 

36 Cyan foreground 

37 White foreground 

40 Black background 

41 Red background 

42 Green background 

43 Yellow background 

44 Blue background 

45 Magenta background 

46 Cyan background 

47 White background 

Set screen mode (SM): ESC 
ESC [ ? n h 

= n h 1 or ESC [ h 1 or 

Reset screen mode (RM): ESC [ = n 1 or ESC [ = 1 or 
ESC [ ? n 1 

These sequences set and reset the screen operating mode. 
Specify any one of the following values for n: 
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Table 9-4 

Screen Operating Modes 

9-24 

n 

0 

2 

3 

4 

5 

6 

7 

Operating Mode 

40 x 25 monochrome 

40 x 25 color 

80 x 25 monochrome 

80 x 25 color 

320 x 200 monochrome 

320 x 200 color 

640 x 200 monochrome 

Enables (SM) or disables (RM) wrapping at the end of 
rows. When enabled, this option "wraps" extra 
characters on to the next line. When wrapping is 
disabled, these characters are lost. 

Assign a key (KR): ESC [ n ; n ; • • • n p 

Changes the function of a key. You define the key to change and 
then define the change. 

You can use extended character codes (ECCs) by typing the first 
variable in the sequence as 0 (NUL) followed by the second key. 
0;68;, for example, is the <Fl 0> key. The last variables in the 
sequence are the character codes for the values you are assigning 
to the key. 

An alternative to specifying a sequence of numbers is to use a 
string defined as characters and enclosed by double quotation 
marks. 65;66;67;, for example, can be shown as "ABC";. 

The following table lists the codes for function keys <Fl> 
through <Fl 0>, when used alone and with <Shift>, <Ctrl>, and 
<Alt>. 
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Table 9-5 

Decimal Key Codes 

Key Code 

<Fl> 59 

<F2> 60 

<F3> 61 

<F4> 62 

<F5> 63 

<F6> 64 

<F7> 65 

<F8> 66 

<F9> 67 

<F10> 68 

<Fl 1 > 133 

<F12> 134 

+Shift +Ctrl +Alt 

84 94 104 

85 95 105 

86 96 106 

87 97 107 

88 98 108 

89 99 109 

90 100 110 

91 101 111 

92 102 112 

93 103 113 

135 137 139 

136 138 140 

Examples 

You can try the following example by using EDIT to create a file 
containing the escape sequences described and then entering the 
name of the file as the parameter of the TYPE command. 

Remember that you must enter the control code for ESC, not the 
character itself; in EDIT, you produce the ESC code by pressing 
<Ctrl> P followed by the <Esc> key. 

The following escape sequence will position the cursor at row 10, 
column 10 and print an x at that point: 

ESC [lO;lOHX 
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DISPLAY.SYS 

Options 

The next sequence sets the screen mode to 40x25 color: 

ESC [?lH 

The following sequence assigns the command XDIR C: to the <Fl 0> 
key: 

ESC [0;68;"XDIR C:";l3p 

To reset current attributes and then set green as foreground color on 
a white background: 

ESC [0;32;47M 

DISPLAY.SYS enables code page switching for EGA and VGA 
displays. 

Loading DISPLAY.SYS 

DISPLAY.SYS is loaded automatically if you use the SETUP program 
to install code page switching. You can also install DISPLAY.SYS by 
editing the CONFIG.SYS file yourself. The format of the statement 
that loads DISPLAY.SYS is as follows: 

DEVICE=C:\NWDOS\DISPLAY.SYS CON=(type,hwcp,nl (n,m)) 

type The type of active display; specify EGA for EGA and VGA displays. If you do 
not specify a display type, DISPLAY.SYS checks your hardware to 
determine the display type you are currently using. 

hwcp The hardware resident code page; DISPLAY.SYS cannot check this, so do 
not specify it if you are unsure about what to specify. 
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Options continued 

n 

m 

The number of additional code pages you want to prepare, usually 1. The 
maximum number you can specify is 12. 

Preparing a code page allocates space in memory for it; the amount of 
memory available for applications is therefore reduced by each code page 
preparation you specify. 

Note that this parameter only prepares for additional code pages. You 
prepare and select specific code pages using the MODE command, in your 
AUTOEXEC.BAT file or at the system prompt. Refer to the "Command 
Reference" chapter of DOSBook for information about the MODE 
command. 

The number of subfonts stored in memory; the default is for all font sizes 
to be resident in memory but using m reduces the number to increase the 
amount of available memory. You can specify one of the following values 
form: 

Dsp Type m Supported Fonts 
EGA 2 (the default) 8*14 and 8*8 
EGA 1 8*14 
VGA 3 (the default) 8*16, 8*14, and 8*8 
VGA 2 8*16 and 8*8 
VGA 1 8*16 

Refer to Chapter 17, "Setting Up Code Page Switching" for more 
information about code pages and code page switching. 

Examples 

The following command defines EGA (or VGA) as the display type 
and 43 7 as the hardware code page, with one additional code page 
to be specified by the MODE command: 

DEVICE= C:\NWDOS\DISPLAY.SYS CON=(EGA,437,1) 

The next command is the same as the previous one except that it 
restricts the number of subfonts stored in memory to 1 (8*14): 

DEVICE= C:\NWDOS\DISPLAY.SYS CON=(EGA,437,(1,1)) 
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DRIVER.SYS 

Options 

/D:n 

IC 

/F:f 

/H:h 

/N 

DRIVER.SYS defines the characteristics of a physical disk drive. 

Use DRIVER.SYS when you want to add a new logical drive to your 
system that is a different type: a 3.5-inch diskette drive to a system 
that uses 5.25-inch drives, for example. Note, however, that 
DRIVER.SYS would only be necessary if the computer's ROM BIOS 
does not support 3.5-inch diskette drives. Consult your hardware 
documentation before using DRIVER.SYS. 

If you want to modify the characteristics of a disk drive already 
recognized by the operating system, use the DRIVPARM command 
in CONFIG.SYS; refer to the description of DRIVPARM in this 
chapter. 

Loading DRIVER.SYS 

The format of the DEVICE statement in CONFIG.SYS that loads and 
configures DRIVER.SYS is as follows: 

DEVICE=C:\NWDOS\DRIVER.SYS /D:n [/C] [/F:f] [/H:h] 
[/N] [/S:ss] [/T:tt] 

The physical drive for which you are defining characteristics; n is 0, 1, 2, 
and so on. 

Specifies that the drive is able to detect when a diskette is changed. 

The type of drive. The possible values are: 

f Drive Type 
0 360 KB 5.25-inch 
1 1.2 MB 5.25-inch 
2 720 KB 3.5-inch (the default) 
7 1.44 MB 3.5-inch 
9 2.88 MB 3.5-inch 

The number of drive heads; specify 1 or 2. 

Specifies that the drive is for permanent media. 
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Options continued 

/S:ss 

/T:tt 

PRINTER.SYS 

Options 

LPTn 

The number of disk sectors per track that the drive supports; specify a 
number between 1 and 63. 

The number of tracks that the drive supports; specify 40 or 80. 

Example 

The following statement defines a 720 KB 3.5-inch drive as the 
second drive: 

DEVICE = C:\NWDOS\DRIVER.SYS /D:l /C /F:2 /H:2 /S:9 
/T:SO 

PRINTER.SYS enables code page switching for printers. 

Loading PRINTER.SYS 

You can install the PRINTER.SYS driver automatically by using the 
SETUP program. You can also install it by editing CONFIG.SYS 
directly. Either way, the format of the DEVICE statement in 
CONFIG.SYS that installs PRINTER.SYS is as follows: 

DEVICE = C:\NWDOS\PRINTER.SYS LPTn=(type,hwcp,n) 

The port to which the printer is connected, where n is 1, 2, or 3. You can 
use PRN instead of LPTl; they are equivalent. 

You must define each printer that supports code page switching, if you 
have more than one on your system. There is a limit of three printer 
definitions in a single DEVICE statement. 

Configuring the System 9-29 



Options continued 

type 

hwcp 

n 

VD I SK.SYS 

The type of printer. Specify one of the following: 

Type Printer 
4201 IBM* 4201 Proprinter*/4202 Proprinter XL 
4208 IBM Proprinter 4207 XL24/4208 XL24 
5202 IBM Quietwriter* Ill 
1050 Epson FX 850/FX 1050/compatible type 

The hardware resident code page; this is optional. 

The number of additional code pages that you want to prepare for the 
printer, usually 1 or 2. The maximum number you can specify is 12. 

Preparing a code page allocates space in memory for it; the amount of 
memory available for your applications is therefore reduced by each code 
page preparation that you specify. 

Example 

The following DEVICE statement in CONFIG.SYS prepares two 
printers with one additional code page: 

DEVICE=C:\NWDOS\PRINTER.SYS PRN=(4201,437,l) 
LPT2=(5202,437,l) 

The VDISK.SYS driver allows you to set up a memory disk: a portion 
of memory that acts as a very fast disk. 

A memory disk is fast but only exists while your computer is 
switched on; when you switch your machine off or reset the 
computer, everything stored in a memory (or virtual) disk is lost. 
Consequently, anything stored on a virtual disk that you want to 
keep must be copied to a hard disk or diskette before you switch off 
power to the computer. 

Use the VDISK.SYS driver when you want to store temporary files 
used by programs or when you are using programs that need to 
access a lot of information quickly and frequently, such as databases 
and spreadsheets. 
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Options 

disksize 

sectsize 

maxfiles 

/E:[sectors] 

IX 

Loading VDISK.SYS 

If you do not have extended or expanded memory on your system, 
a virtual disk is automatically set up in conventional memory. If 
you do have extended or expanded memory, however, you can 
specify various options with VDISK.SYS. The format of the DEVICE 
statement that loads VDISK.SYS is as follows: 

DEVICE = C:\NWDOS\VDISK.SYS [disksize] [sectsize] 
[maxfiles] [/E:[sectors]] [/X] 

The size of the disk in KB; specify a size between 1 and 256 KB (unless you 
have extended memory on your system). The default size is 64 KB. 

The smallest amount of space reserved on the disk. The default is 128 
bytes but you can also specify 256 or 512 bytes. 

The maximum number of files that can be written to the root directory of 
the virtual disk. Specify a number between 2 and 512; the default is 64. 

The number you specify determines the amount of disk space reserved for 
the disk directory. Keep in mind that specifying a large number of files will 
waste space unless you actually do copy large numbers offiles to the disk. 

Locates the virtual disk in extended memory, if extended memory is 
available on your system. Specify the number of sectors at a time to be 
transferred between conventional memory and extended memory when 
the virtual disk is being used; sectors can be a number between 1 and 8 
(the default is 8). 

Locates the virtual disk in expanded memory, if available on your system. 
A virtual disk in expanded memory can be up to 32 MB in size. 

You must load VDISK.SYS in CONFIG.SYS before any other drivers 
that use extended memory but after your memory manager, such as 
EMM386 or HIMEM. If you use SETUP or INSTALL to create a 
memory disk, however, VDISK.SYS is loaded automatically, in the 
correct sequence. 

Also note that if you use the HIDEVICE/DEVICEHIGH command to 
load VDISK.SYS in extended memory, you must use the /E switch; 
refer to Chapter 10, "Managing Memory" for information about 
using HIDEVICE/DEVICEHIGH. 
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DOS 

Format 

Explanation 

Examples 

The following DEVICE statement defines a virtual disk of 200 KB 
with a sector size of 256 bytes and a maximum of 32 files: 

DEVICE = C:\NWDOS\VDISK.SYS 200 256 32 

The next statement defines a virtual disk of 10,240 KB, located in 
expanded memory: 

DEVICE = C:\NWDOS\VDISK.SYS 10240 /X 

DOS=HIGHILOWIUMBIHIGH,UMBIUMB,HIGH 

DOS specifies the location of the system software. 

If you do not have extended memory, the operating system 
software is loaded in the lowest part of conventional memory 
(DOS=LOW). 

If your computer has extended memory, however, you can make 
more conventional memory available to your applications by 
running the DOS software in the High Memory Area (HMA) and in 
upper memory (when the HMA is not available). DOS=HIGH,UMB 
is the default for the operating system when extended memory is 
available. In order for high or upper memory to be enabled, a 
memory manager (EMM386 or HIMEM) must be loaded first. Refer 
to Chapter 10, "Managing Memory" for information about 
memory managers. 

You can also force the operating system software to use the HMA or 
upper memory exclusively (DOS=HIGH or DOS=UMB). 
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Note,.f' 

Example 

DRIVPARM 

Format 

Explanation 

To change the default location of the operating system, run SETUP, 
choose DOS System and Memory Management, and then choose 
Memory Manager. You can specify Conventional Memory, Upper 
Memory, or High Memory. SETUP automatically updates the DOS 
command in CONFIG .SYS and the next time you boot your 
machine, the new DOS setting takes effect. 

When you choose High Memory, DOS=HIGH,UMB is added in CONFIG.SYS. To 
specify high memory only edit the CONFIG.SYS file manually. 

The following command loads the system software in upper 
memory, if available: 

DOS=UMB 

DRIVPARM = /D:n [/C] [/F:n] [/H:nn] [/I] [/N] 
[/S:nn] [/T:nn] 

The DRIVPARM command defines the physical characteristics of a 
specified disk drive. Use it to associate a particular type of physical 
disk drive with a logical drive. To add a 3.5-inch diskette drive to a 
computer that does not expect to use 3.5-inch diskette drives, for 
example, the DRIVPARM command is required to redefine the drive 
parameters for subsequent use by the operating system. 

You can also use DRIVPARM to modify a logical drive already 
recognized by the operating system but to add and define a new 
logical drive, you must use the DRIVER.SYS device driver instead. 
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Options 

/D:n 

IC 

/F:n 

/H:nn 

/I 

/N 

/S:nn 

/T:nn 

9-34 

Refer to the description of DRIVER.SYS in this chapter for 
information. 

Specify the single digit that corresponds to the logical drive (drive A, drive 
C, and so forth.) for which you are defining characteristics. 

Specifies that the drive is able to detect when a disk is changed. 

Specifies the drive type. Specify one of the following: 

n Drive Type 
0 160/180 KB or 320/360 KB 
1 1.2 MB 
2 720 KB (the default) 
5 Hard disk 
6 Tape 
7 1.44 MB 
8 Read/write optical disk 
9 2.88 MB 

Specifies the maximum number of drive heads; specify a number from 1 
through 99. The default depends on the value specified for /F:n. 

Specifies a 3.5-inch diskette drive that is installed on your computer and 
uses the existing diskette drive controller. Use this switch when your 
computer does not support 3.5-inch diskette drives. 

Specifies that the drive is for permanent media. 

The number of sectors supported by the drive. Specify a number between 
1 and 99. The default depends on the value specified for /F:n. 

The number of tracks supported by the drive. The default depends on the 
value specified for /F:n. 
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ECHO 

Format 

Explanation 

Example 

EXIT 

Format 

Explanation 

ECHO [message] 

Use the ECHO command to display messages on screen when you 
start the operating system. 

Questions and explanatory messages, for example, are useful as part 
of your CONFIG.SYS file. Messages you specify with ECHO 
commands appear in the order in which you enter them in 
CONFIG.SYS and exactly as you type them in ECHO statements, 
including any spaces you leave. 

The following ECHO statement causes the message INSTALL CODE 

PAGE SWITCHING? to appear on your screen whenever 
CONFIG.SYS executes: 

ECHO INSTALL CODE PAGE SWITCHING? 

EXIT 

EXIT forces the system to terminate CONFIG.SYS execution. 
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FASTOPEN 

Format 

Explanation 

Example 

FAS TO PEN nnnnn 

The FASTOPEN command increases the speed at which the 
operating system accesses files on a hard disk that are being 
accessed repeatedly. FASTOPEN records the locations of these files 
so that the operating system does not have to "navigate" along the 
path every time a file is accessed. 

FASTOPEN causes the system to set up a special table of filenames 
in memory, the size of which you set by specifying the number of 
entries (nnnnn). Specify a number between 128 and 32768; the 
default is 512 entries. 

Remember that FASTOPEN improves disk performance but results 
in less available space in memory; each table en try uses 2 bytes of 
memory. Consequently, you should not define a table larger than 
you need. 

The following command defines a table size of 512 entries: 

FASTOPEN = 512 
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FCBS 

Format 

Explanation 

Note~f" 

Options 

m 

n 

Example 

FCBS m,n 

Use the FCBS command to specify the number of files that can be 
opened by programs at the same time using data structures called 
File Control Blocks. 

Some older applications may require an FCBS statement in CONFIG.SYS rather 
than a FILES statement; FILES is also used to control the number of files that can 
be opened simultaneously. Always use the FILES command to control the 
number of open files allowed unless your application specifically requires an 
FCBS entry. 

For FCBS to have much effect, the SHARE program or networking 
support must be loaded. Refer to the "Command Reference" 
chapter of DOSBook for a description of the SHARE command. 

The number of files that FCBs can open at one time; specify a number 
from 1 to 255. 

The number of files opened by FCBs that are protected from automatic 
closure by the system; specify a number from 1 to 255. If an application 
attempts to open more than m file(s) by FCBs, all but the first n file(s) may 
be closed by the operating system. 

The following command sets the maximum number of open files 
allowed to 8 and the number of protected files to 4: 

FCBS = 8, 4 
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FILES 

Format 

Explanation 

Example 

FILES nnn 

The FILES command specifies the number of files that can be 
opened simultaneously by programs. The operating system uses 
this number to determine how much memory to set aside for 
controlling open files. 

Specify a number (nnn) between 20 and 255; the default is 20. 

You should only specify more than the default number of files (20) 
if the documentation for an application you are using instructs you 
to do so or if the application returns error messages indicating that 
the number of open files allowed is insufficient. 

The following command sets the maximum number of open files 
allowed to 20: 

FILES = 20 
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GOSUB 

Format 

Explanation 

Example 

GOSUB label 

GOSUB forces execution to jump to a group of statements 
(subroutine) within the same CONFIG.SYS file, execute the 
subroutine, and then jump back (when a RETURN command is 
encountered) to the statement immediately after the GOSUB. You 
must specify a label, and that label must be present in the 
CONFIG.SYS file to identify the start of the subroutine. A RETURN 
command must be present to identify and exit from the subroutine. 

In the following sequence of statements, execution jumps to the 
statement after the label and through the following statements 
before jumping back to the statement after GO SUB when it reaches 
RETURN: 

GOSUB memdisk 

exit 

:memdisk 

DEVICE=vdisk.sys 

return 
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GOTO 

Format 

Explanation 

Example 

GOTO label 

Use GOTO to change the order in which commands are executed. 

GOTO directs the operating system to jump to another part of the 
file, identified by a label. The label parameter must identify a label 
that is present in the same CONFIG.SYS file. 

You can use? with GOTO commands so that if a certain condition 
is satisfied, or response received, execution jumps to the 
appropriate statements. 

If you want execution to jump to a certain point in the file and then 
jump back again, use GOSUB and RETURN commands instead; refer 
to the descriptions of GOSUB and RETURN in this chapter. 

In the following sequence of statements, execution jumps to the 
label (MEMDISK) if the user enters Y (for Yes) when prompted by 
the? statement: 

? "Do you want a memory disk? (Y/N)" GOTO MEMDISK 

:MEMDISK 

DEVICE=VDISK.SYS 
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HIDEVICE/DEVICEHIGH 

Format 

Explanation 

Example 

HIDEVICEjDEVICEHIGH [SIZE=nnnn] filespec 

HIDEVICE or DEVICEHIGH loads an installable device driver into 
upper memory. 

You must specify the name of the device driver (filespec) that you 
want to load high. 

If you want to load a device driver that is unable to determine the 
amount of memory that it will ultimately need, you can also specify 
the amount of upper memory required for the driver (SIZE=nnnn). 
To determine this amount, load the driver into conventional 
memory and then run the MEM command to see how much 
memory the driver uses. Refer to the "Command Reference" 
chapter of DOSBook for information about MEM and its options. 

The following command loads ANSI.SYS into upper memory: 

HIDEVICE=C:\NWDOS\ANSI.SYS 
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HllNSTALL/INSTALLHIGH 

Format 

Explanation 

Example 

HIINSTALLjINSTALLHIGH=filespec [options] 

HIINSTALL or INSTALLHIGH loads and executes a specified 
program in upper memory rather than conventional memory. 
HIINSTALL or INSTALLHIGH performs the same function as 
HILOAD or LOADHIGH except that it is processed as part of 
CONFIG.SYS rather than at the system prompt or in a batch file 
(such as AUTOEXEC.BAT). 

You must specify the full filespec of the program you want to load 
into upper memory. You can also specify any parameters (options) 
that you want to pass to the program. 

The specified program will load and execute in upper memory every 
time you start the operating system, as long as upper memory is 
enabled by a memory manager (EMM386 or HIMEM) and is 
available. Before attempting to load a program into upper memory, 
you can check to make sure that there is enough upper memory 
available by running the MEM command; refer to the "Command 
Reference" chapter of DOSBook for information about MEM and its 
options. 

The following command installs the CURSOR program in upper 
memory: 

HIINSTALL=C:\NWDOS\CURSOR.EXE 
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HISTORY 

Format 

Explanation 

Options 

nnnn 

[,ONIOFF] 

HISTORY ON[,nnnn[,ONIOFF][,[ONIOFF][,ONIOFF]]] IOFF 

Use the HISTORY command to turn the extended command line 
editing features on and off. Extended command line editing stores 
commands you issue in a memory buffer so that you can recall 
commands that you recently issued and re-issue or modify and 
re-issue them. 

Set HISTORY to ON if you want to be able to recall and modify 
command lines using the extended editing keys. See the 
"Command Reference" chapter of DOSBook for a full description of 
extended command line editing. 

Set HISTORY to OFF if you want to disable extended command line 
editing completely. 

You can also enable or disable the command line search mode 
features specifically; refer to the descriptions of the third and forth 
ONIOFF parameters in the options table below. 

Defines the size of the memory buffer in which commands are stored. The 
size of the buffer determines how many command lines you can recall. 
Specify a buffer size between 128 and 4096 bytes. The default is 51 2 
bytes, which allows you to recall approximately 10 commands. 

Note that the operating system actually uses two memory buffers of the 
size you specify; the first buffer stores commands entered in the command 
line and the second buffer stores commands entered from applications. 

Turns "insert mode" on and off; off is the default. When insert mode is on, 
characters you enter in the command line are inserted in front of the 
cursor. When insert mode is off, characters at the cursor position are 
overwritten. 
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Options continued 

[,[ONIOFF]] 

[,ONIOFF] 

Example 

INSTALL 

Format 

Explanation 

This third ONIOFF option enables or disables the command line search 
feature specifically. Command line search allows you to display the 
most-recently-entered command that matches the current one by 
pressing <Ctrl> R. 

The fourth ONIOFF option enables and disables the more sophisticated 
search feature; this allows you to recall the most-recently-entered 
command that matches each character you type, by pressing <Ctrl> _. 

The following command switches insert mode on and defines a 
memory buffer of 512 bytes: 

HISTORY = ON,512,0N 

INSTALL filespec [options] 

Use the INSTALL command to load a program automatically from 
CONFIG.SYS when you start the operating system; this saves you 
from entering the program name in the command line every time 
you want to use it. 

You can specify options to pass to the specified program (fi.lespec). 

The following programs can be loaded using the INSTALL 
command: 

9-44 Novell DOS 7 User Guide 



Note~~ 

Example 

LASTDRIVE 

Format 

Explanation 

CURSOR.EXE 

GRAITABL.COM 

GRAPHICS.COM 

KEYE.COM 

NLSFUNC.EXE 

PRINT.COM 

SHARE.EXE 

To load installable device drivers during startup, use the DEVICE command; 
refer to the description of DEVICE in this chapter. 

The following statement loads the KEYB program (with the UK 
keyboard option) whenever CONFIG.SYS is executed: 

INSTALL = C:\NWDOS\KEYB UK 

LASTDRIVE drive letter 

Use the LASTDRIVE command to set a different "last drive letter" 
than the one automatically set by the operating system. 

The operating system assigns a drive letter to each actual drive that 
it finds during startup (including any virtual disk drives) and sets 
the last drive letter it assigns as the "last drive letter"; all remaining 
drive letters become invalid. Use LASTDRIVE so that the operating 
system will recognize drive letters not already assigned. 

If you are using the operating system's network component, set 
LASTDRIVE to the letter Z. 
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Example 

REM 

Format 

Explanation 

Example 

Assume that your computer has a diskette drive (A:), a hard disk 
drive (C:), and two virtual disk drives (D: and E:) but you are using 
a program that requires you to use the SUBST command with drives 
F: and G:. The following command causes the operating system to 
recognize drive letters F: and G: as well as A: through E: 

LASTDRIVE = G 

REM I [comment] 

Use REM to add comments to your CONFIG.SYS file. Simply use 
REM (for "remark") or a semicolon as the first character in a 
statement to identify it as a comment; the statement will be ignored 
when the file is executed. 

Comments are useful to clarify the purpose of a command. You can 
also use the comment markers (REM or;) without a comment itself 
to add spaces in the file so that it is easier to read. 

The following statements include a DEVICE command that loads 
the ANSI.SYS driver and a comment preceding it that explains what 
the DEVICE command does: 

REM * Load the ANSI driver for Wordmaster 

DEVICE =ANSI.SYS 
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RETURN 

Format 

Explanation 

SET 

Format 

Explanation 

RETURN 

Use RETURN with a GO SUB or SWITCH command to direct 
execution back to the statement following the GOSUB or SWITCH 
command after the appropriate subroutine has been executed; refer 
to the descriptions of GOSUB and SWITCH in this chapter. 

SET name=parameter 

Use the SET command to add environment variables to the 
command processor's master environment. 

The name of an environment variable is determined by the 
commands and device drivers loaded in your system configuration. 
Applications and batch files such as AUTOEXEC.BAT can then 
"test" the value (parameter) of a variable and execute commands 
accordingly. 
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Examples 

SHELL 

Format 

Explanation 

The following statements include a SET command that specifies a 
value for the VDISK variable: 

?"Create a lMb RAM Disk" gosub ramdisk 

exit 

:ramdisk 

set VDISK=1024 

device=c:\nwdos\vdisk.sys 1024 /X 

return 

The next group of statements (in AUTOEXEC.BAT) tests the value 
of the VDISK variable (set above) and changes the value of the 
TEMP variable accordingly. 

SET TEMP=C:\TEMP 

if NOT "%VDISK%" 
MD %TEMP% >NUL 

" " SET TEMP=D:\TEMP 

SHELL filespec dirpath /P[:filename] [/E:n] [/Mx] 

SHELL defines the name (filespec) and location (dirpath) of the 
command processor used by the operating system. By default, 
COMMAND.COM is loaded from the root directory of the C: drive. 
Change the SHELL statement in CONFIG.SYS if you want the 
operating system to use a different command processor or a 
command processor that is located in a directory other than the 
root directory. 
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Note .... f' 

Options 

/P[:filename] 

/E:n 

/Mx 

Examples 

The IP switch is required with the SHELL command to fix the 
specified command processor in memory. 

You can load another copy of the command processor by using COMMAND at 
the system prompt. Refer to the description of COMMAND in the "Command 
Reference" chapter of DOS Book for more information. 

Makes the command processor permanent in memory. The EXIT 
command (to terminate a secondary command processor) is disabled. The 
operating system runs AUTOEXEC.BAT by default after COMMAND.COM 
is loaded; use filename to specify a different batch file, if required. 

Defines the size of the command processing environment in bytes, where 
n is a number from 129 to 32,751. The default size is 256; the default is 
also used if you specify a number outside the valid range. 

Forces the command processor to load in a specific memory area, where 
xis L (for low), H (for high), or U (for upper). The default is low memory. 
You must have a memory manager that supports high and upper memory 
loaded before you can use /MH or /MU. If there is insufficient high or 
upper memory available, the command processor loads in conventional 
memory. 

The following statement loads COMMAND.COM from C:\NWDOS 
rather than from the root directory: 

SHELL = C:\NWDOS\COMMAND.COM C:\NWDOS /p 
/E:512 

The COMSPEC environment variable, which defines the path to the 
command processor, is now set as follows: 

COMSPEC = C:\NWDOS\COMMAND.COM 

If you reset COMSPEC using the SET command (at the system 
prompt or in a batch file), however, this will override the value set 
in the SHELL statement. 
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STACKS 

Format 

Explanation 

Example 

SWITCH 

Format 

Explanation 

STACKS=n,s 

The STACKS command supports the use of data stacks for hardware 
interrupts. 

Specify the number of stacks (n) as 0 or 8 through 64 and the size of 
each stack (s) as 0 or 32 through 512. 

The default STACKS setting is 0,0 for IBM PCs and PC/XTs and 9, 128 
for other machines. 

The following command allocates 8 stacks of 512 bytes each for 
hardware interrupt handling: 

STACKS=S,512 

SWITCH labell, label2[, labeln] 

Use the SWITCH command to switch between different subroutines 
within the same CONFIG.SYS file. When CONFIG.SYS executes, 
SWITCH causes the operating system to prompt you to select a 
configuration subroutine. Execution then jumps to the selected 
subroutine. 
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Example 

Each subroutine must start with a label and end with a RETURN 
statement. 

You can use up to 9 labels. 

The following statements specify switching between three 
subroutines. 

echo 

echo 

echo 

CONFIGUR..~T!ON 1 

CONFIGURATION 2 

CONFIGURATION 3 

echo = Please select CONFIGURATION 1 2 or 3 ? 

switch configl, config2, config3 

echo CONFIGURATION COMPLETE 

exit 

:configl 

echo CONFIGURATION 1 selected 

return 

:config2 

echo CONFIGURATION 2 selected 

return 

:config3 

echo CONFIGURATION 3 selected 

return 

These statements would cause the following to display when 
executed: 

CONFIGURATION 1 

CONFIGURATION 2 

CONFIGURATION 3 

Please select CONFIGURATION 1 2 or 3 ? 
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TIMEOUT 

Format 

Explanation 

The valid responses to the prompt would be 

+ A number (1 through 3) to select a CONFIGURATION. 

+ Just the <Enter> key to automatically select CONFIGURATION 
1. 

+ No response (but with a TIMEOUT condition specified) to 
automatically select CONFIGURATION 1 after the TIMEOUT 
limit is reached; refer to the description of TIMEOUT in this 
chapter. 

Assuming you type 2 and press <Enter>, you then see 

CONFIGURATION 2 selected 

Then 

CONFIGURATION COMPLETE 

TIMEOUT [=] n 

Use TIMEOUT to set a time limit for the amount of time allowed to 
respond to a? or SWITCH prompt (see ? and SWITCH); the 
command is then ignored (for ?) or the first option is assumed (for 
SWITCH) if you do not enter a response within the TIMEOUT limit. 

Specify n seconds, where n is a number, or accept the default of 0, 
which forces the system to wait indefinitely until a key is pressed. 

Note that a TIMEOUT setting applies to all? and SWITCH 
statements that follow it. 
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Example 

The following statement sets a time limit of 10 seconds for ? and 
SWITCH prompts: 

TIMEOUT 10 
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chapter 1 o 
Managing Memory 

This chapter describes the different kinds of memory that could be 
available and how you can optimize the way in which the operating 
system uses that memory. 

Types of Memory 

Table 10-1 

Types of Memory 

Type of Memory 

Conventional 

Upper 

The following table describes the different types of memory that 
your computer may have. 

Description 

The first 640 KB of memory on a computer. Conventional memory is 
required, and directly addressable, by all DOS-based applications. Lower 
memory refers to the lowest 64 KB of conventional memory; this is where 
the operating system and device drivers are usually loaded; the remaining 
area of conventional memory contains most of your data and programs. 
Most DOS-based applications can only run in conventional memory but 
you can optimize your system's memory configuration to take advantage 
of other memory types and make as much conventional memory as 
possible available to your applications. 

The 384 KB of memory above conventional memory. This area of memory 
is used by various elements of your system hardware, such as the video 
display adapter or network adapter. Unused upper memory, however, 
may be available for loading device drivers and memory-resident 
programs. 
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Table 10-1 continued 
Types of Memory 

Type of Memory 

Extended (XMS) 

High (HMA) 

Expanded (EMS) 

Description 

Memory above 1 MB on computers with 80286 and 386* (and later) 
microprocessors. An extended memory manager is required to use 
extended memory; Novell DOS™ 7 includes the EMM386 and HIMEM 
memory managers for this purpose. Some applications, such as MS 
Windows, require extended memory. XMS (Extended Memory 
Specification) refers to the protocol that provides a standard interface to 
upper and extended memory and allows it to be accessed via the Novell 
DOS 7 memory managers. 

In order to use extended memory, an 80286 or 386 (and later) computer 
must run in protected mode as opposed to real mode. 386 (and later) 
machines can also run in virtual 8086 mode, which means that although 
the computer appears to be running in real mode as far as an application 
is concerned, protected mode features are available. 

The first 64 KB of extended memory, also referred to as the High Memory 
Area or HMA. The operating system, by default, is set to run in high 
memory so that more conventional memory is available for your 
applications. The HMA is special extended memory because it can be 
accessed when the computer is running in real mode; refer to the 
explanation of real and protected mode in the description of extended 
memory (above). 

Memory (additional to conventional memory) that some DOS-based 
applications can use. This memory, which conforms to the Lotus* /Intel* I 
Microsoft* (LIM) Expanded Memory Specification (EMS), is referred to as 
expanded or EMS memory. Originally, expanded memory was provided by 
an expanded memory board fitted inside the computer that came with an 
expanded memory manager. The EMM386 memory manager, however, 
can now emulate expanded memory, on a 386 (or later) computer, for 
applications that need it. Some applications can use EMS memory via a 
64 KB part of upper memory called the page frame. This area is reserved 
in upper memory by the memory manager when expanded memory is 
required. 

10-2 Novell DOS 7 User Guide 



Figure 10-1 
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Displaying the Current Memory Configuration 

Before you begin making changes to optimize the way in which 
your system uses memory, it is important that you know what types 
of memory are available on your computer and how memory is 
currently being used. 

The MEM command displays extensive information about memory 
usage. Refer to the "Command Reference" chapter of DOSBook for 
a detailed description of the MEM command. For a brief description 
of MEM and its options, simply enter either of the following version 
of the MEM command at the system prompt: 

MEM /? 
MEM /H 
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Novell DOS 7 Memory Managers 

EMM386 

To access extended, expanded, or upper memory, the operating 
system includes memory managers. A memory manager is a special 
device driver that provides access to different memory types. The 
memory manager you use depends on what type of hardware you 
are using. 

The EMM386 memory manager provides access to the upper 
memory area. It also uses extended memory to emulate expanded 
(EMS) memory for those applications that need it. 

Use EMM386 if your computer is a 386-based machine or later. 

EMM386 is loaded and configured by a DEVICE statement in the 
CONFIG.SYS file. This statement is automatically placed in 
CONFIG.SYS when you choose to load the 386 memory manager 
during SETUP (or INSTALL). The configuration ofEMM386 depends 
on the values you set in SETUP and on changes you make yourself 
to CONFIG.SYS. 

The full syntax of the EMM386 DEVICE statement is as follows: 

DEVICE= C:\NWDOS\EMM386.EXE [[/]?I [/]H] [[/]AUTO] 
[ [I] COMPAQ [=ON I OFF] ] [ [I] DPMI [=ON I OFF] ] 
[[/]EXCLUDE=start-end[,start-end] ... ] 
[[/]FRAME=AUTOINONEiaddress] [[/]GATEA20=type] 
[[/]INCLUDE=start-end[,start-end] ... ] 
[ [/]INTlS=kb] [ [/]MULTI[=ONIOFF]] [[/]OFF] [[/]ON] 
[[/]ROM=start-end[,start-end] ... ] 
[[/]USE=start-end[,start-end] ... ] 
[[/]VIDEO[=[start-]end]] [[/]VXD=path] 
[[/]WEITEK=ONjOFF] [[/]WINSTD] [[/]XBDA] 
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Option 

[/]?or [/]H 

[/]AUTO 

[/]COMPAQ[=ON I OFF] 

[/]DPMl[=ON I OFF] 

The following table describes the EMM386 options. For information 
about specifying these options, either through SETUP or by editing 
CONFIG.SYS yourself, see "Making More Memory 
Available" on page 10-10. 

Description 

Displays help text. 

Switches the memory manager ON and OFF automatically, 
as required. This is the default. 

Controls COMPAQ* support. By default on a COMPAQ 
computer (386 and later), support is enabled to provide an 
additional 256 KB of memory. Use the COMPAQ switch if 
you experience problems and want to disable this support 
(COMPAQ=OFF). 

Provides DOS Protected Mode Interface (DPMI) support. If 
ON or OFF is not specified, ON is assumed. You can also 
enable or disable DPMI temporarily at the system prompt 
by entering DPMl=ON or DPMl=OFF. 

[!]EXCLUDE=start-end[,start-end] ... Forces the memory manager to exclude the specified areas 
of upper memory when it searches for usable memory; 
start and end are the starting and ending segment 
addresses of each area to exclude. 

[/]FRAME=AUTO I NONE I address 

[!]GATEA20=type 

[!]INCLUDE=start-end[,start-end] ... 

Enables expanded (EMS) memory emulation. AUTO (the 
default) lets the memory manager locate the page frame; 
NONE disables EMS emulation; address identifies a specific 
location in upper memory. 

Specifies handling of control address line A20. The 
memory manager normally detects the machine type 
automatically but in certain situations you may need to 
specify it yourself. Type can be one of the following: 
AT Standard AT* 
HP Hewlett-Packard* Vectra* 
MCA MCA (such as PS/2*) or compatible 
XMS Third-party XMS driver 

Tells the memory manager to test the specified areas of 
upper memory when it searches for usable memory; start 
and end are the starting and ending segment addresses of 
each area to include. 
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Option 

[/]INITl 5=kb 

[/]MULTl[=ON I OFF] 

[/]OFF 

[/]ON 

[!]ROM=start-end[,start-end] ... 
I AUTO I NONE 

[/] USE=start-end 

[/]VIDEO[ =[start-]end] 

[!]VXD=path 

[/]WEITEK=ON I OFF 

[/]WIN STD 
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Description continued 

Reserves the specified amount (kb) of extended memory 
for use by third-party software that cannot use XMS or 
expanded (EMS) memory. 

Provides support for multitasking. This switch is added 
automatically when you choose to load the multitasking 
software in SETUP. If ON or OFF is not specified, ON is 
assumed. 

Turns the memory manager OFF. The computer is 
permanently in real mode. 

Turns the memory manager ON. The computer is 
permanently in protected/virtual 8086 mode. 

Copies slow Read-Only Memory (ROM) into fast Random 
Access Memory (RAM); start and end specify the starting 
and ending segment addresses of each area of ROM to 
copy, AUTO copies all slow ROM to RAM, and NONE 
disables copying. 

Forces the memory manager to use a specified area of 
upper memory when it searches for usable memory; start 
and end are the starting and ending segment addresses of 
the area to use. 

Makes unused video memory space available to 
applications when all the video memory is not being used 
by the video display adapter. Video memory (the upper 
memory immediately above 640 KB) is normally reserved 
for use by the video display adapter. 

Specifies the location of the EMM386 VxD, if necessary, to 
MS Windows 3.0 or later in Enhanced mode. By default, 
the VxD is located in the directory from which the memory 
manager is loaded. 

Enables or disables DOS access to the Weitek* coprocessor, 
if fitted on your machine. 

Provides support for MS Windows 3.0 in Standard (80286) 
mode. MS Windows 3.0 in Standard mode requires upper 
memory to be disabled. 



Option 

[/]XBDA 

HIMEM 

Note,.f' 

Description continued 

Keeps the extended BIOS data area (XBDA) at the top of 
conventional memory, for applications that require it to be 
there. If you enable sharing of video memory (/VIDEO), the 
memory manager automatically moves the XBDA to the 
bottom of conventional memory to allow contiguous 
memory. 

The HIMEM memory manager provides access to the upper memory 
area. The features provided by HIMEM, however, will depend on 
your hardware. If you are using a 286-based computer with 
extended memory, the only HIMEM feature you may be able to use 
is relocation of the DOS software to high memory. If you have a chip 
set or expanded memory board, you can use other HIMEM features. 

Use HIMEM if your computer is 80286-based. Also use HIMEM if 
you are using a pre-386 machine that has any of the following: 

+ A chip set such as Chips and Technologies NeAT* or NeATsx*, 
LeAPSet* or LeAPSetsx*, and SCAT* 

+ An EMS or EEMS expanded memory board and driver 

+ Permanent upper RAM 

If you are using a machine with one of the chip sets mentioned above, HIMEM 
can only initialize upper memory if you have enabled Shadow RAM and if 
Shadow RAM is available. Your machine's hardware setup program, which is 
normally invoked by a special keyboard sequence during reset, enables Shadow 
RAM. However, the setup program usually allows you to move ROM into RAM 
as well; ensure that you leave Shadow RAM available for HIMEM. Otherwise, the 
only HIMEM feature you will be able to use is the relocation of the operating 
system software to high memory. 

HIMEM is loaded and configured by a DEVICE statement in the 
CONFIG.SYS file. This statement is automatically placed in 
CONFIG.SYS when you choose to load the 80286 memory manager 
during SETUP (or INSTALL). The configuration of HIMEM depends 
on the values you set in SETUP and on changes you make yourself 
to CONFIG.SYS. 
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Option 

The full syntax of the HIMEM DEVICE statement is as follows: 

DEVICE = C:\NWDOS\HIMEM.SYS 
[/CHIPSET=AUTOjchipsetjNONE] 
[/EXCLUDE=start-end[,start-end] ... ] 
[/INCLUDE=start-end[,start-end] ... ] 
[/ROM=start-end[,start-end] ... IAUTOjNONE] 
[/USE=start-end] [/VIDEO[=[start-]end]] [/XBDA] 

The following table describes the HIMEM options. For information 
about specifying these options, either through SETUP or by editing 
CONFIG.SYS yourself, see "Making More Memory 
Available" on page 10-10. 

Description 

/CHIPSET =AUTOI chipsetlNONE Specifies the chip set type of your computer. You may need to 
specify this information if the memory manager has difficulty 
mapping Shadow RAM into upper memory. AUTO (the 
default) allows the memory manager to determine the chip 
set or memory type automatically and NONE disables 
mapping of Shadow RAM. For a complete list of the values 
you can specify for chipset, see "Specifying the Chip Set or 
Memory Type (HIMEM Only)" on page 10-19. 

/EXCLUDE=start-end[,start-end] ... 

/INCLUDE=start-end[,start-end] ... 

/ROM=start-end I AUTO I NONE 

/USE=start-end 

Forces the memory manager to exclude the specified areas of 
upper memory when it searches for usable memory; start and 
end are the starting and ending segment addresses of each 
area to exclude. 

Tells the memory manager to test the specified areas of upper 
memory when it searches for usable memory; start and end 
are the starting and ending segment addresses of each area to 
include. 

Copies slow Read-Only Memory (ROM) into fast Random 
Access Memory (RAM); start and end specify the starting and 
ending segment addresses of an area of ROM to copy, AUTO 
copies all slow ROM to RAM, and NONE disables copying. 

Forces the memory manager to use a specified area of upper 
memory when it searches for usable memory; start and end 
are the starting and ending segment addresses of the area to 
use. 
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Option 

/VIDEO[=[start-]end] 

/XBDA 

EMMXMA 

Option 

/FRAME=address 

/KB=nnnn 

Description continued 

Makes unused video memory space available to applications 
when all the video memory is not being used by the video 
display adapter. Video memory (the upper memory 
immediately above 640 KB) is normally reserved for use by the 
video display adapter. 

Keeps the extended BIOS data area (XBDA) at the top of 
conventional memory, for applications that require it to be 
there. If you enable sharing of video memory (/VIDEO), the 
memory manager automatically moves the XBDA to the 
bottom of conventional memory to allow contiguous 
memory. 

EMMXMA is a memory manager that provides EMS (expanded) 
memory for applications that can take advantage of it. 

EMMXMA converts extended memory on XMA-compatible 
memory cards to expanded memory, which is mapped to a 64 KB 
window in upper memory. 

To load and configure EMMXMA, add a DEVICE statement to the 
CONFIG.SYS file as follows: 

DEVICE = C:\NWDOS\EMMXMA.SYS 
[/FRAME=address] [/KB=nnnn] 

The following table describes the EMMXMA options: 

Description 

Specifies the hexadecimal address for the start of the 64 KB mapping 
window. If you do not specify this option, EMMXMA automatically 
searches upper memory between COOOH and DFFFH for a free 64 KB 
window. 

Specifies the total amount of extended memory to be allocated for EMS 
(expanded memory). If you do not specify this option, all available 
memory is used for EMS. 
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Making More Memory Available 

Most programs require conventional memory; when a program fails 
to run, it is often because there is insufficient conventional memory 
available for it. You can make more conventional memory available 
for applications by minimizing the amount of conventional 
memory used by the operating system, device drivers, and other 
memory-resident programs. You can maximize the amount of 
available conventional memory in the following ways, all of which 
are described in detail in this chapter: 

+ Use the SETUP program to load and configure the memory 
manager (EMM386 or HIMEM), load DOS Protected Mode 
Services (DPMS), and run DOS in the High Memory Area (HMA). 

+ Use commands at the system prompt or in a batch file to load 
and execute programs in upper memory (HILOAD or 
LOADHIGH) and control lower, upper, and video memory areas 
(MEMMAX). 

+ Edit CONFIG.SYS manually to enable advanced memory 
manager options, run programs in upper memory (HIINSTALL/ 
INSTALLHIGH), and load device drivers into upper memory 
(HIDEVICE/DEVICEHIGH). 

Optimizing Memory Using SETUP 

SETUP is a program that allows you to make changes to the system 
configuration. Refer to Chapter 9, "Configuring the System" for 
information about how to start the program. The following sections 
describe how to use the memory management portions of SETUP. 

Loading and Configuring the Memory Manager 

Before you can take advantage of extended, expanded, or upper 
memory, you must load a memory manager that enables these 
memory types. To load the memory manager, run SETUP, choose 
DOS System and Memory Management, choose Memory Manager, and 
then choose to load either the 386 (and later) memory manager 
(EMM386) or the 80286 memory manager (HIMEM), depending on 
your hardware. 
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After you choose to load a memory manager and exit SETUP, the 
CONFIG.SYS file is automatically updated with a DEVICE statement 
that loads the memory manager. The next time you boot your 
machine, the memory manager is automatically loaded and 
configured as specified in the DEVICE statement. 

The options available for the memory managers are described in 
"Novell DOS 7 Memory Managers" on page 10-4. You can set many 
of these values in SETUP; the following sections describe how to do 
this. 

Copying Slow ROM into Fast RAM (EMM386 and HIMEM) 

The EMM386 and HIMEM memory managers can automatically 
copy data from read-only memory (ROM), which often executes 
slowly, to Random Access Memory (RAM), which executes much 
faster. EMM386 and HIMEM ensure that the RAM to which they 
copy ROM has the same address. Copying ROM to RAM is 
particularly useful when you have a video card that calls ROM to 
output characters, for example; character output will be faster. 

To specify the ROM option in SETUP, choose to load either EMM386 
or HIMEM, choose to configure the memory manager, and then 
choose to copy ROM to RAM. 

If you want to specify particular memory areas from which to copy 
ROM, choose <Advanced Options screen>. You will see a memory 
table that can help you specify areas of memory. See "Advanced 
Memory Options" on page 10-13 for more information. 

Providing LIM 4.0 EMS Support (EMM386 Only) 

EMM386 can use extended memory to emulate an expanded 
memory driver, for applications that use LIM EMS 4.0 (expanded) 
memory. This means that expanded memory is available without a 
special add-on memory board. 

To provide expanded memory support, enable the EMM386 FRAME 
option by running SETUP, choosing to configure EMM386, and 
then selecting LIM 4.0 EMS support. 
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If you want to specify the location in memory for the LIM EMS page 
frame, choose <Advanced Options screen>. You will see a memory 
table that can help you specify a location. See "Advanced Memory 
Options" on page 10-13 for more information. 

Supporting MS Windows 3.0 in Standard Mode (EMM386 Only) 

If you are using MS Windows 3.0 in Standard (80286) mode, the 
program will not normally run under EMM386. EMM386 can 
support MS Windows 3.0 in Standard mode, however, if you choose 
to enable the WINSTD option, to disable upper memory. Do this by 
running SETUP, choosing to configure EMM386, and then selecting 
support for MS Windows 3.0 in Standard mode. 

Using Spare Video Memory Space for RAM (EMM386 and HIMEM) 

Note,.f' 

The video memory on your computer immediately above 640 KB is 
used by EGA/VGA video display adapters for displaying high 
resolution graphics. If high resolution graphics are not required, 
however, EMM386 and HIMEM can make the spare memory 
available for applications. This can provide up to 96 KB of 
additional memory, depending on the kind of video display adapter 
you have: 64 KB if you have an MDA, Hercules*, or EGA/VGA 
(monochrome) adapter and 96 KB if you have a CGA or EGA/VGA 
(color) adapter. 

To make spare video memory available, run SETUP, choose to 
configure EMM386 or HIMEM, and select to use spare video 
memory space for RAM. If you specify this option, the default is to 
use all spare video memory space, beginning at segment address 
AOOO. You can specify an ending segment address for the memory, 
but only by editing CONFIG.SYS yourself; refer to for the table of 
EMM386 options in "Novell DOS 7 Memory Managers" on page 
10-4 for the VIDEO option syntax. 

If you have an EGA or VGA video display adapter, /VIDEO only reserves video 
memory. Before it can be made available, you must also run MEMMAX +V to 
enable the use of video memory. If you want to use graphics, you must return 
the video memory to the video display adapter by running MEMMAX -V. 
MEMMAX +V and MEMMAX -V can be run at the system prompt or in 
AUTOEXEC.BAT. See "Enabling and Disabling Lower, Upper, and Video 
Memory" on page 10-16 for more information about the MEMMAX command. 
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Loading DPMI (EMM386 Only) 

You can load the DOS Protected Mode Interface (DPMI) if you are 
using programs that require it. 

To load DPMI, run SETUP, choose to configure EMM386, and then 
choose to load DPMI. When you exit SETUP, the DPMI option is 
automatically added in CONFIG.SYS and when you next boot the 
machine, this change takes effect. 

To temporarily enable or disable DPMI, you can use the following 
command at the system prompt: 

DPMI=ONjOFF 

Reserving Extended Memory for non-XMS/LIM Applications (EMM386 Only) 

EMM386 can reserve a certain amount of extended memory for 
applications that cannot use XMS or LIM 4.0 EMS (expanded) 
memory. 

To specify the amount of reserved memory in SETUP, choose to 
configure EMM386 and then enter the amount. This will 
automatically set the INTlS option and the change will take effect 
the next time you boot the machine. 

Advanced Memory Options 

If you choose <Advanced Options screen> when configuring 
EMM386 or HIMEM in SETUP, you see a table which indicates how 
memory is currently being used. You can set the following options 
for EMM386 or HIMEM on this screen: 

+ Specific areas of ROM to copy to RAM (ROM option). Specify the 
starting and ending addresses of each memory area. You can 
also specify AUTO (which copies all slow ROM to RAM) or 
NONE (to disable copying of ROM). If you do not specify this 
option, NONE is the default. 
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+ Memory areas that should be tested by the memory manager 
when it searches for usable memory (INCLUDE option). Use this 
option when you know about an area of memory that you 
suspect is available but which normal scanning by the memory 
manager would define as not available. Specify the starting and 
ending addresses of each memory area; the default, if you do 
not specify this option, is to let EMM386 or HIMEM determine 
which memory areas are available. 

+ Memory areas to exclude when the memory manager searches 
for usable memory (EXCLUDE option). Specify the starting and 
ending addresses of each memory area that you do not want the 
memory manager to use; the default, if you do not specify this 
option, is to let EMM386 or HIMEM determine which memory 
areas are available. 

You can also set the following option, if you are using EMM386: 

+ Location of the LIM 4.0 EMS page frame (FRAME option). This 
is where EMM386 will establish a 64 KB window in upper 
memory, as long as 64 KB of contiguous memory is available at 
that address. You can specify an address or you can specify 
NONE (to disable expanded memory emulation) or AUTO (to 
let the memory manager search between addresses COOOH and 
FFFFH and find its own location for the window). If you do not 
specify this option, the default is AUTO. 

Running DOS in High or Upper Memory 

If you do not have extended memory, the operating system 
software is loaded in the lowest part of conventional memory 
(DOS=LOW). 

If your computer has extended memory, however, you can make 
more conventional memory available to your applications by 
running the DOS software in the High Memory Area (HMA) and in 
upper memory (when the HMA is not available). DOS=HIGH,UMB 
is the default for the operating system when extended memory is 
available. In order for high or upper memory to be enabled, a 
memory manager (EMM386 or HIMEM) must be loaded first. Refer 
to "Loading and Configuring the Memory Manager" on page 10-10 
for information about memory managers. 
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Note~f' 

You can also force the operating system software to use the HMA or 
upper memory exclusively (DOS=HIGH or DOS=UMB). 

To change the default location of the operating system, run SETUP, 
choose DOS System and Memory Management, and then choose 
Memory Manager. You can specify Conventional Memory, Upper 
Memory, or High Memory. SETUP automatically updates the DOS 
command in CONFIG.SYS and the next time you boot your 
machine, the new DOS setting takes effect. 

When you choose High Memory, DOS=HIGH,UMB is added in CONFIG.SYS. To 
specify high memory only edit the CONFIG.SYS file manually. 

Loading DPMS Software 

Load the DOS Protected Mode Services (DPMS) driver (DPMS.EXE) 
when you are using Stacker* disk compression, the NWCACHE 
program, DELWATCH, or the Personal NetWare server 
(SERVER.EXE), all of which use DPMS to reduce the amount of space 
they occupy in conventional memory. DPMS allows these programs 
to run in protected mode, outside of conventional memory. Load 
the DPMS software by running SETUP, choosing DOS System and 
Memory Management, choosing Memory Manager, and then choosing 
to load DPMS. You must have a memory manager (EMM386 or 
HIMEM) loaded before DPMS can load. 

Optimizing Memory at the System Prompt 

The following sections describe the commands you can use at the 
system prompt to optimize memory, assuming that upper memory 
is made available by a memory manager (EMM386 or HIMEM). 

Running a Program in Upper Memory 

You can load and execute a specified program in upper memory, 
rather than conventional memory, by using the HILOAD or 
LOAD HIGH command at the system prompt. This command can be 
abbreviated to LH. The full syntax of the command is as follows: 

HILOADILOADHIGHILH [/?l/H] filespec 
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Note~~ 

If you specify/? or /H, you see online help about the HILOAD/ 
LOADHIGH command. 

You must specify the filespec of the program you want to load high. 
This program will load and execute in upper memory, as long as 
upper memory is enabled by a memory manager (EMM386 or 
HIMEM) and is available. 

You cannot use HILOAD/LOADHIGH if you are using a third-party memory 
manager because third-party memory managers use different methods of 
mapping upper memory from EMM386 or HIMEM. Third-party memory 
managers usually provide their own utilities to load programs into upper 
memory. 

The program will remain in upper memory until the next time you 
start the operating system. 

If you want to load a program high every time you start the 
operating system, place the HILOAD or LOADHIGH command in 
AUTOEXEC.BAT rather than running it every time at the system 
prompt. 

It is recommended that you load the following programs high if you 
want to use them: CURSOR.EXE, GRAPHICS.COM, 
GRAFrABL.COM, and JOIN.EXE. The following programs, however, 
will attempt to load themselves high by default, so there is no need 
to load them high yourself: KEYE.COM, NLSFUNC.EXE, and 
SHARE.EXE. 

Enabling and Disabling Lower, Upper, and Video Memory 

You can control lower, upper, and video memory at the system 
prompt, when required, by using the MEMMAX command. 
MEMMAX allows you to temporarily enable and disable memory 
areas. Some applications may not work properly when certain 
memory types are enabled or disabled. 

The full syntax of the MEMMAX command is as follows: 

MEMMAX [ I? I /H] [ - I +L] [ /L] [ - I +u] [ /u] [ - I +v] [ /v] 

If you specify /? or /H, you see online help about the MEMMAX 
command. 
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When you load the DOS software into high or upper memory, the 
lower (conventional) memory normally used by DOS is made 
available to applications. Some applications, however, will not work 
correctly in lower memory and may require lower memory to be 
disabled. Use MEMMAX -L to disable lower memory and MEMMAX 
+L to re-enable it. Use MEMMAX /L to display the current status of 
lower memory. 

Because some applications are sensitive to upper memory, it is 
disabled by default when you start the operating system. Unless you 
are using HILO AD or LOADHIGH (which automatically enables and 
then disables upper memory), you may need to enable upper 
memory yourself in order to load device drivers and programs high. 
Use MEMMAX +U to enable upper memory and MEMMAX -U to 
disable it again. Use MEMMAX /U to display the current status of 
upper memory. 

When you are using an EGA or VGA video display adapter, and you 
reserved video memory space by configuring the memory manager, 
you will need to enable the video memory with MEMMAX + V 
before it can be used by applications. To disable the use of video 
memory, use MEMMAX-V. Use MEMMAX IV to display the current 
status of video memory. 

If you want a MEMMAX command to take effect every time you 
start the operating system, place it in AUTOEXEC.BAT rather than 
running it every time at the system prompt. 

Switching EMM386 Between Protected Mode and Real Mode 

The EMM386 memory manager is enabled automatically when it is 
required, providing extended memory according to the way in 
which it is configured in CONFIG.SYS. Some applications require 
the computer to be running in real mode, rather than protected or 
virtual 8086 mode, when they load. You can temporarily place the 
computer into real mode at the system prompt by disabling 
EMM386. Use EMM386 at the system prompt as follows: 

EMM386 [[/]AUTOjOFFjON] 
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Note~f' 

EMM386 OFF puts the computer in real mode, EMM386 ON puts it 
back in protected/virtual 8086 mode, and EMM386 AUTO (the 
default) lets the memory manager turn itself off if possible but stays 
on when required. 

You may not be able to turn EMM386 off at the system prompt if the memory 
manager is providing upper memory or some other feature that requires 
protected mode. If this is the case, you must add the OFF option to the 
EMM386 DEVICE statement in CONFIG.SYS yourself by editing the file. 

EMM386 Weitek Coprocessor Support 

You can enable or disable DOS access to the Weitek coprocessor, if 
fitted on your machine, at the system prompt. Use EMM386 as 
follows: 

EMM386 [/]WEITEK=[ONIOFF] 

Optimizing Memory by Editing CONFIG.SYS 

The following sections describe ways in which you can edit 
CONFIG.SYS to optimize memory usage. 

If you are editing CONFIG.SYS yourself, ensure that the EMM386 or 
HIMEM memory manager is loaded before any other device driver 
that uses extended, high, upper, or expanded memory. 

Advanced Memory Manager Options 

There are certain EMM386 and HIMEM options that you can only 
enable by editing the DEVICE statement in CONFIG.SYS yourself. 
These options are described in the following sections. 
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Specifying the Chip Set or Memory Type (HIMEM Only) 

Value 

AM286ZX 

EM SALL 

EM SU MB 

HEDAKA 

NEAT 

RAM 

SCAT 

HIMEM automatically detects the type of chip set on your computer 
(or EMS or permanent upper RAM). If the chip set or memory type 
is supported, HIMEM maps Shadow RAM into upper memory 
accordingly. You can use the CHIPSET option, however, when you 
experience difficulty mapping Shadow RAM or if you want to 
prevent mapping. Add the following to the DEVICE statement that 
loads HIMEM in CONFIG.SYS: 

[/]CHIPSET=AUTOlchipsetlNONE 

AUTO (the default) allows HIMEM to determine the chip set or 
memory type automatically. NONE disables mapping of Shadow 
RAM. 

You can specify any of the following as chipset: 

Explanation 

For Advanced Micro Devices Am286ZX/LX chip set. 

For all EMS upper memory, including the page frame. This option disables 
use of EMS by all other programs. 

For EMS 4.0 or EEMS upper memory blocks. An EMS 4.0 or EEMS memory 
manager must also be loaded before HIMEM. 

For Ever-Success HEDAKA 060 chipset. 

For Chips and Technologies NeAT, NeATsx, LeAPSet, or LeAPSetsx chip set. 

For permanent upper RAM. You must also use the /USE option to define 
the location of the RAM to HIMEM; see "Making an Area of Upper 
Memory Available (EMM386 and HIMEM)" on page 10-21. 

For Chips and Technologies SCAT chip set. 
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Controlling Support for COMPAQ Computers (EMM386 Only) 

If you are using a COMPAQ 386 (or later) computer with at least 
1 MB of memory, EMM386 automatically enables support to 
provide an additional 256 KB of extended memory. If you 
experience problems and want to disable this support, however, add 
the following option to the EMM386 DEVICE statement in 
CONFIG.SYS: 

[/]COMPAQ=OFF 

Setting the Machine Type for GATEA20 (EMM386 Only) 

Normally, EMM386 automatically detects your machine type and 
controls address line A20 accordingly. If necessary, however, you 
can specify this information by adding the following option to the 
EMM386 DEVICE statement in CONFIG.SYS: 

[/]GATEA20=type 

You can specify any of the following as type: 

Value Explanation 

AT Standard AT or compatible. 

HP Hewlett-Packard Vectra. 

MCA Any machine with Micro Channel* Architecture (MCA), or a machine that 
is compatible with MCA in its method of switching gate A20. Many IBM* 
PS/2 machines are of this type. 

XMS Any machine with a third-party XMS driver loaded before EMM386 which 
provides gate A20 switching via the XMS interface. 
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Making an Area of Upper Memory Available (EMM386 and HIMEM) 

Note~f' 

You can make specific areas of upper memory available even if the 
memory manager would normally define them as not usable. Do 
this by adding the following option to the EMM386 or HIMEM 
DEVICE statement in CONFIG.SYS, where start is the hexadecimal 
starting segment address of each memory area and end is the 
hexadecimal ending segment address: 

[/]USE=start-end[,start-end] ... ] 

Because USE can map RAM over any hardware or ROM present in the specified 
memory area, you should not use it unless you are very experienced in 
allocating upper memory. Also, use conditional statements when you 
experiment with USE in CONFIG.SYS or have a bootable diskette available 
containing copies of your original CON FIG.SYS and AUTOEXEC.BAT files, in 
case you encounter problems. 

Specifying Location of the VxD to MS Windows (EMM386 Only) 

For MS Windows 3.0 or later in Enhanced mode, you can specify the 
location of the EMM386 VxD. The default location is the location 
from which EMM386 is loaded. If you need to specify a different 
location, add the following option to the EMM386 DEVICE 
statement in CONFIG.SYS, where path is the VxD location: 

[/]VXD=path 

Preventing Relocation of the Extended BIOS Data Area (EMM386 and HIMEM) 

When you enable the use of spare video memory by applications, 
the memory manager moves the extended BIOS data area to the 
bottom of conventional memory. This is because its presence at the 
top of conventional memory would prevent that being contiguous 
with video memory. Certain applications, however, are sensitive to 
relocation of the extended BIOS data area. To prevent relocation, 
add the following option to the EMM386 or HIMEM DEVICE 
statement in CONFIG.SYS: 

[/]XBDA 
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Running a Program in Upper Memory 

You can load and execute a specified program in upper memory, 
rather than conventional memory, by using the HIINSTALL or 
INSTALLHIGH command in CONFIG.SYS. HIINSTALL or 
INSTALLHIGH performs the same function as HILOAD or 
LOADHIGH except that it is processed as part of CONFIG .SYS rather 
than at the system prompt or in a batch file (such as 
AUTO EXEC.BAT). 

The full syntax of the command is as follows: 

HIINSTALLIINSTALLHIGH=filespec [options] 

You must specify the full filespec of the program you want to load 
high. You can also specify any parameters (options) that you want to 
pass to the program. 

This program will load and execute in upper memory every time 
you start the operating system, as long as upper memory is enabled 
by a memory manager (EMM386 or HIMEM) and is available. Before 
attempting to load a program into upper memory, you can check to 
make sure that there is enough upper memory available by running 
the MEM command; refer to the "Command Reference" chapter of 
DOSBook for information about MEM and its options. 

Loading Device Drivers in Upper Memory 

You can load an installable device driver into upper memory by 
replacing the DEVICE command in CONFIG.SYS with a HIDEVICE 
or DEVICEHIGH command. 

The full syntax of the HIDEVICE or DEVICEHIGH command is as 
follows: 

HIDEVICEIDEVICEHIGH [SIZE=nnnn] filespec 

You must specify the name of the device driver (filespec) that you 
want to load high. 
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If you want to load a device driver that is unable to determine the 
amount of memory that it will ultimately need, you can also specify 
the amount of upper memory required for the driver (SIZE=nnnn). 
To determine this amount, load the driver into conventional 
memory and then run the MEM command to see how much 
memory the driver uses. Refer to the "Command Reference" chapter 
of DOSBook for information about MEM and its options. 

Additional Tips for Managing Memory 

Because Novell DOS 7 is designed to work on any IBM-compatible 
personal computer and with any software application, there is no 
single memory configuration that is ideal for all situations. You may 
need to experiment before memory usage is optimized for your 
particular software and hardware. 

Consider the following issues when you are experimenting with 
memory. 

Disabling Expanded Memory 

Load Order 

When you are using applications that do not require expanded 
memory, make sure that you disable expanded memory emulation 
when configuring EMM386 so that the page frame in upper 
memory is not defined. This saves 64 KB of memory. See "Providing 
LIM 4.0 EMS Support (EMM386 Only)" on page 10-11 for 
information about how to do this. If you are using HIMEM, use the 
CHIPSET =EM SALL option; see "Specifying the Chip Set or Memory 
Type (HIMEM Only)" on page 10-19 for more information. 

Load the device drivers and TSRs that occupy the most memory 
first. The documentation for a device driver or TSR may indicate the 
amount of RAM it requires. If not, however, you can load the driver 
or program into conventional memory and then use the MEM 
command to determine how much memory it uses. Refer to the 
"Command Reference" chapter of DOSBook for a detailed 
description of the MEM command and its options. 
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Add-on Cards 

There are some exceptions to loading the largest device drivers and 
TSRs first; some programs need to be loaded in a particular order. 
Always read the documentation carefully before you install a device 
driver or TSR. 

Some device drivers and TSRs temporarily require more memory 
when loading or "initializing" than they occupy afterwards. In 
these cases, the loading order may need to be changed to fit the 
program into upper memory. If a device driver or TSR does not find 
the required upper memory, it will automatically be placed in 
conventional memory. MEM can display the location of each 
program loaded in conventional and upper memory. Refer to the 
"Command Reference" chapter of DOSBook for a description of 
MEM. 

If your computer has add-on cards that use RAM addresses, 
configure the cards so that the memory addresses used are close 
together and near the bottom or the top of upper memory. Address 
a network board, for example, immediately above the video 
memory area instead of somewhere in the middle of upper memory. 
Consult the documentation for the card for more information. 
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chapter 11 
Improving Disk Performance 

This chapter describes two programs that you can use to make the 
best use of your hard disk or diskette drive. 

+ DISKOPT "optimizes" disk performance by re-arranging data on 
the disk. 

+ NWCACHE makes your system run faster by caching data to 
reduce the amount of time your computer spends waiting for it. 

Optimizing a Disk 

DISKOPT is a "disk optimizer" that will improve the performance of 
a disk by doing the following every time you run it: 

+ Defragment files. 

As programs read and write to the disk, files on the disk can 
become broken into multiple pieces of data that are stored in 
different locations. This is referred to as file fragmentation. It 
takes much longer for the system to read and write fragmented 
files than it does to read and write unfragmented files. 

+ Defragment free space. 

The areas of free space between files are made contiguous and 
moved to the end of the disk. 

Optionally, DISKOPT can also do the following: 

+ Change the location of files within the same directory so that 
they are physically adjacent 

+ Sort directories on the disk according to a specified criterion 
such as size or name 
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Before Running DISKOPT 

Starting DISKOPT 

Before you run DISKOPT, be aware that it can take some time, 
depending on the amount of data and degree of file fragmention on 
the disk. The more often DISKOPT is run, however, the shorter the 
time each DISKOPT operation will take. 

You can stop disk optimization at any time by pressing the <Esc> key 
but do not attempt to reboot the system or switch off the computer 
while DISKOPT is still running. 

Also, take the following precautions before starting DISKOPT: 

+ Back up the data on the disk. If you need information about 
how to back up data, refer to the explanation of the FBX 
command in the "Command Reference" chapter of DOSBook. 

+ Ensure that no other program will use the hard disk while 
optimization is in progress. This is especially important to 
remember if your machine is a Personal Net Ware server or if you 
are using the Task Manager or TSRs, for example, or the 
NWCACHE disk cache. 

+ Be aware that DISKOPT ignores system files; you can only 
include a system file in optimization by changing the file 
attribute. Refer to the explanation of the ATTRIB command in 
the "Command Reference" chapter of DOSBook for information 
about changing file attributes. 

There are two ways of using DISKOPT: interactively using the 
DISKOPT screen and menus or by using a command line. Either 
way, you start the program by entering the DISKOPT command at 
the system prompt. 
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Using DISKOPT Menus 

Note~f' 

Type the following at the system prompt: 

DISKOPT <Enter> 

Optionally, you can also specify the letter of the drive you want to 
optimize. If you do not, however, DISKOPT will provide you with a 
list of drives from which to choose. 

The DISKOPT screen consists of four elements: a title bar, the 
optimization "methods," the legend describing the symbols used in 
the graphical representation of data on the disk, and the graphical 
representation itself. 

+ The title bar contains the names of four pull-down menus: 
Optimize, Method, Sort, and Help. 

+ The optimization methods indicate how much DISK OPT will do 
to the disk. You can change the optimization methods using the 
menus. 

The default methods are displayed unless you specified different methods 
in the command line; see "Using the DISKOPT Command 
Line" on page 11-6. 

+ The rest of the screen illustrates how much space on the disk is 
currently allocated. Read the legend at the bottom of the screen 
to identify the various symbols that represent blocks of data in 
the picture of the disk. Once you start to optimize the disk, the 
picture will change to indicate how data is being read and then 
rewritten by DISKOPT. 

Open a pull-down menu by clicking on it with your mouse or by 
pressing the <Alt> key along with the highlighted letter in the menu 
name. 

Once a menu is open, you can move between the four menus using 
the <left-cursor> and <right-cursor> keys. 

Close a menu by either selecting an option, pressing <Esc>, or 
clicking on it twice with your mouse. 
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Select any of the options in an open menu by clicking on them with 
the mouse or by moving the selection bar with the cursor keys and 
pressing <Enter>. You can also select an option by typing the 
highlighted letter in the option name. For example, to sort by date, 
press <Alt> S to open the Sort menu and then D to select the Date 
option. 

Changing the Optimization Method 

Menu Option 

Full Optimization 

Full Optimization 
with File Reorder 

File Defragment Only 

Free Space 
Defragment Only 

Sort Directories Only 

Full Optimization 
with Restack 

You can change the current optimization method (the method 
displayed on the screen) by using the Method menu. The options 
on this menu are as follows: 

Explanation 

Defragments files and free space. No directory sorting is always the 
default. 

Defragments files and free space on the disk and moves files within the 
same directory so that they are physically adjacent. This method is slower 
than Full Optimization only. 

Defragments files but not free space. This method is very fast but leaves 
gaps of free space between files. 

Defragments free space without defragmenting files. 

Sorts directories only; files and free space are not defragmented. Use the 
Sort menu to change the sort criteria (alphabetically by name is the 
default). 

Defragments the disk and recompresses data. Use this option on Stacker* 
drives which have been converted from DoubleSpace and SuperStor* 
drives. 
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Sorting Directories 

Menu Option 

Name 

Extension 

Date 

Size 

No sort 

Starting Optimization 

Menu Option 

Change drive <Alt> D 

Optimize disk 

Exit <Alt> X 

If you chose an optimization method that includes directory 
sorting, you can specify the criteria for sorting by using the Sort 
menu. The options on this menu are as follows: 

Explanation 

Sorts directory entries alphabetically by name. This is the default. 

Sorts directory entries alphabetically by file extension. 

Sorts directory entries by date, from oldest to most recent. 

Sorts directory entries by size, from smallest to largest. 

Leaves directory entries unsorted. 

Start optimization, choose another disk drive, or cancel DISK OPT by 
using the Optimize menu. The options on this menu are as follows: 

Explanation 

Allows you to specify a different disk drive. 

Starts disk optimization for the selected disk drive. You see a message 
indicating that DISKOPT is analyzing the disk. The screen reflects data 
movement while optimization is in progress. You see another message 
when optimization is finished. 

Cancels DISKOPT and returns you to the system prompt. 

You can interrupt optimization by pressing <Esc> and you can exit 
from the DISKOPT screen at any time by pressing <Alt> X. Do not, 
however, attempt to reboot the system or switch off the computer 
while DISKOPT is still running. 
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Using the DISKOPT Command Line 

Command Switches 

/?or /H 

/B 

/Mx 

/O 

/Sx 

To bypass the DISKOPT menu options, simply enter the DISKOPT 
command followed by the appropriate command switches. 

The full syntax of the DISKOPT command is as follows: 

DISKOPT [/?l/H] [d:] [/B] [/Mx] [/O] [/Sx] 

Displays help text. 

Specifies a monochrome (no color) DISKOPT screen. 

Specifies the optimization method, where x can be one of the following: 

Full Optimization 

2 Full Optimization with File Reorder 

3 File Defragment Only 

4 Free Space Defragment Only 

5 Sort Directories Only 

6 Full Optimization with Restack 

Starts optimization immediately. The optimization and sorting methods 
used depend on how you specified the /M and /S switches. The default 
method is automatically determined by DISKOPT; the default for/Sis to 
leave directories unsorted. 

Specifies the directory sort criteria, where x can be one of the following: 

a Sort alphabetically by name. 

e Sort alphabetically by file extension. 

d Sort chronologically by date. 

s Sort by file size, from smallest to largest. 

n Leave unsorted. 
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Caching Disk Data 

Because of the high degree of repetition built into DOS disk 
processing, caching disk data, which eliminates repetitive disk 
accesses, provides significant improvements in disk performance. A 
cache is an area in memory that keeps copies of the data read from 
and written to your hard disk and diskettes. When a disk read is 
requested, data that is already in the cache is delivered directly from 
the cache to your program. Because the data is already in memory, 
it can be delivered faster. When the cache is full, the least recently 
used data is discarded (or written to disk) to make space for newer 
data. 

In Novell DOS™?, disk caching is provided by NWCACHE, which 
includes the following features: 

+ Caches data on all types of compressed drives (Stacker, 
SuperStor, DoubleDisk) 

+ Shares memory with other applications automatically 

+ Reduces its resident memory requirements by using DPMS to 
load itself into extended memory, if available 

The following sections in this chapter explain how to use 
NWCACHE and all of its features. 

Memory Requirements 

Note~f" 

If DOS Protected Mode Services (DPMS) is loaded, NWCACHE will 
use it to load itself into extended memory. This means that the size 
of the resident NWCACHE code in conventional or upper memory 
can be kept down to maximize the memory available to your 
applications. For information about loading DPMS, refer to Chapter 
10, "Managing Memory." 

The cache Lookahead buffer cannot load into extended memory. For more 
information about memory and the Lookahead buffer, refer to "Using Upper 
Memory" on page 11-19. 
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Note,.~ 

The resident memory requirements for NWCACHE are as follows: 

Resident program: 5 KB (10 KB if DPMS 
is not used) 

Lookahead buffer: 4 to 16 KB 

Control tables OKB (1 KB plus 3 KB 
(for extended memory per megabyte of 
cache): cache if DPMS is 

not used) 

Control tables OKB 
(for expanded memory 
cache): 

If your system configuration requires double buffering of disk transfers, an 
additional 2 KB of resident conventional memory will be required by the 
DBLBUF.SYS driver. See "Configuration Issues" on page 11-18 for more 
information about double buffering. 

Various command options affect the placement and utilization of 
memory. See the next section, "Loading and Configuring 
NWCACHE" on page 11-9, for information about these command 
options. 

If your system CPU is an 80286 and has extended memory installed, 
you should load the HIMEM memory manager before adding 
NWCACHE to your system. Using HIMEM resolves compatibility 
issues that arise when different programs attempt to share extended 
memory. 

If your system CPU is a 386* or later, you should install the EMM386 
memory manager before adding NWCACHE to your system. 
EMM386 allows using upper memory for program loading, and will 
allow you to convert extended memory to EMS memory if needed. 

Refer to Chapter 10, "Managing Memory," for information about 
loading HIMEM or EMM386. 
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Loading and Configuring NWCACHE 

Table 11-1 

The NWCACHE start-up command and its options determine the 
size of the cache and the type of memory it will use, which drives 
will be cached, where the cache program will be loaded, the 
Lookahead buffer size and location, and initial operational settings 
for the cache. 

When NWCACHE loads into memory, it automatically caches all 
available disk drives; refer to "Selecting Drives to Cache" on page 
11-13 for information about including or excluding specific drives. 

The full syntax of the NWCACHE start-up command is as follows: 

NWCACHE [/?I /H] [d[:] Id[: ]+Id[:]-] [maxsizelminsize] 
[/A20] [[/BEl/BLl/BU][=size]] [/CHECK] 
[/DELAY=ONIOFFltime] [/E] [/L] [/LEND=ONIOFF] 
[/MU[X] I [/ML[X]] [/W=size] [/X[=address]] 

You can use the start-up command at the system prompt to load and 
configure NWCACHE. To load the cache automatically every time 
you start the operating system, however, use the SETUP program or 
edit the start-up command line in AUTOEXEC.BAT. Refer to "Using 
SETUP to Load NWCACHE" on page 11-11 for more information. 

NWCACHE Start-up Options 

Options 

/?or /H 

d[:]+ 

d[:]-

d[:] 

max size 

Displays start-up help. 

Forces caching of drive d with delayed write mode enabled. Refer to 
"NWCACHE Write Modes" on page 11-14 for information about write 
modes. 

Excludes DOS drive letter d from caching. Note that you cannot use an 
NWCACHE control option to re-enable caching for a drive disabled at 
start-up. 

Forces caching of drive d as a write-through drive. 

Specifies the maximum size of the cache. By default, NWCACHE uses all 
available expanded or extended memory up to 7670 KB (the maximum 
size of the cache). 
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Table 11-1 continued 
NWCACHE Start-up Options 

Options 

minsize 

/A20 

/BE[=size] 

/BL[=size] 

/BU[=size] 

/CHECK 

/DELAY=OFF 

/DELAY=ON 

/DELAY=time 

/E 

/L 

/LEND=ON 
/LEND=OFF 

Specifies the minimum size of the cache. The default is based on the 
amount of available memory, as described in the section "Setting the 
Cache Size" on page 11-15. 

Suppresses enhanced A20 mode, if you are using the extended memory 
cache. This option degrades cache performance, and should be used only 
when required to resolve unusual compatibility problems. Also, you can 
only use it if an XMS memory manager is not loaded. 

Loads the Lookahead buffer into EMS memory and, optionally, specifies 
the buffer size (4 to 16 KB). The /BE option should be used with care, as 
some add-on memory boards are very slow and can reduce cache 
performance substantially. 

Loads the Lookahead buffer into conventional memory and, optionally, 
specifies the buffer size (4 to 16 KB). This is the default. See "Setting the 
Lookahead Buffer Size" on page 11-15 for more information about the 
Lookahead buffer. 

Loads the Lookahead buffer into upper memory and, optionally, specifies 
the buffer size (4 to 16 KB). 

Enables a cache memory diagnostic test when the cache is started. 

Disables write delay, and sets all drives to write-through mode. 

Enables write delay. The default is 5000 milliseconds. 

Specifies the write delay value in milliseconds (50 to 5000). When the 
write delay value is 50 or more, write requests may be accumulated in the 
cache before being written to the drive. 

Forces the use of EMS memory for the cache. 

Forces the use of conventional memory for the cache. 

Enables or disables sharing of cache memory with other programs which 
require XMS or EMS memory. When lending is enabled, NWCACHE 
monitors allocation requests for XMS and EMS memory, and automatically 
reduces the cache size to fulfil the request. When the requesting program 
releases the borrowed memory, it is returned to the cache. Refer to 
"Sharing Cache Memory" on page 11-16 for more information. 
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Table 11-1 continued 
NWCACHE Start-up Options 

Options 

/ML[X] 

/MU[X] 

/W=size 

/X[ =address] 

Loads NWCACHE into conventional memory. /ML overrides the default of 
using DPMS to load NWCACHE into extended memory; to load 
NWCACHE into conventional memory and into extended memory via 
DPMS, use the /MLX option. 

Loads NWCACHE into upper memory (memory addresses above 640 KB 
and below 1 MB), if available. /MU overrides the default of using DPMS to 
load NWCACHE into extended memory; to load NWCACHE into upper 
memory and into extended memory via DPMS, use the option /MUX. 

Do not use this option if you are using Maximize (386MAX*), Optimize 
(QEMM*), or a similar product to assign fixed upper memory addresses. 

Sets the delayed write data limit (0 to 7670 KB). This option limits the 
amount of delayed write data which can be accumulated in the cache. If 
the limit is set to 0, write requests for all drives are satisfied immediately. 
If the limit is set to a non-zero value n, no more than n KB of delayed write 
data will be held back before writing. If you do not set this option, the 
entire cache area may be used for write data. 

Forces the use of extended memory for the cache. If no memory manager 
is loaded, but the computer has extended memory, specify the location of 
the cache buffer in address (above 1 024 KB). You cannot specify the 
location if you have EMS memory. 

Using SETUP to Load NWCACHE 

You can load and configure NWCACHE using the SETUP program. 
Start SETUP, choose Disk Performance from the SETUP main menu, 
and then select the NWCACHE disk cache. The start-up command 
line will be added to AUTOEXEC.BATwhen you exit SETUP and the 
cache will load automatically the next time you reboot the system. 

If you load the cache using SETUP, you can also specify the 
following cache settings: 

+ Maximum and minimum sizes for the cache (maxsize and 
minsize) 

+ Enable or disable write delay (/DELAY=ONIOFF) 

Improving Disk Performance 11-11 



+ Enable or disable memory lending (/LEND=ONIOFF) 

All other cache settings will be set to the default values. To change 
these settings, edit the start-up command line in AUTOEXEC.BAT 
yourself. 

Refer to Chapter 9, "Configuring the System," for general 
information about the SETUP program and how to use it. 

Controlling NWCACHE 

Table 11-2 

The NWCACHE control command and its options allow you to 
display cache status, enable and disable caching, flush data from the 
cache, modify the cache program settings, and quit the cache. 

The full syntax of the NWCACHE control command is as follows: 

NWCACHE [ I ? I I H ] [ - I + ] [ d [ : ] I d [ : ] - I d [ : ] + ] 
[/DELAY=ON!OFFltime] [/Ql/U] [/S] [/SIZE=MINIMAX] 

Use the control command line at the system prompt after the cache 
is started. The next time you reboot the system or reload the cache 
after unloading it, however, the cache settings will return to the 
values set in the start-up command line. 

NW CACHE Control Options 

Options 

/?or /H 

+ 

d[:]+ 

11-12 

Displays cache control help text. 

Flushes and disables the cache. This option completes any pending 
delayed writes, clears all drive data from cache memory, and disables the 
cache. Disk reads and writes are subsequently performed without caching, 
although NWCACHE remains in memory. You can re-enable caching with 
the + option. 

Flushes and enables the cache. This option completes any pending 
.delayed writes, clears all drive data from cache memory, and resets the 
cache statistics to zero. If the cache was previously disabled with the -
option, caching is re-enabled. 

Re-enables caching of drive d. Write delay enabled. 
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Table 11-2 continued 
NW CACHE Control Options 

Options 

d[:]­

d[:] 

/DELAY=ON 

/DELAY= time 

/DELAY=OFF 

IQ or /U 

IS 

/SIZE=MIN 
/SIZE=MAX 

Excludes DOS drive letter d from caching. 

Identifies DOS drive letter d as a write-through drive. 

Enables write delay. The default delay is 5000 milliseconds. 

Specifies the write delay value in milliseconds (50 to 5000). When the 
write delay value is 50 or more, write requests for delayed write may be 
accumulated in the cache before being written to the drive. 

Sets all drives to write-through. This option completes any pending 
delayed writes and sets all cached drives to write-through mode. Write 
delay may subsequently be re-enabled, either for all the drives with the 
/DELAY=ON option, or for individual drives using the d+ control option. 

Quits the cache. This option completes any pending delayed writes, 
permanently releases all buffer, cache, and control table memory, and 
attempts to remove the cache program from memory. 

NWCACHE may be unable to remove the cache program if another 
program has rehooked the system interrupt vectors. In this case, you must 
first remove the other program(s) from memory and then repeat the 
control command with the Q option. 

Displays cache status. This option completes any pending delayed writes 
before displaying the cache status. 

Minimizes or maximizes cache size. This option completes any pending 
delayed writes, clears all drive data from cache memory, and either 
reduces cache memory to its minimum size or attempts to increase cache 
memory to its maximum start-up size. 

Selecting Drives to Cache 

NWCACHE automatically caches all fixed and removable disk 
drives. This includes any Stacker, SuperStor, or DoubleDisk 
compressed drives. RAM drives and remote network drives are 
excluded from caching as are CD-ROM or Bernoulli* drives and any 
other non-block devices. 
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You can use the d: and d:- start-up options to override NWCACHE's 
default selection of cached and non-cached drives. See "Loading 
and Configuring NWCACHE" on page 11-9 for more information. 

NWCACHE Write Modes 

Write-through Mode 

Delayed Write Mode 

NWCACHE supports three different protocols for writing data to 
the disk: write-through, buffered write, and delayed write. When 
you load and configure the cache during installation or SETUP, 
write-through mode is enabled for all drives, by default. 

In write-through mode, write request data is written to the drive 
immediately. NWCACHE uses write-through mode to access drives 
with non-standard formats, which may not operate reliably with 
delayed or buffered writes. You can use the d: and /DELAY=OFF 
start-up options to override default settings and enable or disable 
write-through mode for specific drives. See "Loading and 
Configuring NWCACHE" on page 11-9. You can also use the d:, d+, 
/DELAY=OFF and /DELA Y=ON control options to do the same 
things once the cache is loaded into memory; see "Using SETUP to 
Load NWCACHE" on page 11-11. 

NWCACHE can be configured to access fixed disks in delayed write 
mode, in which write requests are held in the cache for a few 
seconds before the data is written to the disk. NWCACHE uses the 
delay to eliminate duplicate sector writes and to combine multiple 
write requests into fewer and larger physical writes, reducing the 
number of disk accesses and the time required for writing. 

You can use the /DELAY=time option (start-up or control) to change 
the default write delay value. See "Loading and Configuring 
NWCACHE" on page 11-9 and "Using SETUP to Load NWCACHE" 
on page 11-11 for more information. 
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Buffered Write Mode 

Diskettes and other removable media drives are normally accessed 
in buffered write mode. Buffered write processing uses the 
Lookahead buffer to combine successive write requests into a single 
disk write for faster access. Buffered writes offer many of the benefits 
of delayed writes, while maintaining data integrity when the 
removable media is changed. 

Setting the Lookahead Buffer Size 

NWCACHE uses a special area of memory called the Lookahead 
buffer to consolidate multiple read and write requests into larger 
read or write commands, to minimize disk activity and increase 
system speed. 

Lookahead efficiency is a critical factor in system performance. If 
too few sectors are read in, sequential file access is slowed; if too 
many sectors are read in, random disk access is slowed. Lookahead 
continually monitors the pattern of disk activity to dynamically 
select the best Lookahead size for each disk transfer. 

NWCACHE normally allocates 16 KB of resident memory to the 
Lookahead buffer. You can, however, use the /BL, /BU, and /BE 
options to force the buffer to load into conventional, upper, or EMS 
memory. The buffer is loaded in conventional memory, by default. 
Refer to "Using Upper Memory" on page 11-19 for more 
information about memory and the Lookahead buffer. You can also 
set a different Lookahead buffer size by specifying size when you use 
the /BL, /BU, or /BE option. See "Loading and Configuring 
NWCACHE" on page 11-9 for more information. 

Setting the Cache Size 

The maximum and minimum size values for the cache are set when 
the cache is started. These values are determined by the amount of 
memory available and by the minimum and maximum sizes 
specified in the start-up command; see "Loading and Configuring 
NWCACHE" on page 11-9. You can also switch between the 
minimum and maximum cache size values after start-up by using 
the /SIZE=MIN and /SIZE=MAX control options; see "Using SETUP 
to Load NWCACHE" on page 11-11. 
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If a cache size specification is included in the start-up command, 
NWCACHE attempts to allocate a cache of that size. If no cache size 
is specified, or if the specified size cannot be allocated, NWCACHE 
will allocate as much memory as possible to the cache. The initial 
allocation size is assigned as the maximum cache size value. 

If a valid minimum cache size value is included in the start-up 
command, NWCACHE will set the minimum cache size to this 
value. If no minimum size is specified, NWCACHE establishes a 
minimum size based on the amount of available memory, as 
follows: 

Available Memory Minimum Size 

to 384 KB 0 KB 

to 512 KB 32 KB 

to 1 MB 64 KB 

to 2 MB 512 KB 

to4 MB 1024 KB 

to 6 MB 1536 KB 

6 MB+ 2048 KB 

Sharing Cache Memory 

NWCACHE's /LEND option allows automatic sharing of cache 
memory with other programs. With lending enabled, NWCACHE 
monitors other programs' requests for allocation of XMS and EMS 
memory, and reduces the cache size if needed to fulfil the request. 
When the requesting program releases the borrowed memory, 
NWCACHE automatically returns it to the cache. The cache size is 
kept between its established minimum and maximum sizes during 
lending. Lending is enabled by default when you install NW CACHE 
but you can also use the /LEND start-up option to disable it. 
See "Loading and Configuring NWCACHE" on page 11-9 for more 
information. 
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Displaying Cache Status 

Cache status is automatically displayed when the cache is loaded. 
You can also display cache status at any time after that by using the 
JS control command switch; see "Using SETUP to Load 
NWCACHE" on page 11-11 for more information. 

The top portion of the cache status display shows the current cache 
memory size and type, the minimum cache size, the current write 
mode for the cached drives, and the cache options currently in 
effect. 

If caching is disabled, the message Cache is inactive will be 
displayed. If Cache is inactive is followed by an error code, a 
serious problem exists. An error code of 99 indicates that some other 
program is writing data into NWCACHE's control tables. Any other 
error code indicates a problem with your system's memory manager. 

The disk usage statistics include the following information: 

+ The number of read requests DOS made, the number of physical 
disk reads that were actually performed, and the percentage of 
reads saved because the data was in the cache. The higher the 
percentage, the more benefit the cache is providing. 

+ The number of write requests that DOS made, the number of 
physical disk writes actually performed, and the percentage of 
disk writes saved. 

The error statistics include the following: 

+ The number of memory manager errors. These are totalled 
whenever an error is detected in the computer's extended or 
expanded memory system. 

+ The number of disk transfer errors. These are totalled whenever 
an error is reported from your disk. DOS normally performs up 
to 5 retries for each error before displaying an error prompt. The 
NWCACHE status display counts all errors, including errors 
corrected by DOS retries. A large number of disk errors may 
indicate a serious problem which could significantly degrade 
system performance. 
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+ The number of "ignore" error responses. Errors ignored by the 
user are totalled whenever a disk error is detected while 
performing a buffered or delayed write, and an ignore response 
is entered to the Retry or Ignore? prompt. Ignore responses 
may leave corrupted data on the disk. 

The cache disk usage statistics are cleared and reset to zero whenever 
the cache is enabled or disabled. Disk error statistics are cumulative, 
and are unaffected by enabling or disabling of the cache. 

Turning Off Power or Rebooting Your Machine 

If you wish to turn off your system, first issue a cache disable 
command to ensure that any pending delayed writes are completed 
before the power is turned off. 

The format of the cache disable command is as follows: 

NWCACHE -

If you reboot your computer while delayed writes are pending, 
NWCACHE will complete all pending delayed writes before 
resuming the reboot sequence. 

Configuration Issues 

Setting DOS Buffers 

When you choose to enable NWCACHE via SETUP, a NWCACHE 
start-up command is inserted in AUTOEXEC.BAT, according to the 
options you choose in SETUP. Some configuration issues, however, 
especially the use of upper memory and correct load order, may 
require you to manually edit CONFIG.SYS or AUTOEXEC.BAT. 

The NW CACHE Lookahead facility greatly reduces the need for DOS 
buffers. For best performance, you should use 10 or fewer DOS 
buffers. This means your CONFIG.SYS file should set BUFFERS to 10 
or less. 

11-18 Novell DOS 7 User Guide 



Using Upper Memory 

Double Buffering 

If you are using a 386 (or later) computer, you may have upper 
memory available. NWCACHE will load into this upper memory by 
default, making more conventional memory available for running 
programs. NWCACHE may, however, still place the cache program 
or control tables in conventional memory if you do not have 
enough upper memory to complete loading. See "Loading and 
Configuring NW CACHE" on page 11-9 for more information about 
the /ML[X] and /MU[X] options. 

The Lookahead buffer is loaded in conventional memory by default. 
You can use the /BU option, however, to load it in upper memory. 
If you experience problems when the Lookahead buffer is loaded in 
upper memory (when you are using certain SCSI systems, for 
example), try keeping the buffer in conventional memory or use 
double buffering (see the following section). 

Some SCSI disk systems do not operate normally in advanced CPU 
configurations and the system may "hang" when programs are 
loaded high. This may indicate a need for double buffering of disk 
transfers. The operating system includes a double buffering program 
named DBLBUF.SYS. You can enable double buffering by manually 
inserting the line below in your CONFIG.SYS file at or near the 
beginning of this file, before any lines which load memory or 
network device drivers: 

DEVICE=C:\NWDOS\DBLBUF.SYS 

DBLBUF.SYS must be loaded into conventional memory; do not 
attempt to load DBLBUF.SYS high. 
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Load Order 

Loading programs in the correct order will avoid compatibility 
problems. The programs listed below are grouped into two 
categories, depending on whether they must be loaded before or 
after NWCACHE. 

Load the following before NWCACHE: 

+ XMS managers (such as HIMEM.SYS) 

+ EMS and VCPI managers (such as EMM386) 

+ DOS extenders (such as DPMI and DPMS managers) 

+ Add-on disk drivers (such as DRIVER.SYS) 

+ Double buffering drivers (such as DBLBUF.SYS) 

Load the following after NWCACHE: 

+ Any DOS network (including Personal NetWare™) 

+ Multitasking programs (such as Task Manager) 

Other programs can be loaded before or after NWCACHE, as 
desired. 
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chapter 12 
Disk Compression 

The Stacker* program allows you to increase the capacity of a disk 
so that there is more space available for your data and programs. 

Stacker uses data compression. Compressing a file makes it use less 
space by eliminating repetitive pieces of information. After 
compressing the drive by running Stacker on it, you use it exactly as 
you did before running Stacker. Data, however, is automatically 
compressed when written to the drive and automatically 
decompressed when read back from the drive. 

The amount by which a disk drive can be compressed depends on 
the type of files stored on it. Word processor files usually compress 
to half their original size, for example, while spreadsheet files 
compress even more. Programs and command files tend to 
compress less because they do not contain very much repetitive 
data. 

This chapter describes the Stacker program and how to use it. 

Before Compressing a Drive 

You should perform the following tasks before running the Stacker 
program. 

Back Up the Contents of the Drive 

Before making any changes to an entire disk drive, it is always a 
good idea to make a backup copy of its contents. Refer to the 
description of the FBX command in the "Command Reference" 
chapter of DOSBook for information about how to back up an entire 
disk drive. 
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Log Off the Network 

If your computer is connected to the network, log off the network. 
You cannot compress network drives. 

Remove Copy-Protected Software 

Exit Any Shell 

If you have copy-protected software on the disk drive you want to 
compress, remove it; some copy-protected software may interfere 
with the compression process. You can replace the software on the 
disk drive after the compression process is finished. Refer to the 
documentation of specific applications for information about 
removing them from a disk and then replacing them again. 

Compression can only be done through the SETUP program under 
DOS. If you are using any other operating environment, such as MS 
Windows or GeoWorks*, exit from it before compressing a disk 
drive. 

Check for Sufficient Free Space 

The Stacker program requires working space on the disk drive being 
compressed. Make sure that there is at least 1 MB of free space on 
the drive. If you want to compress a bootable drive (usually drive 
C:), Stacker needs at least one percent of the total space plus an 
additional 45 KB of free space. 
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Compressing a Drive 

ProcedureT 

You can compress any of the following: 

+ An existing hard disk drive including all the data on the drive 

+ The free space on an existing hard disk drive 

+ A blank diskette 

You compress a disk drive using the SETUP program. Refer to 
Chapter 9, "Configuring the System" for general information about 
SETUP and how to use it. 

After starting SETUP, do the following: 

1. Choose Disk Compression from the main menu. 

SETUP offers to reboot the computer to disable any software, 
such as TSRs and device drivers, that might interfere with the 
compression process. 

2. Choose to reboot if you are aware of any such software. 

It is recommended that you always choose to reboot. 

SETUP displays a list of the disk drives currently available on 
your system, along with the type and capacity of each drive. 

3. Select the drive you want to compress or cancel compression 
and return to the SETUP main menu. 

When you choose a drive, SETUP displays the current status of 
the drive: the total amount of space and the amount of free 
space (in KB). 

4. You can now choose to compress all of the data on the drive or 
to compress the free space only to create a new Stacker drive. 

If you are compressing a diskette, the Stacker program will only 
compress a blank diskette; you cannot compress existing data 
on a diskette or any other type of removable drive. 
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Compressing the Entire Hard Disk Drive 

ProcedureT 

Compressing the entire drive means that all existing data on the 
drive will be compressed. After the drive is compressed, there will be 
more free space. 

1. Choose to compress the entire drive and SETUP displays a 
message that it is ready to begin compression. Then choose to 
begin compression or, if you have changed your mind, you can 
cancel compression and return to the SETUP main menu. 

You see several different processes as the drive is compressed. 
They are as follows: 

+ Stacker begins by compressing all the files on the drive. You 
see a "progress bar" that indicates how much Stacker has 
completed so far. 

+ Once the files are compressed, Stacker runs the DISK OPT disk 
optimizer on the drive so that the files on the Stacker drive 
will not be fragmented. You see the DISKOPT display; refer to 
Chapter 11, "Improving Disk Performance" for a complete 
description of DISKOPT and how it works. 

+ After DISKOPT is complete, Stacker scans the drive so that it 
can avoid any problem areas. You see a progress bar that 
indicates how much of the drive verification Stacker has 
completed so far. 

For a detailed description of how Stacker is working, refer to 
"The Compression Process" on page 12-6. 

2. When compression is finished, you see the size of the stacked 
disk and the amount of free space, before and after 
compression. 

3. If you choose to restart the operating system. SETUP reboots 
the computer and you can use all of your disk drives the same 
way you have always done. 

The compressed drive is automatically mounted and available 
for use. 
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After compressing a drive and rebooting, you will also notice that 
an additional drive, using the next available drive letter, has been 
created. This is the uncompressed drive associated with the Stacker 
drive. For information about this drive and its function, refer to 
"The Compression Process" on page 12-6. 

Creating a Compressed Drive From Free Space on a Hard Disk 

Instead of compressing an entire hard disk drive, you can choose to 
use all the free space on the drive to create a new Stacker drive. You 
compress free space the same way you compress the entire drive; 
refer to "Compressing the Entire Hard Disk Drive" on page 12-4 for 
a description. The only differences are as follows: 

+ Stacker only scans the disk space to verify its integrity; it does 
not compress files. 

+ An uncompressed drive is not created along with the new 
Stacker drive. 

Creating a Compressed Diskette 

If you are compressing a diskette, you can only compress a blank 
diskette; you cannot compress any existing data. When you 
compress a diskette, all existing data will be deleted before the 
diskette is compressed. After the diskette is compressed, any new 
data written to it will automatically be compressed. 

Instead of using SETUP, you can quickly compress a blank diskette 
by using the CREATE command at the system prompt. Refer to the 
"Command Reference" chapter of DOSBook for information about 
the syntax and function of the CREATE command. 
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Converting DoubleSpace and SuperStor Drives 

If you have DoubleSpace or SuperStor compressed drives on your 
computer, SETUP can automatically convert these drives to Stacker 
drives. 

SETUP automatically detects the presence of DoubleSpace or 
SuperStor drives when you choose Disk Compression from the main 
menu. When prompted, choose whether or not to convert all 
DoubleSpace and SuperStor drives to Stacker drives. 

After converting drives via SETUP, it is a good idea to make sure your 
data is as safe as possible by recompressing your data using 
DISKOPT. The DISKOPT program includes an option to perform a 
full optimization and "restack" of the drive. For information about 
running DISKOPT, refer to Chapter 11, "Improving Disk 
Performance." 

The Compression Process 

When you are compressing existing data, the Stacker program 
works on an uncompressed disk drive as follows: 

1. Stacker reserves a certain amount of space on the drive to 
remain uncompressed: 1 MB if the drive is bootable and 100 KB 
for any other drive. This uncompressed drive contains the files 
that need to remain uncompressed: IBMBIO.COM and 
IBMDOS.COM, for example, if the drive is bootable. The Stacker 
configuration file (STACKER.IN!) and device driver 
(STACKER.BIN) are also stored in the uncompressed drive. 

2. Stacker creates the STACVOL.DSK file to hold all the data on the 
drive. The STACVOL file fills the rest of the drive and will 
become the Stacker (compressed) drive. 

3. Stacker compresses all the files on the drive and stores them in 
the STACVOL file. 

4. Stacker creates a logical drive for the STACVOL file which is 
double the size of the file itself. The next available drive letter is 
used for the new logical drive. 
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5. Stacker switches drive letters so that you access the data on the 
compressed drive with the original drive letter, as you did before 
compression. Normally, only DOS needs to access the 
uncompressed drive. 

When you are compressing the free space on a drive to create a new 
Stacker drive, the Stacker program works the same way except that 
it does not compress files and it does not create an uncompressed 
drive. The new Stacker drive (containing the STACVOL file) is 
mounted as the next available drive letter when you reboot the 
system. 

Accessing Compressed Drives (STACKER.BIN and STACKER.INI) 

The operating system needs information about how to access a 
compressed drive once it has been created. 

When you run the Stacker program in SETUP, it copies the Stacker 
device driver, STACKER.BIN, to the root directory of your boot 
drive. STACKER.BIN remains uncompressed. It is loaded into 
memory at system startup before any device driver; other device 
drivers are loaded in CONFIG.SYS. 

STACKER.BIN is configured specifically for your system. To do this, 
SETUP creates a hidden configuration file in the root directory of 
your boot drive called STACKER.IN!, which sets the compression 
speed and defines STACVOL files as logical drives. Normally, you 
will not need to edit this file; SETUP creates and changes it 
automatically for you. 
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Mounting and Unmounting Compressed Drives 

After the Stacker program is run on any of your disk drives, 
compressed drives are automatically mounted when you boot the 
system and available to use. You may, however, need to unmount a 
compressed disk to access the uncompressed drive. You will also 
need to unmount compressed diskettes before you can run the DOS 
DISKCOPY or FORMAT commands on them. 

Unmount a compressed drive using the STACKER command at the 
system prompt. To mount a compressed drive, you can also use the 
STACKER command. Refer to the description of the STACKER 
command in the "Command Reference" chapter of DOSBook for 
more information. 

Checking Compressed Drives 

The Stacker program includes a way of checking the current status 
of your compressed drives, checking the integrity of those drives, 
and displaying information about them such as the compression 
ratio. 

Displaying Drive Status 

You can use the STACKER command at the system prompt to 
display a report on the status of each drive. Refer to the "Command 
Reference" chapter of DOSBook for information about the syntax 
and function of the STACKER command. 

Checking Drive Performance and Usage 

To check Stacker drive integrity, use the CHKDSK command. 
CHKDSK includes options that apply specifically to Stacker drives. 
Refer to the description of CHKDSK in the "Command Reference" 
chapter of DOSBook for more information. 
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Viewing Stacker Information in MS Windows 

After you run Stacker, a Stacker pull-down menu is added to your 
File Manager the next time you go into MS Windows. 

Choose one of the following from this menu: 

+ File Info 

If you choose File Info, you see the name, type of file, size of the 
file, and compression ratio for the files selected. The bottom left 
corner of the screen contains the Sort Order buttons. The 
bottom right corner of the screen displays Overall Info, 
including the actual compression ratio for the files selected as 
well as the total bytes contained in the file. 

+ Disk Info 

If you choose Disk Info, you see the KB used and free for the 
entire compressed drive plus the expected and actual 
compression ratios for that drive. 

Creating MS Windows Permanent Swap Files 

ProcedureT 

When you are running MS Windows in 386 Enhanced mode, it frees 
memory and speeds up performance by swapping information from 
memory to a "swap file" on your hard disk (virtual memory). You 
can display or change the swap file settings by using the standard 
MS Windows Virtual Memory dialog box but you will not be able to 
create a permanent swap file on a Stacker drive. 

To be able to create a permanent swap file on a Stacker drive, you 
must display and change information about your system's virtual 
memory as follows: 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Virtual Memory icon. 

The Virtual Memory dialog box appears, which displays the 
current swap file settings. 
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3. Choose the <Change> button, to change the drive location, 
size, and type for the swap file. 

The dialog box expands, enabling you change the settings. You 
can now select a Stacker drive to contain a permanent swap file. 
You cannot create a temporary swap file on a compressed drive, 
however. 

For further information about MS Windows swap files, refer to the 
appropriate section of your MS Windows documentation. 

Decompressing a Compressed Drive 

12-10 

On rare occasions, you may want to decompress all the data on a 
compressed drive. You can reverse the compression process by using 
the UNSTACK command. 

You cannot decompress a compressed diskette. 

UNSTACK removes all the files from the compressed drive, 
decompresses them, places them back on the uncompressed drive it 
created when you originally compressed the drive, and deletes the 
STACVOL file. Refer to "The Compression Process" on page 12-6 for 
information about how Stacker compresses the drive. 

Start decompressing a drive by typing the following at the system 
prompt, where dis the drive letter of the compressed drive: 

UNSTACK d: <Enter> 

You see a display that shows the progress made so far in 
decompressing the drive. 

Before it starts decompressing, Stacker checks to make sure all the 
data will fit on the uncompressed drive. If they will not fit, you are 
informed and Stacker indicates how much additional space is 
required. Delete enough files or move them to another disk drive 
before running UNSTACK again. 

The UNSTACK display will also prompt you twice before proceeding 
to decompress the drive; this is a safety precaution. 
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Using a Compressed Diskette on a Computer Without 
Stacker 

When you use a compressed diskette on a computer on which the 
Stacker program has been installed, the compressed diskette is 
automatically mounted. If you want to use a compressed diskette on 
a computer on which Stacker has not been run, however, you will 
need to manually mount the diskette and make it available for use. 

An unmounted Stacker drive contains the following files only: 

+ STACVOL.DSK, the file containing the compressed data 

+ STACKER.EXE, the program that mounts the Stacker drive 

+ README.STC, which identifies this drive as a Stacker drive and 
tells you to run STACKER on it 

To make the compressed drive available on a non-Stacker computer, 
simply run STACKER by typing the following at the system prompt, 
where dis the drive letter of the compressed drive: 

STACKER d: <Enter> 

If you need to unmount the compressed drive, type the following at 
the system prompt: 

EXIT <Enter> 
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chapter 13 
Multitasking and Task Switching 

The operating system provides you with the ability to run more 
than one application at the same time. The program that provides 
this feature is referred to as the "Task Manager." 

Running multiple applications simultaneously, and being able to 
switch between them, means that your most frequently-used 
applications are always available instantly. You can also run 
multiple copies of the same application, such as a word processor. 
You can load multiple TSRs, to make the best use of memory. 

You add applications as "tasks" to a menu, which you can display at 
any time. When you switch from one task to another, the task you 
switch from is "swapped out" to memory, or to a "swap file" on disk. 

If your computer has a 386* processor (or later) with at least 2 MB 
of extended memory, you can use the Task Manager as a 
"multitasker," running multiple tasks simultaneously and switching 
between them. Alternatively, you can use the Task Manager as a 
"task switcher" only, in which case you can switch between 
applications but those you switch from are suspended in the 
background until you return to them. If your computer is 80286-
based, with at least 3 MB of memory, you can only use the Task 
Manager as a task switcher. 

Loading and Configuring the Task Manager 

You can load and configure the Task Manager using SETUP (or 
INSTALL). SETUP will add a statement to AUTOEXEC.BAT to load 
TASKMGR.EXE and will also provide the necessary memory 
management. Once loaded, the program is available at any time; 
there is no need to load it at the system prompt every time you want 
to use it. 
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You can load the Task Manager at the system prompt using the 
TASKMGR command. If you are loading the task switcher only, you 
can configure the Task Manager this way. To load the Task Manager 
at the system prompt as a multitasker, the EMM386 memory 
manager must be configured for multitasking with the /MULTI 
switch. When you use the TASKMGR command, the program will 
only remain available until the next time you boot the machine. 

Using SETUP to Load the Task Manager 

Start SETUP and choose Task Management from the main menu. You 
can then set options for the Task Manager. If you are using the Task 
Manager as a task switcher only, you can also specify the type of 
memory you want the Task Manager to use. SETUP automatically 
updates the appropriate files (TASKMGR.INI, AUTOEXEC.BAT, and 
the EMM386 memory manager in CONFIG.SYS) when you exit the 
program. The next time you boot your machine, the changes take 
effect and the Task Manager is loaded automatically and as you 
specified in SETUP. 

Multitasking or Task Switching 

Task Manager Options 

Note~f' 

Choose to load either the multitasking or the task switching 
software. To use the multitasking software, your computer must 
have at least a 386 processor. 

After you choose to load either the multitasking or the task 
switching software, choose to configure the Task Manager. You can 
set the following options: 

+ The key combination that activates the Task Manager menu. 
The shift key activates the "hot key" and the hot key (in 
combination with the shift key) displays the Task Manager 
menu. The default shift and hot key combination is <Ctrl><Esc>. 

If you are loading the task switcher only and if you are going to load GeoWorks 
as a task, you must use <Ctrl><Esc> because GeoWorks intercepts all other key 
combinations. If you are using MS Windows with the task switcher, specify a key 
combination other than <Ctrl><Esc>. 
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+ Glob al Drives and Paths. Choose this option to make drive 
mappings "global." This means that any network resource you 
map to a drive letter in a task will be recognized in all 
subsequent tasks you add. 

You can also set the following option, if you are loading the 
multitasking software: 

+ Foreground/background ratio. This value specifies the amount 
of processor time that will be allocated to the tasks running in 
the background. A value of 10, for example, means that the 
current (foreground) task gets ten times as much processor time 
as any single background task. If you had ten tasks running in 
the background, the current task would get fifty percent of total 
processor time. The default foreground/background ratio is 5. 

You can set the following options if you are loading the task 
switcher only: 

+ The path for the swap file. This is a file on the hard disk that will 
be used when there is no more RAM available for the Task 
Manager. The default location for the swap file is 
C: \NWDOS\ TMP. Before specifying a different location, make 
sure that there is enough free space available at that location for 
all the tasks that you want to run. 

To increase task swapping speed, swap tasks to a memory disk. 
To calculate the size of the memory disk required, load all the 
tasks you want to run and note the size of the swap file created 
on the hard disk. Then create a memory disk that is slightly 
larger. Use the VDISK.SYS device driver in CONFIG.SYS to create 
a memory disk. You can enable VDISK.SYS with the SETUP 
program. Refer to Chapter 9, "Configuring the System" for 
information about creating memory disks. 

Allocating Memory for the Task Manager (Task Switching Only) 

The Task Manager can use extended or expanded (EMS) memory, 
rather than conventional memory, if these memory types are 
available. Refer to Chapter 10, "Managing Memory" for 
information about enabling extended or expanded memory. 
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The Task Manager uses extended memory, if available, by default. 
You can change the amount of extended memory to reserve for the 
program; by default, 1024 KB is reserved. You can also specify 0 KB 
to disable the use of extended memory. 

If you want the Task Manager to use expanded memory, specify the 
amount of expanded memory to reserve for the program. The 
default is 0 KB (use of expanded memory is disabled). 

To change memory settings for the multitasker, you must edit the 
TASKMGR.INI file directly. Refer to the following section, "Changes 
Made by SETUP" for information about TASKMGR.INI. 

Limiting the Amount of Memory Used per Task 

Whether you are using the multitasker or the task switcher, you can 
specify the maximum amount of extended or expanded memory 
that can be used by any single task. The limit you specify applies to 
whichever type of memory the Task Manager is configured to use. 
Some applications will try to allocate all the available extended or 
expanded memory to themselves when they load; in this case, there 
may not be any further memory available for other applications. 

To change memory settings for the multitasker, you must edit the . 
TASKMGR.INI file directly. Refer to the following section, "Changes 
Made by SETUP" for information about TASKMGR.INI. 

Changes Made by SETUP 

When you load and configure the Task Manager using SETUP, the 
appropriate changes are made to the TASKMGR.INI file, the 
AUTOEXEC.BAT file, and the EMM386 memory manager in 
CONFIG.SYS. 
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The TASKMGR.INI File 

The configuration of the Task Manager is defined in a file called 
TASKMGR.INI, a special configuration file used only by the Task 
Manager. TASKMGR.INI is stored in the C: \NWDOS directory by 
default or in the directory specified by the NWDOSCFG 
environment variable; you can specify a different directory for 
configuration files in SETUP. You can also set the NWDOSCFG 
variable yourself using the SET command; refer to the "Command 
Reference" chapter of DOSBook for a description of the SET 
command. 

TASKMGR in AUTOEXEC.BAT 

The TASKMGR command loads the Task Manager software. When 
you load and configure the Task Manager in SETUP, the TASKMGR 
command is automatically added to AUTOEXEC.BAT, so that the 
software loads every time you start the operating system. You can 
also use TASKMGR at the system prompt; refer to "Loading the Task 
Manager at the System Prompt" on page 13-7 and "Working with 
Tasks at the System Prompt" on page 13-14. 

EMM386 DPMI Support (Multitasking Only) 

If you load the multitasking software, DOS Protected Mode 
Interface (DPMI) support is also provided via the EMM386 memory 
manager. DPMI allows applications to access the protected mode 
features on 386 (and later) computers. The DPMI switch, which 
enables DPMI support to improve multitasker performance, is 
automatically added to EMM386 in CONFIG.SYS, along with the 
MULTI switch, when you choose to load the multitasking software 
in SETUP. Refer to Chapter 10, "Managing Memory" for more 
information about the EMM386 memory manager. 
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Task and System Environments 

When you choose to load the Task Manager, be aware of the 
relationship between the local environment that each task create 
and the operating system's global environment, which each task w 
inherit. If you load a TSR as a task, for example, it can only be US( 

within the task and will only use memory available within that tas 
The Task Manager program is loaded into the global environmen 
which includes all currently-loaded device drivers, TSRs, and all 
currently available memory. Anything that you want all tasks to 
share must, therefore, be loaded before the Task Manager. 

You should attempt to keep the number of programs loaded globa1 
to a minimum because each program loaded before the Task 
Manager reduces the amount of memory available to the 
applications you load as tasks. Programs you should load before t] 
Task Manager, however, could include the following: 

+ Print spoolers, which allow you to print files without stoppir 
the computer from performing other tasks at the same time. 
you load a print spooler within a task, you can only use it whi 
that task is active. 

+ Network drivers. 

+ Mouse drivers. 

+ The MEMMAX command. You cannot use MEMMAX while 
using the Task Manager so you should make sure that you 
specify the appropriate switches (such as+ V to enable sharin 
of video memory) before you load the Task Manager. 

Because the Task Manager is loaded in AUTOEXEC.BAT (by the 
TASKMGR command) and the statements in AUTOEXEC.BAT an 
processed in the order in which they appear, any changes to the 
global environment that you want all tasks to share must be locat1 
before the TASKMGR command. If necessary, you may need to ec 
the AUTOEXEC.BAT file yourself using EDIT or another text edit 
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Using Disk Utilities 

1mportantV 

Before loading the Task Manager, you should also run any disk 
utilities (such as disk optimizers and disk editors) that you want to 
use. Some of these will work under the multitasker, but you may see 
a warning message when they load. 

Using disk utilities while the Task Manager is loaded could result in disk 
corruption. 

1 

Loading the Task Manager at the System Prompt 

Command Switches 

/?or /H 

/M 

IS? or /SH 

IS 

You can load and configure the Task Manager at the system prompt, 
using the TASKMGR command. The changes you make using 
TASKMGR are only effective until the next time you boot your 
machine. Permanent loading and changes to the configuration of 
the Task Manager can only be made via SETUP or by editing 
TASKMGR.INI, AUTO EXEC.BAT, and CONFIG.SYS yourself. Refer to 
"Changes Made by SETUP" on page 13-4 for information about Task 
Manager configuration. 

Different TASKMGR options are available depending on whether 
you previously loaded the multitasking or the task switching 
software using SETUP. 

If the multitasking software is loaded, the only options available 
when loading the Task Manager at the system prompt are as follows: 

TASKMGR [/?I /H] [ /M] [ /S? I /SH] [ /S] 

Displays help text for the multitasker. 

Allows you to switch tasks using the numeric keys on the keyboard, when 
you are using a keyboard that does not have a separate numeric keypad. 

Displays help text for the task switcher only. 

Loads the task switcher instead of the multitasker, even if the multitasking 
software was enabled in SETUP. 
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Command Switches 

/?or /H 

/D=dirpath 

/E[=nnnn] 

/F 

/M 

/V[:l] 

/X[=nnnn] 

If the multitasker is not enabled, use the TASKMGR command as 
follows: 

TASKMGR [/?j/H] [/D=dirpath] [/E[=nnnn]] [/F] [/M] 
[/V[:l]] [/X[=nnnn]] 

Displays help text. 

Specifies the location (dirpath) of the swap file. The swap file is used for 
storing suspended tasks when there is no RAM available. The default is 
C:\NWDOS\ TMP. 

Allocates the specified amount of extended memory (nnnn KB) to the Task 
Manager. Tasks will be swapped to extended memory. If you do not 
specify an amount, or if you specify an amount greater than the amount 
available, all the available extended memory is used. To disable the use of 
extended memory and reserve it for applications, specify /E=O. 

Saves user-defined fonts and code pages when you switch tasks. 

Allows you to switch tasks using the numeric keys on the keyboard, when 
you are using a keyboard that does not have a separate numeric keypad. 

Forces a VGA display to be accessed in the same way as an EGA display. 
Try /V:l first, then /V if necessary. 

Allocates the specified amount of expanded (EMS) memory (nnnn KB) to 
the Task Manager. Tasks will be swapped to expanded memory. If you do 
not specify an amount, or if you specify an amount greater than the 
amount available, all the available expanded memory is used. To disable 
the use of expanded memory and reserve it for applications, specify /X=O. 

Using the Task Manager Menu 

13-8 

Press <Ctrl><Esc> (or the shift and hot key combination you 
specified during SETUP) to display the Task Manager menu. 

The Task Manager menu appears in the top right corner of the 
screen. If you are running a graphics application, such as a drawing 
package, the screen clears before the menu appears; you return to 
the application when you exit the menu. 

Novell DOS 7 User Guide 



Note~~ 

Adding Tasks 

The menu has two parts: a task list on the left side, which lists the 
tasks you add, and an option list on the right side. The initial 
options (before you add any tasks) are About TaskMgr, Create new 
task, and Remove TaskMgr. 

Select an option from the Task Manager menu by pressing the key 
shown to the right of the option; press <Del> to remove the Task 
Manager, for example. You can also select an option by clicking 
your mouse on it. Each of the menu options are explained in the 
following sections of this chapter. 

If you are using a non-enhanced keyboard, you can press <F2> and <F4> instead 
of <Ins> and <Del>. 

When you display the menu before adding any tasks, the task list 
already contains one task, COMMAND,that represents your current 
session. Tasks are listed in the menu in the order in which you add 
them. Your current task (the one you are, or were most recently, 
using) is indicated by an arrow in the task list. 

To move around the task list, use one of the following: 

+ The <up-cursor> and <down-cursor> keys 

+ The <Spacebar> (which moves down the menu and then jumps 
to the top) 

+ The <Tab> and <Shift><Tab> keys (which move ahead or back a 
task respectively) 

To cancel the Task Manager menu, press <Esc>. Cancelling the menu 
does not unload the Task Manager program; it simply removes the 
menu from the screen. 

You can add tasks up to the limit of your available memory but you 
should limit the Task Manager to the tasks you use frequently. 
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ProcedureT 

A task, once loaded, remains loaded until you delete it, unload the 
Task Manager program, or reboot the computer. If you load a TSR as 
a task, the Task Manager automatically recognizes it as a TSR so that 
even when you are not running the program, it stays loaded as a 
task and appears in the Task Manager menu. 

Before adding a task, make sure there is enough space for it. Check 
the amount of space already used by selecting the About TaskMgr 
option on the Task Manager menu; refer to "Showing the Space 
Available for Tasks" on page 13-11 for information about this 
option. Graphics applications can require up to 800 KB. If you try 
to add a task and there is not enough space for it, you see a warning 
message. Remove an existing task and continue. 

To add a task, do the following: 

1. Press <Ctrl><Esc> (or the shift and hot key combination you 
specified) to display the Task Manager menu. 

2. Select the option to create a new task by pressing the <Ins> key 
or clicking your mouse on the option. 

You return to the system prompt. 

3. Display the Task Manager menu again. 

There is now a second task called COMMAND in the task list 
and the option to delete a task now appears in the menu, 
replacing the option to remove the Task Manager. Press <Esc> to 
cancel the menu. 

4. Start the application that you want to add as a task. 

Start the application in the same way that you would normally 
start it; change to the appropriate drive and directory, for 
example, or run the appropriate batch file. As an example, start 
EDIT; type EDIT and press <Enter>. 

EDIT (or whichever application you started) is now loaded as a 
task. 
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5. Once the application is loaded, the Task Manager menu can be 
displayed by pressing <Ctrl><Esc> (or the shift and hot key 
combination you specified) as before. 

The application appears in the task list as the second task. 

Nate that the task name in the list can be a maximum of 8 
characters long, so if the name of an application is longer than 
8 characters, the Task Manager shows an abbreviated version of 
the name. Also, if the Task Manager cannot determine the 
name, you see Task n as the task name, where n is the number 
of the task in the list. 

6. Continue to add applications between which you want to 
switch. 

Remember that you can only switch between applications that 
you add as tasks to the Task Manager menu. 

7. If you add the maximum number of tasks (20), the option to 
create a new task disappears from the menu so that you cannot 
add another task. 

Adding COMMAND.COM as a Task 

Note~f' 

The Task Manager is designed for running multiple applications but 
you can also load several copies of the command processor 
(COMMAND.COM) as separate tasks. You can then use COMMAND 
at the system prompt to customize the local environment for each 
COMMAND.COM. Refer to the "Command Reference" chapter of 
DOSBook for information about using COMMAND. 

If you already have more than one copy of COMMAND.COM loaded before you 
load the Task Manager, you can only load the Task Manager from the original 
COMMAND.COM. 

Showing the Space Available for Tasks 

Select the About TaskMgr option on the Task Manager menu to see 
how much space your current tasks are using and how much space 
is left; this information is useful when you are deciding whether or 
not to add more tasks. 
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Switching Tasks 

Note,.f" 

When you switch tasks, and if you are using the multitasking 
software, the task you leave continues to run. If you are using the 
task switching software only, the task you leave is suspended in the 
background and stored in memory or in the swap file. 

When you are using communications software such as electronic mail or file 
transfer, make sure you do not switch tasks while the communications software 
is sending or receiving data via the serial port on your computer; if you do, data 
may be lost. Use the application to stop the remote card sending data before 
you switch tasks or adjust the foreground/background ratio setting. 

You switch between the tasks in the task list using the menu. Move 
the highlight bar to the task and press <Enter> or click your mouse 
on the task. 

You can switch between tasks and bypass the menu by doing one of 
the following: 

+ Press <Ctrl> and+ (on the numeric keypad) to switch to the next 
task listed on the menu 

+ Press <Ctrl> and - (on the numeric keypad) to switch to the 
previous task listed on the menu 

+ Press <Ctrl> and the number of the task (on the numeric 
keypad), if you know the number of the task on the menu and 
it is one of the first nine tasks 

If you are using a keyboard that does not have a numeric keypad, 
add the /M switch to the TASKMGR command line in 
AUTOEXEC.BAT. Refer to "Loading the Task Manager at the System 
Prompt" on page 13-7 for information about the TASKMGR 
command switches. 
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Problems Switching Tasks? 

Deleting Tasks 

ProcedureT 

If you try to switch tasks and get a message warning you that there 
is insufficient space available, save any changes you want to keep in 
the current application and exit from it. 

If you try to switch tasks and the Task Manager does not switch or 
you try to display the Task Manager menu from within a task and 
you cannot, the current application may have taken control of the 
keyboard from the Task Manager; it is no longer interpreting your 
keystrokes because the application is intervening and reading the 
keystrokes directly. 

Use the SETUP program to change the Task Manager shift key 
( <Ctrl> by default) to a different key or key combination; the 
preferred alternative is <Ctrl><Left-shift> (the <Left-shift> key is the 
<Shift> key on the left side of the keyboard). 

If the problem still remains, refer to the documentation for the 
application; it may have a "system" option that selects the 
command processor, COMMAND.COM. Selecting this option will 
take you to the system prompt and you should then be able to 
switch tasks. When you switch back to the application's task, you 
must type EXIT <Enter> at the system prompt to return to the 
application itself. 

You can only delete a task when there is more than one task in the 
task list. When the system prompt is the only task (COMMAND), 
the option to delete a task is replaced by the option to remove the 
Task Manager. 

To delete a task, do the following: 

1. Switch to the task you want to delete. 

2. Exit the application running as the task. 

3. Display the Task Manager menu. 

The name on the menu for the task you are deleting is replaced 
by COMMAND (representing the system prompt). 
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4. The task you are deleting is your current task, since it is the task 
you most recently used. Press <Del> to delete it or click your 
mouse on the option. 

If you did not exit the application running as the task, you are 
asked whether you really want to delete it; type Y for YES or N 
for NO. Be careful; if you delete a task with open files, you may 
lose data. 

5. After you delete a task, the task at the top of the task list 
becomes the current task. 

Unloading the Task Manager Without Rebooting 

To unload the Task Manager without rebooting the machine, do the 
following: 

+ Delete all tasks you added until the option to remove the Task 
Manager appears on the Task Manager menu. 

+ Select the option by pressing <Del> or clicking your mouse on it. 

You return to the system prompt and the Task Manager is no longer 
loaded. The software is not removed from your hard disk, however; 
you can reload the Task Manager at any time by either rebooting the 
machine (if you previously loaded the Task Manager in SETUP) or 
by using the TASKMGR command. Refer to "Using SETUP to Load 
the Task Manager" on page 13-2 and "Loading the Task Manager at 
the System Prompt" on page 13-7 for more information. 

Working with Tasks at the System Prompt 

If you are using the multitasker, you can use the TASKMGR 
command at the system prompt to add and delete tasks without 
using the Task Manager menu. If you are using the task switching 
software only, you can also change the name of a task and specify a 
limit on the amount of expanded memory used by any single task. 
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Command Switches 

/?or /H 

JC command 

/K:nn 

/L=nnnn 

/N[:nn] name 

/N[:nn] 

Use the TASKMGR command as follows: 

TASKMGR [/?l/H] [/C command] [/K:nn] [/L=nnnn] 
[ /N [ : nn] name] [ /N [ : nn] ] 

If the multitasking software is loaded, IC and/Kare the only 
switches you can use. 

Displays help text. 

Adds a task to the Task Manager menu, where command is the command 
or batch file that starts the application you are adding as a task. Specify 
command exactly as you would enter it at the system prompt. When you 
add a task using /C, make sure that you wait approximately 10 seconds 
before pressing any keys; this pause allows the Task Manager to regain 
control of the keyboard after the application you are adding loads. 

Removes the specified task, where nn is the number of the task on the Task 
Manager menu. If you are using the multitasker, you cannot delete the 
current task. 

Limits the amount of expanded memory (to nnnn KB) that any single task 
is able to use, when the Task Manager is configured to use expanded 
(EMS) memory. 

Names a task, which is either the current task (by default) or task nn on 
the Task Manager menu. The name you specify can be a maximum of 
eight characters in length. This name overrides the name automatically 
determined by the Task Manager when the task is created. 

Restores the default task name, for either the current task (by default) or 
task nn on the Task Manager menu. 
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Rebooting While the Task Manager is Loaded 

If you press <Ctrl><Alt><Del> while the Task Manager is loaded, or if 
you run SETUP and then restart the operating system, the computer 
will not reboot immediately. Instead, you are prompted to delete 
your current task. When all current tasks are deleted and you press 
<Ctrl><Alt><Del> again, you are asked to confirm that you want to 
remove the Task Manager. 

This is a safety feature to prevent the computer from rebooting 
while several applications are running or suspended in the 
background with open files. You should avoid trying to reboot 
when you are working with a file; the application may be reading or 
writing the file. 

Once the Task Manager has been removed, press <Ctrl><Alt><Del> 
again to reboot the computer. 

Task Manager Troubleshooting 

This section describes some common problems that you might 
experience when using the Task Manager and what you can do 
about them. 

Cannot Run MS Windows as a Task 

If you are using the multitasker, you can run MS Windows 3.1 as a 
task but in Standard mode only. If you are using the task switcher 
only, however, you can run MS Windows 3.1 as a task in either 
Standard or Enhanced mode. No earlier versions of MS Windows are 
supported. 

Open File Limit Too Low 

The operating system expects only one application to be loaded at 
a time so when you are using the Task Manager to load multiple 
applications, you may need to increase the limit to the number of 
files that can be open simultaneously. If the current limit is too low, 
you will see a message telling you that an application cannot start 
because of this. 
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To increase the open files limit, run SETUP to change the FILES 
value in CONFIG.SYS. The value you specify depends on the 
requirements of your applications; if a word processor and a 
spreadsheet, for example, require 20 files each, you must specify a 
value of at least 40. Refer to the documentation for your 
applications to determine the ideal number of open files required. 
Do not specify more than the required number because each file has 
memory assigned to it. 

Errors Running Multiple Copies of the Same Application 

If you load more than one copy of an application and you get an 
error message, the problem could be the result of either of the 
following: 

+ The application is designed to run as if it is the only application 
currently running. 

Possible solution: Use the ATTRIB +R command to set the 
application's overlay and .EXE files to "read-only." An 
application uses overlay files when it cannot fit entirely into 
memory; the main file is loaded and the rest of the application 
is divided between overlay files, which are loaded into memory 
only when required. The documentation for your application 
should identify the overlay and .EXE files. 

+ The application creates temporary files with fixed names so that 
the second copy of the application interferes with the 
temporary files belonging to the first copy. 

Possible solution: Refer to the documentation for the 
application to determine whether there is an environment 
variable you can use to specify where temporary files are 
created. Then use this variable to specify a different location for 
each temporary file. If the application creates its temporary files 
in the local directory (where it is loaded), load each copy of the 
application in a different directory. 
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chapter 14 
Securing Information 

There are four aspects to keeping information secure with this 
operating system: 

+ Securing information on a standalone computer 

Use standalone security when the computer is not part of a 
network. Standalone security prevents unauthorized users 
logging in to the computer, or booting it from a diskette drive 
and accessing the hard disk. This is known as hard disk security. 

+ Securing information on a networked computer 

When you use a computer as a Personal NetWare server, there 
are certain things that you need to be aware of to keep your 
information secure. Use security on a computer that is part of 
the network to grant access to information and devices only to 
those users who need it. 

+ Securing information against viruses 

The anti-virus software, Search and Destroy, is an up-to-date 
virus detection program, able to remove most types of virus. 
Search and Destroy has a scanner and memory-resident 
program, both of which you can use to detect and remove virus 
infection and prevent viruses from being transmitted to the 
hard disk from diskettes. 

+ Securing information using backups 

When you take a backup of the information on the computer, 
you make a copy of the information that you can use if some 
information is lost or corrupted. For a backup to be useful, you 
must take regular backups so that you have a recent copy of the 
information. 
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Enabling Security 

14-2 

Procedure'W 

Note .... f 

warningV 

Before you enable security, it is recommended that you scan the 
computer for viruses, take a backup of the hard disk, and remove 
any options to load other operating systems. To enable security, use 
the SETUP program as follows: 

1. At the system prompt, type the following: 

SETUP <Enter> 

2. Select the Data Protection and Security option, and then select 
Configure Security. 

SETUP shows whether security is currently enabled or disabled. 
If you are enabling security for the first time, select the Enable 
Security option. 

3. You are prompted to enter a password. 

This password is the master key password. You must use 
alphanumeric characters for the password. The maximum 
length for a password is 15 characters. 

When you choose a password, do not choose one that is too easy to guess, 
such as your own name, but do not use one that you find hard to 
remember. Use a nonsense word, or put some numbers into a word to 
make it harder for anyone to guess your password. 

This password is used with both standalone and network 
security. 

Do not forget the master key password. If you enable security and specify 
a master key password, you must enter this password before you can gain 
access to the computer. 

4. Save the changes you made and exit SETUP. 

Now, when you reboot your computer, you are prompted for the 
master key password before you gain access to your computer. 
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If your computer is not part of a network, read the following section 
"Security on a Standalone Computer" to learn about using security 
on your computer. If your computer is part of a network, read the 
section "Security With the Network" on page 14-4. To learn about 
protecting your computer against viruses whether it is part of a 
network or not, read the section "Security Against Computer 
Viruses" on page 14-8. For an introduction to taking backups, read 
the section "Security with Backups" on page 14-16. 

Once you enable security, you might find that some third party disk utilities 
report errors in the partition table. You can ignore these messages. However, if 
you suspect that the disk is corrupted, do not try to use a third party utility to 
correct this until you have disabled security and restarted your computer. 

Security on a Standalone Computer 

When a computer is not part of a network, there are several ways to 
keep the information on the computer secure from unauthorized 
access. They are as follows: 

+ Hard disk security 

+ Screen saver lock 

+ File and directory password protection 

Using the Master Key Password to Protect the Hard Disk 

The master key password prevents unauthorized users from gaining 
access to your computer unless they know this password. When you 
reboot your computer, the operating system detects that security is 
enabled and prompts for the master key password. You must enter 
the password in order to obtain access to the operating system. 

You set the master key password when you enabled security in 
SETUP. You can also use SETUP to change this password. 

Security also protects the hard disk from unauthorized access by 
denying access to the hard disk, when an attempt is made to boot 
an operating system from diskette. 
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If you have more than one operating system loaded on your hard 
disk, you must supply the master key password to load any other 
operating systems as well as Novell DOS™ 7. 

Locking your Computer with the Screen Saver 

Use the screen saver to lock your computer if you are going to leave 
it unattended for a short while and do not want to switch it off. You 
can invoke the screen saver from the command line or in 
MS Windows, or you can use it as a TSR. To use it as a TSR, set a 
timeout limit so that if there has been no user input for the specified 
time, the screen saver locks the screen automatically. In order to 
regain access to your computer you must enter the master key 
password, or the password you specified when you started the LOCK 
program. 

Refer to the description of the LOCK command in the "Command 
Reference" chapter of DOSBook for more details about locking your 
computer. Note that you can use LOCK whether or not you have 
enabled security on your computer. 

Protecting Files and Directories with Passwords 

You can protect files and directories individually by assigning 
passwords to them. Refer to the description of the PASSWORD 
command in the "Command Reference" chapter of DOSBook to 
learn how to use this command to assign passwords to files and 
directories. 

Security With the Network 

14-4 

Note~~f' Refer to Chapter 3, "Installing Personal NetWare" for a description of how to 
V install the network software, and to Chapter 20, "Setting Up the Network," for 

a description of how to set up the network. 

In order to keep information secure on a computer that is part of the 
network, there are various issues that you need to consider. When 
you load the network software on a computer so that it can be a 
Personal NetWare server, you are opening up access to the resources 
available on that computer. You need to ensure that all users have 
access to the resources that they need, but also to make sure that 
unauthorized access is not possible. 
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The following is a brief description of some of the features of the 
operating system network that you can use to make sure that 
information on your computer is secure. For a more detailed 
description of any of these aspects of workgroup administration 
refer to Chapter 20, "Setting Up the Network," and Chapter 21, 
"Using the Network." 

Using Access Rights 

You can set access rights on shared directories and shared printers. 
Access rights set the level of access for that resource. When you 
assign access rights, you need to consider both the default access 
rights that apply to the resource, and the non-default rights that 
you can give to a particular user for that particular resource. Make 
sure that the default access rights for the shared directory are 
suitable for the workgroup as a whole, and assign non-default rights 
only when needed. The following is a list of rights available for 
shared directories. 

Right 

All 

None 

Read 

Write 

Explanation 

This gives users all rights to the shared 
directory. 

This stops users from having any access to 
the shared directory. 

This allows users to read files in the shared 
directory and execute them where 
appropriate. 

This allows users to write to files in the 
shared directory, create and delete files, but 
not read them. 

Shared printers have the rights ALL or NONE. 
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Setting Passwords on Accounts 

If you want to ensure that accounts on the network are secure, give 
each account a password. When you create an account, specify that 
the account requires a password. Then give a password for the 
account. Tell the user of the new account what the password is, so 
the user can log in and change that password. 

The SUPERVISOR Account 

The GUEST Account 

In order to be secure, this account must have a password. If you do 
not set a password for this account, anyone can log in to your 
workgroup and change the way the workgroup, accounts, and 
resources are set up. 

It is a good idea to reserve use of the SUPERVISOR account for 
workgroup or server administration only. Use another account for 
day-to-day work. 

While user accounts have passwords set on them, you may like to 
have an account that does not belong to any one user. This is often 
called the GUEST account. Since this account is meant to give 
limited access to anyone, you may not want to set a password on 
this account. If you do not set a password on the account, make sure 
that the default access rights for all resources are suitable for an 
account that anyone could use, and assign non-default access rights 
where appropriate. You could also alter the login times for the 
account, restricting use of the GUEST account to office hours, for 
example. 

If you do set a password on this account, you can change the 
settings so that a user of the GUEST account cannot change the 
password. 
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Creating Local Users 

When you enable security on a computer that is a Personal NetWare 
server, you can give local access to workgroup users by creating local 
users for the computer. A local user must enter a username and 
password to gain access to the resources on that computer when the 
computer is switched on. When you make a local user account, you 
can give access for that account to the hard disk, diskette drives, 
printer, one-time login facility, and the serial communication ports. 

Assigning Workgroup Administrator Piivileges 

If you give an account workgroup administrator privileges, then the 
user for that account can make changes to the way in which the 
workgroup and the resources are set up. Make sure that you only 
give workgroup administrator privileges to users that you want to be 
able to perform workgroup administration tasks. 

Choosing the Security Loadable Module 

The security loadable module is one of the modules that is loaded 
automatically. In order to save space in memory, you can choose 
not to load SOJJ1e of the modules. If you do not load the security 
module, then access rights no longer apply, and all users have access 
to all the resources. 

Disabling an Account 

If you suspect that an account is being misused, you can disable that 
account. The account still exists in the user database but no-one can 
use the account 

Using the Master Key Password 

The master key password is the one you set when you enabled 
security. On a computer that has local users, you can use this 
password in place of any user password. 
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Protecting the Hard Disk on the Client or Server 

Once you have enabled security, the hard disk is protected from 
access via the diskette drive. If anyone attempts to boot up your 
machine using a diskette, they are unable to gain access to the hard 
disk, no matter what operating system they are trying to load. 

Locking the Client or Server 

The LOCK screen saver is available on both server and client 
computers. Local users can use LOCK as a TSR, and specify a timeout 
period. Once LOCK is invoked, either by elapsed time or from the 
command line, you must type in the user password for that account 
to regain access to that computer. 

On a client computer, use the master key password to regain access 
after using LOCK. Refer to the description of LOCK in the 
"Command Reference" chapter of DOSBook for more information 
on using the screen saver and locking your computer. 

Protecting Files and Directories with Passwords 

You can use the PASSWORD command to protect files and 
directories, but note that you will not be able to access a file or 
directory that is protected by a password across the network. You 
can only access such a file or directory from the machine that holds 
that file or directory. 

Security Against Computer Viruses 

A computer virus is a computer program that can replicate itself. In 
order to replicate itself, the virus must first attach itself to a host 
program, and when the host program is run, the virus program is 
activated too. Some viruses also contain code that damages other 
data on the computer. This code can be generated randomly, 
continuously, or can be triggered by external events, such as the 
date. 
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Search and Destroy anti-virus software comprises a memory­
resident program, loaded when you boot your computer, and a 
scanner that searches your hard disk and drives for viruses. You can 
also use the scanner to remove viruses from the hard disk. 

Installing Search and Destroy 

Use SETUP to load Search and Destroy. Once you have loaded 
Search and Destroy, the memory-resident monitor scans memory 
every time you reboot your computer. To protect files on the hard 
disk from being infected, run the Search and Destroy scanner 
regularly. Use the scanner on diskettes with contents you are not 
sure of to prevent any viruses from being transmitted to your 
computer's hard disk from an infected diskette. 

The Search and Destroy Scanner (SDSCAN) 

Once you have installed the scanner, you can run it in three ways. 

+ By using the full screen interface DOS version 

+ By using the MS Windows version if you have MS Windows on 
your machine 

+ By using the scanner from the command line 

Refer to the "Command Reference" chapter of DOSBook for a 
description of using the scanner at the command line. The 
following sections describe how to use the DOS and 
MS Windows versions of the scanner. 

Using the Scanner Under DOS 

To use the DOS scanner, type the following at the system prompt: 

SDSCAN <Enter> 

The scanner first checks memory for viruses and then tests itself in 
order to prevent its own infection. The Search and Destroy Virus 
Scanner/Remover screen displays. 
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Operation 

Start scanning 

Options ... 

Quit SDScan 

List viruses 

This screen displays the operations and drive groups available. The 
operations are: 

Explanation 

Select this to start the scanning operation on the drive listed in the Drive 
Groups field. 

Select this to list the options available for the scanning operation; 
see "Using the Scanner Options" on page 14-11. 

Select this to leave the Search and Destroy virus Scanner/Remover screen. 

This lists all the viruses that Search and Destroy knows about. Note that 
some viruses are included in the same "family" of viruses and not listed 
individually. 

Select an operation by moving the highlight using the cursor keys, 
and press <Enter> to start the operation. 

Scanning a Drive, Directory or File 

You can use the scanner on hard disk drives, network drives, 
diskettes, directories and files. Select the Start scanning option to 
begin scanning the default drive. The default is the hard disk 
drive(s). Use the Drive Groups option to change the drive to scan. 

Changing the Drive to Scan 

Move the highlight to the Drive Groups field by pressing <Tab>. Use 
the cursor keys to move between the different options. Press 
<Spacebar> when the highlight is over the correct drive group. 

Selecting a Directory or File to Scan 

To scan a specific file or directory, select the File/directory ... drive 
group. You can then either type the name of the file or directory you 
want to scan, or to see a list of directories and files on the current 
drive, press <Fl 0>. 
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Using the Scanner Options 

Select Options ... to display the scanner options. The scanner options 
enable you to change which files the scanner scans, whether a 
report is generated and the scanner's action upon finding a virus. An 
asterisk next to an option shows its current setting. 

Select an option by moving the highlight over it using the cursor 
keys and pressing <Spacebar>. The scanner options are: 

+ Look for boot sector viruses: 
*Yes No 

This option tells the scanner whether to scan the disk's boot 
block or partition table. The default is Yes. 

+ Check: 
*Program files All files 

This option tells the scanner whether to search just executable 
program files, or all the files including program and data files. 
The default is to check just the program files because, so far, 
viruses only attach themselves to executable files. 

+ Scan: 
Archive files (ZIP, LHA, ARJ): *Yes No 
Compressed EXEs (LZEXE, PKLITE, DIET): *Yes No 

This option tells the scanner to search archive and compressed 
files for viruses. The default is Yes. 

+ Generatereportto=~~~~~~~~~~~~~~~-

If you enter a filespec in this field, Search and Destroy creates a 
report of the search according to the filespec given. If you do 
not want the report, leave the field blank. Specify PRN to send 
the report to a printer. 

+ Append to existing report: 
Yes *No 

This option tells Search and Destroy to add each new report to 
the existing report file. The default is No. 
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+ When a file is found to be infected: 

This option tells Search and Destroy what action to take if a 
virus is found. Choose from the following options: 

+ *Prompt user 

Prompt user means that the scanner alerts you when it 
detects a virus, and requires a response before removing the 
virus. This is the default. 

+ Report only 

Report only means that the scanner reports that a virus is 
present and takes no further action. 

+ Remove virus 

Remove virus means that the scanner removes the virus 
automatically. 

If you select the Scanner Options in order to check their current 
settings but do not want to change any of them, press <Esc> to leave 
Options ... To save changes made to the settings, press <Ctrl><Enter>. 

Listing the Known Viruses 

Select this option if you want to see which viruses are currently 
known to Search and Destroy. Not all the individual viruses known 
to Search and Destroy are listed, because some are classed as being a 
member of the same virus family and the virus family is listed. 

Quitting the Scanner 

Select the Quit SDScan option to exit the scanner. 

Using the Scanner Under MS Windows 

14-12 

If you installed the MS Windows version of Search and Destroy's 
scanner, you can run the scanner from within MS Windows. 
INSTALL sets up a program icon for you to use. Select the Search and 
Destroy program icon to make this the active window. 
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The screen has a list of drives to the left; drives to scan are marked 
by ticks. At the base of the screen are three buttons for changing the 
drives to scan. Note that where your computer does not have a 
particular type of drive, you cannot press the button for that drive. 
On the right are buttons for 

+ Starting the scanner 

+ Exiting the scanner 

+ Changing the scanner options 

+ Listing the known viruses 

The scanner also has three menus available; Scan, Options, and 
Help. 

Scan Options Help 

Drive(s) Scanning ... Contents 

File Report ... Using help 

Exit About... 

Starting the Scanner 

To start scanning the selected drives, select the Drive(s) option from 
the Scan menu, or press the <Scan for Viruses> button. 

Changing the Drives to Scan 

To change the current drives, select a different drive from the drives 
list, or use the buttons at the base of the screen. 

To scan a specified file, use the File option from the Scan menu. 
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Option 

Scanning scope 

Scanning options 

When a virus is found 

Report 

Scanning Icon 

Changing the Scanning Options 

To change the scanner options, use the Scanning ... option from the 
Options menu, or press the <Options> button. The options you can 
change are listed below. 

Explanation 

Changes the scope of the scanner between program files and all files. The 
default is Program files. 

Selects whether archive and compressed files are scanned. The default is 
to scan both Archive files and Compressed programs. 

Determines the scanner's action on finding a virus. Choose between 
Prompt, Remove, and Report only. The default is for the scanner to 
prompt the user when a virus is found. 

Specifies the name of the report file. The scanner generates a report only 
when there is an entry in the Report field. The default is for the scanner 
not to generate a report. To enter a path and filename for the report, type 
the path and filename directly into the report field, or press the 
<Browse ... > button. To view an existing report file, select the Report ... 
option from the Options menu. 

Selects the icon the scanner uses during the scan operation. The default is 
the Sniffy hound icon. Enable the Scan lconized option if you want the 
scanner screen minimized while it scans. 

Listing the Known Viruses 

Select the <List Viruses> button to see a list of the viruses recognized 
by the scanner. Note that some viruses are listed under the family of 
viruses they belong to rather than as individual viruses. 
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Drag and Drop 

You can scan files using MS Windows "drag and drop" function. 

+ Open the scanner icon to make it active. You can minimize the 
scanner icon if you prefer. 

+ Open the File Manager and open the directory containing the 
file you want to scan. 

+ Select the file to be scanned and drag the file onto the scanner 
icon. 

When you release the mouse button the scanner scans that file. 

Getting Help on Using the Scanner 

There is an extensive online help available with the scanner. Select 
the Contents option from the Help menu to see a list of contents. 
Select the Using help option to learn how to use the online help. 

The Search and Destroy Memory-Resident Monitor (SORES) 

Once installed, the memory-resident monitor checks memory for 
viruses every time you restart your computer. It is called from 
AUTO EXEC.BAT. 

You can also run it at the command line by typing 

SD RES 

followed by options that you can use to change the way SD RES runs 
from your AUTOEXEC.BAT or CONFIG.SYS files. Refer to the 
description of SDRES in the "Command Reference" chapter of 
DOSBook for more information about these options. 

Note~'!~ If you installed the MS Windows version of Search and Destroy, the SORES icon 
Y appears in the Novell DOS 7 window to let you know that SORES Windows 

version is present and working on your computer. 
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Security with Backups 

14-16 

When you take a backup, you make a copy of the information on 
your machine. You can use this copy to replace lost or corrupted 
information. If there is only one copy of the information kept in 
one place, for example, on the hard disk, and the hard disk is 
corrupted in some way, you lose all that information. With a backup 
copy, it only takes a short time to restore the lost information. 

The operating system comes with its own backup facility, FBX. Refer 
to the "Command Reference" chapter of DOSBook for a full 
description of how to use FBX. 

Before you start taking backups, it is a good idea to plan how often 
you need to take backups and what type of backup you need to 
make. 

You can perform a full backup of your hard disk, copying every 
single file on the hard disk, or a partial backup where you only copy 
some of the files according to particular criteria. 

One backup plan might be to take a full backup once a week, and at 
the end of each day, take a partial backup of the files that have 
changed since the last backup was made. It is possible to specify this 
in FBX, or use other criteria to make a partial backup. You can even 
select individual files to backup. However, you must set your own 
backup plan according to what information is essential, or changes 
frequently. Once you have made a backup plan, carry it out 
rigorously. 

A full backup of a hard disk is time-consuming and, if you are copying files to 
diskette, can use a lot of diskettes. Make sure that you have a plentiful supply of 
diskettes and labels. Write the label for each diskette using the name displayed 
as files are being copied to that diskette. 
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chapter 15 
Recovering Information 

The operating system provides several methods of recovering 
deleted data. The chances of successfully recovering a deleted file 
depend on which method the operating system is able to use. This 
chapter provides an overview of file recovery and the recovery aids 
you can use to make this easier and more successful. See the 
command descriptions in the "Command Reference" chapter of 
DOSBook for more information about how to use the file recovery 
commands. 

File Recovery Aids 

DISKMAP 

Before you actually start deleting files, you should know how to use 
two utilities that the operating system provides to aid file recovery 
after delete operations: DISKMAP and DELWATCH. File recovery 
without either of these two methods is referred to as unaided. 

DISKMAP is a utility that copies and saves the File Allocation Table 
(FAT) of a disk. The FAT is like an index to a disk that records the 
location and size of all files on the disk. Running DISKMAP on a 
regular basis means that you always have a recent copy of the FAT, 
and the operating system can therefore retrieve information about 
a deleted file that it would not normally be able to retrieve. Refer to 
the "Command Reference" chapter of DOSBook for a description of 
DISKMAP. 
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DELWATCH 

DELWATCH is another utility provided with the operating system 
that actually saves deleted files on the disk. Instead of removing a 
deleted file, DELWATCH simply marks it as a pending delete file. The 
file appears to be deleted, however. Using DELWATCH means that 
you are fairly sure of successfully recovering a deleted file. Refer to 
the "Command Reference" chapter of DOSBook for a description of 
DELWATCH. 

Recovering Deleted Files (UNDELETE) 

Use the UNDELETE command to recover deleted files, regardless of 
which method the operating system is able to use: DELWATCH, 
DISKMAP, or unaided. UNDELETE automatically determines and 
displays the method available. 

By typing UNDELETE on the command line without a file 
specification, you can use a full-screen menu version of the 
UNDELETE command. The screen you see contains a list of the 
deleted files in your current directory and a series of menu options 
from which to choose. The list displays information about deleted 
files. You can select any of the following menu options: 

+ Start UNDELETE for a selected file 

+ Change the current disk drive 

+ Select a file or group of files 

+ Sort the files in the list by name, extension, date, size, or 
recovery method available 

+ Display different kinds of online help 

+ Exit from UNDELETE and return to the system prompt 
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By typing UNDELETE on the command line with a file specification, 
you start UNDELETE for the specified file. 

For example, to recover a file called REPORT.TXT that you deleted 
from your current directory, you can do either of the following: 

+ Type UNDELETE to use the full-screen version, select 
REPORT.TXT in the list of deleted files, and choose the Undelete 
option from the File menu. 

+ Type the following in the command line: 

UNDELETE REPORT. TXT <Enter> 

You are prompted about proceeding before UNDELETE attempts 
to recover REPORT.TXT. 

Refer to the explanation about UNDELETE in the "Command 
Reference" chapter of DOSBook for more information about using 
this file recovery feature. 
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chapter 16 
Redirecting Information 

Normally, you enter information at the keyboard, which is the 
standard input device, and the information is sent to your screen, 
which is the standard output device. You can redirect this flow of 
information and send it to a place other than your screen, such as a 
file or printer. 

Note that input is simply what you enter at the keyboard, such as a 
command, while output is the result of that command. 

Redirecting Output 

Instead of your information being sent to the screen you can send 
it to a file or print device. To do this you use the redirection symbol 
>. 

For example, to redirect a DIR listing to a file called MYLIST.DOC 
instead of displaying it on the screen, enter the following: 

DIR >MYLIST.DOC 

If MYLIST.DOC does not exist, it is created for you. If it does exist, 
the original is overwritten, so be careful when redirecting to an 
existing file. 

Instead of the filename, you can enter a file specification, if the file 
to which you want to redirect output is not on the current drive: 

DIR >A:\REPORT\MYLIST.DOC 
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Redirecting Output to or from a Device 

Table 16-1 

You can redirect output to a device rather than a file or command. 
Typical devices are printers, plotters, and modems. 

As discussed in Chapter 4, "Working with Novell DOS 7," devices 
are often named according to the communication port on the 
computer to which they are connected. Printers can be called PRN 
or LPTn, (where n could be 1, 2 or 3). Table 16-1 lists the device 
names and shows how they can be used with redirection. 

Device Names and Redirection Use 

Device 

CON 

AUX or COM1 

CO Mn 

PRN or LPT1 

LPT2 

LPT3 

NUL 

Description 

User console (the keyboard and the 
screen). 

First serial communication port. 

Second and subsequent serial ports 
where n is 2, 3, or 4, depending on the 
particular computer. 

First parallel printer. 

Second parallel printer. 

Third parallel printer. 

All output from this device is discarded. 
No input is returned from the device. It 
is used to discard unwanted output. 

Use 

Input and output 

Input and output 

Input and output 

Output 

Output 

Output 

Input and output 

For details on how to set up a port for a particular device, refer to 
the "Command Reference" chapter of DOSBook for a description of 
the MODE command. The form of the command for redirecting to 
a device is: 

command >device 

For example, the following command sends the DIR listing of drive 
A: to the printer rather than to the screen: 

DIR A: >PRN <Enter> 
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Appending Output 

You can append the output of a command to the end of a file, using 
the redirection symbol». For example, to add a file INDEX.DAT to 
the end of an existing file called BOOK.TXT, enter: 

TYPE INDEX.DAT >>BOOK.TXT 

BOOK.TXT now contains the contents of both files. 

Redirecting input 

Sometimes it is useful to make the contents of a file the input for a 
command. You achieve this by using the redirection symbol <. 

For example, to make a file called TELEPH.DOC the input to the 
SORT command (which sorts the contents of a file into alphabetical 
order), enter 

SORT <TELEPH.DOC 

SORT takes the file, sorts its contents alphabetically, and outputs the 
result to the screen. 

Taking this a step further, to store the output of SORT into a file 
instead of just displaying it on screen, enter 

SORT <TELEPH.DOC >TELELIST.DOC 

SORT takes the TELEPH.DOC file, sorts it into alphabetical order, 
and stores the result in the file TELELIST.DOC. 
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Using Pipes and Filters 

Pipes 

Filters 

16-4 

Sometimes you may find it convenient to use the output from one 
program as the input to another. For example, the DIR command 
often produces a listing so long that all of it cannot fit on the screen. 
In this case, you can connect the output of DIR to the input of the 
MORE command, which displays output one screenful at a time, by 
using a pipe. The piping symbol is I (a vertical bar). You would 
invoke the DIR and MORE commands together as follows: 

DIR I MORE 

You can pipe as many commands as you like. Piping is often used 
with filter commands (MORE is a filter command). 

When you pipe programs together, the data piped between them is stored by 
the operating system in temporary files it creates on the default disk; there must 
be sufficient space on the disk for them and the disk should not be write­
protected. The temporary files are removed when the operation is complete. 

The operating system has several commands that act as filters and 
can be piped together. A filter command reads your input, acts upon 
it in some way, and then outputs the result, usually to the screen. 
The following table lists the main filter commands. 

Command 

SORT 

MORE 

FIND 
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Function 

Arranges data into alphabetical order 
before displaying it on the screen. 

Displays the contents of a file a screenful at 
a time. 

Extracts specified items of data to display. 



For example, SORT is often used with the DIR command to sort the 
listing produced, by filename or by file size for example. Entering 
the following in the command line sorts the DIR listing in reverse 
alphabetical order; the /R switch causes sorting from last to first 
rather than from first to last. 

DIR I SORT /R 

The following command sorts a file called NAMELIST.DOC using 
SORT. SORT arranges the contents of the file into alphabetical order 
before it is displayed on the screen: 

SORT <NAMELIST. DOC <Enter> 

Assume NAMELIST.DOC contains the following names: 
HENRY 
SALLY 
JAMES 
SUE 
FRED 

The SORT command would therefore arrange them into 
alphabetical order as follows: 
FRED 
HENRY 
JAMES 
SALLY 
SUE 

In the following command line, DIR and FIND are piped together to 
search for (FIND) and list (DIR) a directory called TEMP: 

DIR I FIND TEMP <Enter> 
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Combining Pipes with Redirection Symbols 

You can also use piping and redirection together. For example: 

DIR I SORT >DIRSORT <Enter> 

This command produces a directory listing which is sorted into 
alphabetical order and then stored in DIRSORT. 

The following command sorts a file called TELE.LST into 
alphabetical order and displays the result a screenful at a time: 

SORT <TELE • LST I MORE <Enter> 
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chapter 17 
Setting Up Code Page Switching 

The operating system allows you to use the range of characters 
required in a number of national languages by interpreting the 
different language-specific characters using a mechanism called 
code page switching. 

Usually you only need to set your computer up for code page 
switching if you 

+ Receive foreign language ASCII do cum en ts in which some 
letters become unintelligible characters when displayed or 
printed. 

+ Use an application that is difficult to read on the screen because 
some graphics characters, such as boxes, appear as letters. 

If you are not in any of these situations, you probably do not need 
to use code page switching, or to read the information in this 
chapter. 

What is Code Page Switching? 

When you press a key on a keyboard (a letter, symbol, or number), 
the computer receives a numeric code that represents the way in 
which that keystroke is to be displayed, printed, and stored. 
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Up to 256 codes are available to represent lower and upper case 
letters, numbers, punctuation marks, and all the mathematical 
symbols on your keyboard. This may seem to be more than enough, 
but it is not possible to represent all the letters and characters used 
in every language in one character set of 256 codes. For example: 

+ Some languages have a much larger alphabet than others and 
include many accented characters. On most keyboards these 
accented characters are produced by adding extra single 
keystroke characters. These key combinations are known as dead 
keys. 

+ Many graphics characters such as lL and II can be entered. 

Character Sets 

To accommodate these differences, a number of character sets are 
available. The numeric code entered when you press a key 
represents a different character depending on which character set is 
in use. 

The most common character set (known as 43 7) is used for several 
languages including English, German, and French. Character sets 
865 and 860 contain the characters needed for Danish and 
Portuguese respectively. In these character sets, some symbols 
available in 43 7 have been removed to make room for the extra 
letters needed. For example, the code for f (franc) has been used for 
6 in 860. 

Definition of a Code Page 

The character sets are stored in a table called a code page. The 
operating system allows you to change the code page that your 
computer uses, allowing you to view in its original form a document 
created using a different code page. Appendix D, "Code Pages" lists 
lhe characters available from different code pages. 
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Table 17-1 

Hardware Code Page 

The hardware code page is the standard code page built into your 
computer. Additional code pages are provided in the Code Page 
Information or .CPI files in your software. Table 17-1 shows the 
national prepared code pages supported by the operating system. 
There is also an international code page, Code Page 850, that can be 
used in any of the countries (see Table 17-1). 

National Prepared Code Pages 

Country Code Pages Used 

Australia 437 850 

Austria 437 850 

Belgium 437 850 

Canada (English) 437 850 

Canada (French) 863 850 

Denmark 865 850 

Finland 437 850 

France 437 850 

Germany 437 850 

Hungary 852 850 

Italy 437 850 

Latin America 437 850 

Netherlands 437 850 

Norway 865 850 

Portugal 860 850 

Russia 866 850 

Spain 437 850 

Sweden 437 850 
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Table 17-1 continued 
National Prepared Code Pages 

Code Page 850 

Country Code Pages Used 

Switzerland (French) 437 850 

Switzerland (German) 437 850 

Turkey 857 850 

United Kingdom 437 850 

United States 437 850 

To simplify the exchange of computerized documents between 
countries, the International Standards Organization (ISO) defined a 
new code page called 850, for use across national boundaries. This 
standard, ISO 8859/1, can be used instead of local code pages and 
reduces the need for code page switching because the sender and 
the recipient always use the same code page. 

Limitations of Code Page 850 

17-4 

In Code Page 850 it was not possible to keep the original code for 
every character in every local code page. For example, two 
characters in 437, the Yen¥ and Cent <t signs, have been moved and 
some graphics characters have been removed to make room for 
characters frequently used in the other languages. 

In most cases you should be able to use either your local code page 
or the international Code Page 850, but there may be occasions 
when you need to switch code pages while you work. 
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Summary 

Some applications are written specifically for Code Page 437, 
especially those that use line-drawing characters. These applications 
may produce displays which are difficult to read when run under 
Code Page 850. Typically, graphics corners and joints become 
accented letters. 

The following is an example of a display that was intended for use 
in Code Page 43 7 and how it looks in Code Page 850. 

~~~~~~~~ A 
I I 
E ~~~~~~~-

Code Page 850 

I I 
¢ 11 11 

Code Page 43 7 

If you are running an application that uses line-drawing characters 
that are not available in the code page delivered on your computer, 
run the application under the code page in which it was written. By 
switching to the original code page, you get a display that is easier 
to read. 

+ If the local code page is not supported by your hardware, you 
can use code page support to remedy this. 

+ If you need to work in more than one language, use Code Page 
850 for all new work. 

+ If you receive a document in a language that was created in a 
local code page, use that code page. If your local language is not 
covered by a specific code page, use Code Page 850. 

+ If you use an application that was written for a particular code 
page, or that uses line-drawing characters, use the code page 
that it was written in. 
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Hardware Supported 

The operating system supports code page switching on EGA and 
VGA displays and on the following printers: 

+ IBM* Proprinter* (4201) and Proprinter XL (4201) 

+ IBM Proprinter X24 ( 4207) and XL24 ( 4208) 

+ IBM Quietwriter* III (5202) 

+ Epson* FX850 and FXlOSO printers 

+ Printers compatible with the above printers 

Setting Up for Code Page Switching 

You can set up your system initially to allow code page switching 
either when you install the operating system or later using the 
SETUP program (see Chapter 9, "Configuring the System"). Either 
way, you configure your system to use code page switching by 
answering a few questions. You need to 

+ Say that you want code page switching 

+ Define which printer(s) will be configured for code page 
switching if required 

+ Select the code page the operating system is to use as the default 
(that is, the one that will be active when the computer is 
switched on) 

Just follow the on-screen prompts provided. 

When you finish installation or SETUP, make sure all printers 
supporting code page switching are switched on and online before 
you reboot your system. 
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When you set up code page switching, certain commands are 
automatically placed in the CONFIG .SYS and AUTO EXEC.BAT files, 
reflecting the parameters that you selected. The keyboard, display 
and printer are set up to use code page switching each time the 
system is turned on. Fonts for the default code page (which are held 
in the .CPI files) are downloaded to all the devices that support code 
page switching. 

Example Configuration Files 

Note,.f" 

This section provides an example of a CONFIG.SYS file and 
AUTOEXEC.BAT file for a system with one printer set up to use 
Code Page 850 as the default code page. 

The hardware code page (that is, the character set available as standard with 
your computer) is always prepared for use. The INSTALL and SETUP programs 
configure your system to allow one alternative code page. The example files 
described in this section are set up to allow you to switch from Code Page 850 
to the hardware code page by entering the CHCP (Change Code Page) 
command at the system prompt (see "Working with Code 
Pages" on page 17-10 in this chapter for a description of CHCP). 

A brief explanation of the commands is given below the example. 
Refer to the "Command Reference" chapter of DOSBook and 
Chapter 9, "Configuring the System," for detailed descriptions of all 
the parameters. 

Example CONFIG.SYS File 

SHELL = C:\COMMAND.COM /P /E:512 

BREAK = ON 

BUFFERS = 15 

FILES = 20 

FASTOPEN = 512 

LASTDRIVE = E 

HISTORY = ON, 256 

COUNTRY = 044,850,C:\NWDOS\COUNTRY.SYS 

DEVICE C:\NWDOS\DISPLAY.SYS CON=(EGA,,l) 

DEVICE= C:\NWDOS\PRINTER.SYS LPT1=(4201,,l) 
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COUNTRY.SYS, PRINTER.SYS and DISPLAY.SYS are the drivers that 
support code page switching. 

COUNTRY.SYS 

COUNTRY.SYS provides the date and time format appropriate for 
your country, the currency symbol of your country, and the code 
page to use. In European countries, for example, the preferred date 
format is day/month/year whereas in the United States the 
preferred format is month/day/year and in Japan it is year/month/ 
day. 

PRINTER.SYS and DISPLAY.SYS 

PRINTER.SYS and DISPLAY.SYS load the drivers for the display and 
printer. The drivers define the number of code pages (in addition to 
the hardware code page) that can be used (1 in the example). 
Memory is set aside for each of these code pages, reducing the 
memory available to run applications. The maximum number of 
code pages you can prepare is 12. 

Example AUTOEXEC.BAT File 

@ECHO OFF 

PATH C:\NWDOS 

VERIFY OFF 

KEYB UK+,850 

MODE CON: CODEPAGE PREPARE=((850) 
C:\NWDOS\EGA.CPI) 

MODE LPTl: CODEPAGE PREPARE=((850) 
C:\NWDOS\4201.CPI) 

NLSFUNC 

CHCP 850 

KEYB, MODE, NLSFUNC and CHCP are the commands that support 
code page switching. 
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KEYB 

Sets the keyboard nationality and the code page that will be used for 
the keyboard. 

MODE device PREPARE 

Prepares a code page for a display or printer. Code pages must be 
prepared before they can be selected. Several code pages can be 
prepared for one device in one statement, the maximum being the 
number defined in the DEVICE=PRINTER.SYS or 
DEVICE=DISPLAY.SYS statement. 

You do not need to prepare the hardware code page. Note that there 
are other MODE code page options, described in the next section. 

NLSFUNC 

Provides support for extended country information and enables you 
to use the CHCP command to select code pages for all devices set up 
to use them. 

CHCP 

Selects a code page for all the devices that are set up for code page 
switching. In the example, 850 will be the active code page when 
the system is turned on. The keyboard, display and printer will be 
set up for Code Page 850. 
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Working with Code Pages 

Changing Between Code Pages 

When you have set the system up for code page switching, it is 
simple to switch from the default code page to any other that was 
prepared (that is, the hardware code page and any other code page 
defined in a MODE PREPARE command). You do this using the 
CHCP command. 

Loading NLSFUNC 

However, before you can use CHCP, NLSFUNC must be loaded. This 
can be done at installation. Typing NLSFUNC on its own at the 
command line loads the program if it is not already installed. 

To change the code page on all devices, from the system prompt 
type: 

CHCP CP <Enter> 

where CP is the number of the code page that you want to use now. 
When the operation is complete, the system prompt is returned. 

The code page is changed on all the devices (displays and printers) 
that were defined as supporting code page switching in the 
CONFIG.SYS file. 

All printers supporting code page switching must be switched on and be online 
when the CHCP command is used. The system may take some time to report 
an error if the printer is not switched on or is off-line. 
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Using MODE SELECT 

You can use the MODE SELECT command to change the code page 
on a single device. If you do this, however, you will find that the 
country information and some other information used by the 
device is set up differently to the rest of the system. 

Changing a Code Page Temporarily 

You may find the MODE SELECT command useful if you want to 
change a code page temporarily on only part of the system. For 
example, you may want to display a document in a local code page 
without printing the document. 

Listing your Current Code Pages 

You can display currently prepared and selected code pages for 
screens or printers using the MODE command as follows: 

MODE device CODEPAGE [/STATUS] 

The selected code page number is displayed, followed by a list of 
hardware code pages defined in the CONFIG.SYS file and code pages 
prepared using the MODE PREPARE command. 

For example if you type: 

MODE LPT 1 CP <Enter> 

You see a display similar to this: 

Active codepage for device LPTl is 850 

hardware codepages: 

codepage 437 

prepared codepages: 

codepage 437 

codepage 850 

Completed codepage status function 
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See the "Command Reference" chapter of DOSBook for more 
information. 

Refreshing Lost Code Pages 

If you select a code page for a printer, then turn the printer off, the 
code page information may be lost. If this happens, you can reload 
the fonts for the active code page on to the printer by using the 
MODE CODEPAGE REFRESH command: 

MODE device CODEPAGE REFRESH 

For example: 

MODE LPTl CODEPAGE REFRESH <Enter> 

refreshes the code page on the printer connected to port LPTl. See 
the "Command Reference" chapter of DOSBook for more 
information. 
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chapter 18 
Introduction to Personal NetWare 

This chapter explains the ideas and terms you will need to know in 
order to use Personal NetWareT~ the networking component of 
Novell DOS™ 7. 

Personal NetWare supplies you with server and client software that 
enables you to set up a network, and connect to a Novell® Net Ware® 
server. You can choose whether to run your machine as a client, or 
client and server. You can also set it up as a peer-to-peer network, or 
as a server-based one, or combine the two approaches depending on 
what resources you need to share between which users. 

Personal NetWare Concepts 

Servers 

Workgroups 

Any computer with a hard disk, running DOS or MS Windows, and 
attached to the network may be set up as a Personal NetWare server. 
Any software or device on (or attached to) a server can be shared 
with other computers on the network. These shared resources 
include printers, space on the server's hard disk, applications, and 
CD-ROMs. All computers, including servers, can be used to run DOS 
and MS Windows programs, because the networking software runs 
unobtrusively in the background. 

If there are NetWare servers on the same network, you can connect 
to them as well as connecting to a workgroup. The term "shared 
directory," as used in this manual, includes "NetWare volume." 
Also, the term "shared printer" includes NetWare print queues. 

For convenience and security the network can be divided into 
workgroups, each containing one or more Personal NetWare servers. 
A workgroup consists of a number of users who require the same 
access to certain information. Rather than making a file or directory 
available to any user on the network, you can make it available to 
the members of a workgroup only. 
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Clients 

User Accounts 

A computer that uses the resources of servers is called a client. It 
makes logical connections, via the network software, to shared 
directories and printers. The terms "connect" and "disconnect," as 
used in this manual, only refer to software connections, not 
physical (cable) attachments. Connecting to network directories 
and printers is called "mapping" and "capturing" respectively in 
Novell NetWare, but the term "connect" is used in this manual 
wherever possible. 

Every user has an account in each workgroup of which they are a 
member. You connect to a workgroup, NetWare servers and/or a 
Net Ware Directory Services™ tree by logging in. This involves typing 
your account's username and, if necessary, your password. 

Each workgroup has a user called SUPERVISOR who has workgroup 
administrator privileges. Other users can be given workgroup 
administrator privileges as well, allowing them to create new user 
accounts and workgroups and perform other administrative 
functions. 

A Personal NetWare server has an owner who can change the server's 
settings. Anyone else to whom the owner has granted the right 
(such as the SUPERVISOR) can also do this. Server settings include 
the rights of all or specific users to access each shared resource 
belonging to that server. 

Figure 18-1 shows a network with a workgroup called ADMIN, 
whose members can use shared directories and printers on two 
Personal NetWare servers. The user called Ray also has an account 
on a NetWare server SERVER!, so he can use its volumes and 
printers as well as using those on RAY_PC and BILL_PC. 

Members of workgroup ADMIN cannot use shared directories or 
printers in the workgroup ACCOUNTS unless they are members of 
ACCOUNTS. Even if you have accounts in two or more workgroups, 
you can only be logged in to one at a time. 

18-2 Novell DOS 7 User Guide 



Figure 18-1 
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As well as sharing disks and printers, you can send short NetWare 
messages to other users who are logged in to the same workgroup or 
server. Messages appear on their screens immediately. 

To share one of your disk drives or printers, enable the server 
software when you install Personal NetWare. Then, use SETUP 
/FIRST or run the NET ADMIN program to specify which printers 
and or disk drives are to be shared and with whom. Often, you will 
not want to share an entire disk drive but only some of the 
subdirectories on it. 

You give the server and each shared directory and printer a name. 
Tell the other users in your workgroup these names and what they 
may use them for. They do not need to know the DOS directory 
path or printer port number you are using, only the name you give 
them. 
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Connecting to the 
Network 

Before you run an application that is to use shared drives or printers, 
you must do the following two things: 

1. Log in to identify yourself and your workgroup. 

2. Connect disk drive letters and printer port numbers to the 
shared drives and printers you want to use. 

Each time you switch on or reboot your computer you must log in 
and connect by running the NET program. To automate the process, 
you can save your current connections in a batch file which will 
then run automatically every time you log in. 

Components of Personal NetWare 

Personal NetWare includes the following components: 

+ Personal NetWare Server 

A DOS TSR (SERVER.EXE) with support for up to SO users per 
workgroup. 

+ Universal Client (Link Support Layer™, network board drivers, 
IPXODI, NetWare DOS Requester™) 

+ Installation Programs 

Installation programs for both DOS and MS Windows. There is 
also an upgrade program for NetWare Lite™ users. 

+ Network Security 

Allows a single password for both Personal NetWare and 
NetWare 4.x servers. Access rights are compatible with NetWare 
4.x but they are in a simpler format for Personal NetWare users. 

+ User Programs 

DOS-based and icon-based (MS Windows) programs for network 
user tasks, such as drive mapping, that are common across all 
versions of NetWare including Personal NetWare and NetWare 
2.x through 4.x. 
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+ Administration Programs 

DOS-based and icon-based (MS Windows) programs for network 
administration tasks that are common across all versions of 
NetWare including Personal NetWare and NetWare 2.x through 
4.x. 

+ Network Diagnostics 

A diagnostics program designed for network troubleshooting 
and planning. 

+ NetWars 

An arcade-style network game for one to four players. 
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chapter 19 
Planning Your Network 

This chapter is aimed at the person who is responsible for installing 
and maintaining the network. To get the most out of Personal 
NetWareT~ it is worth doing some planning before configuring the 
software. Before you start creating servers, workgroups, and user 
accounts, consider your answers to the following questions: 

+ How many workgroups are required? 

+ Which computers should be servers? 

+ Where should security be enabled? 

+ Which workgroup should each server be in? 

+ Which printers should be shared? 

+ Should any printers be moved to more convenient locations? 

+ Who should have accounts in each workgroup? 

All of these issues are discussed in this chapter. Also consider who 
should make the decisions; it may make sense to appoint someone 
to ensure that the workgroup and server names you create are 
unique and helpful. It may also be more efficient and secure for one 
person to do all the software installation. 
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How Many Workgroups Are Required? 

Unless you have a very large number of computers or are concerned 
about security, you should create just one workgroup to start with. 
You can create more workgroups later and move specific servers and 
users between workgroups. You must give each workgroup a name 
(up to 15 characters). 

If you decide to create several workgroups, remember that a user can 
only log in to one at a time so only one set of resources or another 
can be used. 

The networks on different sites can be connected together through 
devices called routers. For the best performance and security, you 
should create different workgroups at different sites. Users at one 
site can log in to workgroups at another site, however. 

If you have Net Ware® 2.x, 3.x or 4.x, you may prefer to use Personal 
NetWare to create NetWare clients only. You need to create 
workgroups only if you want Personal NetWare (desktop) servers. 
You can use Personal NetWare or NetWare commands to control 
Net Ware. 

Which Computers Should Be Servers? 

If you want the greatest flexibility, you should make every computer 
in the network a server. Only a server can share its disks, directories 
and printers, so if two users want to share data it is easiest if both of 
them are servers. 

The costs of making a computer a server are that its user may notice 
a performance degradation when other users are accessing it, and 
that the server software occupies memory while it is running. The 
amount of memory available to DOS applications is reduced by 
40 KB or more. Consider these factors when deciding how many 
servers you need and which computers to make servers. 
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Should Security Be Enabled and Where? 

Note~f" 

It is recommended that you enable security on any computer that 
is to be a server. Do this to prevent someone impersonating the 
owner of the server and gaining unauthorized access to it. When 
you enable security on a server, it is the network software that 
validates user access rights, whether the user is trying to log in at the 
keyboard or over the network. 

Access over the network to any server is controlled by two further 
levels of security. Firstly, users must log in by typing a username and 
password (which is never displayed on the screen), and secondly 
every shared resource can have a list of specific users who are 
allowed to read and/or write it. 

You can use the same username and password to log in to the 
network as the ones you use to start up your computer. This is 
referred to as "one-time login." Logging in this way is easier and 
secure because it encrypts your password as soon as you type it. 
Refer to Chapter 14, "Securing Information," for detailed 
information about the security features available on each computer 
and how they work. 

If you are concerned about security, give the SUPERVISOR account a password 
as soon as you create the first workgroup; by default, it has none. 

Which Workgroup for Each Server? 

Unless you have only one workgroup, you need to decide which 
workgroup to place each server in. You must also give this 
information to network users. Remember that you can change a 
server's workgroup at any time. 

Which Printers Should Be Shared? 

When you decide which printers to share, make sure you inform 
network users of the printer names, locations, and suggested uses. 

Printers are attached to servers. They are available to the members 
of the server's workgroup. 
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Should Printers Be Moved? 

You may want to move printers to more accessible locations before 
setting up the network. Any printer that needs its paper type 
changed often, for example, should be physically located near 
someone who is willing to do this. 

Which Accounts Should Be Created? 

The workgroups you create will probably reflect existing divisions 
within your organization. Remember the following when deciding 
which accounts to create within a workgroup: 

+ You can give users accounts in more than one workgroup but a 
user can only be logged in to one workgroup at a time. 

+ You can give any user workgroup administrator privileges. 

+ You can specify exactly who can change the settings for each 
server, and who can use each shared directory and printer. 

+ There are no restrictions on how many people can log in with 
the same username at the same time, nor on where they do so. 

As well as creating accounts for individual network users, you may 
want to create special-purpose accounts, such as a GUEST account. 
A GUEST account must not have workgroup administrator 
privileges. 
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chapter 20 
Setting Up the Network 

This chapter explains how to set up the network and how to change 
the network configuration. Before setting up your network, it is 
recommended that you read the previous chapter in this manual, 
Chapter 19, "Planning Your Network." 

If you ran SETUP /FIRST after you installed the network, as described 
in the section "After Configuring" on page 3-10, you have already 
set up a basic network and the following are true: 

+ A single workgroup has been created which has at least one 
server in it. 

+ A SUPERVISOR account for the workgroup has been created. 
This account has workgroup administrator privileges. 

+ Accounts are created for all users whether their computers share 
resources (client-servers) or simply use the resources provided 
by other computers (clients only). All these accounts have 
workgroup administrator privileges. No account has a password 
yet. 

+ The resources to share (hard disk drives and printers) have been 
specified. 

You may find that this network is sufficient for your needs. If so, 
refer to the sections "Managing Servers" on page 20-14, "Sharing 
Directories" on page 20-24, and "Sharing Printers" on page 20-32 to 
learn how to set these up for use. If you do not want every user of 
the workgroup to have administrative privileges, or if you want to 
create other accounts in the workgroup, refer to "Creating and 
Modifying User Accounts" on page 20-6. 
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If you did not use SETUP /FIRST, you must set up the network as 
described in this chapter. The tasks you need to perform to set up 
the network are listed as follows in the best order for doing them. 

+ Creating a Server (20-2) 

+ Creating a Workgroup (20-3) 

+ Creating and Modifying User Accounts (20-6) 

+ Changing a Server's Workgroup (20-11) 

+ Managing Servers (20-14) 

+ Sharing Directories (20-24) 

+ Sharing Printers (20-32) 

Creating a Server 

20-2 

When you install Personal NetWareT~ you create a server by 
selecting the option Share this computer's resources. You can choose 
to share any of your drives or printers. To create a server on a 
computer, if you did not select this option during installation, run 
SETUP and choose the option Share this computer's resources. 

Note that when you add a computer to an existing workgroup, at 
least one server must be switched on and running in the workgroup 
in order for SETUP to be able to detect the workgroup. 

Once a server is created, its owner should be aware of the following 
obligations to other users. 

+ Other users cannot access the server unless it is running DOS 
and the network software is loaded. 

+ Do not reboot or switch off the computer without checking to 
make sure that other users do not have connections to it. They 
could lose information, although the network software 
attempts to reconnect users if you immediately restart the 
server. 
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If this is the first server on the network, leave it running while other 
users install Personal NetWare. 

Creating a Workgroup 

checklistV 

When you create the first server on the network, you can create a 
new workgroup for this server by using SETUP /FIRST immediately 
after configuring, and entering a name for the workgroup. If you do 
not use SETUP /FIRST, or if you later create another workgroup, the 
local server (that is, the server that is loaded on the computer in 
front of you) becomes the first server in the new workgroup. 

Before you can create a workgroup you must do the following: 

0 Make sure the server that you want to add to the workgroup is 
loaded. 

If a workgroup has been created already, and the server has been 
added to it, you must also 

0 Log in to the server's current workgroup. 

0 Make sure you are the server owner or have rights to manage the 
server. 

Also, you should have decided the following: 

+ A name for the new workgroup. All workgroup names on a 
network should be different; otherwise users will find them 
difficult to distinguish. 

+ Whether you want the server's existing shared resources 
(directories and printers) to be moved to the new workgroup or 
deleted. 
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+ Whether you want the new workgroup to have the same list of 
routes as the old one. 

Routes are the identifiers used for network communications. If 
your network boards are all the same type and connected to the 
same network, you only need one route to address them. You 
will need multiple routes only if you have a complex 
configuration, including a router or a NetWare® server acting as 
a router. In those cases, whoever installed the NetWare or other 
network should be able to advise you about routes. 

+ Whether you want to reset the new workgroup's user database, 
or copy it from the server's previous workgroup. 

If you reset the user database the following occur: 

+ The new workgroup is created with just one user called 
SUPERVISOR, without a password. 

+ The owner of the server is set to SUPERVISOR. 

+ You are logged in to the new workgroup as SUPERVISOR. 

If you do not reset the user database 

+ Users of the old workgroup are also given accounts in the 
new one, with the same passwords and privileges, and with 
the same rights on your server. 

+ You are logged in to the new workgroup with the same 
username as you had in the old one. 

You can create a new workgroup from DOS or MS Windows. 

Creating a Workgroup from DOS 

20-4 

ProcedureT 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. If this is the first workgroup you are creating, ignore Step 3 and 
proceed to Step 4. 
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3. If you are not logged in, you can log in now by choosing Login ... 
from the Workgroup menu. 

4. Choose Create ... from the Workgroup menu. 

5. Type in the new workgroup's name. 

6. Select whether to move the existing shared resources, if any, to 
the new workgroup. 

7. Select whether to copy the known routes to the new 
workgroup. 

8. Select whether to reset the user database. 

9. Choose the <OK> button to proceed. 

The server is now in the new workgroup. The next step is to create 
user accounts in the new workgroup. 

If the SUPERVISOR account does not have a password yet, give a 
password for the SUPERVISOR account now. The section, "Creating 
and Modifying User Accounts" on page 20-6, describes how to 
assign passwords. 

Creating a Workgroup from MS Windows 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

To choose an object, double-dick it or highlight it and press 
<Enter>. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-dick the 
NetWare icon in the main window. 

Note that if the <Include non-connected resources> button is 
selected, you can adjust the widths of both sides of the window. 
The left side shows current connections, the right side shows 
other objects. 
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3. If you are creating the first workgroup, ignore Step 4 and 
proceed to Step 5. 

4. Select an existing workgroup. 

5. From the File menu, choose New ... , or press <Ins>. 

The Create New dialog appears. 

6. In the Type list box, choose Workgroup. 

7. In the Name text box, enter a name for the new workgroup. 

8. Choose the <OK> button. 

9. In the Create Workgroup dialog which appears 

9a. Choose whether to move the existing shared resources to 
the new workgroup. 

9b. Choose whether to copy the known routes to the new 
workgroup. 

9c. Choose whether to reset the user database. 

9d. Choose the <OK> button. 

The server is now in the new workgroup. The next step is to create 
user accounts in the new workgroup. 

If the SUPERVISOR account does not have a password yet, give a 
password for the SUPERVISOR account now. The following section, 
"Creating and Modifying User Accounts," describes how to assign 
passwords. 

Creating and Modifying User Accounts 

Users with workgroup administrator privileges (such as 
SUPERVISOR) can create, modify, disable, or delete a workgroup's 
user accounts. 

If you have NetWare on your network, you should use the same 
account usernames that already exist in NetWare, so that you can 
use the one-time login facility. 
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checklistV 

Before you can create or modify a user account 

0 You must be logged in to the appropriate workgroup. 

0 You must have workgroup administrator privileges. 

0 Decide whether to give the user workgroup administrator 
privileges. A workgroup administrator can 

+ Create workgroups. 

+ Create, modify or delete any user's account except the 
SUPERVISOR account. 

+ Reconfigure any server which has workgroup administrator 
rights set to ALL (or READ and WRITE). Refer to 
"Configuring a Server" on page 20-14. 

+ View and delete the workgroup's audit log. Refer to "Audit 
Log" on page 22-4. 

+ View and delete the workgroup's error log. Refer to "Error 
Log" on page 22-6. 

Always give a password to any account that has workgroup administrator 
privileges to prevent use of the account by anyone other than its proper 
user. 

You can create or modify an account from DOS or MS Windows. 

Creating or Modifying an Account from DOS 

ProcedureT 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. If you are not logged in, you can log in now by choosing Login ... 
from the Workgroup menu. 

3. Choose Users from the View menu. 
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To 

Create a user account 

Modify a user 
account 

Rename an account 

Delete a user account 

4. Refer to the following table for information about what to do 
next. 

Do this 

1. Choose Add ... from the File menu or press <Ins>. 

The Add User dialog appears. 

2. Type the username (up to 15 characters, no spaces) and choose <OK>. 

The Account Properties dialog appears. 

3. Complete the dialog as described on page 20-9. 

1 . Select a username from the list. 

2. Choose Properties ... from the File menu or press <Alt><Enter>. 

The Account Properties dialog appears. 

3. Complete the dialog as described on page 20-9. 

1 . Select a username from the list. 

2. Choose Rename ... from the File menu or press <F3>. 

3. Edit the name field in the dialog that appears. 

1. Select a username from the list. 

2. Choose Delete ... from the File menu or press <Del>. 
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Field 

User's full name 

Account disabled 

Workgroup 
Administrator 

Allow to change 
password 

Password required 

<Login Times ... > 

<Password ... > 

Min. length, Unique, 
Changes required, 
and Days between 
changes 

The Account Properties dialog has the following fields: 

Purpose 

Provides the user's full name. 

Allows you to disable an account temporarily. 

Gives the user workgroup administrator privileges. 

Allows the user to change their own password. Normally enabled, but you 
should disable it for GUEST accounts. 

Ensures the account always has a password. 

Allows you to specify, in half hour units, when this user is allowed to be 
logged in. During a restricted time the user cannot log in. 

Allows you to give the account a new password. Note that you do not 
have to know its existing password. 

Control passwords to ensure security standards are maintained. 
Uniqueness tests that an old password is not reused. Changes required 
forces a user to change the password regularly. 

5. If you are creating a workgroup, configure the server next, as 
described in "Configuring a Server" on page 20-14. 

Creating or Modifying an Account from MS Windows 

Procedure"i" 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Double-click the workgroup's icon in the NetWare window to 
select it and show its objects. 
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To 

Create a user account 

Note~f' 

Set a user's password 

Modify a user 
account 

Delete a user account 

4. Refer to the following table for information about what to do 
next. 

Do this 

1 . From the File menu, choose New ... , or press <Ins>. 

The Create New dialog appears. 

2. In the Type list box, select User. 

3. In the Name text box, type the username (up to 15 characters, no 
spaces). 

4. Choose the <OK> button. 

The Account Configuration dialog appears. 

5. Complete the dialog as described on page 20-11. 

The account has no password initially. Set it, if required, as described next. 

1 . Select the relevant username from the list in the NetWare window. 

2. From the File menu, choose Properties ... , or press <Enter>. 

3. Choose the <Set Pass ... > button on the User Information dialog. 

The Set Password dialog appears. 

4. Complete the dialog. You must type the new password twice to ensure 
that it is correct. 

1. Select the relevant username from the list in the NetWare window. 

2. From the File menu, choose Properties ... , or press <Enter>. 

3. Choose the <Configure ... > button. 

The Account Configuration dialog appears. 

4. Complete the dialog as described on page 20-11. 

1. Select a username from the list in the NetWare window. 

2. Choose Delete ... from the File menu or press <Del>. 
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Field 

Login name 

User's full name: 

Account disabled 

Workgroup 
Administrator 

Allow to change 
password 

Password required 

Min. length, Unique, 
Changes required, 
and Days between 
changes 

The Account Configuration dialog has the following fields: 

Purpose 

The username which the user types when logging in. Must be one word 
of up to 15 characters. 

Provides the user's full name. 

Allows you to disable an account temporarily. 

Gives the user workgroup administrator privileges. 

Allows the user to change their own password. Normally enabled, but you 
should disable it for GUEST accounts. 

Ensures the account always has a password. 

Control passwords to ensure security standards are maintained. 
Uniqueness tests that an old password is not reused. Changes required 
forces a user to change the password regularly. 

5. If you are creating a workgroup, configure the server next, as 
described in "Configuring a Server" on page 20-14. 

Changing a Server's Workgroup 

After creating a workgroup, move those servers to it whose resources 
you want to share with users in that workgroup. You can also 
change the workgroup of any server at any other time. 

Before you can move a server to a new workgroup, you must do the 
following: 

0 You must be working on the server whose workgroup you want to 
change. 

0 You must log in to the server's current workgroup, if any. 

0 You must be the server owner or have rights to manage the server. 
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0 At least one server in the workgroup to which you want to move 
must be available (running). 

0 You must have a username and password for the workgroup to 
which you want to move the server. 

You can change a server's workgroup from DOS or MS Windows. 

Changing a Server's Workgroup from DOS 

ProcedureT 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Select your server from the list. 

3. Choose Properties ... from the File menu, or press <Enter>. 

4. In the Server Properties dialog, choose the <Set Workgroup ... > 
button. 

The dialog that appears lists all the local workgroups in which 
at least one server is running. It does not, initially, list remote 
workgroups on a wide area network. 

5. To include remote workgroups, choose the <Find workgroup ... > 
button. This may take a minute or more. 

6. Select the required workgroup from the list. 

7. Select whether to move the existing shared resources to the 
new workgroup. 

If you do not select this option, the server's shared printer and 
shared directory information is lost. If the server has no shared 
resources, this option is not selectable. 

8. Choose the <OK> button to continue. 
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9. Confirm that you want to log out of the old workgroup and in 
to the new one. 

You cannot proceed without doing this. 

10. Give your username and password for the new workgroup. 

The server is now in the new workgroup. 

If you want to create or change shared directories or printers, or to 
change the rights of users in the workgroup to manage and use the 
server, refer to the section "Managing Servers" on page 20-14. 

Changing a Server's Workgroup from MS Windows 

Procedure'W 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

To "choose" an object, double-click it or highlight it and press 
<Enter>. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

Note that if the <Include non-connected resources> button is 
selected, you can adjust the widths of both sides of the window. 
The left side shows current connections, the right side shows 
other objects. 

3. Double-click the workgroup's icon in the NetWare window to 
show its objects. 

4. Select the server's name. 

5. From the File menu, choose Properties ... 

The Server Information dialog appears. 

6. Choose the <Set Workgroup> button. 

The Change Workgroup dialog appears. It lists all local 
workgroups in which at least one server is available. 
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7. Choose the <All Workgroups> button if the desired workgroup is 
not shown because it has no servers on your local network. 

8. From the list box, choose the required workgroup. 

9. Choose the <OK> button. 

The Login dialog appears. You must log in to continue. 

10. Type your username, if not shown correctly, and your 
password. 

11. Choose the <OK> button to log in. 

12. Choose the <Close> button to close the Server Information 
dialog. 

Managing Servers 

When you create a server, you can allow the software to set default 
values for all settings. With knowledge of your requirements, or by 
observing network and server statistics, you may be able to choose 
more optimal values yourself. Also, you can select which users have 
the rights to manage the server. 

As well as configuring a server, you can synchronize server clocks 
and obtain performance information about the server. 

Configuring a Server 

checklistV 

You can display the server configuration dialogs to see what the 
current server settings are, or to change them. Change them only if 
experience tells you that server performance can be improved by 
doing so. 

Before you can configure the server, you must do the following: 

0 You must log in to the server's workgroup. 

0 You must be the server's owner or have rights to manage the server. 

0 The server must be available (running). 
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You can display or change a server's settings from DOS or MS 
Windows. 

Configuring a Server from DOS 

ProcedureT 

Field 

Description 

Owner 

Workgroup 
Administrator Rights 

Automatic 
Configuration 

1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Select the server that you want to configure. 

If the server is listed as not available, you cannot configure it. 

3. Choose Properties ... from the File menu, or press <Enter>. 

If the Server Properties dialog shows that more than one 
connection exists, someone else is connected to the server, so 
you may not be able to reconfigure the server. 

4. In the Server Properties dialog, choose the <Configure ... > 
button. 

The Server Configuration dialog appears. The dialog has the 
following fields: 

Purpose 

This can give more information about the server. 

The owner can always configure the server. Only the owner may change 
this field. 

ALL means any workgroup administrator can configure the server. NONE 
means they cannot, unless they are named as a Server Manager with 
rights set to ALL. 

Selects one of three sets of server parameters. You can choose between 
maximum performance, minimum use of memory, or a balance between 
these. 

In the Advanced Settings dialog you can change any of the server 
configuration parameters that affect memory and performance. 
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Field Purpose continued 

<Server Managers ... > A list of users who are server managers with more orfewer rights than the 
default. Set the rights to ALL or NONE. 

<Advanced Settings ... > Displays the Advanced Settings dialog, which shows settings which you 
can change in order to improve the server's performance or memory 
usage. Some of these are explained in "Advanced Server Settings" on 
page 20-19. 

<Loadable Modules ... > Displays a dialog which lets you specify which server components you 
want to be loaded. You can reduce the amount of memory the server uses 
by not loading unused modules, but if you load DPMS the modules load 
in extended memory, so have very little impact on conventional memory. 

Renaming a Server from DOS 

ProcedureV 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Select the server that you want to rename. 

If the server is listed as not available, you cannot rename it. 

3. Choose Rename ... from the File menu, or press <F3>. 

Configuring a Server from MS Windows 

20-16 

ProcedureV 

This procedure performs all server configuration functions except 
for setting which users have the right to configure the server. To set 
these rights, see "Setting Users' Rights to Configure a Server from 
MS Windows" on page 20-18. 

1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

! 
2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 
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Field 

Server Name: 

Owner: 

Description: 

Allow Server to Load 

Parameters 

Modules 

3. Choose (double-click) the workgroup's icon in the NetWare 
window. This shows the workgroup's objects. 

4. Select the server. 

5. From the File menu, choose Properties ... 

The Server Information dialog appears. 

6. Choose the <Configure ... > button. 

The Server Configuration dialog appears. The dialog has the 
following fields: 

Purpose 

The name all users see in server lists. Make sure no one is connected to the 
server when you rename it. 

The owner can always configure the server. Only the owner may change 
this field. 

A longer name that could give more information about the server. 

Can be deselected to disable the server and free up 40 KB or more of 
memory temporarily. You must reboot the computer before this takes 
effect, though you can often unload the client and server by typing 

VLM /U <Enter> 
SERVER U <Enter> 

Settings which you can change in order to improve the server's 
performance or memory usage. These are explained in "Advanced Server 
Settings" on page 20-19. 

Lets you specify which server components you want to be loaded. You can 
reduce the amount of memory the server uses by not loading unused 
modules, but if you load DPMS, the modules load in extended memory so 
have very little impact on conventional memory. 
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Setting Users' Rights to Configure a Server from MS Windows 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
Net Ware icon in the main window. 

3. Choose (double-click) the workgroup's icon in the NetWare 
window. This shows the workgroup's objects. 

4. Select the server. 

5. From the File menu, choose Rights ... 

The Rights dialog appears, showing workgroup administrators' 
rights and a list of all users. 

6. To change the rights of all workgroup administrators, except 
those explicitly excluded in Step 7, change the READ and WRITE 
settings together. 

7. To change the rights of any user, select the user from the list, 
then give them one of the following rights: 

• Default: 

If the user is a workgroup administrator, their rights will be 
those set for workgroup administrators. Otherwise, they will 
be none. 

• Explicit: Read and Write: 

The user is allowed to manage the server. 

• Explicit: Neither Read nor Write: 

The user is not allowed to manage the server, even if they are 
a workgroup administrator. 
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Advanced Server Settings 

The advanced settings allow you to fine-tune server performance. In 
most cases, the default server configuration values provide suitable 
performance. Change them only if performance deteriorates. 

Before changing settings for a server, make sure you know the 
statistics and configuration settings that are related to the 
performance problem. You can obtain statistics about network 
traffic and server performance by displaying the server Statistics 
dialog, as described in "Obtaining Performance Statistics" on page 
20-20. 

The following are examples of situations that could require you to 
change the server configuration: 

+ If the response time of the server increases, try increasing the 
size and number of buffers. You could also use SETUP to change 
the BUFFERS statement in CONFIG.SYS. 

+ If you get errors from the server indicating that files cannot be 
opened, increase the number of buffers. You could also use 
SETUP to change the FILES statement in CONFIG .SYS. 

+ If shared directories or printers are suddenly unavailable, check 
the maximum number of connections allowed and increase it if 
necessary. 

When setting the size and number of buffers, consider the 
following: 

+ If you have a server sharing numerous applications in the 
workgroup, you may want to increase the size and number of its 
directory and receive buffers. 

Increasing the receive buffer size allows clients to request more 
data from or send more data to the server with each read and 
write operation. When more data is sent, fewer requests are 
necessary so you get better performance from the server. 

+ The number of receive buffers does not need to be more than 
two above the number of simultaneous connections but it 
should not exceed 12 receive buffers. 
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+ Generally, 8 to 12 receive buffers and 1to41/0 buffers are 
sufficient. 

+ Using multiples of 512 bytes, increase the receive buffer size to 
the maximum supported by the network topology (for example, 
Ethernet or token ring) up to a maximum of 4096 bytes. 
However, increasing the size of the receive buffer increases the 
size of the server software when it is in RAM. If you enter too 
large a number, the network software uses the highest value that 
the network board can transmit or receive. Refer to the 
documentation for the network board to find out the maximum 
receive buffer size supported by the network topology. 

Obtaining Performance Statistics 

checklistV 

Once a server has been running, you can display information about 
its performance measurements. You can then use these in deciding 
how to improve performance, as described in "Configuring a 
Server" on page 20-14. 

Before you can view the server's performance statistics, you must do 
the following: 

0 You must log in to the server's workgroup. 

0 You must be the server owner or have rights to manage the server. 

You can display the performance statistics from DOS or MS 
Windows. 

To Display the Performance Statistics from DOS 

ProcedureT 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. In the Servers view, select the required server. 

3. Choose Properties ... from the File menu, or press <Enter>. 
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4. In the Server Properties dialog, choose the <Statistics ... > button. 

The statistics show the cumulative and current values and the 
configured limits. These are explained in "Configuring a Server" 
on page 20-14. 

5. In the Server Statistics dialog, choose the <Next...> button to 
see more statistics. 

To Display the Performance Statistics from MS Windows 

Procedure W., 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Choose (double-click) the workgroup's icon in the NetWare 
window. This shows the workgroup's objects. 

4. Select the server. 

5. From the File menu, choose Properties ... 

The Server Information dialog appears. 

6. Choose the <Statistics ... > button. 

The Server Statistics dialog appears, showing current and 
cumulative values and configured limits. These are explained in 
"Configuring a Server" on page 20-14. 
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Setting a Server's Local Security 

checklistV 

ProcedureT 

Network clients can only access the shared resources on a server, 
according to the user's rights. The person sitting at the server's 
keyboard can perform many more operations on the server. If you 
are concerned about the security of a server, you can restrict the 
operations that different users can perform at its keyboard by 
enabling security. 

Before you can set local security for a server, you must do the 
following: 

0 The computer must have security enabled. To enable security, 
use SETUP. 

0 You must be working on the server for which you want to set local 
user security. 

0 You must log in to the server's workgroup. 

0 You must be the server owner or have rights to manage the server. 

To set local security for a server, do the following: 

1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Choose Machine Security from the Workgroup menu. 

The Local Security dialog appears. It has a list of local users who 
are allowed to use the computer. Initially, the list is empty. You 
may add names, delete them, or modify their rights. Each user 
may be given rights to log in, to use the diskette drives and serial 
and parallel ports, and to have a one-time login script. 

If there is at least one local user, you are asked for your name 
and password whenever the computer is rebooted. If not, you 
are asked for the Master Key password. 
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Synchronizing Server Clocks 

checklistV 

Some applications, such as databases, depend on accurate time­
stamping of files. If you are saving files on different computers, it 
can be important that their clocks are synchronized. 

Before you can synchronize the server clocks, you must do the 
following: 

0 You must log in to the workgroup. 

0 You must have workgroup administrator privileges. 

You can synchronize server clocks from DOS or MS Windows. 

To Synchronize Server Clocks from DOS 

ProcedureT 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Choose Sync Server Time ... from the Workgroup menu. 

A dialog appears in which you can set the current date and time. 

3. Choose the <OK> button to set all servers in the workgroup to 
this date and time. 

To Synchronize Server Clocks from MS Windows 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Select the workgroup's icon in the NetWare window. 
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4. From the File menu, choose Prnperties ... 

The Workgroup Connection Information dialog appears. 

5. Choose the <Sync Servers> button. 

The Date and Time Synchronization dialog appears. 

6. Set the correct date and time, then choose the <OK> button to 
synchronize servers to that time. 

Sharing Directories 

Server owners can share DOS directories, subdirectories, and files on 
their hard drives (including CD-ROM drives) with other users in the 
same workgroup. 

The server owner, or any other user with the right to manage the 
server, specifies that the drive or directory is to be shared, gives it a 
name, and specifies who can access it. Then, any user who logs in 
can connect to the shared directory, if they have the rights to do so, 
by mapping an unused DOS drive letter to it. All references 
subsequently made to files or subdirectories on that drive actually 
refer to files or subdirectories within the shared directory on the 
server. 

You can use shared directories for many purposes, including the 
following: 

+ Sharing a single copy of an application program so that there is 
no need to keep a copy on each client's hard disk. This is further 
explained in "Sharing an Application" on page 20-30. Ensure 
that you only share applications that are licensed for network 
use. 

+ Sharing data: static, read-only, or dynamically changing 
information. The system makes sure that only one user at a time 
can change the contents of a file. 

+ Sharing spare space on hard disks. 
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Directory Security 

Access Right 

ALL (READ - WRITE) 

WRITE 

READ 

NONE 

Note that some applications may require that particular files be in a 
root directory. A shared directory to which a client has mapped a 
drive letter appears to applications as a root, regardless of its actual 
DOS path. Subdirectories within a shared directory do not, but you 
can make any subdirectory be a shared directory in its own right, 
and users can map to it, if it must behave as a root. 

You can choose which workgroup users are allowed to access each 
of your directories and what type of access they have. For example, 
all workgroup administrators might be given read and write access, 
while GUEST can only read. 

You cannot individually set access rights to each file in a shared 
directory, but you can set access rights to subdirectories within a 
shared directory. You do this by declaring a subdirectory to be a 
shared directory itself. For example, even if all users have all rights 
to C:\PUBLIC, you could restrict C:\PUBLIC\PRIVATE to be 
readable only by yourself by making it a shared directory in its own 
right. If C:\PUBLIC\PRIVATE was not a shared directory, then 
access rights to it would be the same as to C: \PUBLIC. 

There are four levels of access rights, any of which may be made the 
default or given to certain named users. They are as follows: 

Description 

Users can perform all operations on files in the directory. 

Users can create new files and write to existing files. They cannot read or 
execute existing files, or scan the directory. 

Users can read and execute existing files and scan the directory. 

Users can connect to the directory but they have no rights in it. Users can 
have rights to a subdirectory within it, if the subdirectory itself is made a 
shared directory. 

If you want to restrict access to a shared directory, assign READ, 
WRITE, or NONE as the default user access rights, and specify the 
usernames of anyone who is to have ALL rights. 
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You cannot access password-protected files (on servers running 
Novell DOS™) across the network. 

Naming Shared Directories 

Note.,.f" 

When you create a shared directory, you give it a name which 
should describe the contents of the directory to help users locate 
applications and files. 

Do not confuse the name of the shared directory with its DOS name. For 
example, the DOS path C:\PUBLIC\CUST.DAT identifies a directory called 
CUST.DAT which could be given the name NEW_CUSTOMERS as a shared 
directory. 

It is sometimes best not to include the name of the server in the 
name of the directory. Excluding the server name makes it possible 
to move a directory to another server without having to change 
workgroup users' batch files to access the moved directory, although 
login scripts explicitly specify server names. 

Creating, Modifying, and Removing Shared Directories 

checklistV 

Before you can manage shared directories, you must do the 
following: 

0 You must log in to the server's workgroup. 

0 You must be the server owner or have rights to manage the server. 

0 Before deleting or moving a shared directory, make sure that no 
user has an open connection to it. Refer to "Closing Down Your 
Server" on page 21-42. 

You can manage shared directories from DOS or MS Windows. 
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To Create, Modify or Delete a Shared Directory from DOS 

ProcedureT 

To 

Share an existing 
directory or create a 
shared directory 

Modify access rights 
to a shared directory 

1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Choose Shared Directories from the View menu. 

The screen changes to show all existing shared directories on all 
servers in your workgroup. 

3. The following table shows the procedures for managing shared 
directories. 

Do this 

1 . Choose Add ... from the File menu or press <Ins>. 

The Add Shared Directory dialog appears. 

2. Type a name for the directory and select the server it is on, then choose 
the <OK> button. The name need not be the same as the directory's 
DOS name. It may have up to 15 characters, but no spaces. 

The Directory Properties dialog appears. 

3. Type the actual DOS path or choose the <Browse Path ... > button to see 
the list of directories on the server. If the directory does not already 
exist, you may create it now by choosing the <Create ... > button on the 
Browse Path dialog. 

4. Complete the Directory Properties dialog according to what you want 
to do. 

1. Select the directory from the list. 

2. Choose Properties ... from the File menu or press <Alt><Enter>. 

The Directory Properties dialog appears. 

3. Complete the dialog according to what you want to do. 
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To 

Move a shared 
directory to a 
different location on 
the same server 

Rename a shared 
directory 

Stop sharing a 
directory 

Field 

Default Access Rights 

<Browse Path ... > 

<User Rights ... > 

Suggested Drive 

Do this continued 

1 . Select the directory from the list. 

2. Choose Properties ... from the File menu or press <Alt><Enter>. 

3. Edit the DOS path. 

1 . Select the directory from the list. 

2. Choose Rename ... from the File menu or press <F3>. 

3. Edit the name in the dialog that appears. 

This affects the name other network users see, not the DOS name. 

1. Select the directory from the list. 

2. Choose Delete ... from the File menu or press <Del>. 

This does not delete the DOS directory or any of its contents. It merely 
stops network users connecting to it. 

The Directory Properties dialog has the following fields: 

Purpose 

Sets the rights of all users except those listed in <User Rights ... >. 

Refer to "Directory Security" on page 20-25. 

Shows you all existing DOS directories. Allows you to select one of these 
or to create a new one. 

Lets you control who may do what with a directory. Typically used either 
to give the server owner more rights or to give guests fewer rights than 
the default. 

The User Rights dialog lists all users who have non-default rights. You can 
add or remove usernames and modify individual users' rights. 

Allows you to specify the drive letter to which users should map this 
directory. This is only used if the mapping is made by the NET MAP 
command without specifying a drive letter. 
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To Create, Modify or Delete a Shared Directory from MS Windows 

ProcedureT 

To 

Share an existing 
directory 

1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Choose (double-dick) the workgroup's icon in the NetWare 
window. This shows the workgroup's objects. 

4. The following table shows the procedures for managing shared 
directories. 

Do this 

1. Choose (double-click) the required server's icon. This shows its drives. 

2. Choose the required drive icon to show its first level directories. 

3. If necessary, choose the required directory icon to show lower level 
subdirectories. Repeat until the required subdirectory is visible. 

4. From the File menu, choose Share ... 

The Share dialog appears, showing the name by which the directory will 
be known on the network. By default, this name is the same as its DOS 
name. 

5. If desired, type a name for the directory. The name need not be the 
same as the directory's DOS name. It can have up to 15 characters, but 
no spaces. 

6. Choose the <OK> button. The Rights dialog appears. 

7. Set the default rights for all unspecified users. 

8. If desired, set the rights of specific users by selecting the user's name, 
then setting a combination of read and/or write rights. Repeat for all 
the users who are to have non-default rights. 

9. Choose the <Close> button on the Rights dialog. 

The directory is now shared. It will appear in the NetWare and Drives 
windows of all the workgroup's users. 
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To 

Modify access rights 
to a shared directory 

Stop sharing a 
directory 

Do this continued 

1. Select the directory in the NetWare window. 

2. From the File menu, choose Rights ... 

The Rights dialog appears. 

3. Set the default rights for all unspecified users. 

4. To set the rights of a specific user, select the user's name, then set a 
combination of read and/or write rights. Repeat for all the users who 
are to have non-default rights. 

5. Choose the <Close> button. 

1 . Select the directory in the NetWare window. 

2. From the File menu, choose Delete ... or press <Del>. 

Note that this does not delete the DOS directory or any of its contents. It 
merely stops network users connecting to it. 

Sharing an Application 

20-30 

One of the uses of a shared directory is to share an application. This 
allows you to keep just one copy of the application on a server. It is 
easier to maintain, and saves disk space on users' computers. 

Many applications, however, need special attention if installed onto 
a network server. Consider the following: 

+ They may keep a file with the users' preferences and hardware 
configurations. These files must not be shared. 

+ They may be network-aware. If so, they may need to know what 
network type they are running on so that they can control it 
directly. 

+ They may modify system files such as CONFIG.SYS and 
AUTOEXEC.BAT when you install them. 

+ Their license conditions may prohibit network use. Always 
check this before installation. 
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checklistV 

ProcedureT 

Before installing an application, know the hardware configurations 
of the computers that will use it. 

Assume you are installing the application TESTAPP.EXE, for 
example, and the installation program asks what kind of monitor 
will be used with the application. Some of the computers on your 
network might have a VGA screen, but others have EGA. You should 
install TESTAPP.EXE for EGA, because VGA screens can display EGA, 
but not vice versa. 

If you are a client, connected to the server and have ALL (or READ 
and WRITE) rights for the directory onto which you want to install 
the application, you can install applications that do not read or 
modify system files. In general, though, it is easier if the server 
owner installs the application onto its hard disk, then shares the 
directory it is in. The procedure described below follows this 
method. 

Before you can share an application, you must do the following: 

0 You must be working on the server where you want to install the 
application. 

0 You must be the server owner, or have rights to manage the server. 

To share an application, do the following: 

1. Install the application on a hard drive. 

1 a. Follow the installation instru'ctions in the documentation 
for the application. 

1 b. If the application's installation program prompts you for 
your network type, select the DOS-based (or "other," 
IBM* COMPATIBLE, NETBIOS, or PEER-TO-PEER) option 
instead of the NetWare option. 

le. Make sure the server's AUTOEXEC.BAT loads SHARE with 
sufficient locks and file handles (IL and /F parameters), 
depending on how many files the application opens 
simultaneously. 

Refer to the description of the SHARE command in the 
"Command Reference" chapter of DOSBook. 
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1 d. Separate shared and non-shared files into different 
directories. 

Ideally, each user's preference and configuration files 
should be stored on their own hard disks, not on the 
server. The application's installation instructions should 
tell you how best to achieve this. 

1 e. Make sure you have sufficient connections and tasks on 
the server to do the job. 

Refer to "Configuring a Server" on page 20-14. 

2. Log in to the server's workgroup. 

3. Make the application directory shared with READ access. 

Refer to "Sharing Directories" on page 20-24. Make the default 
access rights READ, to allow multiple users to run the 
application simultaneously. If, for some reason, you have to 
allow users to write to the directory, you could make executable 
files read-only using the ATTRIB command. Refer to the 
"Command Reference" chapter of DOSBook for a description of 
ATTRIB. 

4. Tell users the name of the shared directory, so they can connect 
to it and run the application as described in "Using Shared 
Directories and NetWare Volumes" on page 21-8. 

Sharing Printers 

20-32 

Any printer attached to a server's parallel ports or serial ports can be 
shared with other users of the workgroup. The network software 
ensures that each print job is complete before it is printed, so that 
the printouts do not become muddled. It can also print a banner, 
identifying the user, before each job, and can tell the user when 
printing is complete. 

If you have NetWare on your network, you might prefer to use 
NetWare's facilities for sharing printers because they are more 
comprehensive. 
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1mportantV 

When you send a file to print on a shared printer, that file is stored 
as a print job in a print queue. The print queue stores each print job 
until the printer is ready to print it. 

Note that if you want to print on a printer which, while physically attached to 
your computer, is being shared with other network users, you must not do so 
by sending your output to the printer's physical port. You must connect to it as 
a shared printer, as described in "Using Shared Printers and NetWare Print 
Queues" on page 21-18. 

Creating and Modifying Shared Printers 

checklistV 

Before you can share a printer, you must do the following: 

0 You must log in to the server's workgroup. 

0 You must be the server owner or have rights to manage the server. 

0 Before deleting or moving a shared printer, make sure that there are 
no print jobs waiting to print in the print queue, and that no user 
has an open connection to it. Refer to "Closing Down Your Server" 
on page 21-42. 

You can manage shared printers from DOS or MS Windows. 

To Create, Modify or Delete a Shared Printer from DOS 

Procedure'W 1. At the system prompt, type 

NET ADMIN <Enter> 

The Workgroup Administration program loads, showing the 
Servers view. To display online help, press <Fl>. 

2. Choose Shared Printers from the View menu. 

The screen changes to show all existing shared printers on all 
servers in your workgroup. 
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To 

Share a printer 

Modify a shared 
printer's settings 

Move a printer to a 
different port or 
server 

Rename a shared 
printer 

Stop sharing a printer 

3. Refer to the following table to see what to do next. 

Do this 

1 . Choose Add ... from the File menu or press <Ins>. 

The Add Shared Printer dialog appears. 

2. Type a name for the printer. The name should tell users which printer 
it is or what they should use it for. 

3. Select the server and the actual port to which the printer is physically 
connected, then choose the <OK> button. 

The Printer Properties dialog appears. 

4. Complete the dialog as described in the following table. 

1 . Select the printer from the list. 

2. Choose Properties ... from the File menu or press <Alt><Enter>. 

The Printer Properties dialog appears. 

3. Complete the dialog as described in the following table. 

1 . Stop sharing the printer, as described next. 

2. Move the printer's interface cable to the desired port/server. 

3. Follow the steps in "Share a printer" above. Give it the same name as 
before. 

1 . Select the printer from the list. 

2. Choose Rename ... from the File menu or press <F3>. 

3. Edit the name in the dialog that appears. 

1 . Select the printer from the list. 

2. Choose Delete ... from the File menu or press <Del>. 
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Field 

Server Port: 

Default Access Rights: 

Characters Per 
Second 

Error Wait Time 

<Serial Settings ... > 

<User Rights ... > 

<Setup Strings ... > 

<Form Names ... > 

The Printer Properties dialog has the following fields: 

Purpose 

Shows you to which port the printer is physically attached. 

Sets the user rights to the printer except for those explicitly listed in <User 
Rights ... >. ALL means users can use the printer and modify their own jobs 
in the queue. NONE means a user cannot use the printer. 

Sets the maximum rate at which characters will be sent to the printer. Up 
to a point, increasing this will improve printer performance. Beyond that 
point, it will merely interrupt the server unnecessarily, and so slow the 
computer down. 

The time, in seconds, that the server waits for a printer that is not 
accepting data. At the end of this time, a message pops up on the server's 
screen, alerting the owner to the problem. 

Allows you to set the parameters of the serial port. This only applies to 
printers attached to COM1 or COM2. 

Allows you to give non-default access rights to users for the printer. 

Lets you create and name one or more strings of characters which will be 
sent to the printer at the start of any job that requests it. 

The names are those that users select in the Printer Settings dialog of the 
NET program; see "Connecting to a Printer" on page 21-19. 

The string is a sequence of two-character hexadecimal numbers 
representing bytes, separated by spaces. For example: 

OA OD 

Lets you give names to the paper or form types that the printer uses. 

When a print job requires a form other than the one currently loaded, a 
pop-up message on the server's screen requests the server's owner to 
change the paper manually to the specified form. 
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Field 

<Advanced Info ... > 

Purpose continued 

Displays additional settings that you can use to change the way the printer 
is set up. 

• Startup Form Name is the form type which is assumed to be loaded 
into the printer at start-up. 

• Old Print Jobs allows you to hold, delete or print jobs which are still in 
the queue from the previous session when the server starts up. 

• Use Console Timeout allows you to say for how long pop-ups should 
be displayed on the server's screen. 

• Spool Location allows you to specify in which directory the print 
queue's spool files should be placed. 

To Create, Modify or Delete a Shared Printer from MS Windows 

20-36 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Choose (double-dick) the workgroup's icon in the NetWare 
window. This shows the workgroup's objects. 
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To 

Share a printer 

Modify access rights 
to a printer 

4. The following table shows the procedures for managing shared 
printers. 

Do this 

1. Choose (double-click) the required server's icon to show its printer 
ports. 

2. Select the port to which the printer is attached. 

3. From the File menu, choose Share ... 

The Share dialog appears, showing the name by which the printer will be 
known on the network. By default, this name is the same as its DOS port 
number. 

4. Type a name for the printer. The name can have up to 1 5 characters, 
but no spaces. 

5. Choose the <OK> button. The Rights dialog appears. See "Modify 
access rights to a printer" Steps 3 to 5, below. 

The printer is now shared. It will appear in the NetWare window of all the 
workgroup's users. 

6. (Optionally) confirm or change the print queue's configuration. See 
"Configure a print queue" on page 20-38. 

1 . Select the printer in the NetWare window. 

2. From the File menu, choose Rights ... 

The Rights dialog appears. 

3. Set the default rights for all unspecified users, either to both read and 
write or to neither. 

4. If desired, set the rights of specific users by selecting the user's name, 
then setting both read and write rights on or off. Repeat for all the users 
who are to have non-default rights. 

5. Choose the <Close> button. 
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To 

Configure a print 
queue 

Stop sharing a printer 

Field 

Startup Form Name 

Forms ... 

Characters Per 
Second 

Error Wait Time 

Console Timeout 

Spool Location 

Old Print Jobs 

Do this continued 

1. Select the printer from the NetWare window or the Printers window. 

2. From the File menu, choose Properties ... 

The Print Queue Configuration dialog appears. It is described in the table 
below. 

3. Choose the <Close> button. 

1 . Select the printer in the NetWare window. 

2. From the File menu, choose Delete ... or press <Del>. 

The Print Queue Configuration dialog has the following fields: 

Purpose 

The form type which is assumed to be loaded into the printer at start-up. 
This field is blank if no forms are defined for the printer. 

Opens the Forms window in which you can specify the names of forms. 

Sets the maximum rate at which characters will be sent to the printer. Up 
to a point, increasing this will improve printer performance. Beyond that 
point, it will merely interrupt the server unnecessarily, and so slow the 
computer down. 

The time, in seconds, that the server waits for a printer that is not 
accepting data. At the end of this time, a message pops up on the server's 
screen, alerting the owner to the problem. 

Allows you to say for how long pop-ups should be displayed on the 
server's screen. The default is forever. 

Allows you to specify in which directory the print queue's spool files should 
be placed. 

Allows you to hold, delete or print jobs which are still in the queue from 
the previous session when the server starts up. 
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chapter 21 
Using the Network 

This chapter describes the various tasks you can perform when 
using the Novell DOS™ 7 network. To understand this information, 
you do not need to have read the previous chapter, Chapter 20, 
"Setting Up the Network," but you need to be familiar with the 
terms and concepts described in Chapter 18, "Introduction to 
Personal NetWare." The following is a list of the tasks described in 
this chapter. 

+ Logging In (21-2) and Logging Out (21-41) 

+ Connecting to Shared Directories (21-9) 

+ Sharing Data on Shared Directories (21-13) 

+ Running Applications on Shared Directories (21-14) 

+ Connecting to a Printer (21-19) 

+ Printing a File (21-25) 

+ Viewing and Changing Print Queues (21-26) 

+ Viewing and Changing Printer Status and Forms (21-29) 

+ Sending Messages to Other Users (21-30) 

+ Receiving Messages from Other Users (21-32) 

+ Viewing Your Account Details (21-33) 

+ Changing Your Password (21-35) 

+ Changing Your NetWare Directory Services Context (21-37) 

+ Saving Connections (21-38) 
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Logging In 

You must load the network software before you can log in to the 
network. 

Providing a Password for Security 

When you start the operating system, your computer determines 
whether or not security has been enabled on it. If it has, you are 
asked to provide a password. If your computer is a server, it may 
have a list of users who are allowed to use it. If so, you are asked for 
your username as well as your password. 

You must type your user password, not the computer's Master Key 
Password, to take advantage of the one-time login feature described 
in the next section. Refer to "Configuring a Server" on page 20-14 
for information about how to set up security. 

Loading Network Software 

21-2 

1mportantV 

Once the Novell DOS 7 network software has been installed and 
enabled (as described in Chapter 3, "Installing Personal NetWare"), 
you are asked whether or not you want to load it, every time you 
start the operating system. 

If you answer N (for No), you can use your computer exactly as you 
did before you enabled the network software. None of the network 
software is in your computer's memory so you have the maximum 
amount of memory available to run applications. If you decide later 
that you want to use the network, simply type the following 
command at the system prompt: 

STARTNET <Enter> 

This command loads the network software, just as though you had 
answered Y to "Load Network Software?" 

If you answer Y, or later run STARTNET, the network software is loaded into your 
computer's memory. If your computer is set up as a Personal NetWare™ server, 
other users can connect to it from this point. 
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Task Switching: Local and Global Connections 

1mportantV You cannot load the network software while the Task Manager or a similar 
program is running. You must first unload the Task Manager, which means you 
must close all your tasks. After loading the network software you can load the 
Task Manager. 

All network connections made before you load the Task Manager are 
global, so you can use shared printers and directories in any task. 
Any connections you make subsequently are, by default, local to the 
task in which they are made. Each task has its own copy of the 
global connections, so changes made within one task do not affect 
other tasks. You can delete or change drive and printer connections 
without affecting other tasks. You can print to the same or different 
printers simultaneously from different tasks. 

This can greatly increase the number of connections to Personal 
NetWare servers, which each support only a preset number of 
connections. It might be necessary to increase that number if many 
clients use task switching. See "Configuring a Server" on page 20-14. 

Under MS Windows in enhanced (386*) mode, you can choose 
whether you want connections to be local to each task or global. 
Global connections are the same in each application and DOS 
window, even those already running when you make or change a 
connection. Thus, for example, changing the current directory on a 
drive in one DOS window affects all other windows if connections 
are global. 

Note that if you run several NetWare®-aware applications that 
communicate with NetWare servers at a low level (the IPX level), 
you must run the supplied program TBMI2.COM in order that they 
may work together correctly under the Task Manager. See Chapter 
13, "Multitasking and Task Switching," for details about the Task 
Manager. 

Logging In to the Network 

When the network software is loaded, it tries to log you in to the 
network as a user. If security and the one-time login facility are 
enabled on your computer you have already given a username and 
password, so these are used. Otherwise, you must type them now. 
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In any of the following circumstances a login will not succeed: 

+ The username or password are incorrect. 

+ The password has expired. 

+ The user account has been disabled. 

+ The login time restrictions on your account prevent you from 
logging in at that time. 

These factors can be controlled by any user with workgroup 
administrator privileges. See "Creating and Modifying User 
Accounts" on page 20-6. 

If you have ever previously logged in and saved your connections to 
a login script, those connections (to Personal NetWare and NetWare 
servers, directories and printers) are remade now. See "Saving 
Connections" on page 21-38 for further details. 

After logging in, you can connect to shared directories and printers 
on Personal NetWare servers, and to their NetWare equivalents: 
Net Ware volumes and Net Ware printer queues. These operations are 
described starting with "Using Shared Directories and NetWare 
Volumes" on page 21-8. 

Eventually, you will want to log out. Refer to "Logging Out" on page 
21-41 for information. 

Logging In to a NetWare Server or Directory Services Tree 

21-4 

Once the networking software is loaded into your computer's 
memory, you can log in to NetWare servers or NetWare Directory 
Services™ at any time, using the same or a different username 
in each. 

After logging in, if you save your connections they will be remade 
the next time you log in to the network. 

If you want to run your NetWare login script for the specified 
NetWare server or tree, use the NetWare LOGIN command. 
Otherwise, use any of the methods described in the following 
sections. 
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Logging In to a Different Workgroup or Account 

Note,.f 

You can change your workgroup, or use a different account by 
logging in with the new workgroup name, or username for the 
account. 

As with most network functions, you can log in by typing a command line or 
interactively from the system prompt or MS Windows. The MS Windows 
NetWare Tools™ program is, by default, selected by pressing the "hotkey" 
<F6>. You can change this on the NetWare Settings panel which you see when 
you choose "Network" in the MS Windows Control Panel. 

Logging in from DOS, Non-interactive 

Using the command line to log in is the quickest if you are at the 
system prompt. 

+ To log in as a different user or to a different workgroup, use the 
NET LOGIN command. See the "NET Commands" chapter of 
DOSBook for details. 

+ To attach to a NetWare server, use the NET CONNECT 
command. See the "NET Commands" chapter of DOSBook for 
details. 

Logging in from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. If the workgroup, server or tree to which you wish to log in is 
not listed 

2a. Choose Include ... from the View menu. 

2b. Select the types of connection you are interested in. 

2c. If you want to connect to a remote workgroup, choose the 
<Find workgroup ... > button. You may have to wait while 
the entire network is searched. 
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2d. Choose the <OK> button to return to the NetWare view. 

3. Select your workgroup or the NetWare tree or server to which 
you wish to log in. 

4. Choose Connect ... in the File menu or press <Enter>. 

The Login dialog appears. 

5. If you are logging in to a workgroup, and you want it to become 
your default workgroup, select Join workgroup. 

6. Type your username and password, then choose the <OK> 
button. 

If your account has no password, leave the password blank. 
When you type a password, asterisks display on the screen. If 
you think you have made a mistake, press <Backspace>. If you 
do make a mistake, you must repeat the login procedure. 

7. When you have finished using NET, choose Exit from the File 
menu, or press <Alt> X. 

The first time you use NET, you might want to connect to 
directories and printers before you exit. 

Logging in from MS Windows 

21-6 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Novell DOS 7 window. 

To choose an object, double-dick it or highlight it and press 
<Enter>. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-dick the 
Net Ware icon in the main window. 

3. Choose the <Include non-connected resources in list> button. 

Button names are shown along the bottom of the main window 
when the mouse is over a button. 

You may need to make the NetWare window wider to see both 
sides. 
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4. All local trees, NetWare servers and workgroups are listed on 
the right side of the NetWare window. Remote workgroups are 
not shown. Use one of the following two steps: 

4a. For a local workgroup, tree or server, choose the one to 
which you wish to log in. 

4b. For a remote workgroup 

+ Select the workgroup to which you are already logged 
in. 

~ Choose Properties ... from the File menu. 

+ On the Workgroup Connection Information dialog, 
choose the <Change> button. 

+ On the Change Workgroup dialog, choose the <All 
workgroups> button to search for remote workgroups. 

+ Select the desired workgroup when it appears. 

+ Choose the <OK> button. 

The Login dialog appears. 

5. Type your username and password, then choose the <OK> 
button. 

If the username and password are correct, you are now logged 
in. The workgroup, server or tree appears in the left side of the 
NetWare window to show that you are connected to it. 

6. If you have logged in to a different workgroup, and want to 
make it your default workgroup for the future, choose the <Set 
Preferred> button on the Workgroup Connection Information 
dialog. 

If the dialog is not open, you can open it by selecting the 
workgroup, then choosing Properties ... from the File menu. 
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Using Shared Directories and NetWare Volumes 

Figure 21-1 

Sharing Directories 

To use shared directories on Personal NetWare servers and volumes 
on NetWare servers, you must first connect to them. This 
connection establishes a mapping between a DOS drive letter and 
the selected directory. Note that in NetWare the term "map" is used 
for connecting to a volume. 

As far as DOS, MS Windows, and applications are concerned, your 
computer has acquired another hard disk. Note, however, that you 
may not perform "low-level" operations such as formatting the 
disk. 

You can use shared directories to store shared data and shared 
applications, or simply to increase the disk space available to your 
computer. Sharing data is discussed in "Sharing Data on Shared 
Directories" on page 21-13. Sharing applications is discussed in 
"Running Applications on Shared Directories" on page 21-14. 

Client Server 

Network 

Step 1 SERVER shares C:\PUBLIC as 11 COMMON1 11 

Step 2 CLIENT connects F: to 11 COMMON1 11 

Step3 CLIENT can now read and write on F: 

21-8 Novell DOS 7 User Guide 



Connecting to Shared Directories 

checklistV 

Connections are maintained for as long as you are logged in, or 
until you delete them, but are lost when you log out unless you 
have saved them. Refer to "Saving Connections" on page 21-38. 

Before you can connect to a shared directory, you must do the 
following: 

0 You must log in to the server's workgroup or NetWare server. Refer 
to "Logging In" on page 21-2. 

0 The directory must exist as a shared directory (if it is on a Personal 
NetWare server) or NetWare volume. Refer to "Sharing Directories" 
on page 20-24. 

0 You must have rights to read or write files in the directory. Rights 
are controlled by the server's owner. Refer to "Sharing Directories" 
on page 20-24. 

Make connections using one of the following three procedures: 

Connecting to Shared Directories from DOS, Non-interactive 

Use the NET MAP command. See the "NET Commands" chapter of 
DOSBook for details. 

Connecting to Shared Directories from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Drives from the View menu. 

The Drive view appears. It shows all your drive letters and 
whether they are local (physically part of your computer), 
unused, or already connected over the network to a shared 
directory or NetWare volume. 
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To 

Connect (map) a 
drive letter to a 
shared directory or 
NetWare volume 

Change the current 
directory (CD) of any 
drive letter. 

Disconnect a drive 
letter from a shared 
directory or NetWare 
volume 

3. Refer to the following table to see what to do next. 

Do this 

1. Highlight the drive letter you want to use. You can select any letter. If 
the letter is a local drive, that drive will be unusable while the network 
connection exists, so do not select C: if your computer is a server. 

2. Choose Connect... from the File menu or press <Enter>. 

If the drive is already connected, you are prompted to confirm that you 
want to connect it to a different network directory. 

3. Select the desired directory from the list that appears. 

1. Highlight the drive letter you want to change. 

2. Choose Properties ... from the File menu 

3. Select the desired directory from the list that appears. You can go 
several levels down the directory tree, if you wish, but you cannot go 
higher than the shared directory itself, which is treated as a "root" 
directory. 

1. Highlight the drive letter. 

2. Choose Disconnect... from the File menu or press <Del>. 

Connecting to Shared Directories from MS Windows 

21-10 

When first made, connections are not permanent. They last only 
until you switch off or reboot the computer, unless you make them 
permanent. See "Make a connection permanent," in the following 
procedure. 

By default, connections are local, not global. This means, for 
example, that a drive connection is not visible inside a DOS window 
opened before the connection was made. See "Make connections 
global" in the following procedure. 
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ProcedureT 

There are two ways to connect to shared directories. If you are in File 
Manager, you can choose the Network Connections ... command from 
the Disk menu. This opens a window almost identical to the one 
described in Step 3 of the procedure below. Refer to on-line help for 
a fuller explanation. If you are not in File Manager, use the 
following procedure. 

1. In Program Manager, choose the Personal NetWare icon in the 
Novell DOS 7 window. 

2. Open the Drives window, unless it is already open. 

From the Window menu, choose Drives, or double-click the 
Drives icon in the main window. 

Note that the window shows the complete path to the current 
directory of network connections as: 

\\server\volume\dirl\dir2 \<current dir> 

The space indicates the location of the root directory. On 
Personal NetWare shared directories, this must be at the shared 
directory itself. 

3. If you want to connect to a NetWare 4.x server, and the server's 
volumes are not shown, change your current context. See 
"Changing Your NetWare Directory Services Context from MS 
Windows" on page 21-38. 
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To 

Connect (map) a 
drive letter to a 
shared directory or 
NetWare volume 

Connect (map) a 
drive letter to a 
shared directory or 
NetWare volume and 
set the current 
directory (CD). 

Make a connection 
permanent 

4. Refer to the following table to see what to do next. 

Do this 

1. Select the shared directory or NetWare volume from the list on the 
right side of the window. 

2. (Optionally, on NetWare volumes only - not Personal NetWare shared 
directories) if you want to connect to a subdirectory within the volume, 
double-click on the icon to open it. Repeat for each level of 
subdirectory. Select whichever subdirectory you wish to be the root. 

3. Drag the selected directory across to the required drive letter, or select 
the drive letter, then choose Connect ... from the File menu. You can 
select any drive letter. If the letter is a local drive, that drive will be 
unusable while the network connection exists, so do not select C: if 
your computer is a server. If the letter is already connected, the existing 
connection will be deleted. 

1. Select the directory you want to be the current directory from the list 
on the right side of the window. If it is not visible, choose (double-click) 
the shared directory or NetWare volume, then do the same, in turn, to 
each subdirectory in the path. 

2. Select the required drive letter. 

3. From the File menu, choose Connect ... 

4. Edit the Source path field to insert a space between the volume's name 
and the backslash which follows it. The path up to the space becomes 
the root path. On NetWare volumes - not Personal NetWare shared 
directories - this may be a subdirectory within the volume. 

5. Choose the <OK> button. 

1 . Select the connection from the list on the left side of the window. 

2. From the File menu, choose Permanent. Note that the Permanent 
Connections box in the NetWare Settings dialog must be enabled for 
this to take effect. See "Saving Connections" on page 21-38. 
Permanent connections are distinguished in the Drives window by 
having different icons from temporary ones. 

You can make a permanent connection temporary by choosing Permanent 
a second time. 
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To 

Make connections 
global 

Display information 
about a volume 

Display information 
about a mapped 
directory 

Disconnect a drive 
letter from a shared 
directory or NetWare 
volume 

Do this continued 

1. From the Main window in Program Manager, choose "Control." 

2. In the Control Panel, choose "Network." 

3. In the NetWare Settings dialog, select "Global Drives & Paths." 

(See also "Task Switching: Local and Global Connections" on page 21-3.) 

1. Select the shared directory or NetWare volume from the list on the 
right side of the window. 

2. From the File menu, choose Properties ... 

3. The server type and disk space are displayed. 

1 . Choose the drive letter, or select it and choose Properties ... from the File 
menu. 

A dialog is displayed. It tells you whether the drive is local or networked, 
whether it is searched in your current PATH, and whether the connection 
is permanent. 

1 . Select the drive letter. 

2. From the File menu, choose Disconnect ... 

Sharing Data on Shared Directories 

In order that several users can read data files at the same time, 
ensure that 

+ the users' access rights to the directory are set to READ. 

or 

+ the file itself has the read-only attribute which you can set using 
the DOS A TIRIB command. 
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If you try to edit or otherwise modify the file you are denied access 
to it. To modify a shared data file you must first stop it from being 
shared by resetting its read-only attribute; then you can modify it 
before setting it to read-only again. If you are denied access when 
you try to modify the file, you will know that some other user is 
reading the file. You could broadcast a message asking them to close 
it. 

Running Applications on Shared Directories 

Note.,.f' 

checklistV 

To run an application which has been installed on a Personal 
NetWare or NetWare server, you may first have to perform some 
initialization steps on your client computer. These vary greatly from 
application to application, and should be described in the 
application's documentation. In general, though, you follow a 
procedure similar to those described in this section. 

If you expect to run the application more than once, you can save 
time by creating a batch file that automates the procedure. This is 
described in the second procedure in this section. 

If you expect to run the application so frequently that you are 
willing to dedicate one of your drive letters permanently to it, you 
can save a little more time by following the third procedure 
described in this section. 

If you use MS Windows, follow the fourth procedure. 

In all the procedures, an application called THISAPP.EXE in a shared directory 
called THIS DIR on a server called THISSERVER is used as an example. THISAPP 
will be run on drive M:. 

Before you can run an application from a shared directory, you must 
do the following: 

0 The application must have been installed as described in "Sharing 
an Application" on page 20-30. 

0 You must log in to the server's workgroup or NetWare server. Refer 
to "Logging In" on page 21-2. 

0 You must have rights to read files in the application's directory. 
Rights are controlled by the server's owner. Refer to "Sharing 
Directories" on page 20-24. 
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0 Your CONFIG.SYS file must set sufficient FILES and BUFFERS, 
depending on how many files the application opens 
simultaneously. 

Find out if the application has a different way to configure the 
number of open files. Clipper*-compiled applications often have a 
separate configuration method. 

If you need to change the number of FILES or BUFFERS, use SETUP 
to edit CON FIG.SYS, then reboot the computer for the changes to 
take effect. 

Running a Shared Application Once 

ProcedureT 

To run a shared application once, do the following: 

1. Connect a suitable drive letter to the application's directory on 
the server. 

Follow the procedure described in "Connecting to Shared 
Directories" on page 21-9. Some applications may have been 
installed so that they can only be run on a specific drive letter, 
but often the choice is yours. 

2. Make the application's drive letter the current drive. 

This is not needed by all applications, but, for example, in the 
THISAPP example you would type the following at the system 
prompt: 

M: <Enter> 

3. Give the command to run the application. 

For example, in the THISAPP example you would type 

THISAPP <Enter> 

From MS Windows, you could double-click on THISAPP.EXE in 
the File Manager. 
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Creating a Batch File To Run a Shared Application 

ProcedureT 

To create a batch file to run a shared application, do the following: 

1. Use EDIT or any other text file editor to create the batch file. 

The batch file could be called, say, RUNAPP.BAT. This file should 
be on your own hard disk in a directory named in your PATH 
command. Its contents could be as follows: 

NET MAP M: THISSERVER\THISDIR 

M: 

THI SAPP 

NET MAP DEL M: 

You can run this batch file at any time while you are logged in 
to the workgroup. 

The NET MAP command is explained in the "NET Commands" 
chapter of DOSBook. 

2. Enter the command to run the application (via the batch file). 

For example, in the THISAPP example you would type 

RUNAPP <Enter> 

From MS Windows, you could double-click on RUNAPP.BAT in 
the File Manager, or create a program item to run RUNAPP.BAT 
from the Program Manager. 

This method is not suitable for MS Windows applications. 

Assigning a Drive Letter to a Shared Application 

ProcedureT 

To dedicate a drive letter to a shared application, do the following: 

1. Connect a suitable drive letter to the application's directory on 
the server. 

Follow the procedure described in "Connecting to Shared 
Directories" on page 21-9. Some applications may have been 
installed so that they can only be run on a specific drive letter, 
but often the choice is yours. 
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2. Save connections. 

Follow the procedure described in "Saving Connections" on 
page 21-38. 

3. Use EDIT or any other text file editor to edit AUTOEXEC.BAT. 

Add the application's drive letter to the end of the PATH 
statement. For example, if the original line is 

PATH C:\;C:\NWDOS;C:\NWCLIENT 

change it to 

PATH C:\;C:\NWDOS;C:\NWCLIENT;M: 

4. At the system prompt, type the command to run the 
application. 

For example, in the THISAPP example you would type 

THISAPP <Enter> 

Using MS Windows to Run a Shared Application 

ProcedureT 1. Connect a suitable drive letter to the application's directory on 
the server. Make the connection permanent. 

Follow the procedure described in "Connecting to Shared 
Directories" on page 21-9. Some applications may have been 
installed so that they can only be run on a specific drive letter, 
but often the choice is yours. 

2. In Program Manager, create a program item for the 
application. Set the Working Directory to the mapped drive 
letter. 

3. To run the application, double-click on its icon in Program 
Manager. 
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Using Shared Printers and NetWare Print Queues 

Figure 21-2 

Sharing Printers 

To use shared printers on Personal NetWare servers and NetWare 
print queues, you must first connect to them. This connection 
establishes a mapping between a printer port and the selected 
printer's queue. Note that in NetWare the term "capture" is used for 
connecting to a printer. 

As far as DOS and MS Windows applications are concerned, the 
printer is connected to the port on your computer. 

More.,.. •• 
clients 

Client 

Network 

Step 1 SERVER shares printer on LPT2 as "FAST_A4" 

Step 2 CLIENT connects LPT1 to "FAST_A4" 

SERVER connects LPT3 to "FAST_A4" 

Step 3 CLIENT can now print to LPT1 

SERVER can now print to LPT3 

Server 
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Connecting to a Printer 

checklistV 

Follow one of the three procedures below, depending on your 
preferences and whether you are using MS Windows. 

Before you can connect to a shared printer, you must do the 
following: 

0 You must log in to the server's workgroup or NetWare server. Refer 
to "Logging In" on page 21-2. 

0 The printer must be a shared printer (if it is on a Personal NetWare 
server) or NetWare print queue. Refer to "Sharing Printers" on page 
20-32. 

0 You must have rights to use the printer. Rights are controlled by the 
server's owner. Refer to "Sharing Printers" on page 20-32. 

Connecting to a Printer from DOS, Non-interactive 

Use the NET CAPTURE command. See the "NET Commands" 
chapter of DOSBook for details. 

Connecting to a Printer from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Printers from the View menu. 

The Printer Port view appears. For each of your printer ports this 
shows whether they are already connected over the network to 
a shared printer or NetWare print queue. 
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To 

Connect (capture) a 
port to a shared 
printer or NetWare 
print queue 

Change the settings 
of a port 

Disconnect a port 
from a shared printer 
or NetWare print 
queue 

3. Refer to the following table to see what to do next. 

Do this 

1. Select the port you want to use. You can select any number. If there is 
a printer physically attached to that port on your computer, that printer 
will be unusable while the network connection exists. If the port is 
already connected to a different shared printer, the existing connection 
is broken, if you choose to connect the port to a different printer when 
prompted. 

2. Choose Connect... from the File menu or press <Enter>. 

3. Select the desired shared printer or NetWare print queue from the list 
that appears, then choose the <OK> button. 

4. Change the port settings as described next. 

1. Select the port. 

2. Choose Properties ... from the File menu or press <Alt><Enter>. 

3. Make any changes you need in the Printer Settings dialog, described in 
the following table. 

Note these important settings for Postscript* printers: No form feed, tab 
expansion or banner. 

1 . Select the port. 

2. Choose Disconnect ... from the File menu or press <Del>. 
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Field 

AutoEndcap 

Banner 

Direct 

Form Feed 

Keep 

Job hold 

Notify 

Form name 

Setup string 

The Printer Settings dialog has the following fields: 

Purpose 

(Automatic End Capture) Automatically closes each print job when the 
application that created the job terminates. 

Prints a full page banner before each job to identify the username and job 
or filename. 

Make sure Banner is not selected for Postscript printers. 

If you use MS Windows, you can set the banner text with NetWare Tools. 

Specifies whether the printer should start printing the job before it has 
been closed. The potential danger in this is that if the client never closes 
the job, and if Printer wait is set to zero, no-one else can use the printer. 

Sends a form feed character to the printer at the end of each job to make 
it eject the last page. 

Make sure Form Feed is not selected for Postscript printers. 

This option can only be set using the MS Windows NetWare Tools. If 
selected, jobs which have been partly sent when the client-server 
connection is broken are kept in the queue. 

Stops print jobs from printing until you explicitly release them. Until then, 
the jobs will remain in the printer's queue. See "Viewing and Changing 
Print Queues" on page 21-26. 

Pops up a message on your screen when each of your print jobs finishes 
printing, so you know when to go to collect the printout. 

Allows you to specify which of several paper types should be used. When 
one of your jobs is ready to print, a message pops up on the screen of the 
Personal NetWare server, asking its user to load the requested paper into 
the printer. 

This field is blank if the printer has no forms defined for it. 

You can specify which form is currently in the printer. See "Viewing and 
Changing Printer Status and Forms" on page 21-29. 

Allows you to specify which of several setup strings should be used. The 
setup string, if used, is sent to the printer before each of your jobs. 

This field is blank if the printer has no setup strings defined for it. 
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Field 

Copies 

Tab expansion 

Timeout I 
Printer wait (seconds) 

Purpose continued 

You can ask for up to 250 copies. Copies are not collated. 

You can specify how many spaces the tab character should be replaced by. 

Make sure this is set to zero for Postscript printers. 

Sets the time for which the printer waits before deciding that a job is 
finished, if no more output is received during that time. 

A wait of zero is taken to mean "forever." 

Connecting to a Printer from MS Windows 

21-22 

Note,.~ 

ProcedureT 

There are two ways to connect to shared printers. If you are in Print 
Manager, you can choose the Network Connections ... command from 
the Options menu. This opens a window almost identical to the one 
described in Step 3 of the procedure below. Refer to online help for 
a fuller explanation. If you are not in Print Manager, use the 
following procedure. 

If Print Manager is enabled and you select Print Net Jobs Direct, you get the best 
performance without losing the ability to view and control queues. Print Net 
Jobs Direct is in the Network Options dialog which you open by choosing 
Network Settings ... from the Options menu of Print Manager. 

1. In Program Manager, choose the Personal NetWare icon in the 
Novell DOS 7 window. 

2. Open the Printers window, unless it is already open. 

From the Window menu, choose Printers, or double-click the 
Printers icon in the main window. 

3. If you want to connect to a NetWare 4.x server, and the server's 
printers are not shown, change your current context. See 
"Changing Your NetWare Directory Services Context from MS 
Windows" on page 21-38. 
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To 

Connect (capture) a 
port to a network 
printer 

Change the settings 
of a port 

Make a connection 
permanent 

4. Refer to the following table to see what to do next. 

Do this 

1. Select the printer from the list on the right side of the window. 

2. Drag it across to the required port, or select the port, then choose 
Connect ... from the File menu. You can select any port. If the port has 
a local printer attached to it, that printer will be unusable while the 
network connection exists. If it is already connected, the existing 
connection will be closed. 

3. Verify and, if needed, change the port settings. See "Change the 
settings of a port," below. 

When first made, connections are not permanent. They last only until you 
quit MS Windows. See "Make a connection permanent," below. 

By default, connections are local, not global. This means, for example, that 
a connection is not visible inside a DOS window opened before the 
connection was made. See "Make connections global" on page 21-1 3. 

1 . Select the port (from the left side of the window). 

2. From the File menu, choose Properties ... 

3. Make any changes you need in the Printer Settings dialog, described 
on page 21-21. 

Note the important settings for Postscript printers: No form feed, tab 
expansion or banner. 

1 . Select the connection from the left side of the window. 

2. From the File menu, choose Permanent. Note that the Permanent 
Connections box in the NetWare Settings dialog must be enabled for 
this to take effect. See "Saving Connections" on page 21-38. 
Permanent connections are distinguished in the Printers window by 
having different icons from temporary ones. 

You can make a permanent connection temporary by choosing Permanent 
a second time. 
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To 

Make connections 
global 

Disconnect a port 
from a network 
printer 

Notes 

Do this continued 

1. From the Main window in Program Manager, choose "Control." 

2. In the Control Panel, choose "Network." 

3. In the NetWare Settings dialog, select "Global Drives & Paths." 

(See also "Task Switching: Local and Global Connections" on page 21-3.) 

1 . Select the port. 

2. From the File menu, choose Disconnect... 

After connecting to a shared printer, you can use the corresponding 
port name (LPTl, for example) in practically all DOS commands 
and within all applications. As output goes into a print queue, you 
may wish to see the contents of each print queue, and re-order it, or 
change the settings of any of your jobs in the print queue. Refer to 
"Viewing and Changing Print Queues" on page 21-26 for 
information about this. 

The connections are maintained for as long as you are logged in, but 
are lost when you log out unless you have saved them or made them 
permanent. Refer to "Saving Connections" on page 21-38 for 
information about saving connections. 

Each print job is closed when any of the following occurs: 

+ The application closes it. Not all applications do this. 

+ The wait time is exceeded without any further characters being 
sent. 

+ The application terminates (if autoendcap is selected). 

+ The user opens and closes the LPT port as a DOS device. For 
instance, by typing 

ECHO <Ctrl> L > LPT 1 <Enter> 
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Printing a File 

Note~f" 

+ Client-server communications are broken, perhaps by a cable 
becoming detached. In this case, the job is discarded unless 
Keep is selected. 

+ The client closes the connection by NET CAPTURE DEL or NET 
LOGOUT. 

You can print a file on a shared printer using the following methods: 

+ Use a Print command from within an application. Some 
applications default to LPTl:, others allow you to select the port 
number. 

+ Use the printer port number with any DOS command that 
allows you to specify a destination file or device. For example, if 
you have connected a shared (non-Postscript) printer to LPT2: 

DIR > LPT2 <Enter> 

COPY ANYFILE. TXT LPT2 <Enter> 

+ Use the SCRIPT command if you have a Postscript printer. For 
example: 

SCRIPT ANYFILE. TXT LPT2 <Enter> 

If you use SCRIPT as a TSR and use the NET program to print out a file then make 
sure that the timeout value for SCRIPT is less than the printer wait time. Refer to 
the description of the Printer Settings dialog in this chapter, and the description 
of SCRIPT in the "Command Reference" chapter of DOSBook for more 
information. 

+ Use the Print File command from the Print Queues view of the 
NET program. This is described in the following section, 
"Viewing and Changing Print Queues." 

+ From MS Windows, drag the file's icon from File Manager to 
Print Manager's icon or window. It is printed on the default 
printer. 
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Viewing and Changing Print Queues 

checklistV 

Because a print job goes into a print queue before it is printed, you 
can change its settings up to the point when it starts printing. You 
can add a file to the queue, change the order of your jobs in the 
queue, put them on hold, or delete the job. 

You cannot do all these tasks using MS Windows Print Manager. You 
may need to use the NET program. 

Before you can view a print queue, you must do the following: 

0 You must log in to the server's workgroup or NetWare server. Refer 
to "Logging In" on page 21-2. 

0 You must have workgroup administrator privileges to control other 
users' print jobs. 

Using Print Queues from DOS 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Select Print Queue ... from the Printing menu. 

3. Select the required printer or queue from the list. 

The Printer Queue view appears. This shows all the jobs 
currently in the selected queue. 
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To 

Add a file to the 
queue 

Change the settings 
of a print job 

Change the status of 
a print job between 
"holding" and 
"ready" 

Change the order of 
jobs in the queue 

Delete a print job 

View the queue of a 
different printer 

4. Refer to the following table to see what to do next. 

Do this 

1 . Choose Print file ... from the Printing menu or press <Ins>. 

2. Type the file's name in the Print File dialog. 

For Postscript printers, the file must contain Postscript. 

If you have connected a port to this printer, your connection settings are 
used. If not, one copy of your file is printed with no banner, no 
notification, default form, final form feed. While the job is in the queue you 
can change these. 

1 . Select the job. 

2. Choose job settings ... from the Printing menu or press <Enter>. 

3. Make any changes you need in the Printer Job Settings dialog, 
described below. 

1 . Select the job. 

2. Choose job settings ... from the Printing menu or press <Enter>. 

3. Change the Job Hold field in the Printer job Settings dialog. 

1 . Select the job you want to move. You can only move your own jobs. 

2. Choose Move job ... from the Printing menu. 

3. Type the new job number. Jobs are printed in number order. 

1. Select the job. 

2. Choose Delete job ... from the Printing menu or press <Del>. 

1. Choose Select print queue ... from the Printing menu. 

The Printer Job Settings dialog's fields are similar to those in the 
Printer Settings dialog (see the table on page 21-21) except that the 
Print Job Settings dialog does not have the AutoEndcap, Direct, 
Setup string and Printer wait fields. 
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Viewing Print Queues from MS Windows: Using Print Manager 

ProcedureT 

If Print Manager is enabled, you can use it to view queues and delete 
your jobs from them. You enable or disable Print Manager on the 
Printers dialog box in the MS Windows Control Panel. Print 
Manager shows all your jobs in the queue, even if they were created 
while Print Manager was disabled. 

If Print Net Jobs Direct is selected you cannot change the order of 
jobs in a queue with Print Manager, but you can with NET (see the 
previous procedure). 

1. Start the Print Manager from Program Manager. 

Refer to online help if you are not familiar with Print Manager. 

2. View and reorder queues, hold, resume or delete any of your 
jobs, as required. 

Viewing Print Queues from MS Windows: Using Personal NetWare 

21-28 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the Printers window, unless it is already open. 

From the Window menu, choose Printers, or double-click the 
Printers icon in the main window. 

3. In the Printers window, choose the printer or port 
(double-click, or select and press <Enter>). 

The printer's queue window opens, showing all jobs in the 
queue. 
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To 

Put one of your jobs 
on hold, or take it off 
hold 

Delete one of your 
jobs 

Close the window 

Do this 

1. Select the job. 

2. Choose the <Pause> or <Resume> button, as appropriate. 

Note that the job's icon changes color. Paused jobs are not printed, but 
remain in the queue indefinitely. 

1 . Select the job. 

2. Choose the <Delete> button. 

1. Choose the <Close> button. 

Viewing and Changing Printer Status and Forms 

checklistV 

You can view and change the status of shared printers attached to 
Personal NetWare servers (but not NetWare servers). The status is 
either "Printing" or "Holding." 

If the printer supports several named forms, you can specify which 
is currently loaded. 

Note that you must use the NET utility to perform these functions -
not the MS Windows Print Manager. 

Before you can view or change the status of printers, you must do 
the following: 

0 You must log in to the server's workgroup. Refer to "Logging In" on 
page 21-2. 

0 You must have workgroup administrator privileges. 
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ProcedureT 

To view or change the status of a printer or form, do the following: 

1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Select Print Queue ... from the Printing menu. 

3. Select the required printer from the list. 

The Printer Queue view appears. This shows all the jobs 
currently in the selected queue. 

4. Choose Printer status ... from the Printing menu. 

5. Change the status field, or specify the current form. 

Sending Messages to Other Users 

You can send a one line message to any or all workgroup users or 
users logged in to a NetWare server. This can be very useful if you 
are a server's owner and want to draw other users' attention to a new 
or changed setting, for example. 

Users can stop messages from appearing on their screens, so your 
message might not get through. Users only see messages when they 
are logged in. Messages are not held until the user logs in. 

Before you can send a message to another user, you must log in to 
the same workgroup or NetWare server as the other user. Refer to 
"Logging In" on page 21-2. 

Sending Messages from DOS, Non-interactive 

Use the NET SEND command. See the "NET Commands" chapter of 
DOSBook for details. 
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Sending Messages from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Send message ... from the File menu. 

3. Select the workgroup or NetWare server from the list of servers. 

4. Select "All connected users" or one or more usernames by 
highlighting each name and pressing <Spacebar> to select 
them. 

Only logged-in users are shown in the list. 

5. Type the message in its field. 

You do not need to include your username, as this is added 
automatically. 

6. Choose the <OK> button to send the message. 

Remember that you cannot be sure that a user has not disabled 
message reception. Your message might not be seen. 

Sending Messages from MS Windows 

Procedure'?' 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. In the left side of the window, select the workgroup, user or 
group of users to whom you want to send a message 

To see USERS, make sure the <Include users in lists> button is 
selected, and double-click the workgroup or server to display 
logged-in users. 
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To see GROUPS, make sure the <Include groups in lists> button is 
selected, and double-dick the NetWare server to display logged­
in groups. (Groups are defined only on NetWare servers.) 

4. From the File menu, choose Properties ... 

5. Type your message in the Message field. 

6. Choose the <Send> button. 

Receiving Messages from Other Users 

If a user sends a message to you while you are logged in, it appears 
on your screen, unless you have turned off message reception, as 
described below. 

If your screen is in text mode, the message replaces the top line of 
the display. You must press <Ctrl><Enter> to remove it. Anything 
you type before pressing <Ctrl><Enter> is lost. It does not go to the 
application you are currently running. When you press 
<Ctrl><Enter>, the message disappears, the original top line 
reappears, and you can continue with whatever you were doing. 

If you are running MS Windows, the message appears as a pop-up 
window in the center of the screen. The window has an <OK> 
button. You must click on it or press <Enter> to close the window 
and continue. 

Controlling Message Reception 

You can stop messages from being displayed, or set a timeout value 
so that the message is only displayed for a short time. 

Controlling Message Reception from DOS 

Procedure"i" 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 
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2. Choose Message reception ... from the File menu. 

3. Select or deselect <Receive messages>. 

4. If you select <Receive messages>, you can enable a timeout. 

5. If you select <Use timeout>, you can specify a timeout in 
seconds. 

With no timeout, a message stays on the screen indefinitely, 
until the user removes it. With a timeout, the message 
disappears if the user has not already cleared it after the time has 
expired. 

Controlling Message Reception from MS Windows 

ProcedureT 1. Either 

1 a. Press the Network Hotkey ( <F6> by default) then choose 
"NetWare Settings ... " (<Alt> S), or 

1 b. Choose "Network" from the Control Panel. 

2. In the NetWare Settings dialog, select or deselect Broadcasts in 
the Message Reception area. 

Viewing Your Account Details 

You can display the details of your own account. The details shown 
include: 

+ whether you have workgroup administrator privileges 

+ whether you are allowed to change your own password 

+ whether your password is required, its minimum length, and if 
you are required to change it periodically. 

Before you can view your account details, you must log in to the 
workgroup. Refer to "Logging In" on page 21-2. 
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Viewing Your Account Details from DOS 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Show account... from the File menu. 

The details of your account are shown. You cannot change 
them. Their meanings are explained in "Creating and 
Modifying User Accounts" on page 20-6. 

Viewing Your Account Details from MS Windows 

Procedure'W 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-dick the 
NetWare icon in the main window. 

3. In the left side of the window, double-click your workgroup to 
display usernames. 

Make sure the <Include users in lists> button is selected. 

4. Select yourself from the list. 

5. From the File menu, choose Properties ... 

6. Choose the <Configure> button. 

The User Account Configuration dialog displays. The 
information it shows is described in "Creating and Modifying 
User Accounts" on page 20-6. 
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Changing Your Password 

checklistV 

If your account has a password which you are allowed to change, 
change it regularly, even if the account properties do not specify 
that you must. 

If you have an account in several workgroups or on several NetWare 
servers you could have a password for each account. One-time login 
demands that all your accounts have the same password and 
username. Also, to be practical, it is very difficult to remember 
several passwords. Therefore, change all your accounts' passwords 
at the same time, and keep them the same as each other. 

Before you can change your password, you must do the following: 

0 You must log in to the workgroup or NetWare server of your 
account. Refer to "Logging In" on page 21-2. 

Changing Your Password from DOS, Non-interactive 

To change your workgroup password, use the NET SETPASS 
command. See the "NET Commands" chapter of DOSBook for 
details. 

To change your password on a NetWare server or tree, use the 
NetWare SETPASS command. Refer to your Novell NetWare 
documentation for details. 

Changing Your Password from DOS, Interactive 

Procedure'?' 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Highlight the workgroup or NetWare server on which you want 
to change password. 

3. Choose Properties ... from the File menu. 
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4. Type in your new password, press <Tab>, repeat the password. 

If you are changing your password on a NetWare server, you 
must type in the old password first. 

5. Choose the <OK> button to commit to the new password. 

Your account details may impose a minimum length on your 
password. Use the Show account... command from the File menu 
to find out what the minimum length is. 

Changing Your Password from MS Windows 
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ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. In the left side of the window, select yourself in the list of users 
under the workgroup or server where you want to change your 
password. 

To see USERS, make sure the <Include users in lists> button is 
selected, and double-click the workgroup or server to display 
logged-in users. 

4. From the File menu, choose Properties ... 

Your User Information dialog appears. 

Your account details may impose a minimum length on your 
password. To find out if this is the case, display your account 
details by choosing the <Configure ... > button. 

5. Choose the <Set Pass ... > button. 

6. Type your old and new passwords into the boxes provided, 
then choose the <OK> button. 

7. Choose the <Close> button to close the User Information 
dialog. 
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Changing Your NetWare Directory Services Context 

This is only of concern to users on NetWare 4.x networks. This 
section does not apply to any other user. 

Within NetWare Directory Services you have a "current context." 
This is a node in the tree within which the NET utility searches for 
servers and users. You can change the current context in order to 
broaden, narrow, or simply change the part of the tree that will be 
searched. 

If you set your current context to the root of the tree, searches may 
take a long time and include lots of servers in which you have no 
interest, so you should normally set the current context to include 
just the part of the tree that contains the resources you actually 
want to use. 

Before you can change your context, you must log in to NetWare 
Directory Services. Refer to "Logging In" on page 21-2. 

Changing Your NetWare Directory Services Context from DOS, Non-interactive 

Use the NET CONTEXT command. See the "NET Commands" 
chapter of DOSBook for details. 

Changing Your NetWare Directory Services Context from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Current context... from the File menu. 

The Directory Services dialog appears. It shows the current 
organization "0=" and organization unit "OU=" with the 
smallest unit shown first. 

3. To go down the tree, choose a container from the list. To go up, 
choose" .. ". 
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Changing Your NetWare Directory Services Context from MS Windows 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

The NetWare, Drives and Printers window in Personal NetWare 
all show the current context. The context is shown alongside an 
icon which is either an organization icon if the context is the 
root of the tree, or an up-arrow. 

2. To go up the tree, choose the up-arrow icon in any window. 

3. To go down the tree, choose the tree, organization or 
organization unit you want to open. 

Saving Connections 

You can save all your current connections to shared directories and 
printers on Personal NetWare and NetWare servers, so that they are 
reconnected automatically when you next log in. The NET SAVE 
command also allows you to create a batch file which contains the 
same connection commands. You can execute the batch file when 
you need to remake the connections. 

Note that if a task switcher is running, only connections that exist 
in the current task (including those you made before you started the 
task switcher), are saved. 

Saving Connections from DOS, Non-interactive 

ProcedureT 1. You can save connections either as a login script, which is 
executed automatically when you next log in, or as a batch file 
which you can execute on demand. In either case the contents 
are identical, but the filename and location are not. 

1 a. To save a login script, type the following at the system 
prompt: 

NET SAVE /S <Enter> 

See "Saving Connections from DOS, Interactive," below, 
for details of the script ,file created. 
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1 b. To create a batch file, type the following at the system 
prompt: 

NET SAVE [[path\]filename.BAT] <Enter> 

If you omit the filename, NWLOGIN.BAT is created. By 
default it is in the current directory on the current drive. 
See "Saving Connections from DOS, Interactive," below, 
for details of the contents of the batch file created. 

Saving Connections from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Choose Save script... from the File menu. 

All your current connections are saved to a login script file (in 
C: \NWCNTL \MAIL by default) which is executed the next time 
you log in. Its name is unique to your workgroup username. 
Current connections include any made within MS Windows. 

The file contains the following types of statement: 

+ NET LOGIN <username> to log you in to your workgroup. 

+ NET CONNECT <server> <username> to attach to NetWare 
servers (if any). 

+ NET MAP to connect your drive letters to shared directories 
and NetWare volumes. 

For example, NET MAP F:=ANYDIR:ANYSUBDIR connects 
your drive F: to the shared directory ANYDIR, and changes 
the current directory on F: to ANYSUBDIR. 

+ NET CAPTURE to connect your printer ports to shared 
printers and NetWare printer queues. 

+ SET to record your environment variables; PATH is an 
important one. 
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3. (Optionally) use the Edit script. .. command from the File menu 
to edit the script file, if needed. 

Saving Connections from MS Windows 

ProcedureT 

Selected connections can be remade each time you restart MS 
Windows. Note that connections are not closed when you exit from 
MS Windows to DOS. The NET SAVE command described above can 
be used after you exit from MS Windows if you wish to remake the 
connections when you next log in, without needing to start MS 
Windows. 

1. Each drive and printer connection can be made permanent, or 
left as temporary, by choosing Permanent from the File menu in 
the Personal NetWare program. 

Note how the connection's icon changes. Temporary 
connections' icons are gray rectangles. 

Choosing <Permanent> a second time makes the connection 
temporary again. 

2. Select the "Permanent" box in NetWare Settings to enable 
reconnections. 

Reach the NetWare Settings dialog from the Network icon in the 
MS Windows Control Panel. 

Logging in Using Saved Connections 

21-40 

If you have a login script on the computer at which you are 
working, logging in runs it automatically. If you have the same 
username and password in your workgroup and on each NetWare 
server and tree to which you log in, you need only type the name 
and password once. 

If you use MS Windows and selected <Permanent> in NetWare 
Settings, the next time you start MS Windows those connections 
you made permanent will be remade. If this requires logging in to 
any servers, you are prompted for your password. Instead of giving 
a password, you can choose the <Cancel> button, then either the 
<Skip> button to omit the connection for this session, or the 
<Remove> button to delete it permanently. 
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Logging Out 

The best way to disconnect from the network is to type a NET 
LOGOUT command. This immediately tells all servers that your 
connections are closed. This allows server owners to see that there 
are no connections to their server, and switch the server off or 
reboot it without causing data loss or corruption. 

If you switch off or reboot your computer while you are logged in 
to the network, the system eventually realizes that your computer is 
not responding and logs you out. Meanwhile, server owners cannot 
switch their computers off confidently, so it is recommended that 
you always log out explicitly, if possible. 

You can also selectively disconnect from any workgroup or server, 
leaving your other connections open. 

Logging Out from DOS, Non-interactive 

Use the NET LOGOUT command. See the "NET Commands" 
chapter of DOSBook for details. 

Logging Out from DOS, Interactive 

ProcedureT 1. At the system prompt, type 

NET <Enter> 

The NetWare User program loads, showing the NetWare view. 
To display online help, press <Fl>. 

2. Highlight the workgroup or NetWare server from which you 
want to log out. 

3. Choose Disconnect... from the File menu, or press <Del>. 
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Logging Out from MS Windows 

ProcedureT 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-dick the 
Net Ware icon in the main window. 

3. In the left side of the window, select the workgroup or server 
from which you want to log out. 

4. From the File menu, choose Logout. 

Closing Down Your Server 

21-42 

If your computer is a server, you can inadvertently cause other users to lose 
information and time if you switch it off or reboot it while they are using its 
shared files or printers. To minimize the possibility of this, the server intercepts 
the <Ctrl><Alt><Del> reboot command. It displays a pop-up window, 
informing you of the number of open connections and files. Unless these 
numbers are zero, you should not continue with rebooting. 

However, if they have AUTO.VLM loaded, clients have some protection against 
short disconnections. If the server loses power for a few moments, or is 
rebooted, AUTO.VLM attempts to remake connections to it when it becomes 
available again. 

Before you can close down the server, you must log in to your 
server's workgroup. Refer to "Logging In" on page 21-2. 

The best procedures for closing down your server, before you 
attempt to reboot it or switch it off, are as follows. 
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Closing Down a Server from DOS 

Procedure'W' 1. At the system prompt, type 

NET DOWN <Enter> 

If there are no active connections other than your own, this 
closes your server. You can now reboot your computer or switch 
it off. 

If there are active connections, NET DOWN warns you. It allows 
you to close the server anyway, but offers the choice of not 
doing so. It is safest to do the following. 

2. At the system prompt, type 

NET CONSOLE <Enter> 

The NET CONSOLE program's window appears. It shows full 
details of users and their connections, and allows you to 
broadcast a message to them. 

3. Send a message to active users. 

Assuming they respond by closing their files, you can safely 
close the server. 

4. Exit from NET CONSOLE. 

5. At the system prompt, type 

NET DOWN <Enter> 

Closing Down a Server from MS Windows 

Procedure'~ 1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. In the left side of the window, double-click your workgroup to 
display servers. 
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To 

Send the user a 
message 

See if the user has any 
open files on your 
server 

Disconnect the user 

4. Select your server. 

5. From the File menu, choose Properties ... 

In the Server Information dialog, you can see if there are any 
connected users (other than yourself). 

6. For each connected user 

Do this 

1. In the NetWare window, select the user. 

2. From the File menu, choose Properties ... 

3. In the User Information dialog, type the message, then choose the 
<Send> button. 

1. Select the user from the list on the Server Information dialog. 

2. Choose the <Open Files> button. 

1. Choose the <Disconnect User> button on the Server Information 
dialog. 

Note that you cannot disconnect yourself this way. 

7. When you are satisfied that no other user has open files on your 
server it is safe to reboot or switch off your computer. 
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chapter 22 
Optimizing and Maintaining the 
Network 

This chapter describes tasks that should be performed from time to 
time to make sure that the network is running as efficiently as it 
can. 

This chapter includes information about the following tasks: 

+ Network Management (22-1) 

+ Optimizing Server Performance (22-2) 

+ Backing Up Workgroup-Related Data (22-2) 

+ Restoring Workgroup-Related Data (22-3) 

+ Audit Log (22-4) 

+ Error Log (22-6) 

+ Uninstalling Network Software (22-8) 

Network Management 

The network supports SNMP network management, described in 
Chapter 25, "Configuring Your Computer for Desktop SNMP 
Services." To allow SNMP to manage each computer, use SETUP at 
each computer to enable it. 
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Optimizing Server Performance 

You can fine-tune server configuration to improve performance. 
Display the statistics about current server configuration and 
performance, and then use these to change server settings. 
Displaying statistics is described in "Obtaining Performance 
Statistics" on page 20-20. Changing the network configuration is 
described in "Configuring a Server" on page 20-14. 

Because the hard disk performance of a server may be important to 
all users, run DISKOPT regularly to defragment files and free space. 
DISKOPT can only be used by the user who is physically working on 
the server and only when the network software is not loaded. 

When optimizing a server's hard disk, you should also consider 
scanning it for viruses, in addition to a regular virus scan. This is 
described in Chapter 14, "Securing Information." 

Backing Up Workgroup-Related Data 

checklistV 

The network maintains data about the servers, shared resources, and 
users. Some of this data is kept in a distributed database, with a copy 
at each server. Other, server-specific, information is kept only at the 
server to which it refers. To minimize the danger of the workgroup 
data being corrupted, it is recommended that you regularly back it 
up, using NET ADMIN's backup command. 

Then, if it ever appears that data is corrupted, possibly as the result 
of a server crashing, you can restore the data from the backup copy. 

Before you can back up workgroup data, you must do the following: 

0 You must log in to the server's workgroup. Refer to "Logging In" on 
page 21-2. 

0 You must have workgroup administrator privileges as well as the 
right to manage this server. 

You can back up any server if you have appropriate rights for that 
server. You do not have to be using the server locally in order to take 
a backup. 
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ProcedureT 

To back up workgroup data, do the following: 

1. At the system prompt, type 

NET ADMIN <Enter> 

2. Highlight the server to back up from the list of servers. 

3. Select Properties ... from the File menu. 

4. Select the <Backup Databases ... > button. 

5. Specify the name of the directory into which the data should be 
saved. 

It is a good idea to keep more than one backup, in differently 
named directories. The backup consists of several files in one 
directory within the directory you specify. The directory name 
is the same as the server name, with the extension .BAK. 

Restoring Workgroup-Related Data 

Checklist'V' 

If it appears that the workgroup-related data has become corrupt, 
perhaps as a result of a server crashing, you can restore the data 
from the last backup made, as described in the previous section. 

Before you can restore workgroup data, you must do the following: 

0 You must log in as a local user of the Personal NetWare™ server 
which is to be restored. 

0 You must log in to the server's workgroup. Refer to"Logging In" on 
page 21-2. 

0 You must have workgroup administrator privileges as well as the 
right to manage this server. 
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ProcedureT 

Audit Log 

To restore workgroup data, do the following: 

1. At the system prompt, type 

NET ADMIN <Enter> 

2. Highlight the server from the list of servers. 

3. Select Properties ... from the File menu. 

4. Select the <Restore Databases ... > button. 

5. Specify the name of the directory from which the data should 
be restored. 

6. In addition to the server-specific data, specify which parts of 
the workgroup data you want to restore. 

This replaces the workgroup data on every server in the workgroup, and loses 
any changes that have been made since the backup. 

Although you can specify which of the workgroup, user and 
resource databases you want to restore, in almost all cases you 
should restore them together or not at all. 

For each workgroup, an audit log is kept, unless it has been turned 
off. The log records full details each time any of the following 
occurs: 

+ A server is switched on and becomes available. 

+ A server is switched off or closed down. 

+ A user logs in or out. 

You can turn audit logging on or off, and display, save, or delete the 
log. 

22-4 Novell DOS 7 User Guide 



checklistV 

Before you can use the audit log, you must do the following: 

0 You must log in to the workgroup. Refer to "Logging In" on page 
21-2. 

0 You must have workgroup administrator privileges. 

You can maintain the audit log from DOS or MS Windows. 

Maintaining the Audit Log from DOS 

ProcedureT 

To 

Turn auditing on or 
off 

Save the log to a file 

Delete the log 

1. At the system prompt, type 

NET ADMIN <Enter> 

2. Select Audit Log ... from the Workgroup menu. 

The log is displayed. It shows all events in the workgroup 
known to the servers that are currently available. If any server is 
"down" its events are not shown. The log is ordered by time and 
date. 

3. Refer to the following table to see what to do next. 

Do 

1 . Select or deselect the "Auditing Enabled" check box. 

1. Choose the <Save As ... > button. 

2. Specify the file's path and name. 

The saved file is an ASCII text file which can be edited and printed. 

1 . Choose the <Delete ... > button. 

4. When you have finished, select the <OK> button. 

Optimizing and Maintaining the Network 22-5 



Maintaining the Audit Log from MS Windows 

ProcedureT 

To 

Turn auditing on or 
off 

Save the log to a file 

Delete the log 

Error Log 

1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Select the workgroup from the list on the left side of the 
NetWare window. 

4. From the File menu, choose Properties ... 

5. In the Workgroup Connection Info dialog, choose the 
<Audit Log ... > button. 

The audit log appears. Scroll it to see all events. 

6. Refer to the following table to see what to do next. 

Do this 

1. Select or deselect the "Workgroup auditing active" check box. 

1 . Choose the <Save as ... > button. 

2. Specify the file's path and name. 

The saved file is an ASCII text file which can be edited and printed. 

1 . Choose the <Clear Log> button. 

7. Choose the <Close> button to close the dialog. 

For each workgroup, an error log is kept. The log records full details 
each time an error occurs. 

You can display, save, or delete the log. 
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checklistV 

Before you can use the error log, you must do the following: 

0 You must log in to the workgroup. Refer to "Logging In" on page 
21-2. 

0 You must have workgroup administrator privileges. 

You can maintain the error log from DOS or MS Windows. 

Maintaining the Error Log from DOS 

ProcedureT 

To 

Save the log to a file 

Delete the log 

1. At the system prompt, type 

NET ADMIN <Enter> 

2. Select Error log ... from the Workgroup menu. 

The log is displayed. It shows all error messages in the 
workgroup known to the servers that are currently available. If 
any server is "down" its errors are not shown. The log is ordered 
by time and date. 

3. Do either of the following. 

Do 

1. Choose the <Save As ... > button. 

2. Specify the file's path and name. 

1. Choose the <Delete ... > button. 

4. When you have finished, select the <OK> button. 
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Maintaining the Error Log from MS Windows 

ProcedureT 

To 

Save the log to a file 

Delete the log 

1. In Program Manager, choose the Personal NetWare icon in the 
Personal NetWare group window. 

2. Open the NetWare window, unless it is already open. 

From the Window menu, choose NetWare, or double-click the 
NetWare icon in the main window. 

3. Select the workgroup from the list on the left side of the 
NetWare window. 

4. From the File menu, choose Properties ... 

5. In the Workgroup Connection Info dialog, choose the 
<Error Log ... > button. 

The error log appears in a scrollable field. 

6. Refer to the following table to see what to do next. 

Do this 

1 . Choose the <Save as ... > button. 

2. Specify the file's path and name. 

The saved file is an ASCII text file which can be edited and printed. 

1. Choose the <Clear Log> button. 

7. Choose the <Close> button to close the dialog. 

Uninstalling Network Software 

To uninstall the network software on your computer, you must edit 
AUTOEXEC.BAT to remove the reference to STARTNET.BAT. You 
can reclaim the disk space used by the network software by deleting 
the contents of the directory it is in (C:\NWCLIENT and 
C:\NWCNTL, by default). 
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chapter 23 
NET Commands 

This chapter introduces the commands that network users can enter 
at the system prompt. These commands largely duplicate the 
interactive functions described in Chapter 20, "Setting Up the 
Network," Chapter 21, "Using the Network," and Chapter 22, 
"Optimizing and Maintaining the Network." The choice of using 
these commands or using the NET program depends on which you 
find quicker and easier. Refer also to the following section, "Why 
Use NET Command Lines?" 

Chapter 18, "Introduction to Personal NetWare," explains the ideas, 
terms, and operations you need to use the network. Refer to this 
information if you are not already familiar with it. 

In addition to the commands listed in this chapter, NetWare® 
commands can be used to achieve many of the same functions, if 
you are a NetWare client, where they relate to NetWare servers. In 
some cases, you must use a NetWare command to refer to a NetWare 
server and a NET command to refer to a workgroup. This is stated 
where appropriate in the full descriptions of the NET commands, in 
the "NET Commands" chapter of DOSBook. 

To use the interactive NET program, rather than NET command 
lines, type one of the following at the system prompt: 

NET <Enter> 

NET ADMIN <Enter> 

NET CONSOLE <Enter> 

NET DIAGS <Enter> 

These operations are all described in Chapter 20, "Setting Up the 
Network," Chapter 21, "Using the Network," and Chapter 22, 
"Optimizing and Maintaining the Network." 
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If you type any other form of the NET command, it executes that 
command line and returns to the system prompt. A few commands 
ask you for a password or to press Y to confirm them but other than 
this they are not interactive. 

Why Use NET Command Lines? 

NET command lines have the following uses: 

+ Individually, they are quicker than running the interactive NET 
programs. 

+ Some commands can only be used in command lines. 

+ The output from command lines can be saved to a file, or 
printed, to provide a permanent record. 

+ NET command lines can be put into batch files. 

NET SYNC and NET WAIT, for example, do not have an 
interactive equivalent because they are intended for use in 
batch files only. 

Putting NET commands into batch files simplifies reconnecting 
to the network, especially when they are used in conjunction 
with the NET SAVE command. User Bryan, for example, could 
put the following lines in a file called UPDATEX.BAT: 

NET MAP G: LIVEDATA 

NET MAP T: TOOLS 

T:UPDATEX G:MARCH %1 

NET MAP DEL G: 

NET MAP DEL T: 
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NET Command Summary 

The NET commands fall into the following groups: 

+ Connection commands 

+ List available resources 

+ Inquire about existing resources 

+ Make and break connections 

+ Settings commands 

+ Inquire about network settings 

+ Change certain network settings 

+ Function commands 

+ Administration: write to the audit log, share resources, 
synchronize, close servers 

+ User features: get online help, print files, send messages, save 
connections 

These commands are all listed in the following tables. Most 
commands require parameters that are not shown in the tables; for 
information about these parameters, refer to the full command 
descriptions in the "NET Commands" chapter of DOSBook. 
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Connection Commands 

Table 23-1 

You can list available resources, and display, make, or change any 
connection to them. Use the following NET commands. 

Connection Commands 

your 
workgroup 

any 
workgroup 

NetWare 
servers 

directories 

printers 

users 

server 
extensions 

23-4 

To list To inquire about To connect To disconnect 

NET INFO NET LOGIN NET LOGOUT 

NETWGFIND NET JOIN NET LOGOUT 
NETWGLIST 

NET SLIST NET CONNECT NET CONNECT NET LOGOUT 

NETWDLIST NET MAP NET MAP NET MAP DEL 

NET WPLIST NET CAPTURE NET CAPTURE NET CAPTURE DEL 

NET ULIST 

NET XLIST 

Note that the output normally seen on your screen can be saved to 
a file or printed. For example, the following command sends a list 
of connected (mapped) drive letters to a file named FLIST.TXT: 

NET MAP >FLIST. TXT <Enter> 

Novell DOS 7 User Guide 



Settings Commands 

Table 23-2 

Settings Commands 

your computer's details 

your workgroup password 

message reception 

rights to a directory 

audit logging 

NetWare 4.x context 

You can inquire about and change many (but not all) settings. 
Other settings can only be changed by running NET ADMIN 
interactively, as described in Chapter 20, "Setting Up the Network." 

To inquire about To set 

NET INFO 

NET SETPASS 

NET RECEIVE NET RECEIVE ON/OFF/time 

NET RIGHTS NET RIGHTS ADD 

NET AUDIT NET ADMIN 

NET CONTEXT NET CONTEXT 

protocol retries and timing NET LINK NET LINK 

watchdog timer NET SETDOG 

Function Commands 

Table 23-3 

Function Commands 

You can perform the following miscellaneous administrative and 
user functions. 

Function Use 

Write an entry in the audit log NET AUDIT 

Share a directory or printer NET SHARE 

Synchronize servers' clocks NET NTIME 

Synchronize batch files NET SYNC 

Synchronize client's clock NET TIME 
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Table 23-3 

Function Commands 

Function Use continued 

Wait NET WAIT 

Close your server NET DOWN 

Get help on any NET command NET HELP command 

Print a file NET PRINT 

Send a message NET SEND 

Save connections NET SAVE 

Before Running NET Commands 

Before you run NET commands at the system prompt, be aware of 
the following: 

+ The network software must be installed on your computer. 

+ The client software must be loaded. Normally, this means that 
you must have run STARTNET.BAT. 

+ Some commands require you to be logged in. This is noted in 
the detailed command descriptions in the "NET Commands" 
chapter of DOSBook. If you are not logged in, commands that 
relate to your current workgroup use the last workgroup you 
logged in to in the current session, if any, or the workgroup set 
in your NET.CFG file. 

+ Almost all commands can be entered at the system prompt or 
can be placed in a batch file. 
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chapter 24 
Using Network Diagnostics 

The Personal NetWare™ Network Diagnostics utility allows you to 
monitor the operation of the network. The information it provides 
is primarily of interest to users who have a good technical 
understanding of how networks function. In particular, Network 
Diagnostics enables you to do the following: 

+ View and monitor another workgroup or network 

+ Compare traffic for servers and clients 

+ Compare server utilization 

+ Compare server and client disk information 

+ View server and client configuration information 

+ View server and client statistics 

+ Test server and client connections 

There are DOS and MS Windows versions of Network Diagnostics. 
The two versions provide similar functionality, but some features 
are unique to the DOS version. These additional DOS features are 
described in "Features Specific to Network Diagnostics in DOS" on 
page 24-4. 
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Enabling Network Diagnostics 

ProcedureT 

By default, network diagnostics are enabled when you install the 
networking software. To disable or re-enable network diagnostics 
after installation, do the following: 

1. At the system prompt, type 

SETUP <Enter> 

2. Choose the Networking option. 

You can now page through the network configuration screens. 

3. Select or deselect the option Load NMR Network Management 
module, then save the changes and exit SETUP. 

SETUP automatically adds (or removes) the command 
VLM=NMR.VLM to the NET.CFG file on your computer. If the 
command is added, this VLMT~ the Network Management 
Responder, is loaded automatically when you restart the 
operating system. 

4. Restart the operating system, and answer Y to the prompt 

Load Network Software (Y/N) 

Starting Network Diagnostics in MS Windows 

checklistV 

Network Diagnostics in MS Windows provides a graphical interface 
to the diagnostics tasks. Information about how to perform these 
tasks is provided in the online help in Network Diagnostics. 

0 You must be logged in; see "Logging In" on page 21-2. 

0 You must have enabled Network Diagnostics; see the previous 
section "Enabling Network Diagnostics." 
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ProcedureT 

To access Network Diagnostics, do the following: 

1. Open the Program Manager "Personal NetWare" group. 

2. Choose the "Network Diagnostics" icon. 

The Network Diagnostics window appears. 

3. Use the online help within the Network Diagnostics utility for 
more information. 

Starting Network Diagnostics in DOS 

checklistV 

ProcedureT 

Network Diagnostics in DOS provides all the diagnostic features 
included in the MS Windows version. It also has some additional 
features, which are described in the next section, "Features Specific 
to Network Diagnostics in DOS." 

0 You must be logged in; see "Logging In" on page 21-2. 

0 You must have enabled Network Diagnostics; see "Enabling 
Network Diagnostics" on page 24-2. 

1. At the system prompt, type 

PNWDIAGS <Enter> 

or 

NET DIAGS <Enter> 

The Main Menu appears. 
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Features Specific to Network Diagnostics in DOS 

The DOS version of Network Diagnostics has two options that are 
not available in the MS Windows version. 

+ The Select Data option enables you to view another workgroup 
or network, and manage network name files without leaving the 
workgroup you are in. It also enables you to associate network 
names. 

+ The Save LANalyzer Name File option saves files created through 
the Associate Network Names option as files that can be viewed 
in Novell's LANalyzer® for Windows product. 

Viewing Another Workgroup 

24-4 

ProcedureT 

You can view and monitor activity in any known workgroup on 
your network. By selecting a workgroup, you can view statistics and 
user activity associated with it. 

To view another workgroup, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Choose Select Data from the Main Menu. 

3. Choose Select a Workgroup from the Data Selection Items menu. 

A list of available workgroups appears. 

4. Choose a new workgroup and press <Enter>. 

The new workgroup name is displayed at the top of the screen. 
All options selected will apply only to that workgroup. 

Some workgroups on the network may not immediately appear. 
To search for a workgroup not currently displayed, use the NET 
WGFIND command before entering Network Diagnostics in 
DOS. 
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Viewing A Network 

ProcedureT 

You can view and monitor activity on a network by selecting it. All 
known network segments are available for viewing. Each network is 
identified by a unique hexadecimal number called a network number. 

To view another network, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Choose Select Data from the Main Menu. 

3. Choose Select a Network from the Data Selection Items menu. 

A list of available network numbers appears with your current 
network number highlighted. 

4. Choose a new network segment and press <Enter>. 

5. To view nodes on the selected network, return to the Main 
Menu and choose View Configuration. 

All network computers (nodes), including clients and servers 
currently connected to the selected network, are displayed. 

Only the node addresses are displayed. You can display the list 
of server names and login names by using the Associate Network 
Na mes option. 

Associating Network Names 

After node addresses are listed using the Select a Network option, 
login and server names can be viewed for each node address. 

Be aware that, depending on the number of nodes connected to the 
selected network segment, obtaining the login and server names of 
each node could be quite time consuming. 
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ProcedureT 

Refreshing Data 

ProcedureT 

To associate network names, do the following: 

1. Choose Select Data from the Main Menu. 

2. Choose Select a Network from the Data Selection Items menu. 

3. Choose a network. 

4. Choose Associate Network Names from the Data Selection Items 
menu. 

5. Choose Find Diagnostics User Names from the Network Names 
menu. 

The Diagnostics utility searches the network and compiles 
server and login names for each node address. 

6. To view the names associated with each node, return to the 
Main Menu and choose View Configuration. 

After searching the network, server names, login names, and 
node addresses are displayed. Diamonds appear next to any 
associated names obtained from a previously saved network 
name file. 

The names and addresses are saved to a file and may be accessed 
and updated through the Use Diagnostics Name File option in the 
Network Names menu. 

The Refresh the data option refreshes the workgroup or network 
information since a diagnostic option was selected or since the last 
refresh. 

Refreshed data displays all computers (nodes) that are found in a 
workgroup or network. It will not display nodes that have logged 
out. 

To refresh data, do the following: 

1. Choose Select Data from the Main Menu. 

2. Choose Refresh the data from the Data Selection Items menu. 
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Saving LANalyzer Name Files 

ProcedureT 

You can save files that can be used with Novell's LANalyzer for 
Windows product. When using LANalyzer for Windows, each node 
can be viewed by its name, rather than by its node address. 

To save the name files, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Choose Save LANalyzer Name File. 

3. Type a filename and, if desired, a path. 

Comparing Traffic for Servers and Clients 

Network traffic information can help you determine if a particular 
computer is overloaded or having problems. 

Comparing Traffic in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "Graph Node Traffic" in the online help in Network Diagnostics 
for information about traffic comparison procedures. 
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Comparing Traffic in DOS 

ProcedureT 

To compare traffic, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Select Compare Data. 

The Select Nodes menu appears with the following choices: 

+ All Nodes, for computers running as client, server, or both 

+ Servers, for computers running server software only 

+ Clients, for computers running client software only 

3. Select the computers (nodes) you want to view traffic 
information about: all nodes, servers, or clients. 

The Compare Options menu appears. 

4. Choose Traffic. 

Network traffic information is displayed for the nodes you 
selected. For help with this screen, press <Fl>. 

5. Press <ESC> to exit. 

Comparing Server Utilization 

You can view two different measures of Personal NetWare server 
utilization. 

+ Ratio of local requests to remote requests processed by the 
computer 

+ Actual number of packets a server is processing 

Server utilization information can help you decide how to allocate 
current resources and help you plan for distributing future 
resources. 
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In addition to these statistics, Network Diagnostics in DOS also 
displays the following information: 

+ Connection information 

+ Number of open files 

+ Server activity 

Comparing Server Utilization in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "Graph Server Utilization" in the online help in Network 
Diagnostics for information about comparing server utilization. 

Comparing Server Utilization in DOS 

ProcedureT 

To compare server utilization, do the following: 

1. Start Network Diagnostics as described in "Starting Network 
Diagnostics in DOS" on page 24-3. 

2. Select Compare Data. 

The Select Nodes menu appears with the following choices: 

+ All Nodes, for computers running as client, server, or both 

+ Servers, for computers running server software only 

+ Clients, for computers running client software only 

3. Select the computers (nodes) you want to view server 
utilization information about: all nodes, servers, or clients. 

The Compare Options menu appears. 

4. Choose Local/Remote Utilization or Server Utilization, depending 
on the kind of server information you want to view. 

Server utilization information for the kind of computers you 
selected appears. For help with this screen, press <Fl>. 
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5. Press <ESC> to exit. 

Comparing Server or Client Disk Information 

Disk information can help you determine current resource 
efficiency and plan for future resources. You can view the 
information in the following ways: 

+ Physical resource information, such as available hard drive 
space and CPU type 

+ Activity levels for computers and hard drive usage 

Comparing Disk Information in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "Graph Node Disk Space" in the online help in Network 
Diagnostics for more information. 

Comparing Disk Information in DOS 

ProcedureT 

To compare disk information, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Select Compare Data. 

The Select Nodes menu appears with the following choices: 

+ All Nodes, for computers running as client, server, or both 

+ Servers, for computers running server software only 

+ Clients, for computers running client software only 

3. Select the computers (nodes) you want to view disk 
information about: all nodes, servers, or clients. 

The Compare Options menu appears. 
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4. Choose Resource Distribution or Resource Efficiency, depending on 
the kind of disk information you want. 

Resource information for the kinds of computers you selected 
appears. For help with this screen, press <Fl>. 

5. Press <ESC> to exit. 

Viewing Server and Client Configuration Information 

Configuration information provides information about a 
computer's physical components, such as memory, drives, 
operating system, and network cards. 

Configuration information regarding software components such as 
cache and server is also included. 

Viewing Configuration Information in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "View Node Statistics and Configuration" in the online help in 
Network Diagnostics for more information. 

Viewing Configuration Information in DOS 

ProcedureT 

To view the configuration information, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Select View Configuration. 

The Select Nodes menu appears with the following choices: 

+ All Nodes, for computers running as client, server, or both 

+ Servers, for computers running server software only 

+ Clients, for computers running client software only 
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3. Select the computers (nodes) you want to view configuration 
information about: all nodes, servers, or clients. 

If you choose All Nodes, all nodes are listed by either server 
name (if server software is running) or user login name (if server 
software is not loaded but the user is logged in). 

If you choose Server, all server names and server node addresses 
are listed. 

If you choose Client, all user login names and node addresses are 
listed. 

4. Select the specific computer (node) you want to view 
configuration information about. 

Configuration information for the computer you selected 
appears. For help with this screen, press <Fl>. 

5. Press <ESC> to exit. 

Viewing Server and Client Statistics 

Server and client statistics provide information about the 
networking software on a computer, such as media frame type, 
network packet requests, error counts, and server and workgroup 
names. 

Viewing Statistics in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "View Node Statistics and Configuration" in the online help in 
Network Diagnostics for information about how to view statistics. 
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Viewing Statistics in DOS 

ProcedureT 

To view statistics, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Select View Statistics. 

The Select Nodes menu appears with the following choices: 

~ All Nodes, for computers running as client, server, or both 

+ Servers, for computers running server software only 

+ Clients, for computers running client software only 

3. Select the kinds of computers you want to view statistics for: all 
nodes, servers, or clients. 

If you choose All Nodes, all computers are listed by either server 
name (if server software is running) or user login name (if server 
software is not loaded but the user is logged in). 

If you choose Server, all server names and addresses are listed. 

If you choose Client, all user login names and node addresses are 
listed. 

4. Select the specific computer (node) you want to view statistics 
for. 

Statistical information for the computer you selected appears. 
For help with this screen, press <Fl>. 

5. Press <ESC> to exit. 
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Testing Server and Client Connections 

You can test connections in the following ways: 

+ Connections between two specific computers (nodes) on the 
network (for DOS only) 

+ Connections between all computers on the network 

Testing Connections in MS Windows 

If you use MS Windows, start Network Diagnostics as described in 
"Starting Network Diagnostics in MS Windows" on page 24-2. Refer 
to "Test Workgroup Connections" in the online help in Network 
Diagnostics for information about how to test connections. 

Testing Connections in DOS 

Procedure'?' 

To test connections, do the following: 

1. Start Network Diagnostics as described in the section "Starting 
Network Diagnostics in DOS" on page 24-3. 

2. Choose Test Connections. 

The Connection Tests menu appears, listing the following 
available tests: 

+ Point to point tests communication between two specific 
computers on the network 

+ All points tests communication between all computers on the 
network 

3. Select Point to point test or All points test, depending on what 
connections you want to test. 

For help with the results of either test, press <Fl>. 

4. Press <ESC> to exit. 
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chapter 25 

Introduction 

Configuring Your Computer for Desktop 
SNMP Services 

Simple Network Management Protocol (SNMP) is an industry­
standard protocol for communication between a network 
management console and the network devices that the console is to 
monitor. This chapter explains how to enable desktop SNMP 
services on your computer, and how to modify the NET.CFG file to 
implement additional SNMP options. The chapter is primarily for 
supervisors of networks in which an SNMP-based network 
management -system is implemented. 

Through the SNMP agent provided with Personal Net Ware™, 
workgroups can be managed from Novell's NMS™ (NetWare 
Management System™), from other industry-standard SNMP 
management consoles, or from other third-party management 
systems. 

Personal NetWare includes the following components: 

+ HOSTMIB, the Host Resources MIB (Management Information 
Base), which collects information about any computer that is 
running Novell DOS™ 7. 

+ PNW, which collects information about a Personal NetWare 
server. 

+ PNWTRAP, which notifies the management console of certain 
events on the Personal NetWare server, such as logins or the 
entry of invalid passwords. 
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Note that you require additional software running on a network 
management console to monitor the information collected by the 
SNMP agent, and you should refer to the documentation for that 
software to find out how to use it with the Personal NetWare agent. 

Enabling Desktop SNMP Services 

ProcedureT 

By default, desktop SNMP services are not enabled when you install 
the networking software. To enable desktop SNMP services, do the 
following: 

1. At the system prompt, type 

SETUP <Enter> 

2. Choose the Networking option. 

3. Choose the <Network Management> button. 

4. Select load SNMP Agent, then save the changes and exit SETUP. 

SETUP does the following: 

+ Modifies the STARTNET.BAT file on your computer to load 
HOSTMIB.EXE, the Host Resources MIB, and STPIPX.COM, 
the Desktop SNMP transport provider. 

+ Modifies the NET.CFG file on your computer to load the 
necessary VLMs, and sets the appropriate VLM™options in 
NET.CFG. 

+ Reads the addresses of the NetWare Management Services 
(NMS) consoles from the bindery of the attached server if the 
computer is attached, and copies them to your NET.CFG file 
as trap target addresses. 

+ Prompts the user to enter the trap target addresses if not 
attached, then copies these addresses to the NET.CFG file. 

5. Restart the operating system and answer Y to the following 
prompt: 

Load Network Software (Y/N)? 
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Note~f' Personal NetWare network management support includes the files 
PNWTRAP.MIB and PNW.MIB; these files are needed on the network 
management console to enable the console to view the data collected at the 
desktop. The files are held in the directory C:\NWCLIENT. Refer to the 
documentation provided with the network management console to find out 
how to integrate the MIBs with the software on the console. 

Setting the Time Zone Parameter 

Use the DOS SET command at the system prompt or in a batch file 
to set the correct time zone for your area, as follows: 

SET TZ = time zone 

If the time zone is not set in your computer's environment, traps for 
SNMP may report an incorrect time. 

Configuring the HOSTMIB.INI File 

The Host Resources MIB does not return information about devices 
attached to the host computers, such as printers, modems, and tape 
drives. If the network management console is to display details of 
such devices, you must list them in the HOSTMIB.INI file. This file 
is located in the directory to which you installed Personal NetWare 
(C:\NWCLIENT by default) on your computer. Use a text editor to 
enter a short description of each device. For example: 

# Sample configuration file for HOSTMIB.EXE 

# List of all printers connected to host 

[printers] 

HP LaserJet IIIp on LPTl: 

#NEC P20 on LPT2: 

# List of all modems connected to host 

[modems] 

Hayes Optima 144 on COMl: 
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# List of all tape drives connected to host 

[tapes] 

#Colorado DJlO 

HP 35480A SCSI DAT (4-8 GB) 

# other devices obtained via DOS APis 

Sample NET.CFC File for Desktop SNMP Services 

25-4 

A sample of the NET.CFG for SNMP services is as follows: 

Link Driver NE2000 

PORT 300 

INT 3 

FRAME Ethernet 802.2 

MEM DOOOO 

Netware DOS Requester 

USE DEFAULTS = ON 

VLM WSSNMP.VLM 

VLM WSTRAP.VLM 

VLM WSREG.VLM 

VLM WSASNl.VLM 

VLM MIB2IF.VLM 

VLM PNW.VLM 

VLM PNWTRAP.VLM 

PREFERRED WORKGROUP = PN_WORLD 

WORKGROUP NET = 04a23500:FEEEFFFFFFFF 

PREFERRED SERVER = ENGINEERING 

FIRST NETWORK DRIVE = F 

NAME CONTEXT = "OU=TECHSUPPORT" 

DESKTOP SNMP 

sysName = "" 

sysLocation = "" 

sysContact = "" 

snmpEnableAuthenTraps = ON 

Enable Monitor Community = SPECIFIED 

monitor community = "public" 
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Enable Control Conununity = SPECIFIED 

control conununity = "public" 

Enable Trap Conununity = SPECIFIED 

trap conununity = "public" 

asynchronous timeout = 20 

TRANSPORT PROVIDER IPX 

trap target 04a68900:0000lb0ef8f8 

trap target = 04a26700:00001blelef8 

TRANSPORT PROVIDER UDP 

trap target 123 .123 .111.111 

trap target = 222.121.111.122 

Conventional Memory Usage 

Note,.f" 

If you are willing to trade conventional memory for performance, 
you can load one or more Desktop SNMP VLM files in conventional 
memory. 

To load all VLM files in conventional memory, use the VLM /MC switch when 
running the VLM manager. 

To load a Desktop SNMP VLM in conventional memory, place lines 
of the following form in the NET.CFG file: 

Netware DOS Requester 

VLM = VLMName.VLM 

Load low VLMName = On 

For example, to load Desktop SNMP while loading WSASNl.VLM 
and WSREG.VLM in conventional memory, place the following 
lines in NET.CFG: 

Netware DOS Requester 

VLM WSSNMP.VLM 

VLM WSTRAP.VLM 

VLM WSREG.VLM 

VLM WSASNl.VLM 

Load low WSREG = On 

Load low WSASNl = On 
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Where to Go from Here 

After you have completed the initial configuration of the desktop 
SNMP agent, you can modify the SNMP options in the NET.CFG file 
to meet your specific network requirements. Refer to the "NET.CFG 
Options Reference" chapter in DOSBook for a description of these 
modifications. 
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chapter 26 

Introduction 

Note~f' 

Running /PX and SPX Applications in a 
Task-Switching Environment 

The NetWare® task-switching files provide the data buffers needed 
to support IPX™and SPX requests made by applications running in 
a DOS session. You may need this support if you use a DOS task 
switcher, or if you switch DOS sessions within MS Windows in 
standard or real mode. If your application does require the NetWare 
task-switching files and you do not use them, the session fails and 
your computer may hang. 

This chapter describes how to use the NetWare task-switching files, 
and gives advice about which parameters to review in NET.CFG if 
problems arise while you are using these files. 

If you are not sure whether your application needs task-switching support, go 
ahead and run the task-switching files; they use only a small amount of memory. 
After running the application, enter the command line parameter /D and look 
at the number in the "Far Call Usage" field. If this number is zero, your 
application has not used the task-switching files, so you can run it without them. 

Task Switching in DOS 

You must use the Net Ware task-switching files if 

+ Your application bypasses the NetWare DOS Requester™ and 
accesses IPX or SPX directly, and 

+ You will be switching between applications in DOS. 
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Note~~ 

ProcedureT 

The term "switching" is used here to refer to task switching, whereby 
background tasks are suspended, rather than to multitasking. If you run the 
Novell DOS™ Task Manager as a multitasker, you do not need to use the 
NetWare task-switching files described in this chapter. Refer to Chapter 13, 
"Multitasking and Task Switching," for a description of task switching and 
multitasking. 

To use the NetWare task-switching files in DOS 

1. At the system prompt, type 

TBMI 2 <Enter> 

2. Start the Novell DOS 7 task switching software. 

Task Switching in MS Windows 

The NetWare task-switching files help non-MS Windows IPX and 
SPX programs work in a task-switching environment. 

You must use the task-switching files if 

+ You will be switching between DOS sessions, and 

+ Your application bypasses the NetWare DOS Requester and 
accesses IPX or SPX directly, and 

+ You are running in standard or real mode 

Do not use the task-switching files if you will not be switching 
between DOS sessions, or if you are running in enhanced mode. 

If you are running MS Windows 3.0, see the following section "Task 
Switching with MS Windows 3.0." If you are running MS Windows 
3.1, see "Task Switching with MS Windows 3.1" on page 26-3. 

Task Switching with MS Windows 3.0 

26-2 

The task-switching files for MS Windows 3.0 are TBMI2.COM and 
TASKID.COM. 

Load TBMI2 at the command line before you begin MS Windows; 
load TASKID in Windows after opening a system prompt. 
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Procedure~'W 1. At the system prompt, type 

TBMI 2 <Enter> 

2. Start MS Windows. 

3. Start a DOS session. 

4. At the new system prompt, load TASKID. Type 

TASKID <Enter> 

For each system prompt you open, repeat Step 5 before running 
an application from that prompt. 

5. When you close a DOS session with the EXIT command, unload 
TASKID by typing 

TASKID /U <Enter> 

If you do not unload TASKID before you close the session, your computer 
may hang. You do not need to unload TBMl2 after you exit MS Windows 
unless you want to free memory. 

Task Switching with MS Windows 3.1 

The task-switching file for MS Windows 3.1 is TBMI2.COM. 

Load TBMI2 at the command line before you begin MS Windows. 

1. At the system prompt, type 

TBMI 2 <Enter> 

2. Start MS Windows. 
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Using Command Line Parameters with TBMl2 or TASKID 

Table 26-1 

You can use any of the following command line parameters with 
TBMI2 or TASKID. 

TBMl2 or TASKID Command Line Options 

Option 

/?or /H 

/Cfilename 

ID 

/I 

/U 

Description 

Displays help text. 

Specifies an alternative configuration file that TBMl2 should use; the 
default is NET.CFG. Do not put a space between /C and the filename. For 
exam pie, you would type TBMI 2 I CTBMI 2 • CFG <Enter> at the system 
prompt. 

Displays diagnostic information. 

Displays version information. 

Unloads TBMl2 after you exit MS Windows. 

Troubleshooting TBMl2 

If you have problems while using TBMI2, you may need to change 
configuration parameters in the NET.CFG file. View configuration 
parameters by typing "TBMI2 /D" at the system prompt, and check 
the values associated with 

+ "Max Buffers Used," which tells you how many buffers are used. 

+ "Configured Data ECBs," which tells you how many buffers are 
available. If the number of buffers used approaches or equals the 
number of buffers available, increase the number of buffers 
available using the "ECB Count" and "Data ECB Count" 
parameters in the configuration file. 

+ "Unavail Buffer Count." If it is more than zero, increase the 
number of buffers available using the "ECB Count" and "Data 
ECB Count" parameters in the NET.CFG file. Refer to the 
"NET.CFG Options Reference" chapter of DOSBook for 
information about "ECB Count" and "Data ECB Count." 
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appendix A 
Troubleshooting 

This appendix describes problems you may experience with the 
operating system and suggests possible solutions. It is divided into 
three parts: the first part describes general conditions that 
commonly cause problems; the second part describes problems 
specific to certain areas, such as memory and the Task Manager; the 
third part explains fatal error messages. 

For a complete explanation of any error message that you see when using the 
operating system, consult DOSBook; from within DOSBook, type the following: 

TROUBLESHOOTING <Enter> 

Common Error Conditions 

This section represents a "checklist" of some common conditions 
which can cause errors when you are using the operating system. 

When absolutely nothing happens, remember to wait before 
assuming there is a problem; some programs take time to execute 
and some errors, such as disk 1/0 errors, cause the operating system 
to retry an operation many times before reporting an error. Once 
you are experienced with the operating system, you will know when 
a command is taking too long to complete. 

No DOS partition prepared on your hard disk 

You cannot access your hard disk until you prepare a DOS partition. 
Refer to the "Command Reference" chapter of DOSBook for a 
detailed description of FDISK, the disk partitioning utility. 

Hard disk unit not switched on 

An external hard disk unit may have its own electrical connection. 
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Peripheral devices not connected properly 

Check that peripheral devices are properly connected to your 
computer and to electrical outlets. 

File is read-only 

If a file is set to read-only, you cannot edit the file. Refer to the 
"Command Reference" chapter of DOSBook for information about 
using the ATTRIB command to set the file to read-write. 

Operating system cannot find file 

By default, the operating system looks for a file in the current 
directory of the current drive and in any directories specified in 
your current PATH. You must specify the appropriate directory if the 
file is located elsewhere. 

File is password-protected 

You must provide the correct password in order to access a file if the 
file is password-protected. Refer to Chapter 14, "Securing 
Information," for information about using passwords and security. 

Incorrect version of the operating system being used 

Many system commands will only run under the version of the 
operating system with which they are shipped. Refer to the 
description of the SETVER command in the "Command Reference" 
chapter of DOSBook for more information. 

Diskette used incorrectly or damaged 

The way in which you use diskettes is the source of many errors. 
Remember the following points: 

+ Always handle diskettes carefully. 

+ Make sure that the diskette is correctly inserted and that the 
drive door is closed. 

A-2 Novell DOS 7 User Guide 



+ Make sure that the disk you are using is the correct type for the 
drive. 

+ Double-sided drives can read single and double-sided diskettes. 
Single-sided drives can access single-sided diskettes only. 

+ Some drives can only access certain types of diskette. The 
description of the FORMAT command in DOSBook includes 
information about diskette types. 

+ Make sure that the diskette is not physically write-protected. 

+ Your diskette may be damaged. Use the COPY command to 
copy information to a new disk; refer to the description of 
COPY in the DOSBook chapter "Command Reference." Replace 
any files you cannot copy with backups, if available. If you do 
not have backup copies, you must recreate the files. You can use 
the CHKDSK command to verify the condition of your disks. 
CHKDSK will not damage your disks in any way. Refer to the 
description of CHKDSK in DOSBook, "Command Reference." 

File is corrupted 

Files can be corrupted for many reasons but power failure is 
probably the most common cause. 

If files are corrupted after you run a program that you wrote 
yourself, debug the program carefully; the program may be 
overwriting files or corrupting a directory. 

To replace a damaged file, use your backup copy. If you do not have 
a backup copy, you may have to recreate the file. 
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Problems and Solutions 

This section describes specific problems you could encounter with 
various operating system features and solutions to these problems. 

Problems with Memory 

Insufficient conventional memory 

Explanation You are running out of conventional memory. 

Action First, ensure that you are optimizing memory usage on your system; 
refer to Chapter 10, "Managing Memory" for detailed information. 

If you think you have made all the necessary changes but still run 
out of memory, try the following: 

+ Use MEMMAX +L to make sure that lower memory has not 
been disabled by an earlier command or batch file. 

+ Use the /VIDEO option with EMM386.EXE or HIMEM.SYS (if 
you are not using high-resolution graphics) to reserve video 
memory, before loading applications. Then enable video 
memory using MEMMAX +V at the system prompt or in 
AUTO EXEC.BAT. 

Computer will not boot 

Explanation Conflicting use of upper memory. Most likely, the memory manager 
is moving something into an area of upper memory also required by 
a hardware device driver. 

Action Determine the cause of the problem by performing a "clean boot" 
and then editing CONFIG.SYS and AUTO EXEC.BAT to turn off lines 
one at a time (using REM or ?) . Reboot after disabling lines that you 
suspect may be causing the problem to see if the problem remains. 
Refer to Chapter 9, "Configuring the System," for information 
about performing clean boots. 
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Packed file is corrupt 

If you determine that the memory manager is causing the problem 
by occupying an area of upper memory required by something else, 
use the /EXCLUDE option with your memory manager 
(EMM386.EXE or HIMEM.SYS) to exclude the area of memory 
causing the problem. Refer to the descriptions of EMM386.EXE and 
HIMEM.SYS in Chapter 10, "Managing Memory" for more 
information. 

Explanation An application written with packing utilities is running in lower 
memory (the first 64 KB of conventional memory) because the 
memory manager has relocated the operating system. Lower 
memory is normally occupied by the operating system and the 
application you are running does not expect lower memory to be 
available. 

Action Disable lower memory before you run the application (MEMMAX 
-L). Re-enable lower memory after exiting the application 
(MEMMAX +L). 

Program reports no EMS available 

Explanation The program you are using requires EMS (expanded) memory but 
determines that none is available. The program may be assuming 
that the LIM page frame starts at a specific address. 

Action Make sure that the LIM page frame address is defined the same way 
by EMM386.EXE (or EMMXMA.SYS) as it is in SETUP or in the 
documentation for the program. Remember that the /FRAME 
option defines the address of the page frame. Use the advanced 
memory management options in SETUP. 

Program does not load into upper memory 

Explanation One of the following: 

+ Upper memory is not available 

+ Upper memory is not enabled 

+ The memory manager is not correctly loaded 

+ The program is expanding when loaded 
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Action Check that upper memory is available by running the MEM 
command. Upper memory blocks that are available will be marked 
as FREE in the "Type" column of the MEM listing. 

If MEM indicates that upper memory is not being used, check that 
the memory manager you are using (EMM386.EXE or HIMEM.SYS) 
is correctly loaded in CONFIG .SYS. Pay particular attention to the 
/FRAME, /INCLUDE, and /EXCLUDE options to make sure that any 
addresses in upper memory are correctly specified. A common error, 
for example, is to specify a letter 0 rather than the digit 0. Also make 
sure that if you do not require expanded memory, the /FRAME 
option is set to NONE. 

Check that upper memory is enabled. HILOAD or LOADHIGH 
automatically enables and disables upper memory when you use it 
in AUTOEXEC.BAT to load a program high. You can still use 
MEMMAX +I- U at the system prompt to enable and disable upper 
memory. 

Finally, if sufficient upper memory is shown as available but a 
HILOAD/LOADHIGH, HIINSTALL/INSTALLHIGH, or HIDEVICE/ 
DEVICEHIGH command is still failing to put a program in upper 
memory, refer to the information about expanding files in Chapter 
10, "Managing Memory. The program you are trying to load could 
be expanding when it initializes and using more RAM than it will 
ultimately need. Therefore, there is not enough memory for the 
program to initialize itself in upper memory. 

Problems with the Task Manager 

Task terminates abnormally (task switching only) 

Explanation The swap file may have increased in size. 

Action Exit the Task Manager and delete the swap file to create more disk 
space. A new swap file with the same name will be created 
automatically. 

Task reports insufficient EMS 

Explanation The task you are running in expanded memory is not finding 
sufficient memory in which to run. Possibly, you have too many 
tasks currently loaded. 
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Action Remove some tasks from the Task Manager or change the maximum 
amount of EMS allowed per task and start the original task again. 

Error Messages 

There is a full list of error messages in DOSBook. This section 
explains error messages that may be generated in situations in 
which you are unable to access DOSBook, for example if the 
operating system crashes or fails to boot correctly. 

Abort, Retry, Ignore, Fail? 

Source Several commands 

Explanation Typically this message follows an error in a read or write operation. 

Action You can respond by typing A, R, I or F. 

Bad or missing file 

If the reason for the error is obvious (such as no diskette in the target 
drive) then correct the error and type R to try again. A (for abort) 
stops the current operation. I (for ignore) results in the next stage of 
the current operation continuing, as if the error had not been 
detected. F (for fail) lets the current operation know that there is an 
error, and it may therefore continue or stop. In both the last two 
cases (ignore and fail) there is a risk of data being corrupted. 

Source DOS startup procedure 

Explanation The operating system either cannot find or cannot read the 
CONFIG.SYS file on the root directory of your startup disk. 

Action Alter the CONFIG.SYS file and then restart the operating system. See 
the description of CONFIG.SYS in Chapter 9, "Configuring the 
System," for information. 
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Can't load DOS file 

Source DOS startup procedure 

Explanation The IBMDOS.COM file may be missing or corrupt. 

Action Start the operating system from your startup diskette. You will then 
need to copy the system files from that startup diskette back to the 
hard disk or diskette that failed. You can do this with the SYS 
command. Type SYS/? or SYS/Hat the system prompt to see online 
information about SYS. 

Command or filename not recognized 

Source Any command 

Explanation You have typed an invalid command. 

Action Check the spelling (Chapter 8, "Commands" explains how to recall, 
edit, and reissue commands) and re-enter the command. Also check 
the path to ensure that the required program, if spelled correctly, 
should be found. 

Data error 

Disk full 

Source Any application 

Explanation There is an error accessing the device specified. 

Action Check the device (for example make sure it is connected properly). 
If the device being accessed is a disk drive (hard or diskette), this 
error implies that data on the disk is corrupt. Make backups of all 
non-corrupt files on the disk, and then either reformat the disk, or 
use a different disk. 

Source Any command 

Action Erase some unwanted files from your disk and try again. 

Drive not ready 

Source Any command 

Explanation The diskette is not correctly in the drive, or the drive door is still 
open. 
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Error reading system area 

Source FDISK 

Explanation This message implies a hardware failure. 

Action Contact your dealer. 

Failed to get current path on drive ... (OS error code ... ) 

Source Several commands 

Explanation This is probably an error on the disk in the drive mentioned or a 
problem with the disk drive itself. 

Action Consult your dealer. 

File not found 

Source Several commands 

Explanation The command cannot find the file specified in your command line. 

1/0 error ... 

Action Check the spelling of the filespec. If the filespec was spelled 
correctly, use DIR or XDIR to check the contents of other directories 
for the location of the specified file. 

Source Any application 

Explanation An Input/Output error occurred while accessing the requested 
device. In the case of a diskette drive, this may mean a corrupt 
diskette. 

IBMBIO.COM read error 

Source Diskette system loader 

Explanation The programs used to startup the operating system from diskette are 
corm pt or in the wrong order. 

Action Start DOS from a different startup diskette. If you want to use the 
failed startup diskette again you will need to reformat it using the 
IS (copy system files) switch within FORMAT. 
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Illegal drive in Path Specification 

Source Several commands 

Explanation You specified a drive that is not assigned in your system, or you 
mistyped the drive specification. 

Action Retype the command with a valid drive. 

Incorrect version of operating system 

Source Several commands 

Explanation The version numbers are different between the operating system 
running on your computer and the file containing the utility that 
you have just tried to load. 

Action The best solution is not to keep any old version of the operating 
system on your disks. 

Insert a boot diskette in A: then PRESS Ctrl/ Alt/Del... 

Source DOS hard disk system loader 

Explanation This message follows any error message that arises from the hard 
disk system loader. The effect is to get you to restart the operating 
system from your startup diskette. No system files can be found. 

Action Use the SYS command or re-install the operating system, as there are 
no files on the disk. 

Internal error: System tables too large 

Source Task Manager 

A-10 

Explanation The configuration on your computer is too complex, there is not 
enough memory to describe it and it has exceeded the internal 
structures created by the Task Manager. 

Action Consult your dealer with details of your configuration, explaining 
the error message you received. 
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Invalid partition table 

Source DOS hard disk system loader 

Explanation More than one partition is marked as bootable (that is, able to start 
DOS), a non-existent partition is marked as bootable, or there is a 
hard disk failure. 

Action Restart the operating system from diskette. Appendix B, "Preparing 
the Hard Disk" describes how to use FDISK to set the bootable 
partition. Note that FDISK formats the disk, and you will lose any 
data on the disk. 

No operating system 

Source Hard disk system loader 

Explanation This message originates in software that your supplier provides with 
the hard disk. 

Action Start the operating system from the diskette. Copy DOS onto the 
hard disk and then use FDISK to make the system partition 
"bootable" (that is, capable of loading DOS when the computer is 
started). 

Not enough memory 
Not enough memory for .. . 
Not enough memory to .. . 

Source Several commands 

Explanation There is insufficient free memory for the command to work. 

Action Free some memory by creating a smaller memory disk, or by 
removing memory-resident programs, or device drivers that you do 
not need. Then try the command again. 

Not ready error 

Source Any application 

Explanation The device you are trying to access is not responding. In the case of 
a diskette-drive, this usually means there is no diskette in the drive, 
or the drive door is not shut. With hard disks, this error may mean 
a hardware failure. 

Action Check that your diskette is inserted correctly into the diskette drive, 
and the door is shut. For hard disks, contact your dealer. 
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Operating system error 

Source Several commands 

Action If you get this error message, make a note of the situation in which 
it occurred, and contact your dealer. 

Operating system load error 

Source DOS hard disk system loader 

Explanation The computer cannot read the operating system's loader file. 

Action Restart the operating system from diskette. Use FBX to save the files 
on the partition onto diskette. Use FDISK to delete and then recreate 
the partition. Then use FBX again to recover your files. 

Physical Media Error 

Source Several commands 

Explanation The operating system was unable to read from or write to a disk. The 
disk has probably been corrupted. 

Action Copy as many files as you can from the corrupt disk to another disk 
and then reformat or dispose of the first disk. 

Sector not found 

Source Any application 

Explanation The requested sector on the disk is not present, or is corrupt. With 
diskette-drives, this usually means that the diskette in the drive has 
not been formatted. 

Seek error 
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Source Any application 

Explanation The disk drive being accessed was physically unable to move its 
read/write heads to the requested location. This generally means a 
disk controller hardware failure. 

Action Contact your dealer. 
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Unknown error code 

Source Several commands 

Action If you get this error message, make a note of the situation in which 
it occurred, and contact your dealer. 

Use another boot disk 

Source Diskette system loader 

Explanation The programs used to startup the operating system from diskette are 
corrupt, or in the wrong order. 

Action Startup DOS from a different startup diskette. If you want to use the 
failed startup diskette again you will need to run the SYS command. 
Enter SYS/? or SYS/Hat the system prompt to see online 
information about SYS. 
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appendix B 
Preparing the Hard Disk 

This appendix describes how to use FDISK, a menu-driven program, 
to format the hard disk prior to installation. 

Preparing a New Hard Disk (FDISK) 

All disks (hard disks and diskettes) need to be prepared before you 
can work with them. This process is called partitioning and 
formatting (in the case of hard disks) and formatting (in the case of 
diskettes). 

Once the operating system is installed, you can use the FORMAT 
command at any time to format diskettes; refer to the "Command 
Reference" chapter of DOSBook for a complete description of the 
FORMAT command. 

Use the FDISK program to prepare a hard disk, if it has not already 
been prepared. In most cases, your dealer will already have done 
this for you. 

The following description of FDISK assumes that you are preparing 
a hard disk for the first time, during system installation, and that 
you need to prepare a DOS primary partition. Once you have 
installed the operating system, refer to the "Command Reference" 
chapter of DOSBook for complete information about using FDISK 
to delete an existing partition, select a bootable partition, display 
the logical drives in an extended partition, or select an alternative 
fixed disk. 

The maximum size of a partition is 2 GB (2048 MB) but you can 
create smaller partitions if you want. 
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ProcedureT 

You can use FDISK to create one primary DOS partition and one 
extended DOS partition which can contain as many logical drives 
as you require. You must create a primary DOS partition in which to 
install the operating system. An extended partition with logical 
drives allows you to pass information between DOS partitions on 
the disk as if between different drives. 

If you divide a hard disk into a primary partition and an extended 
partition containing two logical drives, for example, you can 
address the partitions as follows: C: is the primary partition, D: is 
the first logical drive in the extended partition, and E: is the second 
logical drive in the extended partition. 

When you run the INSTALL program, FDISK is automatically started 
for you if your hard disk is not prepared. You see the current 
partition status of the hard disk and a main menu of options. 

To create a DOS partition, do the following: 

1. Select the Create DOS partition option on the main menu. 

2. Select the type of partition you are creating from the next set 
of options: 

• Create DOS primary partition 

• Create DOS extended partition 

• Create logical drive in extended partition 

3. Proceed to the sections "Creating a DOS Primary Partition," 
"Creating a DOS Extended Partition," and "Creating a Logical 
Drive in a DOS Extended Partition," as required. 

Remember that you must at least create a primary DOS partition 
to install the operating system. 

4. After you have created all the partitions and logical drives that 
you want on the hard disk, the INSTALL program asks you to 
reboot your computer by pressing <Ctrl><Alt><Del>. Leave the 
Startup diskette in drive A: and restart the installation program. 

INSTALL will now load the operating system into the primary 
DOS partition automatically. 
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Creating a DOS Primary Partition 

ProcedureT 

You can only create a DOS primary partition when no primary 
partition already exists on the disk. Do the following: 

1. Select the Create DOS primary partition option. 

You are asked whether you want to use all the available space on 
the disk. 

1 a. Type Y and press <Enter> if you want to use all the space. 

Note that if you accept this default, there will not be any 
space left for an extended DOS partition. 

Continue with Step 3 below. 

1 b. Type N and press <Enter> if you want to use only some of 
the available space. 

Note that the DOS primary partition must be large enough 
to hold the operating system that you want to install. 

Continue with Step 2 below. 

2. You are prompted for the disk size in whole megabytes or the 
starting and ending cylinders for the partition (if you do not 
specify a size), if you answered N to the previous prompt. 

Note that the operating system requires at least 20 cylinders. 

3. If you answered Y to the previous prompt, FDISK assumes you 
want to use all available cylinders. 

4. If FDISK finds a defective track on the system area of the disk, 
it does not create the partition and prompts you for another 
starting cylinder number. You are also prompted for a new 
number if there is insufficient space at a cylinder. 

5. You are prompted to provide a disk label of up to 11 characters; 
this is optional. 

6. You return to the FDISK main menu, which displays the details 
of the new partition. Press <Esc> to leave the FDISK program or 
choose the option to create an extended partition (see the 
following section, "Creating a DOS Extended Partition"). 
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Creating a DOS Extended Partition 

ProcedureT 

You can create a DOS extended partition only if no extended 
partition already exists on the drive and you did not use all the disk 
space for the primary partition. Do the following: 

1. Select the Create DOS extended partition option from the main 
menu. 

2. You are asked to specify the size in megabytes or the starting 
and ending cylinders for the partition. 

After you specify the partition size, you return to the FDISK 
main menu, where the details of the new DOS extended 
partition are displayed. 

Note that you cannot use an extended partition until you have 
created at least one logical drive in it; see the following section, 
"Creating a Logical Drive in a DOS Extended Partition." 

3. Press <Esc> to leave FDISK or choose the option to create a 
logical drive in the extended partition. 

You cannot use an extended partition until you have created a 
logical drive in it. 

B-4 Novell DOS 7 User Guide 



Creating a Logical Drive in a DOS Extended Partition 

ProcedureT 

You can create a logical drive only if you have already created an 
extended partition. Do the following: 

1. Select the Create logical drive in extended partition option from 
the main menu. 

2. The screen displays the current status of the extended partition 
and you are asked to specify the starting and ending cylinders 
for the logical drive. 

3. You can specify a label for the logical drive. The first logical 
drive is usually drive D: 

FDISK displays the details of the logical drive just created. 

4. Press <Esc> to return to the main menu. You can create another 
logical drive on the hard disk if there is space. 

5. Press <Esc> to leave FDISK. 
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appendix c 
NetWare DOS Requester 

The NetWare DOS Requester™ is DOS client software that provides 
the interface between DOS and the network. It consists of 
individual modules that provide various network services. The 
NetWare DOS Requester is loaded when you run the file 
STARTNET.BAT. This file also loads drivers that the NetWare DOS 
Requester needs in order to communicate with the network 
hardware. 

Network Drivers 

Table C-1 

When you run STARTNET.BAT, it loads three network driver 
modules, described in Table C-1. 

NetWare DOS Requester Network Driver Modules 

Driver 

IPXODI 

LSL 

Description 

Delivers requests and replies between a computer and the network. 

Also handles packet sequencing and acknowledgment for the 
workstation-server connection (for example, SPX). 

Takes requests that the NetWare DOS Requester has determined are for 
the network, "packages" them with transmission information (such as 
their destination), and hands them to the LSLTM. 

Puts the packaged requests from the IPXODI into the proper format for 
transmission on the particular physical network that the computer is 
running on. 

Also takes replies for the computer from the network (via the LAN driver), 
removes the network-specific information it has added, and passes the 
reply to IPXODI. 
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Table C-1 continued 

NetWare DOS Requester Network Driver Modules 

Driver 

LAN driver 

Description 

Takes requests from the LSL and sends them to the network. It also 
receives replies from the network and passes them to the LSL. This driver 
is specific to the network board installed in your computer. 

When the network driver modules load, they refer to the NET.CFG 
file, which contains information about the network board settings. 
The modules use the entries under the "Link Driver" heading in 
NET.CFG. Refer to the "NET.CFG Options Reference" chapter of 
DOSBook for details of all the configuration options that can be 
specified in NET.CFG. 

NetWare DOS Requester Modules 

Table C-2 

After the network driver modules have been loaded, STARTNET.BAT 
loads the first NetWare DOS Requester module, VLM.EXE. This is 
the VLM™ memory and module manager. It manages the other 
modules, deciding where the modules are loaded into memory, and 
the order in which they are loaded. The modules refer to the 
Netware DOS Requester section in NET.CFG for any parameters 
that they require. 

Table C-2 summarizes the individual NetWare DOS Requester 
modules. 

NetWare DOS Requester Modules 

Module 

VLM.EXE 

AUTO.VLM 

BIND.VLM 

CONN.VLM 

Description 

Controls communication between the individual VLMs, and VLM memory 
usage. 

Auto-reconnect services. 

Connects to NetWare® 2.x or 3.x servers. 

Connection Table Manager. Enables a computer running the NetWare 
DOS Requester to establish a configurable number of connections with 
multiple NetWare servers. 
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Table C-2 continued 
NetWare DOS Requester Modules 

Module 

FIO.VLM 

GENERAL.VLM 

IPXNCP.VLM 

MIB21F.VLM 

MIB2PROT.VLM 

NDS.VLM 

NETX.VLM 

NMR.VLM 

NWP.VLM 

PNW.VLM 

PNWMIB.VLM 

PNWTRAP.VLM 

PRINT.VLM 

REDIR.VLM 

RSA.VLM 

SECURITY.VLM 

TRAN.VLM 

WSASN1 .VLM 

WSREG.VLM 

WSSNMP.VLM 

WSTRAP.VLM 

Description 

File input/output module that implements a basic file-transfer protocol. 

Miscellaneous functions for NETX.VLM and REDIR.VLM. 

Transport protocol implementation for IPX™. 

SNMP MIB-11 support for interfaces group. 

SNMP MIB-11 support for TCP/IP groups. 

Connects to NetWare Directory Services™. 

Provides backward compatibility with the older NETX shell. 

Network management diagnostic responder for IPX. 

NetWare protocol multiplexor. NWP services include establishing and 
destroying connections, logins and logouts, and broadcast messages. 

Connects to Personal NetWare™ servers. 

Personal NetWare server MIB. 

SNMP trap module. 

Network printing support. 

DOS redirector. 

RSA encryption for NetWare Directory Services re-authentication. 

Enhanced security services. 

Transport protocol multiplexor. 

Required for the diagnostic responder (see WSSNMP.VLM). 

Required for the diagnostic responder (see WSSNMP.VLM). 

Network management diagnostic responder for SNMP. 

Required for the diagnostic responder (see WSSNMP.VLM). 
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VLM Manager (VLM.EXE) 

Option 

/? 

IC 

ID 

/Mmemtype 

/PS=server_name 

/PT =tree_name 

/U 

/Vx 

The VLM Manager has a number of options that you can use when 
the NetWare DOS Requester is loading or running. These options 
allow you to override entries in NET.CFG. For example, you can 
specify a different preferred server to that given in NET.CFG. 

The format of the command is 

VLM [option] 

Description 

Displays help text. 

Specifies an alternative configuration file; the default is the NET.CFC file in 
C:\NWCLIENT. The format of the option is 

/C=[path\] filename 

Displays VLM.EXE diagnostics. 

Specifies that VLM.EXE should attempt to load into the specified memtype, 
where memtype can be one of the following: 

C - conventional memory 
E - expanded memory 
X - extended memory 

Specifies the preferred server, that is, the server you want to attach to 
when you first log in. This option overrides the parameter PREFERRED 
SERVER = server name in the NET.CFC file. 

This option is relevant only to users of NetWare 4.x. It specifies which 
Directory tree you want to use when you first log in. The /PT option 
overrides the parameter PREFERRED TREE = tree_name in the 
NET.CFC file. 

Unloads VLM.EXE from memory. 

Specifies the level of detail in messages, where xis a number, 0 through 4. 

0 - Displays copyright and critical errors only 
1 - Also displays warning messages 
2 -Also displays VLM module names 
3 -Also displays configuration file parameters 
4 - Also displays diagnostics messages 
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Loading the NetWare DOS Requester 

The /M option enables you to specify which area of memory the 
NetWare DOS Requester should first attempt to load into; extended, 
expanded, or conventional. If you want the requester to load into 
extended or expanded memory, you must first have installed the 
appropriate memory manager to gain access to that memory. 
Chapter 10, "Managing Memory," describes the different memory 
managers and how you install them. 

If you use the /ME or /MX option, the NetWare DOS Requester 
attempts to load much of its code into, respectively, expanded or 
extended memory. Some code will always remain in conventional 
memory, but the exact amount of conventional memory used will 
depend upon the amount of extended or expanded memory 
available to the NetWare DOS Requester. 

If you do not specify which memory you want to use, the NetWare 
DOS Requester looks first for extended memory, and then for 
expanded memory. 

Reconfiguring the NetWare DOS Requester 

Note~f' 

The ability to unload the NetWare DOS Requester enables you to 
test different configurations without rebooting the computer. 
Simply edit the NET.CFG file as required, then unload the NetWare 
DOS Requester by entering the following command at the system 
prompt: 

VLM /U 

If you run VLM at the system prompt again, with any command 
line options that you require, the NetWare DOS Requester modules 
will reload, and will refer to the edited NET.CFG file as they do so. 

VLM.EXE is a TSR; be sure it is the last TSR loaded before you attempt to unload 
it. 
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appendix D 
Code Pages 

This appendix shows the code pages supported by Novell DOS™ 7. 
To enter a character, hold down the <Alt> key while you type the 
decimal value shown in the table. 

Code Pages D-1 



Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

O/OOh 

1/0lh @ @ @ @ @ @ @ g 
2/02h @} ~ @ ~ ~ ® ~ ® 
3/03h • • • • • • • • 
4/04h • • • • • • • • 
5/05h eTe eTe eTe eTe eTe eTe eTe eTe 

6/06h • • • • • • • • 
7/07h . . . . . . . . 
8/08h D (] (] (] (] (] (] (] 

9/09h 0 0 0 0 0 0 0 0 
10/0Ah • • • • • • • • 
11/0Bh 0 0 0 0 0 0 0 0 
12/0Ch Q Q Q Q Q Q Q Q 
13/0Dh ~ ~ ~ ~ ~ ~ ~ ~ 

14/0Eh ~ cb ~ ~ ~ cb ~ ~ 
15/0Fh ¢ ¢ ¢- ¢- ¢- ¢ ¢- ¢-

16/lOh ...... ...... ...... ...... ...... ...... ...... ...... 
17 /11 h ...... ...... ...... ...... ...... ...... ...... ...... 
18/12h i i i i i i i i 
19/13h !! !! !! !! !! !! !! !! 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

20/14h CJ[ CJ[ CJ[ CJ[ CJ[ CJ[ CJ[ CJ[ 

21/15h § § § § § § § § 

22/16h - - - - - - - -

23/17h t t ~ i t t t t 
24/18h t t t t t t t t 

25/19h ! ! ! ! ! ! ! ! 

26/1Ah - - - - - - - -
27/1Bh - - - - - - - -
28/1Ch l_ l_ l_ l_ l_ l_ l_ l_ 

29/1Dh - - - - - - - -
30/Hh ... ... ... ... ... ... ... A 

31/1Fh T T ** ** T T ... .,,,. 
32/20h 

33/21h ! ! ! ! ! ! ! ! 

34/22h " " " II " " " " 

35/23h # # # # # # # # 

36/24h $ $ $ $ $ $ $ $ 

37 /25h % % % % % % % % 

38/26h & & & & & & & & 

39/27h I I I I I I I I 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

40/28h ( ( ( ( ( ( ( ( 

41/29h ) ) ) ) ) ) ) ) 

42/2Ah * * * * * * * * 

43/2Bh + + + + + + + + 

44/2Ch 
I I I I I I I I 

45/2Dh - - - - - - - -

46/2Eh 

47/2Fh I I I I I I I I 

48/30h 0 0 0 0 0 0 0 0 

49/31h 1 1 1 1 1 1 1 1 

50/32h 2 2 2 2 2 2 2 2 

51 /33h 3 3 3 3 3 3 3 3 

52/34h 4 4 4 4 4 4 4 4 

53/35h 5 5 5 5 5 5 5 5 

54/36h 6 6 6 6 6 6 6 6 

55/37h 7 7 7 7 7 7 7 7 

56/38h 8 8 8 8 8 8 8 8 

57/39h 9 9 9 9 9 9 9 9 

58/3Ah : : : : : : : : 

59/3Bh ; ; ; ; ; ; ; ; 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

60/3Ch < < < < < < < < 

61 /3Dh = = = = = = = = 

62/3Eh > > > > > > > > 

63/3Fh ? ? ? ? ? ? ? ? 

64/40h @ @ @ @ @ @ @ @ 

65/41h A A A A A A A A 

66/42h B B B B B B B B 

67/43h c c c c c c c c 

68/44h D D D D D D D D 

69/45h E E E E E E E E 

70/46h F F F F F F F F 

71/47h G G G G G G G G 

72/48h H H H H H H H H 

73/49h I I I I I I I I 

74/4Ah J J J J J J J J 

75/4Bh K K K K K K K K 

76/4Ch L L L L L L L L 

77/4Dh M M M M M M M M 

78/4Eh N N N N N N N N 

79/4Fh 0 0 0 0 0 0 0 0 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

80/50h p p p p p p p p 

81/51h Q Q Q Q Q Q Q Q 

82/52h R R R R R R R R 

83/53h s s s s s s s s 

84/54h T T T T T T T T 

85/55h u u u u u u u u 

86/56h v v v v v v v v 

87 /57h w w w w w w w w 

88/58h x x x x x x x x 

89/59h y y y y y y y y 

90/5Ah z z z z z z z z 

91/5Bh [ [ [ [ [ [ [ [ 

92/5Ch \ \ \ \ \ \ \ \ 

93/5Dh ] ] ] ] ] ] ] ] 

94/5Eh /\ /\ /\ /\ /\ /\ /\ /\ 

95/5Fh - - - - - - - -

96/60h I I I I I I I I 

97/61h a a a a a a a a 

98/62h b b b b b b b b 

99/63h c c c c c c c c 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

100/64h d d d d d d d d 

101/65h e e e e e e e e 

102/66h f f f f f f f f 

103/67h g g g g g g g g 

104/68h h h h h h h h h 

105/69h i i i i i i i i 

106/6Ah j j j j j j j j 

107/6Bh k k k k k k k k 

108/6Ch I I I I I I I I 

109/6Dh m m m m m m m m 

110/6Eh n n n n n n n n 

111/6Fh 0 0 0 0 0 0 0 0 

112/70h p p p p p p p p 

113/71h q q q q q q q q 

114/72h r r r r r r r r 

115/73h s s s s s s s s 

116/74h t t t t t t t t 

117/75h u u u u u u u u 

118/76h v v v v v v v v 

119/77h w w w w w w w w 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

120/78h x x x x x x x x 

121/79h y y y y y y y y 

122/7Ah z z z z z z z z 

123/7Bh { { { { { { { { 

124/7Ch I I I I I I I I 

125/7Dh } } } } } } } } 

126/7Eh - - - - - - - -
127/7Fh ~ ~ ~ ~ ~ ~ ~ ~ 

128/80h <:= <:= <:= <:= <:= <:= <:= A 

129/81h ti ti ti ti ti ti ti E 

130/82h e e e e e e e B 

131/83h a a a a a a a r 

132/84h a a a a a A a A 

133/85h a a u a a a a E 

134/86h a a c a A CJ[ a )K 

135/87h c; c; c; c; c; c; c; 3 

136/88h e e l e e e e H 

137/89h e e e e E e e fl 
138/8Ah e e 6 e e e e K 

139/8Bh 1 1 
,, 
0 1 i 1 1 JI 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

140/8Ch i i i i 6 i i M 

141/8Dh i i z 1 i = i H 

142/8Eh A A A A A A A 0 

143/8Fh A A c A A. § A TI 

144/90h E E E E E E E p 

145/91h ~ ~ l ~ A E ~ c 

146/92h IE IE 1 IE E E IE T 

147/93h 0 0 0 0 0 6 0 y 

148/94h 0 0 0 0 6 E 0 <I> 

149/95h 0 0 L 0 0 I 0 x 

150/96h u u I u (J u u 1( 

151/97h u u § u u u u q 

152/98h y y s I i IJ y ill 

153/99h 6 6 6 6 6 6 6 m: 
154/9Ah D D D D D D D 1> 

155/9Bh ([. 0 t 0 ([. ([. 0 bl 

156/9Ch £ £ t £ £ £ £ h 

157/9Dh ¥ 0 L 0 0 0 0 3 

158/9Eh Pt x x § Pt 0 Pt }() 

159/9Fh f f c § 6 f f 51 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

160/AOh a a a a a I a a I 

161/Alh i i i i i i 6 

162/A2h 6 6 6 6 6 6 6 B 

163/A3h u u u u u u u r 

164/A4h fi fi f\ fi fi .. fi A 

165/A5h N N q N N ~ N e 

166/A6h !! !! z c !! 3 !! )K 

167 /A7h Q Q v Q - Q 3 z g 

168/ASh l l ~ l l i l H 

169/A9h I ® <; ® 6 I I 11: 

170/AAh ...., ...., ...., ...., ...., ...., K 

171/ABh Vz Vz i Vz 1/z Vz Vz JI 

172/ACh % % 
v 

c 1.4 % 1.4 1.4 M 

173/ADh i i § i i % i H 

174/AEh « « « « « « « 0 

175/AFh » » » » » » D II 

176/BOh ... . .. ... ... ... ... ... ... 
::::: ···-· ·-·-· ::::: ·-·-· •.•.• •.•.• ···-· 177/Blh ·-·-· ·-·-· ·-·-· ·-·-· ::::: ·-·-· •.•.• •.•.• ·-·-· • .. •.• •.•.• • .. •.• ·-·-· :-:-: :-:-: :·:-: :-:-: :-:-: :-:-: :-:-: :·:-: 

178/B2h m m m m m m m m 
179/B3h I I I I I I I I 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

180/B4h ~ ~ ~ ~ ~ ~ ~ ~ 

181/B5h =1 A A A =1 =1 =1 =1 

182/B6h ~I A A A II II ~I ~I 

183/B7h 11 A E A 11 11 11 11 

184/B8h I © ~ © I I I 

185/B9h 91 91 91 91 91 91 91 91 
186/BAh II II II II II II II II 
187/BBh =n =n =n =n =n =n =n =n 
188/BCh d d d d d d d d 

189/BDh J <t. z <t. J J J J 

190/BEh d ¥ z ¥ d d d 

191/BFh I I I I I I I I 

192/COh L L L L L I_ L 

193/Cl h _l_ _l_ _l_ _l_ _l_ _l_ _L _l_ 

194/C2h T T T T T T T T 

195/C3h f- f- f- f- f- f- I- f-
196/C4h - - - - - - - -

197/C5h + + + + + + + + 
198/C6h F= a A. a F= F= F= F= 

199/C7h If- A a A If- If- If- If-
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Decimal 
Value/ 
Hex Value 

200/C8h 

201/C9h 

202/CAh 

203/CBh 

204/CCh 

205/CDh 

206/CEh 

207/CFh 

208/DOh 

209/01 h 

210/D2h 

211/D3h 

212/D4h 

213/D5h 

214/D6h 

215/D7h 

216/D8h 

217/D9h 

218/DAh 

219/DBh 

D-12 

Code 
Page 
437 

II 

_L 

_lL 

L 

__J 

I 

Code 
Page 
850 

L 

II 

D 

D 

__J 

I 

Code 
Page 
852 

L 

II 

D 

d 

D 

cl 

__J 

I 
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Code 
Page 
857 

L 

II 

_JL 
II 

D 

Q 

__J 

I 

Code 
Page 
860 

L 

II 

_L 

_lL 

L 

__J 

I 

Code 
Page 
863 

L 

II 

_L 

_lL 

L 

__J 

I 

Code 
Page 
865 

L 

_JL 

II 

_lL 

L 

__J 

I 

Code 
Page 
866 

L 

II 

_L 

_lL 

L 

__J 

I 



Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

220/DCh • • • • • • • • 
221/DDh I I T I I I I I I I 

222/DEh I i 0 i I I I I u 
223/DFh • • • • • • • • 
224/EOh a 6 6 6 a a a p 

225/Elh p p p p p p p c 

226/E2h r 6 6 6 r r r T 

227/E3h :rt 6 N 6 :rt :rt :rt y 

228/E4h L 6 n 6 L L ~ cp 

229/E5h a 6 ii 6 a a a x 

230/E6h µ µ s µ µ µ µ Q 

231/E7h 't p s 't 't 't q 

}J 
, 

232/E8h <I> R x <I> <I> <I> III 

233/E9h 8 (J (J (J 8 8 8 m; 

0 
,, 

0 234/EAh Q r Q Q Q 1> 

235/EBh (> u u u (> (> (> bl 

236/ECh 00 y y i 00 00 00 h 

237/EDh cj> y y y cj> cj> cj> 3 

238/EEh E - t - E E E IO 

239/EFh n I I I n n n 51 
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Decimal Code Code Code Code Code Code Code Code 
Value/ Page Page Page Page Page Page Page Page 
Hex Value 437 850 852 857 860 863 865 866 

240/FOh - - - - - - - £ 

241/Flh ± ± II ± ± ± ± e 

242/F2h = 
t 

~ ~ € ~ ~ 

243/F3h % 
v 

% E s s s s 

244/F4h f <JI 
~ 

<JI f f f I 

245/F5h J § § § J J J 1 

246/F6h y 
247/F7h = ~ = = = y 

> 

248/F8h 0 0 0 0 0 0 0 0 

249/F9h • . . . . . . • • • • 

250/FAh 

251/FBh ..; 1 (i 1 ..; ..; ..; ..; 

252/FCh n 3 R 3 n n n NQ 

253/FDh 2 2 r 2 2 2 2 a 

254/FEh - - - - - - - -
255/FFh 
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Gtossary 

Access rights 

Account 

Ambiguous filename 

Application 

ASCII 

AUTO EXEC.BAT 

Backup 

Access rights determine what a user can do with a particular 
resource. Resources have default access rights that can be 
superseded by the access rights given to a user. 

An account is needed for each user in a workgroup. It is the means 
whereby a user who attempts to log in to a workgroup is recognized 
as a valid member of the workgroup. 

A filename that contains either of the wildcard characters ? or *. 
When you replace characters in a filename with these wildcard 
characters, you create an ambiguous filename and can easily 
reference more than one file in a single command. 

A piece of software used to carry out a particular task, like a word 
processor or graphics package. 

The American Standard Code for Information Interchange is a 
standard code for representing numbers, letters and symbols. An 
ASCII text file is a file that can be intelligibly displayed on the video 
screen or printed on paper. 

This is a configuration file which the operating system executes 
every time it is started. The easiest way to change the configuration 
parameters in the AUTOEXEC.BAT file is to use the SETUP program. 

A copy of a file, directory, or disk made for safe keeping. 
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Batch file 

Baud rate 

Bernoulli drives 

Bit 

Buffer 

Built-in command 

Byte 

Client 

Cluster 

A file containing a sequence of commands. When you type the 
name of the file at the command line, each command in the file is 
carried out in turn, just as if you had typed the commands 
individually. The filename becomes in effect a "command" in itself. 
Batch filenames can be up to eight characters in length, but must 
always have the extension .BAT. 

The baud rate is the number of bits transmitted per second in serial 
communications. 

A cartridge drive system supplied by Iomega* Corporation. The 
Bernoulli* cartridges are high-capacity removable media. 

A bit is the smallest unit of memory in a computer. Bits are 
electronic switches. They are given values to indicate whether they 
are switched on or off; 0 is off and 1 is on. Eight bits are equal to 
one byte, or character. See also Byte. 

An area of memory that temporarily stores data during information 
transfer. 

See Internal command. 

A unit of memory or disk storage usually used to represent one 
character. See also Bit. 

A computer that uses services, such as shared directories and 
printers, provided by other computers (servers) on the network. 

A group of contiguous sectors on a disk; a sector is the smallest unit 
of allocation for files on the disk. 
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Code page 

Code page switching 

Command 

Command line 

Communication port 

CON FIG.SYS 

Context 

A code page is a table stored in your computer which defines the 
particular character set required by a specific national language. 

This is a mechanism the operating system uses to allow you to use 
the range of characters needed in a variety of national languages. 
Using it you can switch between the different character sets needed 
by differing languages. 

A short program designed for a specific task. 

The command followed by any other relevant information given at 
one time to the computer, to enable it to carry out your 
instructions. The command line ends when you press the <Enter> 
key. 

A socket to which another computer may be attached usually via a 
cable, thus allowing the computers to communicate with each 
other. 

A configuration file which the operating system executes every time 
it is started. It contains various commands used to set up your 
system for items like keyboard and country information. The easiest 
way to change the configuration parameters in the CONFIG .SYS file 
is to use the SETUP program. 

The context defines which part of the NetWare Directory Services™ 
tree is searched for users, servers, and resources. 

Conventional memory 
Memory below 640 KB, sometimes called base memory. It is 
generally where the operating system and applications are loaded. 
It is usually referred to as RAM (Random Access Memory). 
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Current directory 

Current disk drive 

Cursor 

Data bits 

Default 

Device 

Device driver 

Directory 

Disk 

The current place on the disk where filenames are stored so that the 
operating system can find the files when needed. The current 
directory name is displayed on the command line if you add the 
command PROMPT $p$g to your AUTOEXEC.BAT file. 

The drive on which the operating system first looks for files. The 
current drive letter is usually displayed in the system prompt. 

A blinking line or block on the screen that indicates where your 
next keystroke will have an effect. 

Refers to the number of bits used to define a character on serial data 
transmission, usually 7 or 8. When connecting two computers 
together via the communication ports, it is important to set the 
same number at each end. 

A pre-set value used by a computer until it is specifically changed 
by a user. 

A device is a piece of hardware attached to a computer (usually a 
peripheral), for example a printer or mouse. 

Device drivers are programs that are loaded alongside the operating 
system to operate hardware devices which are not recognized as a 
default part of the system. Device drivers usually have the extension 
.SYS. 

A place on a disk where filenames are stored so that the operating 
system can find the files when needed. Each disk can contain many 
directories. 

Magnetic medium used for storing information. 
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Disk accelerator 

Disk cache 

Diskette 

See Disk cache. 

A disk cache is an area of RAM memory used to store data accessed 
frequently from disk. If your applications want to access a disk for 
data, it can become time-consuming. To speed up the process of 
reading and writing data to and from disk, you can set up a cache. 
Whenever data is read from or written to disk, a check is made to 
see if a copy is in the cache first. If it is in the cache, the copy is used. 
Caches are very useful for increasing the performance of 
applications that have to access a lot of data from disk, like 
databases and spreadsheets. 

A disk that can be removed from the drive (also known as a floppy 
disk). 

Disk operating system 

Drive 

EDIT 

EMM 

EMS 

Enter key 

A collection of programs that manages computer resources and 
other programs on a computer. 

The device that holds and reads a hard disk or diskette. 

A program that allows you to create and edit ASCII text files. 

Expanded Memory Manager; see Chapter 10, "Managing Memory" 
for information. 

Expanded Memory Specification; see Chapter 10, "Managing 
Memory" for information. 

The key that tells the operating system to carry out a command. 
Also referred to as Return or J. 
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Environment 
A source of information within the operating system used by all 
applications, often called the global environment. It is where the 
PATH, PROMPT and SET variables are stored. 

Environment variables 

Esc key 

Executable 

Expanded memory 

Extended memory 

External command 

File 

Variables that define the current operating system environment, for 
example, the version number or search path. 

The key that usually allows you to exit a screen or process. 

This means "programs that can be run by the computer." 
Executable code is a series of instructions that can be carried out by 
the computer. Executable programs usually have the extension 
.EXE or .COM. 

Expanded memory is often known as LIM memory. The LIM EMS 
standard was jointly devised by Lotus*, Intel* and Microsoft*. EMS 
is the Expanded Memory Specification. It describes ways in which a 
program may access up to 32 MB of memory outside conventional 
memory. Programs that use expanded memory include 
spreadsheets, databases, and other programs that need access to 
large amounts of data. See Chapter 10, "Managing Memory" for 
more details. 

Memory above 1 MB on 80286, 386* and i486*-based computers; 
see also Chapter 10, "Managing Memory" for information. 

Commands that are used less often than other commands, and so 
are not automatically loaded into memory. To save space they are 
stored on disk instead. They have the file extension .COM or .EXE. 
When you enter an external command, the operating system 
retrieves the "command file" from disk and runs it. The memory 
used by the command is freed when it has finished its work. See also 
Internal command. 

A collection of related instructions or data stored on disk. 
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File Allocation Table (FAT) 

FILELINK 

Filelist 

The File Allocation Table is a kind of index which exists at the start 
of every disk, and is used by the operating system to locate entries 
for files. 

A utility used to transfer files between two computers connected by 
their serial or communication ports. 

A list of filenames in a file. The file containing the filelist is 
identified by an@ character in front of its filename. Some 
commands that usually operate on only one file per command line 
can, by using a filelist, be made to operate on several files. 

Filename and filename extension 

Files pee 

Fixed disk 

Floppy disk 

Format 

The name assigned to a file. A filename can include a primary 
filename of 1 through 8 characters and an optional filename 
extension of 1 through 3 characters. A period (.) separates the 
filename from the filename extension. 

Short for file specification. The combination of drive letter, path, 
and filename that identifies a file uniquely to the operating system. 

See Hard disk. 

See Diskette. 

The process by which the operating system prepares a disk for use 
by writing electronic markers onto the disk, so that the system can 
store and retrieve files. FDISK is used to prepare partitionable disks 
for use. FORMAT is used to format disks and diskettes. When you 
format a disk, except in special circumstances (see the description 
of FORMAT in the "Command Reference" chapter of DOSBook), all 
the information previously stored on it is erased, so take care when 
using this command. 
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Gigabyte (Gbyte or GB) 

Hard disk 

Hexadecimal 

High memory 

Image file 

Input 

1/0 

Internal command 

IPXODI 

A unit of storage in a computer denoting 1024 Mbytes. It is usually 
denoted as 1 Gbyte or 1 GB. 

A disk for storing information that is not removable from the 
computer. It usually has large storage capacity and provides fast 
access to data. 

Hexadecimal numbers are numbers in base 16. Hexadecimal uses 
the numbers 0-9 and A, B, C, D, E, F. The letters are equivalent to 
the numbers 10, 11, 12, 13, 14, 15 in decimal (base 10). 
Hexadecimal numbers are used as a shorthand for binary. 

The first 64 KB of extended memory. 

A file used to store an image of a diskette; that is, an exact copy of 
the diskette's contents. 

Information going into the computer, usually from typing at the 
keyboard or from a program reading from disk. 

Abbreviation for input/output. 

An operating system command that usually resides in memory. 
Internal commands respond quickly because they do not have to be 
loaded from disk. 

Inter-Packet Exchange Open Data-Link Interface; adds transmission 
information to data being sent across the network. See Appendix C, 
"NetWare DOS Requester" for more details. 

Kilobyte (Kbyte or KB) 
1024 bytes, denoted as 1 Kbyte, 1 KB or 1 K. 32 Kilobytes equal 32 
KB. 1024 KB equal 1 Megabyte (or MB), over one million bytes. 
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Label 

LIM 

Link driver 

Logical drive 

Lower memory 

LSL 

Macro 

Master key password 

A marker within a batch or CONFIG.SYS file. It is used to indicate 
the specific point that execution jumps to, following a GOSUB, 
GOTO, CHOICE, or SWITCH statement. 

See Expanded memory. 

Also known as the LAN driver. Specific to the network board 
installed in the computer, it provides an interface between the 
network board and the rest of the operating system. 

The operating system's internal representation of a drive. It may 
refer to an actual disk device, or to a group of directories specified 
using the SUBST command. 

The lowest part of conventional memory, where the operating 
system and installable device drivers are commonly loaded. 

Link Support Layer; serves as an intermediary between IPXODI and 
the link driver. See Appendix C, "NetWare DOS Requester" for more 
details. 

A macro consists of a number of commands that are executed when 
the macro name is entered at the command line. The macro is lost 
when you reboot the computer. 

The password that the operating system prompts you for if security 
is enabled when you start the computer. The master key password 
controls access to the entire operating system. 

Megabyte (Mbyte or MB) 
A unit of storage in a computer denoting 1024 KB. It is usually 
denoted as 1 Mbyte or 1 MB. 
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Memory 

Memory disk 

MIB 

Modem 

Multitasking 

NET.CFC 

Memory is where the computer stores data and programs. It is 
measured in bytes. One byte is equal to a group of eight bits. A bit 
is the smallest unit of memory in a computer. Each bit has the value 
0 or 1. Memory is thought of in bytes because one byte of memory 
can be used to represent a character such as a,?, or 4. One thousand 
and twenty-four bytes is equal to one kilobyte (KB). As computers 
contain a lot of memory, memory is usually talked about in terms 
of KB rather than bytes. 

A portion of computer memory that is made to act like a very fast 
disk. You store your files on it in the same way as on a physical disk. 
Information stored on a memory disk is lost when the computer is 
switched off or when the operating system is restarted. Memory 
disks are therefore best used for temporary storage of expendable 
data. They are also referred to as RAM disks or virtual disks. 

Management Information Base; a database containing information 
about the device on which it resides. It can be read by network 
management software running on another computer. 

Modulator/Demodulator. A device which converts a digital signal 
from a computer into an analog signal which can then be 
transmitted down telephone lines and decoded by a modem at the 
receiving end. 

The ability to run more than one application simultaneously and to 
switch between these applications while they continue to run. 

A configuration file that defines configuration options for such 
network components as the network board and the NetWare DOS 
Requester™. It is read by the network drivers loaded when you run 
STARTNET.BAT. SETUP automatically creates or updates NET.CFG 
when you install the Novell DOS™ 7 network software. 
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NetWare Directory Services 
NetWare Directory Services is a feature of NetWare® 4.x. It enables 
users and administrators to access any network service without 
needing to know the physical location of the server providing that 
service. 

NetWare DOS Requester 

Network 

One-time login 

Operating system 

Output 

Parallel 

Parent directory 

Parity 

DOS client software that intercepts and prepares requests for the 
transmission of data across the network. 

A network is two or more computers linked together by cables. The 
computers contain network boards and run network software to 
enable them to send and receive information. 

An operating system configuration, whereby the username and 
password input when you start the computer also log you into the 
network. 

See Disk operating system. 

Data that the computer sends to the console, disk, printer, or some 
other device. 

The carrying out of several tasks at the same time. For example in 
parallel communications, 8 bits of a byte would be transmitted 
together (see also Serial). 

A parent directory is the directory immediately above the current 
one in the directory structure. The operating system uses the 
symbol .. to indicate the parent directory. 

A means of checking that data has been transferred correctly, either 
between computers across a communications link, or between 
components inside a single computer, such as a disk and memory. 
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Partition 

Password 

Path 

PC 

Peripheral 

Piping 

Program 

Prompt 

RAM 

RAM disk 

A partition is a section of a hard disk created by the FDISK disk 
preparation utility. 

A series of characters needed to gain access to a computer, file, 
directory, or network. 

The description of the route through the directory hierarchy to a 
subdirectory or file. A drive letter can also be included at the 
beginning of the path. 

An abbreviation for personal computer. 

An external device connected to the computer. Peripherals are 
generally used for input and output. Examples include disks, 
modems, and printers. 

The process where the output from one program is made to be the 
input for another. 

A series of specially coded instructions that perform a specific task 
when executed by a computer. 

The display on the screen that shows you that the operating system 
is ready to receive a command. The standard system prompt can be 
changed by using the PROMPT command. 

Random Access Memory is a type of memory that is used to load 
and run programs from. It can be thought of as the computer's 
workspace. The more complex a task you want to do, the more RAM 
memory your computer needs. It is memory that can be read to, as 
well as written from, in any order. See also ROM and Shadow RAM. 

See Memory disk. 
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Read-only (RO) 

Real time 

An attribute that can be assigned to a file or directory. When 
switched on, the read-only attribute allows you to read from the file 
but not to write any changes to it. 

A system where execution depends on critical timing criteria. For 
example a system may be required to respond to some event within 
a given time. 

Replacement variables 

RETURN 

ROM 

Root directory 

Route 

Router 

Scrolling 

Variables in batch files that are replaced by the parameters you 
enter in the command line when you run the batch file. 

See Enter key. 

Read-Only Memory. This is a type of memory which you can only 
read or copy; you cannot alter its contents. It is normally used to 
contain the computer's diagnostic programs, and a very basic 
input/output system (or BIOS). 

The main directory that the operating system creates on disk when 
the disk is formatted. 

A route determines which computers are accessible from yours 
across the network. A route has two parts separated by a colon; the 
network address and the machine address. 

A computer running software that manages the transfer of data 
between network cabling systems. 

Scrolling means to move text up or down on a screen so that you 
can read it all. 
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SCSI 

Serial 

Server 

Server manager 

Server owner 

Session 

SETUP 

Shadow RAM 

SNMP 

Small Computer System Interface; an industry-standard definition 
of the hardware and software needed for a host computer and a 
peripheral to communicate. 

The carrying out of tasks one after the other. For example, in serial 
communications, each byte is transferred one bit at a time (see also 
Parallel). 

A computer that provides services, such as shared printers and 
directories, to other computers (clients) on a network. 

The server manager is a user who has the right to manage a Personal 
Net Ware™ server and change its configuration. Server managers are 
named explicitly as one of the server properties. 

The server owner is the person who is in charge of the computer on 
which the Personal NetWare server is loaded. The server owner is 
named explicitly as one of the server properties. 

A session at your computer is the time between switching on and 
when you next switch off. 

A menu-driven program which allows you to change the standard 
system configuration. 

RAM in upper memory into which data and code can be copied 
from ROM. The RAM is given the same addresses as the ROM, so 
that in effect shadows the ROM. The term Shadow RAM is used to 
describe any RAM in upper memory that can potentially be used for 
shadowing ROM. 

Simple Network Management Protocol; an industry-standard 
protocol for communicating with devices on the network to 
retrieve information about them. 
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Spooler 

SPX 

STARTNET.BAT 

Stop bits 

Strings 

Subdirectory 

Switch 

System prompt 

Task Manager 

A print spooler provides a queueing system for files you want to 
print. This way files can be printed while your computer performs 
other tasks. 

Sequenced Packet Exchange; a protocol within IPXODI that verifies 
that data has been successfully sent across the network. 

A batch file that loads the network drivers. It is called by 
AUTOEXEC.BAT if you answer Y (for Yes) to the prompt which asks 
you if you want to load the network software. 

A term used in serial data transfer to distinguish where one 
character starts and another stops; communication programs 
normally add one, or sometimes two, stop bits on the end of each 
character. Like data bits, it is important that the number of stop bits 
set up agrees at both ends of the line. 

A sequence of characters, such as "hello" or "arc132." 

Any directory that is not the root directory on a disk can be called 
a subdirectory. 

An option that modifies the way in which the computer carries out 
a command. 

The display on the screen that shows you the operating system is 
ready to receive a command. The standard system prompt can be 
changed by using the PROMPT command. 

The Novell DOS program that manages multitasking and task 
switching. 
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Task switching 

TBMl2 

Timeout 

The ability to switch between applications. The application that 
you have switched to most recently is the only one that runs; tasks 
you have switched from are suspended in the background until you 
switch back to them. 

Task-Switched Manager Buffer for IPX/SPX™; it enables IPX™ and 
SPX programs to work in a task switching environment. 

The operating system sets a time limit for response to a command, 
so it can detect if something is taking too long to respond (for 
example a printer may have inadvertently been switched off), and 
return an error message. 

TSR (Terminate-and-Stay-Resident) program 

Upper memory 

Username 

Utility 

Variable 

A program that leaves some of its code in the computer's memory 
when you exit the program and return to the system prompt. 
Therefore it does not have to be reloaded from disk every time it is 
executed. 

Memory located above the normal DOS limit of 640 KB and below 
the beginning of extended memory at 1024 KB (1 MB) that is 
addressable by 16-bit processors. Parts of this memory are reserved 
for DOS and BI OS functions. 

Each account has a username that the user of the account types in 
to log in to the network and uses to gain access to the network 
resources. 

A program that enables you to perform certain operations such as 
copying, erasing, or editing files. 

In batch files, a variable is a character that is substituted for a 
filename when the batch file is run. 
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Video memory 

Virtual disk 

A special area of memory used by the hardware which operates the 
computer's display or monitor. 

See Memory disk. 

Virtual Loadable Module (VLM) 

Virus 

Volume label 

Wildcard characters 

Wildspec 

Workgroup 

A modular executable program with a group of logically-related 
features or APis. 

A program that attaches itself to a host program, and is activated 
when that host program runs. A virus often contains code that 
damages other data on the computer. 

The name given to a disk for identification. It is set by the LABEL 
command. You can display the volume label on a disk using the 
VOL command. 

Special characters that match certain specified items; there are two 
wildcard characters, ? and*. The? can be substituted for any single 
character in a filename or filename extension (or both) and the * 
can be substituted for one or more characters in the filename or 
filename extension, or both. 

The same as filespec except that you can use wildcard characters in 
the command syntax to specify groups of files. 

A group of users on a network who have information or resources 
that they wish to share among themselves. A workgroup must 
include at least one computer configured as a Personal NetWare 
server. 

Workgroup administrator 
A user given workgroup administrator privileges can change the 
way the workgroup and its resources are set up. 
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Write-protected 

XMS 

A write-protected disk, directory or file can be read but not altered 
or erased. Disks are write-protected physically, usually by the 
absence or presence of a notch on the diskette casing. Files are 
write-protected via the A TIRIB command (setting the read-only 
attribute), and files and directories can be write-protected via the 
PASSWORD command. 

Extended Memory Specification, which defines a protocol that 
controls access to high, upper, and extended memory on Intel 
80286, 386, and i486-based personal computers. 
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Trademarks 

Novell, Inc. has made every effort to supply trademark information 
about company names, products, and services mentioned in this 
manual. The following list of trademarks was derived from various 
sources. 

Novell, NetWare, the N-Design, DR DOS and LANalyzer are 
registered trademarks of Novell, Inc. 

Novell DOS, NetWare DOS Requester, NetWare Directory Services, 
NetWare Management System and NMS, NetWare Lite, 
NetWare Tools, IPX, IPX/SPX, Link Support Layer and LSL, 
Personal NetWare, Virtual Loadable Module and VLM are 
trademarks of Novell, Inc. 

The NetWare Logotype (teeth) is a trademark of Novell, 
Inc. 

386Max is a registered trademark of Qualitas Corporation. 
Bernoulli is a registered trademark of Iomega Corporation. 
Clipper is a registered trademark of Nantucket Corporation. 
COMPAQ is a registered trademark of COMPAQ Computer 

Corporation. 
EPSON is a registered trademark of Seiko Epson Corporation. 
Geo Works is a registered trademark of GeoWorks Corporation. 
Hewlett Packard, HP and Vectra are registered trademarks of 

Hewlett-Packard Company. 
Hercules is a registered trademark of Hercules Computer 

Technology. 
IBM, AT, XT, PC/AT, PS/2, Micro Channel, Proprinter and 

Quietwriter are registered trademarks of International Business 
Machines Corporation. 

Intel is a registered trademark, and 286, 386, and i486 are 
trademarks of Intel Corporation. 

LeAPSet, LeAPSetsx, NEAT, NEATsx and SCAT are trademarks of 
Chips and Technologies Inc. 
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Lotus is a registered trademark of Lotus Development Corporation. 
Microsoft is a registered trademark of Microsoft Corporation. 
Postscript is a registered trademark of Adobe Systems Incorporated. 
QEMM is a trademark of Quarterdeck Office Systems. 
Stacker is a registered trademark of Stac Electronics. 
Syquest is a registered trademark of Syquest Technology. 
Weitek is a registered trademark of Weitek Corporation. 
WordStar is a registered trademark of WordStar International 

Incorporated. 
WYSE is a registered trademark of Wyse Technology, Inc. 
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compressed disks 12-1 
compressed drives 

creating 12-3 
displaying information about 12-8 
mounting and unmounting 12-8 
using on uncompressed computers 12-11 

COMSPEC environment variable 9-49 
conditional execution 7-9, 7-15 
CONFIG .SYS commands 

:label 9-11 
? 9-9 
BREAK 9-11 
BUFFERS 9-12 
CHAIN 9-13 
CLS 9-14 
COUNTRY 9-14 
CPOS 9-17 
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CONFIG.SYS commands 
described 4-5, 9-9 
DEVICE 9-18 
DEVICEHIGH/HIDEVICE 9-41, 10-22 
DOS 9-32, 10-14 
DRIVPARM 9-33 
ECHO 9-35 
EXIT 9-35 
FASTOPEN 9-36 
FCBS 9-37 
FILES 9-38, 13-17 
GOSUB 9-39 
GOTO 9-40 
HIDEVICE/DEVICEHIGH 9-41, 10-22 
HIINSTALL/INST ALLHI G H 9-42 I 10-22 
HISTORY 4-7, 9-43 
INSTALL 9-44 
INSTALLHIGH/HIINSTALL 9-42, 10-22 
LASTDRIVE 9-45 
REM 9-46 
RETURN 9-47 
SET 9-47 
SHELL 9-48 
STACKS 9-50 
SWITCH 9-50 
TIMEOUT 9-52 

CONFIG.SYS file 
adding comments 9-46 
bypassing at startup 9-8 
clearing the screen 9-14 
commands in 9-4 
confirming each command 9-8 
controlling execution of commands 9-39, 

9-40, 9-47, 9-50 
cursor position 9-17 
description 9-5 
displaying messages 9-35 
editing 9-4 
example 9-5 
example for code page switching 17-7 
increasing disk access speed 9-36 
loading COUNTRY.SYS 9-14 
loading programs in upper memory 10-22 
optimizing memory in 10-10, 10-18 



CONFIG .SYS file (continued) 

setting a timeout for ? and SWITCH 9-52 
setting environment variables 9-47 
setting number of open files 9-38 
specifying the command processor 9-48 
switching between subroutines 9-50 
terminating execution 9-35 
transferring control to another configuration 

file 9-13 
viewing in SETUP 9-5 

configuration files 
AUTOEXEC.BAT 9-6 
bypassing 9-8 
CONFIG .SYS 9-5 
confirming each command 9-8 
editing 9-4 

configuring the system 9-1 
conventional memory 10-1 
COPY command 7-3 
copying system diskettes 2-3 
country codes and code pages 9-16 
COUNTRY command 9-14, 17-8 
COUNTRY.SYS 9-14 
CPOS command 9-17 
CREATE command 12-5 
Create New dialog 20-6 
Create Workgroup dialog 20-6 
current directory 4-13 
cursor position 9-17 

D 
data stack support 9-50 
DATE command 9-7 
DBLBUF.SYS program 11-19 
decompressing compressed drives 12-10 
DELWATCH 15-2 
DEVICE command 9-18 
device drivers 

ANSI.SYS 9-19 
configuring 9-18 
DISPLAY .SYS 9-26 
DRIVER.SYS 9-28 

device drivers 
installing 9-18 
load order 10-23 
loading into upper memory 9-41, 10-22 
memory managers 10-4 
PRINTER.SYS 9-29 
supplied 9-18 
VDISK.SYS 9-30 

DEVICEHIGH command 9-41, 10-22 
directories 

commands listed 4-15 
current directory 4-13 
description 4-9 
names 4-9 
paths 4-14 
root directory 4-13 
security 14-4 
sharing 20-24 
sorting during disk optimization 11-1, 11-5 
structures 4-13 
subdirectories 4-9, 4-13 
symbols 4-14 

disk compression 1-6 
DISKCOPY command 2-3 

using on compressed drives 12-8 
diskettes 

3 .5-inch 4-2 
5.25-inch 4-2 
configurations 4-3 
copying 2-3 
description 4-2 
formatting 4-4 
handling A-2 
write-protecting 4-2 

DISKMAP 15-1 
DISK OPT 

and Stacker 12-4 
before running 11-2 
d escri pti on 11-1 
optimization methods 11-4 
running on network servers 22-2 
sorting directories 11-5 
starting 11-2 
starting optimization 11-5 
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DISKOPT (continued) 
stopping 11-2, 11-5 
using 13-7 
using menus 11-3 
using the command line 11-6 

disks 
caching data 11-7 
compressing 1-6, 12-1 
configurations 4-3 
definition 4-1 
improving performance of 1-7, 11-1 
memory 4-3 
optimizing 11-1 
preparing 4-3 

DISPLAY .SYS device driver 17 -8 
described 9-26 
loading 9-26 

displaying messages in batch files 7-5, 7-20 
DOS command 9-32, 10-14 
DOSBook 

buttons 5-5 
description 1-5, 5-1 
getting help 5-3 
glossary keywords 5-5 
keyboard commands 5-6 
keywords 5-4 
moving around 5-5 
printing from 5-7 
reference keywords 5-4 
starting 5-1 
starting from EDIT 6-5 

DOSBO.OK command 5-1 
DOSKEY command 7-31 
double buffering 11-19 
DoubleSpace compressed drives 12-6 
DPMI (DOS Protected Mode Interface) 10-13, 

13-5 
DPMS (DOS Protected Mode Services) 1-6, 

10-15, 11-7 
drive letters 

assigning to shared applications 21-16 
description 4-2 
setting last drive letter 9-45 
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DRIVER.SYS device driver 
description 9-28 
loading 9-28 

drives 
changing 4-7 
configurations 4-3 
creating from free space (Stacker) 12-5 
creating logical drives B-5 
decompressing data on 12-10 
defining characteristics 9-28, 9-33 
description 4-2 
improving performance 11-1 
selecting to cache 11-13 
setting last drive letter 9-45 

DRIVP ARM command 9-33 

E 
ECHO command (in CONFIG.SYS) 9-35 
ECHO subcommand 7-5, 7-20 
EDIT 

automatic backup copies 6-14 
command summary 6-16 
creating batch files with 7-2 
deleting text 6-7 
described 6-1 
getting help 6-1 
inserting or overwriting text 6-3 
menus 6-3 
moving the cursor 6-5 
quitting 6-13 
saving changes 6-11 
searching for and replacing text strings 6-12 
selecting files to open 6-2 
starting 6-1 
technical details 6-15 
using 6-2 
using markers 6-11 
using the EDIT interface 6-1 
working with blocks of text 6-9 
writing to the screen 6-15 

EDIT command 6-1 
editing the command line 4-7, 8-8 



EMM386 memory manager 
A20 handling 10-20 
additional memory for Compaq computers 

10-20 
advanced memory options 10-13, 10-18 
copying ROM to RAM 10-11 
described 10-4 
DPMI support 13-5 
enabling EMS support 10-11 
excluding a specific area 10-14 
including a specific area 10-14 
loading and configuring 10-4, 10-10 
loading DPMI 10-13 
making an area of memory available 10-21 
MS Windows support 10-12 
options described 10-5 
preventing extended BIOS relocation 10-21 
reserving extended memory for non-XMS/ 

LIM applications 10-13 
setting the LIM EMS page frame 10-14 
specifying the VxD location 10-21 
switching between real and protected mode 

10-17 
syntax 10-4 
turning on and off 10-17 
using spare video memory 10-12 
Weitek support 10-18 

EMMXMA memory manager 10-9 
environment variables 

COMSPEC 9-49 
in batch files 7-8 
setting 9-4 7 

error log 
maintaining from DOS 22-7 
maintaining from MS Windows 22-8 

error messages A-7 
EXIT command 9-35 
expanded (EMS) memory 

described 10-2 
disabling when not required 10-23 
enabling 10-4, 10-11 
setting the page frame location 10-14 
using for task switching 13-4 

extended (XMS) memory 
described 10-2 
enabling 10-4 
reserving for non-XMS/LIM applications 

10-13 
extended BIOS data area 10-21 
extended partitions B-4 
external commands 4-4 

F 
FASTOPEN command 9-36 
FBX 14-16 
FCBS command 9-3 7 
FDISK B-1 
File Allocation Table (FAT) 15-1 
file control blocks (FCBs) 9-37 
file recovery 

DELWATCH 15-2 
DISKMAP 15-1 
UNDELETE 15-2 

filelists 4-12 
files 

.BAT files 7-2 

.COM files 4-4 

.CPI files 17-3 

.EXE files 4-4 

.INI files 12-7, 13-5 
commands listed 4-10 
corrupted A-3 
creating and editing text files 6-1 
defragmenting 11-1 
description 4-9 
filelists 4-12 
filename extensions 4-9 
inputing to commands 16-3 
names 4-9 
printing on the network 21-25 
recovering deleted files 15-1 
redirecting output to 16-1 
reserved names 4-10 
security 14-4 
setting number of open files 9-38 
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files (continued) 

undeleting 15-2 
wildcards 4-11 
working with groups of 4-11 

FILES command 9-38, 13-17 
filters 

described 4-16 
list of 16-4 
using 16-4 

FIND command 16-4 
FOR subcommand 7-20 
FORMAT command 12-8 
formatting and partitioning hard disks 4-3 

G 
GOSUB command (in CONFIG.SYS) 9-39 
GOSUB subcommand 7-10, 7-21 
GOTO command (in CONFIG.SYS) 9-40 
GOTO subcommand 7-9, 7-22 

H 
hard disks 

creating a DOS extended partition B-4 
creating a DOS primary partition B-3 
creating DOS partitions B-2 
creating logical drives B-5 
description 4-2 
improving performance 11-1 
preparing 4-3, B-1 
security 14-3 

hardware interrupts 9-50 
HIDEVICE command 9-41, 10-22 
high memory (HMA) 

described 10-2 
loading the operating system into 10-14 

HIINSTALL command 9-42, 10-22 
HILOAD command 10-15 
HIMEM memory manager 

copying ROM to RAM 10-11 
described 10-7 
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HIMEM memory manager 
excluding a specific area 10-14 
including a specific area 10-14 
loading and configuring 10-7, 10-10 
making an area of memory available 10-21 
options described 10-8 
preventing extended BIOS relocation 10-21 
setting advanced memory options 10-13, 

10-18 
specifying the chip set 10-19 
syntax 10-8 
using spare video memory 10-12 

HISTORY command 4-7, 9-43 

I 
IF subcommand 7 -9, 7 -23 
input, redirecting 4-16, 16-1, 16-3 
insert mode (in EDIT) 6-3 
INSTALL command 9-44 
INSTALL program 2-1 
INSTALLHIGH command 9-42, 10-22 
installing the system 2-1 
internal commands 4-4 
IPX/SPX application switching 

description 26-1 
in DOS 26-1 
in MS Windows 26-2 
TBMI2 26-4 

K 
KEYB command 9-7, 17-9 

L 
labels (in batch files) 7-9, 7-16, 7-21, 7-22, 7-29 
LANalyzer name files 24-7 
LASTDRIVE command 9-45 
LOADHIGH command 10-15 
LOCK command 14-4, 14-8 



logging in to the network 21-3 
logging out of the network 21-41 
Lookahead buffer (NWCACHE) 11-7, 11-15, 

11-19 

M 
macros 

creating 7-31 
described 7-31 
editing 7-32 
restrictions 7-32 
running and stopping 7-32 
saving in batch files 7-33 
special characters in 7-31 

master key password 14-3, 14-7 
MEM command 

description 10-3 
getting help 10-3 

MEMMAX command 
using 10-12, 10-16 
using with the Task Manager 13-6 

memory 
buffers 9-12 
conventional 10-1 
copying ROM to RAM 10-11 
definition 4-1 
displaying current usage 10-3 
enabling expanded memory 10-11 
expanded (EMS) 10-2 
extended (XMS) 10-2 
high (HMA) 10-2 
managing 10-1, 10-23 
optimizing 10-10 
optimizing in CONFIG.SYS 10-18 
optimizing using commands 10-15 
problems A-4 
requirements for NWCACHE 11-7 
sharing cache-memory 11-16 
types 10-1 
upper 10-1 
video 10-12 

memory disks 
creating 9-30 
description 4-3 
swapping files to 13-3 

memory managers 
advanced options 10-13, 10-18 
description 10-4 
EMM386 10-4, 11-8 
EMMXMA 10-9 
HIMEM 10-7, 11-8 
loading and configuring 10-10 

messages 
controlling reception 21-32 
controlling reception from MS Windows 

21-33 
displaying in batch files 7-5, 7-20 
error messages listed A-7 
receiving from other users 21-32 
sending from MS Windows 21-31 
sending to other users 21-30 

MODE command 17-9, 17-11 
MORE command 16-4 
MS Windows 

and Stacker disk compression 12-2 
changing a server's workgroup from 20-13 
comparing network traffic in 24-7 
comparing node configuration in 24-11 
comparing node disk information in 24-10 
comparing server utilization in 24-9 
configuring a server from 20-16 
connecting to shared directories from 21-10 
connecting to shared printers from 21-22 
controlling message reception from 21-33 
creating a User Account from 20-9 
creating a workgroup from 20-5 
creating and modifying shared printers from 

20-36 
creating, modifying, and removing shared 

directories from 20-29 
deleting a User Account from 20-9 
displaying network statistics from 20-21 
EMM386 support for 10-12 
IPX/SPX application switching in 26-2 
logging in to the network from 21-6 
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MS Windows (continued) 

logging out of the network from 21-42 
maintaining audit log from 22-6 
maintaining error log from 22-8 
modifying a User Account from 20-9 
running as a task (Task Manager) 13-16 
running shared applications under 21-17 
saving connections from 21-40 
sending messages from 21-31 
setting rights to configure a server from 

20-18 
specifying the VxD location to 10-21 
starting network diagnostics in 24-2 
support for 1-8 
synchronizing server clocks from 20-23 
testing node connections in 24-14 
using SDSCAN under 14-12 
viewing node statistics in 24-12 
viewing print queues from 21-28 

multi tasking 
choosing 13-2 
description 1-8, 13-1 
DPMI support 13-5 

N 
NET 

changing passwords using 21-35 
connecting to shared directories using 21-9 
connecting to shared printers using 21-19 
controlling message reception using 21-32 
logging in using 21-5 
logging out using 21-41 
sending messages using 21-31 
viewing user account details using 21-34 

NET ADMIN 
backing up workgroup-related data 22-3 
changing workgroups for servers with 20-12 
configuring servers with 20-15 
creating and modifying shared printers with 

20-33 
creating and modifying user accounts with 

20-7 
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NET ADMIN 
creating workgroups with 20-4 
creating, modifying, and removing shared 

directories 20-27 
displaying server performance statistics 

20-20 
maintaining audit logs using 22-5 
maintaining error logs using 22-7 
renaming servers with 20-16 
restoring workgroup-related data using 22-4 
setting local security for servers with 20-22 
synchronizing server clocks with 20-23 

NET commands 
before running 23-6 
connection commands 23-4 
described 23-1 
function commands 23-5 
in batch files 23-2 
reasons for using 23-2 
settings commands 23-5 
summary of 23-3 

NET CONSOLE command 21-43 
NET DOWN command 21-43 
NET.CFG file 3-9, C-2 
NetWare 

changing the Directory Services context 
21-37 

logging in to 21-4 
saving connections to 21-38 
using NetWare print queues 21-18 
using NetWare volumes 21-8 

NetWare commands 23-1 
NetWare DOS Requester 

described C-1 
loading C-5 
modules C-2 
network drivers C-1 
reconfiguring C-5 

NetWare Lite 
NLMIGRAT program 3-12 
updating from 3-12 

NetWare print queues 21-18 



network boards 
installing 3-1 
settings 3-3 

network configuration 
changing 20-1 
changing workgroup of servers 20-11 
configuring servers 20-14 
creating and modifying user accounts 20-6 
creating workgroups 20-3 
managing servers 20-14 
setting up 20-1 
sharing directories 20-24 
sharing printers 20-32 

network diagnostics 
associating network names 24-5 
comparing node disk information 24-10 
comparing server utilization 24-8 
comparing traffic for nodes, servers, or clients 

24-7 
enabling 24-2 
refreshing data 24-6 
saving LANalyzer name files 24-7 
specific DOS features 24-4 
starting in DOS 24-3 
starting in MS Windows 24-2 
testing node connections 24-14 
using 24-1 
viewing another network 24-5 
viewing another workgroup 24-4 
viewing node configuration 24-11 
viewing node statistics 24-12 

network drives 
and the Task Manager 13-6 
installing the operating system from 2-1 

network hardware 3-2 
network maintenance 

audit log 22-4 
backing up workgroup data 22-2 
described 22-1 
error log 22-6 
optimizing server performance 22-2 
restoring workgroup data 22-3 
uninstalling network software 22-8 

network security 
access rights 14-5 
changing passwords 21-35 
changing passwords from MS Windows 

21-36 
creating local users 14-7 
enabling 19-3 
for shared directories 20-25 
guest accounts 14-6 
logging in 21-2 
setting account passwords 14-6 
setting local server security 20-22 
supervisor accounts 14-6 
workgroup manager privileges 14-7 

network user tasks 
assigning drive letters to shared applications 

21-16 
changing passwords 21-35 
changing passwords from MS Windows 

21-36 
closing down servers 21-42 
connecting to shared directories 21-9 
connecting to shared directories from MS 

Windows 21-10 
connecting to shared printers 21-19 
connecting to shared printers from MS 

Windows 21-22 
controlling message reception 21-32 
controlling message reception from MS 

Windows 21-33 
described 21-1 
loading the network software 21-2 
logging in 21-3 
logging in to a different workgroup or 

username 21-5 
logging in to NetWare 21-4 
logging in using saved connections 21-40 
logging out 21-41 
logging out from MS Windows 21-42 
maintaining the audit log from DOS 22-5 
maintaining the audit log from MS Windows 

22-6 
maintaining the error log from DOS 22-7 
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network user tasks (continued) 

maintaining the error log from MS Windows 
22-8 

printing files 21-25 
providing a password to log in to the network 

21-2 
receiving messages 21-32 
running applications on shared directories 

21-14 
running shared applications 21-15 
saving connections 21-38 
saving connections from MS Windows 21-40 
sending messages 21-30 
sharing data on shared directories 21-13 
using NetWare print queues 21-18 
using NetWare volumes 21-8 
using shared directories 21-8 
using shared printers 21-18 
viewing and changing print queues 21-26 
viewing and changing printers status and 

forms 21-29 
viewing print queues from MS Windows 

21-28 
viewing user account details 21-33 

networking 
client-server 1-3 
definition 1-2 
peer-to-peer 1-4 

NLMIGRAT program 3-12 
NLSFUNC command 17-9, 17-10 
Novell DOS 7 

configuring 9-1 
error messages A-7 
installing 2-1 
installing from network drives 2-1 
troubleshooting A-1 

NW CACHE 
caching stacked drives 11-13 
configuration issues 11-18 
control command 11-12 
control options described 11-12 
controlling 11-12 
description 11-7 
disk usage statistics 11-17 
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NW CACHE 
displaying cache status 11-17 
double buffering 11-19 
error statistics 11-17 
features 11-7 
including and excluding drives 11-13 
load order 11-20 
loading and configuring 11-9 
Lookahead buffer 11-7, 11-15, 11-19 
memory usage 11-7 
rebooting the system when cache is active 

11-18 
setting cache size 11-15 
sharing cache memory 11-16 
start-up command 11-9 
start-up options described 11-9 
using SETUP to load 11-11 
writes modes 11-14 

NWCACHE control command 11-12 
NWCACHE start-up command 11-9 
NWCACHE write modes 

buffered write mode 11-15 
delayed write mode 11-14 
described 11-14 
write-through mode 11-14 

0 
online information 

command help 1-5, 4-8 
DOSBook 1-5, 4-8, 5-1 

open file limit 13-16 
operating system 

commands 8-1 
configuring 9-1 
description 1-1 
error messages A-7 
features 1-1, 1-5 
installing 2-1 
installing from network drives 2-1 
loading in upper memory 9-32, 10-14 
specifying the command processor 9-48 
troubleshooting A-1 



optimizing disks 11-1 
output 

appending 16-3 
redirecting 4-15, 16-1 

overwrite mode (in EDIT) 6-3 

p 
page frame (LIM EMS) 10-12, 10-14, 10-23 
PASSWORD command 14-4, 14-8 
passwords 

assigning to files and directories 14-4 
changing 21-35 
changing from MS Windows 21-36 
for files and directories 14-8 
for guest accounts 14-6 
for logging in to the network 21-2 
for network user accounts 14-6 
master key 14-2, 14-3, 14-7 
on supervisor accounts 14-6 
user account 20-6 

PATH command 7-3, 9-7 
paths 4-14 
PAUSE subcommand 7-25 
performance, displaying network statistics 

20-20 
Personal NetWare 

and Stacker disk compression 12-2 
concepts 18-1 
description 1-5 
displaying performance statistics 20-20 
hardware requirements 1-5 
installing 3-1, 3-5 
loading the network software at startup 3-8 
NET commands 23-1 
optimizing and maintaining 22-1 
planning 19-1 
preparing to install 3-1 
security 14-2, 14-4 
setting up 20-1 
uninstalling network software 22-8 
using 21-1 
using NetWare commands 23-1 

pipes 
combining with redirection symbols 16-6 
using 16-4 

Postscript printing 5-7 
preferred workgroup, setting 21-7 
prepared code pages 17-3 
preparing a hard disk B-1 
primary partitions B-3 
print queues 

configure dialog 20-38 
viewing and changing 21-26 
viewing from MS Windows 21-28 

print spoolers 13-6 
PRINTER.SYS device driver 17-8 

description 9-29 
loading 9-29 

printers 
redirecting output to 16-1 
sharing 20-32, 21-18 

printing 
from DOSBook 5-7 
PostScri pt 5- 7 

privileges, workgroup administrator 20-7 
programs 

load order considerations for NWCACHE 
11-20 

loading automatically at startup 9-44 
loading into upper memory 9-42, 10-15, 

10-22 
PROMPT command 9-7 
protected mode, switching between real and 

10-17 

R 
real mode, switching between protected mode 

and 10-17 
rebooting 

when NWCACHE is active 11-18 
while Task Manager is loaded 13-16 

recovering data 1-8 
recovering deleted files 15-1 
redirecting information 4-15, 16-1 
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redirection symbols 4-15, 4-16, 16-1 
combining with pipes 16-6 

REM command (in CONFIG .SYS) 9-46 
REM subcommand 7-6, 7-26 
repeated execution of commands in batch files 

7-20 
replacement variables (in batch files) 7-6 
RETURN command (in CONFIG .SYS) 9-47 
RETURN subcommand 7-10, 7-27 
Rights dialog 

directory rights 20-30 
printer rights 20-3 7 
server rights 20-18 

ROM (Read-Only Memory) 
copying a specific area to RAM 10-13 
copying slow ROM to RAM 10-11 

root directory 4-13 
routers 19-2 
running batch files 7-3 

s 
screen 

clearing 9-14 
pausing after each screenful of information 

4-8 
redirecting data to and from 16-1 
scrolling 4-8 
writing to in EDIT 6-15 

screen saver 14-4, 14-8 
SCRIPT command 5-7 
SDRES 14-15 
SD SCAN 

options 14-11 
using 14-9 
using under MS Windows 14-12 

Search and Destroy program 
described 14-9 
installing 14-9 

security 
against viruses 14-8 
backups 14-16 
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security 
described 1-7, 14-1 
enabling 14-2 
for hard disks 14-3 
locking the computer 14-4 
on a standalone computer 14-3 
on the network 14-4 
passwords 14-2 
protecting files and directories 14-4 
screen saver 14-4 
setting server's 20-22 

Server Configuration dialog 20-15, 20-17 
Server Information dialog 20-17 
servers 

advanced settings 20-19 
assigning to workgroups 19-3 
changing workgroup of 20-11 
choosing 19-2 
closing down 21-42 
configuring 20-14 
configuring from DOS 20-15, 20-16 
creating 20-2 
definition 18-1 
description 1-7 
displaying performance statistics 20-20 
managing 20-14 
optimizing performance 22-2 
planning 19-1 
renaming from DOS 20-16 
setting local security 20-22 
synchronizing clocks 20-23 

SET command 7-8, 9-7, 9-47 
SETUP program 

advise mode 9-3 
compressing drives using 12-3 
description 2-3, 9-1 
enabling network diagnostics in 24-2 
enabling security in 14-2 
exiting 9-3 
getting help 9-3 
installing the network software 3-5 
list of features 9-2 
loading and configuring the Task Manager 

13-2 



SETUP program (continued) 

loading DPMS 10-15 
loading NWCACHE using 11-11 
loading the operating system into upper 

memory 10-14 
main menu 9-3 
setting up for code page switching 17-6 
starting 9-3 
using 9-2 
using to optimize memory 10-10 
viewing AUTOEXEC.BAT 9-6 
viewing CONFIG .SYS 9-5 

shared applications 
assigning drive letters to 21-16 
creating batch files to run 21-16 
running 21-15 
running under MS Windows 21-17 

shared directories 
access rights 20-25 
connecting to 21-9 
connecting to from MS Windows 21-10 
creating, modifying, and removing 20-26 
description 20-24 
naming 20-26 
running applications on 21-14 
saving connections to 21-38 
security 20-25 
sharing applications 20-30 
sharing data on 21-13 
using 21-8 

shared printers 
choosing 19-3 
connecting to 21-19 
connecting to from MS Windows 21-22 
creating and modifying 20-33 
description 20-32 
printing files 21-25 
saving connections to 21-38 
using 21-18 
viewing and changing status and forms 

21-29 
SHELL command 9-48 
SHIFT subcommand 7-6, 7-27 
SORT command 16-4, 16-5 

Stacker 
accessing compressed drives 12-7 
before using 12-1 
caching stacked drives 11-13 
checking compressed drives 12-8 
compressing drives 12-3 
compressing free space 12-3, 12-5 
compression process described 12-6 
compression ratio 12-1 
converting DoubleSpace and SuperStor drives 

12-6 
decompressing 12-10 
description 1-6, 12-1 
free space required 12-2 
mounting and unmounting drives 12-8 
STACVOL files 12-6 
using compressed drives on an uncompressed 

computer 12-11 
STACKER command 12-8 
Stacker commands 

CREATE 12-5 
STACKER 12-8 
UNSTACK 12-10 

STACKER.BIN file 12-7 
STACKER.IN! file 12-7 
STACKS command 9-50 
STACVOL files (Stacker) 12-6 
STARTNET command 21-2 
STARTNET.BAT file 3-8, 23-6, C-1 
stopping batch files 7-5 
subroutines in batch files 7-10 
SuperStor compressed drives ll-13, 12-6 
swap file (Task Manager) 13-1, 13-3 
SWITCH command (in CONFIG.SYS) 9-50 

setting a timeout 9-52 
SWITCH subcommand 7-29 
system files 11-2 
system information (in batch files) 7-12 
system prompt 

description 4-5 
editing commands at 4-7, 8-8, 9-43 
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T 
Task Manager 

adding COMMAND.COM as a task 13-11 
adding tasks 13-9 
allocating memory 13-3 
checking for space 13-11 
deleting tasks 13-13 
description 13-1 
DPMI support 13-5 
foreground/background ratio 13-3 
loading and configuring 13-1 
loading at the system prompt 13-7 
loading in relation to disk cache 11-20 
loading programs globally 13-6 
menu 13-8 
problems with A-6 
rebooting while loaded 13-16 
setting options 13-2 
swap file 13-3 
task and system environments 13-6 
task switching problems 13-13 
TASKMGR command 13-5, 13-7, 13-14 
troubleshooting 13-16 
unloading 13-14 
using SETUP to load and configure 13-2 
using with the network 21-3 

Task Manager menu 
adding tasks to 13-9 
cancelling 13-9 
checking for space 13-11 
deleting tasks on 13-13 
described 13-8 
switching tasks using 13-12 
using 13-9 

task switching 
allocating memory for 13-3 
choosing 13-2 
description 1-8, 13-1 
IPX and SPX applications 26-1 
options described 13-8 

TASKID 26-4 
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TASKMGR command 
description 13-5 
options described 13-7, 13-15 
using 13-7 

TASKMGR.INI file 13-5 
tasks 

adding 13-9 
adding COMMAND.COM as a task 13-11 
checking for space before adding 13-11 
deleting 13-13 
switching between 13-12 
using TASKMGR to work with 13-14 

TBMI2 26-4 
text editor (EDIT) 6-1 
text files, creating and editing 6-1 
TIME command 9-7 
time, synchronizing servers' 20-23 
TIMEOUT command 9-52 
troubleshooting information A-1 
TSRs 10-23 

u 
UNDELETE command 15-2 
UNSTACK command 12-10 
upper memory 

described 10-1 
enabling 10-4 
enabling and disabling using MEMMAX 

10-16 
loading device drivers into 9-41, 10-22 
loading programs into 9-42, 10-15 
loading the operating system into 9-32, 

10-14 
making a specific area available 10-21 
using for NWCACHE 11-19 

user accounts 
choosing 19-4 
creating and modifying 20-6 
creating from DOS 20-7 
creating from MS Windows 20-9 
definition 18-2 
guest 14-6, 19-4 



user accounts (continued) 
planning 19-1 
setting passwords 14-6 
supervisor 14-6 
viewing details 21-33 

v 
VDISK.SYS device driver 

description 9-30 
loading 9-31 
using 13-3 

video memory 
enabling and disabling using MEMMAX 

10-16 
enabling use of 10-12 

virtual disks 
creating 9-30 
description 4-3 
swapping files to 13-3 

viruses, security against 14-8 
VLM.EXE requester module C-2 
volumes 

creating shared 20-24 
naming 20-26 

VxD location 10-21 

w 
Weitek support 10-18 
wildcards 4-11 
workgroup 

changing a server's from DOS 20-12 
changing a server's from MS Windows 20-13 

workgroups 
audit log 22-4 
backing up data related to 22-2 
changing 20-11, 21-5 
creating 20-3 
creating from DOS 20-4 
creating from MS Windows 20-5 
definition 18-1 

workgroups 
error log 22-6 
names 19-2 
number required 19-2 
planning 19-1 
restoring data related to 22-3 
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